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1. First Use

1.1 System Requirements
Our recommendations and minimum system requirements are meant to provide general guidelines for run-
ning GMG ColorProof. We recommend systems that meet or exceed the following requirements.

Especially the ripping time and printing speed depend on the computer performance. Please note that the
ideal computer configuration depends on the printer types, number of printers, and proof mode used. As a
rule of thumb, the larger the printer is (job size) and the higher the number of printers connected to the
computer, the higher are the demands on the computer performance.

Operating system: 

GMG ColorProof supports all versions of Windows Pro / Enterprise / Server officially supported and dis-
tributed by Microsoft. Windows Home is not supported.

Processor: Intel® Core ™ i7

Memory: 8 GB RAM, 512 GB SSD hard disk drive

Hardware components:

Required for the GMG GamutViewer feature: Video card with enabled Direct 3D acceleration and
OpenGL 3.2 or higher, updated driver (not Windows default driver)

Minimum resolution 1280 x 1024 pixels

USB port: 1 for dongle, 1 per measuring device

Measuring devices: GMG ColorProof does not support any measuring device taken out of production by
the device manufacturer.

1.2 Program Installation

1.2.1 Before You Install

To ensure a safe installation, please check the following list before starting the process.

Check the system requirements for the software you want to install.

Make sure a valid license required for the software version you want to install is available on the tar-
get computer.

Unplug all measuring devices connected to the computer (if any). Otherwise, device drivers will not
be properly installed.

Make sure you are logged on as a user with full administrator rights.

Make sure no Microsoft system updates are running in the background. This could lead to an install-
ation failure.

1.2.2 First Time Installation

The following information refers to the installation of GMG ColorProof for the first time on a new com-
puter. If you have already installed the application and you want to make an update to a newer version,
please refer to the following information:

Update GMG ColorProof to a New Version

Installing the Software

You can choose between three methods to install the application, depending on whether the computer on
which you install the application will have an active internet connection or not.

../../../../../Content/system/update-application.htm
../../../../../Content/system/update-application-offline.htm
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Available options Description

Web-based setup This method is recommended if the computer on which you install the application has an
active internet connection. You need to download only a very compact setup file. All
required resources will be downloaded automatically via the internet. The setup file can be
found in the download area of the GMG support website.

From DVD All resources are on the DVD you received from GMG.

Downloaded ZIP archive (Full Setup) If the computer has no active internet connection and you have no DVD, you can download
the setup and all resources as a ZIP archive (from a different computer) and then transfer the
ZIP archive to the computer on which you want to install the application. The ZIP archive
can be found in the download area of the GMG support website.

How to install GMG ColorProof from DVD or ZIP archive

Note Graphics card configuration: Please ensure that the hardware acceleration for your card is set to the
maximum value. You will find this configuration option in the display settings in your system settings.

GMG ColorProof supports the ICC profile versions ICCv2 and ICCv4. Standard ICC profiles are installed
into the Windows default folder for ICC profiles (usually C:\Windows\System32\spool\drivers\color\)
together with GMG ColorProof. Already existing ICC profiles with the same name in this folder are not over-
written.

1. If you downloaded the ZIP archive from the GMG website, copy it to a local directory and extract all
compressed files.

2. Double-click the Setup_5.x.x.x.x.exe file to start the installation.

3. Select the additional program features such as GMG ProfileEditor, GMG GamutViewer, or GMG
Remote CaliWizard you want to install.

4. If the computer will not have an active internet connection (or a slow one), select the option Col-
orProof AppData Package. If it is selected, printer calibration files and profiles will be installed on the
computer. If it is not selected, those files will be automatically downloaded on demand from the
GMG cloud.

5. When the installation is complete, click the Finish button to close the wizard.

1.3 Starting GMG ColorProof

How to start GMG ColorProof

1. Connect the license dongle to a USB port.

2. Double-click the GMG ColorProof program icon on the Windows desktop or start the program from
the Windows Start Menu (All Programs > GMG > ColorProof 5).
After verifying the license information on the dongle, GMG ColorProof initializes and loads the applic-
ation data. The GMG ColorProof icon is displayed in the Windows taskbar and the program is ready
to use.
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2. Getting Started

2.1 About the Help and User Manual
The help integrated into the software and the user manual contain all important information about GMG
ColorProof to help you learn about and use its basic features.

It is assumed that you already have a basic understanding of computer and software terms, but no special
skills are required to read this document.

The GMG ColorProof Help provides a fast and convenient way to look for information. Compared to the
printed manual, it gives you the advantage of scrolling through the text in a non-linear fashion, picking up
all the information you need.

Tip When you press the F1 key in GMG ColorProof, a Help topic corresponding to the currently active dia-
log box will be displayed, so that you quickly find the information you need.

The GMG ColorProof software is part of an ongoing developmental process. Please understand that the
provided documentation is not always up to date. The latest information can usually be found in the Help.

2.2 Welcome to GMG ColorProof
Best quality proofing out-of-the-box: GMG ColorProof is a versatile solution for contract proofing and
mockup production that comes with preinstalled, tested color profiles for all relevant printing stand-
ards.

Highly scalable: Customized software packages support different levels of complexity, thus offering an
ideal solution for your specific requirements.

GMG DotProof excels in a realistic simulation of discrete ink dots (raster proofs).

With GMG DotProof XG you can take advantage of the extended color space of multi-ink print-
ers such as Epson Stylus Pro x900 to produce an outstanding dot simulation.

GMG FlexoProof extends the use further to flexographic and packaging applications, including a
paper structure simulation.

The GMG WT module allows to print white ink in a variety of useful and creative ways.

User-friendly calibration concept for highest stability and consistency across printers, measuring
devices and locations - create identical proofs with different printers, at different locations.

Fail-proof color management: Colors are automatically converted to the printer color space based on
DeviceLink proof profiles. Database assisted validation of all important parameters and profiles.

Integrated Raster Image Processor (RIP): The integrated RIP is based on the PDF Print Engine tech-
nology from Adobe Systems Incorporated. RIP settings are optimized specifically for the used proofer.

Quality control: To guarantee quality, a control strip and a proof label can be printed together with
the proof. The proof verification can be fully automated for printers with an integrated measuring
device.

Tip Please see the following section for more in-depth information on basic concepts.

Best quality proofing

The close integration of high-performance proof printers from several providers, high-quality GMG
ProofMedia, and GMG ColorProof software provides an excellent proof output that matches the expected
print result on the press as closely as possible.
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In compliance with world-wide accepted (or locally used) standards, GMG offers a complete proofing solu-
tion meeting even the highest quality demands. Supported print standards are, for example: ISO Offset, ISO
Newspaper, PSR, GRACoL, SWOP, 3DAP, JMPA, JPC, PPA, and more. The GMG proof system (or parts
thereof) has also been certified by official organizations such as Fogra, ECI, IDEAlliance Inc, 3DAP, PPA.
Please see the GMG website for more information.

GMG DotProof excels in a realistic simulation of discrete ink dots as occurring in the later printing process.
With this unique feature, it is, for example, possible to reliably predict imagesetter problems such as Moiré
effects already at an early stage (before plate making). To simulate the behavior of the separate inks, 1-bit
TIFFs (either generated by an external RIP or by GMG 1-Bit Creator) are converted and sent to the printer
by GMG DotProof.

PDF, PS, EPS, and DCS formats as well as various contone and 1-bit file formats are supported input files.
Vector graphics and text (lineworks), and raster image information are converted to the desired output
format and resolution by the integrated RIP.

Integrated Raster Image Processor (RIP)

In GMG ColorProof, the RIP is integrated into the main application. Basically, images can be ripped either
by the integrated or by an external RIP. The integrated RIP converts vector graphics and text into contone
images (for ContoneProof) or 1-Bit images (for DotProof). It is based on the PDF Print Engine technology
from Adobe Systems Incorporated, and as such based on the same PDF technology as Adobe Acrobat® and
Adobe Creative Suite software.

Color management

GMG ColorProof applies DeviceLink profiles that achieve a very good colorimetric representation of the tar-
get print. Together with the printer calibration and additional features such as paper tint simulation, noise
and sharpness, the same colors can be reproduced across different locations and devices, always showing
the same colorimetric and visual match to the target reference.

GMG ColorProof additionally provides a basic color conversion functionality to first convert your image
data to the desired target color space, for example from RGB to CMYK. This basic conversion is, however,
based on ICC technology and does not include the conversion settings you have in a full color conversion
software such as GMG ColorServer.

Tip Checkout GMG ColorServer to automatically convert image files into a target color space, with or
without resampling into a target resolution and file format. All conversions can be done in a batch based on
a hotfolder technology. Hotfolders can be easily integrated into custom workflows. GMG ColorServer sup-
ports both MX and ICC based color management.

Quality control

GMG ColorProof offers the possibility to print important information such as the target printing standard,
the checksum of the used color profile, and the last date of printer calibration as a proof label. The GMG
Standard Proof Logo documents that a proof has been printed on a high-quality proof medium with highly
standardized color management profiles developed by our color experts.

For enhanced quality control, control strips such as the Ugra/Fogra Media Wedge CMYK or IDEAlliance
Digital Control Strip 2007 can be printed together with the proof. GMG ProofControl automatically verifies
that a proof is within the tolerances of the print standard. Quality control is especially important for legally
binding contract proofs, but also guarantees a stable quality to you and your customers.
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2.3 Program Overview

Fig. 1 Main program window.

The main GMG ColorProof window is divided into the six main views Jobs, History, Workflows, Output,
Database, and System. The screenshot shows the Workflows view.

You can switch from one view to another by clicking the appropriate button on the navigation panel (1) on
the left side of the main program window.

The Jobs view displays all jobs in progress until they are finished. The History view displays all jobs that
are finished. You can print a job again from the History view.

If you are using the GMG ProofControl Inline module, the proof verification status of each job will also be
shown in the History view.

The Workflows view displays all hotfolders (2) and linked workflows (3). Multiple workflows can be linked
to the same hotfolder.

Each workflow defines all parameters for a specific image processing workflow, from the input images, over
color management, load balancing and nesting rules, to the output printer. In the example screenshot, sev-
eral workflows dedicated to different input formats (PDF and TIFF) and different proof standards (ISO
Coated (27L), ISO Uncoated Yellowish (30L), and ISO Newspaper (26 v4) are defined.

All printers (4) that are available for load balancing and their status are also shown in the Workflow view.
This way, you can see all important information at a glance.

The info pane (5) provides more information on the item that is currently selected in the list, for example,
all images in the selected hotfolder or the parameters of the selected workflow.

The Print Queue (7) gives you a quick overview on the status of all jobs assigned to a printer from the
printer pool. You can easily identify a job in the print queue by clicking it with the mouse. The cor-
responding job will be automatically selected in the Jobs view. A tooltip shows you the job status.

The menus in the menu bar refer to the view with the same name, for example, the Jobs menu lists all com-
mands related to the processing of manual jobs or to the Jobs view itself.

The toolbar (6) provides quick access to often-needed software features such as restarting and deleting a
job.

2.4 Proofing with GMG ColorProof—How Does It Work?
Let's suppose you want to proof a one page PDF according to ISO Coated v2 (39L). How do you tackle this
task?

Your basic equipment in GMG ColorProof consists of four things, which are bundled into a Proofing Condi-
tion:
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Printer

Media

Calibration Set

Proof Standard

Let's find out where and how to use this equipment. Open GMG ColorProof and try to follow the steps in
the software. If you get lost in one of the steps or just want more information, click on the corresponding
See also link.

Step What to do How to do it See also

1

Set up Proofing Condi-
tion

First, your basic equipment has to be made available in the Data-
base view.

Click on the Add link in the Printer column to open the Add Item
dialog box. Select your printer from the drop-down list and define
the required printer properties. Select the Media you are using
with the printer, and the ISO Coated v2 (39L) Proof Standard.
Decide for a Calibration Set.

Keep an eye on the validation system of the software, this will
help you to find which information needs to be filled in.

"Database—Managing
Color Managements
Items" on page 154

"Media" on page 157

"Interplay of Color Man-
agement Items" on page
156

2 Calibrate printer In this step, the color space of your printer-medium combination
is checked by printing and measuring a small calibration test
chart.

Directly after adding the printer and color management items you
selected in step 1, you will be asked to calibrate the new printer.
Click OK to start the calibration wizard which will guide you
through the calibration process.

"Output—Printers" on
page 97

"Printer Calibration" on
page 106

3 Print proof Now that the printer is set up and ready to use, you can load the
file you want to proof. Click on the Jobs button on the navigation
panel on the left side. You can either use the New Job button on
the toolbar or just drag and drop your file onto the Jobs view.

In the New Job dialog, select ISO Coated v2 (39L) as Proof stand-
ard. Click Print to print the file.

"Creating New Jobs" on
page 52

"Proof Standards" on
page 166

Special equipment: When is a proof a proof?

A tricky question you might think, but quite easy to answer: as soon as you can verify it. To ensure the
proof simulates the printing condition it was printed for, you simply add a Proof Control Strip (Job >
Label/Strips > Job Control Strips) to your job. A Proof Control Strip such as the Ugra/Fogra Media Wedge
CMYK v3.0 is a standardized and internationally recognized control tool. If your printer features an integ-
rated measuring device, the proof verification can be conveniently automated. If you are using an external
measuring device, you can use the add-on tool GMG ProofControl to measure the control strip and print
the verification label.

See also:

l "Proof Verification" on page 187
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3. Color Management

3.1 How Does the Color Management Work?
The following illustration shows the different color management steps which may be involved when print-
ing a proof in GMG ColorProof.

If an input file contains lineworks or vector graphics, it needs to be rasterized first to translate the vector
information into discrete pixels for printing.
The next step is only required for files which have not been converted to the target color space yet, for
example a PDF containing multiple elements in different color spaces which need to be normalized to one
color space first. This color conversion uses ICC profiles for the color transformation from one working
space to another (Conversion CT/LW, 1).
The main color management starts in step 2, optimizing the color data for the printer color space by means
of a proof standard. Each MX DeviceLink profile linked within a GMG proof standard has been calculated
to perfectly simulate a target printing condition on a specific proof printer equipped with a certain print
medium and ink set.

Step 3 brings in the printer calibration that separates the color data into the inks used by the printer and
hands the data to the printer driver. The printer driver processes the color data and generates a Yes/No pat-
tern for the printer, defining at which places each nozzle releases ink onto the print medium.

Tip The quality optimization achieved by DeviceLink profiles only makes sense if the used printer-medium
combination is regularly calibrated. Our key concepts—standardization and repeatability—can only be
achieved if the printer is kept in tight tolerances by the calibration and recalibration capabilities of the soft-
ware.

Simulation features

All advanced color management settings such as noise or missing dots used in proof standards are applied
both to the image and the control strip (except printer calibration control strip). This ensures a high quality,
because the control strip is printed under the same conditions as the image. Thus, you can make sure that
the target Lab values are still inside the tolerances and not significantly affected by noise or missing dots
simulation.



3. Color Management

15 / 209

3.2 Printing Halftone Proofs with DotProof

Fig. 2 Image processing of halftone and contone proofs.

GMG DotProof allows direct processing of 1-bit imagesetter data, so that they can be inexpensively
proofed on inkjet printers, and errors detected before platesetting or the start of a press run.

For DotProof color management, an MX5 or MXD DotProof profile is used instead of an MX4. As each
screening parameter affects the visual appearance of the proof, we recommend to create a specific profile
for each type of dot shape, screen ruling, screen angles, and compensation curve.

Dot meets spot—DotProof XG

GMG DotProof XG is a module which enables the user to simulate additional spot colors in a halftone
proof, as nowadays often required in the packaging business. Available through an additional license,
DotProof XG has been developed to reflect the extended color gamut of multi-ink printers. Up to now, this
was only possible using expensive and slow thermal halftone proofing systems.

Profiling

Use the integrated profiling module GMG ProfileEditor to create an MX5 proof profile specifically for your
imagesetter RIP and target printing condition. For more information on how to create and apply an MX5
profile, please see our MX5 profiling tutorial available on our website.

NEW With our separate profiler GMG OpenColor, you can create multichannel MXD DotProof profiles
that perfectly simulate the interplay of colors, especially spot color overprints. For more information on
OpenColor profiling, please see the separate documentation of GMG OpenColor.

Proof verification

Control strips ripped under exactly the same conditions as the image can be used to verify the color accur-
acy of the halftone output in GMG ProofControl.

You can create DotProof control strips from scratch with eight 1-bit files (Database view > Control Strips >
New), or screen and import an existing contone control strip such as Ugra/Fogra Media Wedge CMYK
(Tools menu > New 1-Bit Control Strip).

Note Since the resolution of the proofing device is generally lower than the resolution of imagesetters and
CTP devices, DotProof is subject to certain technical limitations. For example, halftone information exceed-
ing 175 lpi can hardly be reproduced in high-end quality on most proofing devices currently available.

Descreening and proofing 1-bit files in ContoneProof mode

If desired, however, it is also possible to print 1-bit files in ContoneProof mode by descreening those files.
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See also:

l "Adding a Custom Control Strip" on page 177

l "1-Bit Creator for PDF/PS Files" on page 41

3.3 Printing Photographic and Fine Art Prints with PhotoProof
For photo printing applications, you can use PhotoProof proof standards to get the maximum out of your
printer when printing RGB data. PhotoProof proof standards are not intended for proofing, but are optim-
ized for printing RGB data in excellent quality (using gamut mapping algorithms to achieve the highest pos-
sible saturation and best visual impression).

Fig. 3 Printing RGB images with PhotoProof proof standards.

PhotoProof proof standards are available for all printers supported in GMG ColorProof and for all widely
used RGB color spaces. A PhotoProof proof standard is named after the input color space it supports.

Supported PhotoProof proof standards:

AdobeRGB

sRGB

ECIRGBv2

Note By using a PhotoProof proof standard, the RGB data is automatically converted to the printer color
space, without an intermediate Conversion CT/LW step into a simulation color space.

See also:

l "Proof Standards" on page 166

3.4 Printing Imposition Proofs

Note Requires an additional license.

Any printer can be connected to GMG ColorProof through a windows print spooler in order to print impos-
ition proofs. Imposition proofs are a great way to quickly check the layout and content.

As the focus is on layout and content, imposition proofs have no claim on color accuracy, as the data is
sent directly to the printer ICC and skips GMG color management via MX profiles. The color management
is configured in the Windows Print Spooler only.
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Fig. 4 Configuring the color management of an imposition proofer.

See also:

l "Setting up a New Printer" on page 99

3.5 Conversion CT/LW

3.5.1 Conversion CT/LW—Converting Your Files to the Target Color Space

Note Conversion CT/LW is not supported for preseparated PS/PDF files.

If your input files do not match the target color space of the proof standard, you first have to convert them
before they are processed according to the settings on the Proof Output page.

A color conversion is applied to images that are not already in the target color space. A conversion
can be a separation from RGB to CMYK, or a CMYK to CMYK conversion from the current CMYK
color space to the target color space.

Conversion settings can be defined separately for contone (CT) and lineworks (LW) elements.

To convert all contone and lineworks elements to a target color space, you need to specify an ICC input
profile, converting the input color data to the LAB color space. The color conversion settings can be
defined individually for each input color space (CMYK, RGB, or Gray). The ICC profile you select as Out-
put Intent ICC Profile then converts the color data from the LAB color space to the target color space.

Tip You can define default conversion settings for manual jobs in the System view > Color Conversion
which are automatically used when input files do not match the color space of the selected proof standard.
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How to convert your files to the target color space

1. Create a new job or set up a new workflow (or edit the Properties of an existing job or workflow).

2. Click the Color Management button on the navigation panel on the left of the Manual Job Manager /
Workflow Properties dialog box.

3. Click either the Conversion CT or the Conversion LW tab. Generally, you will use the same settings
for both CT and LW, that is, setting up Conversion CT is sufficient for most applications.

4. Select the color spaces of the input files for which you want to use the color management. Deselect
the color spaces that you want to keep unchanged.

5. Select conversion rules/profiles for each selected input color space.

6. If you select either option Use the following profile or Use embedded profile if available, otherwise
use the following profile, click the browse button and load the desired color profile.

7. Select the Rendering Intent for each profile. Default is Perceptual.

8. Select an ICC Output Intent profile for defining the target color space.

9. If you want to use different settings for the conversion of LW Elements, click the Conversion LW tab
and deselect the option Same Settings as Conversion CT. Repeat steps 4–8.

Can I choose which ICC engine is used for the color conversions?

The ICC engine converts the input colors to the output colors by computing the color profiles selected on
the Conversion CT/LW page.

For color conversion of files that are not ripped before processing (TIFF, JPEG, etc.), you can select the
ICC Engine under System > ICC Defaults.

For color conversion of files that are ripped (PDF, PS, etc.), the integrated RipServer automatically uses
the Adobe® Color Management Module.

Color conversion settings
Group Short description See also

PDF X Processing With the option PDF X Processing, colors are automatically converted accord-
ing to the output intent of the PDF/X file or in case of a PDF 2.0, to the output
intent of the document page. Make sure that the output intent of the PDF
matches the output intent of the Proof Standard. For example, if the output
intent of the PDF is "ISOcoated_v2_300_eci.icc", you should use an "ISO
Coated v2" proof standard. If you are not sure which output intent ICC profile
is linked within a proof standard, just double-click the proof-standard in the
Database view and click on the Color Management button on the left side of
the configuration dialog.
Manual Conversion: If PDF X Processing is deselected, colors can be con-
verted according either to embedded ICC profiles or to custom ICC profiles.

"PDF X Pro-
cessing" on page
19

Color Space Input Profiles for
CMYK, RGB, Gray

Manual Conversion requires an input profile for at least one color space
(CMYK, RGB, or Gray). Color management is only applied to the color spaces
that are selected here. You can use an embedded ICC profile or load a custom
ICC profile.

Output Intent ICC Profile The Output Intent ICC Profile specifies the transformation from the Lab color
space to the color space that is required for the Proof Output. You can use an
embedded ICC profile or load a custom ICC profile.

Input profile options

The input profile can be defined by the following rules. The output color space is defined by the Output
Intent ICC Profile.

Available options Description

Use Embedded ICC Profile The embedded ICC profile is used to define the input color space. Manual Job Manager: This
option is only available if the image has an embedded profile.

Use the Following Profile A selected ICC profile defines the input color space.
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Available options Description

Use Embedded Profile if Avail-
able, Else Use the Following Pro-
file

Only available in the Workflow dialog box. The embedded ICC profile is used to define the input
color space. If the image does not have an embedded ICC profile, the selected profile is used.

3.5.2 Separation of RGB Images

Note RGB images need to be separated to CMYK before the color management for proofing can be
applied. A separation of RGB images to CMYK is not required if PhotoProof standards/profiles are used.

The following illustration shows the complete color transformation for RGB images from the input color
space to the printer color space.

Fig. 5 Separation of RGB images and following color management. 

The separation from RGB to CMYK is performed in the Conversion CT/LW step and is always ICC based.
Please make sure that the used Output Intent profile matches the simulation color space of the proof stand-
ard (for example, ISO Coated v2 (39L)).

For elements inside a PDF/PS that are already in the correct color space, the Conversion CT/LW step is not
required and is automatically skipped. For example, the embedded ICC profile information can be used as
a tag for checking the color space and for an automated Conversion CT/LW if required.
How to separate an RGB image

1. Create a new job or set up a new workflow (or edit the Properties of an existing job or workflow).

2. Click the Color Management button on the navigation panel on the left of the Manual Job Manager /
Workflow Properties dialog box.

3. Click either the Conversion CT or the Conversion LW tab. Generally, you will use the same settings
for both CT and LW, that is, setting up Conversion CT is sufficient for most applications.

4. Select the RGB color space.

5. Select a conversion rule for the RGB input color space.

6. If you selected either option Use the Following Profile or Use Embedded Profile if Available, Else Use
the Following Profile, click the browse button and load the desired color profile.

7. Select the Rendering Intent for each profile. Default is Perceptual.

8. Select an ICC Output Intent profile for defining the target color space.

9. If you want to use different settings for the conversion of LW Elements, click the Conversion LW tab
and deselect the option Same Settings as Conversion CT. Repeat steps 4–8.

3.5.3 PDF X Processing

Note GMG ColorProof supports PDF X-1, PDF X-3, and PDF 2.0 files. Before processing a PDF, the soft-
ware validates whether the input file is a PDF compliant to PDF X or not. Other requirements according to
the PDF X standard are not verified.
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The option PDF X Processing (Color Management > Conversion CT/LW) is automatically preselected for
PDFs that contain embedded ICC profiles. In workflows, you can additionally define color conversion rules
with embedded or custom ICC profiles, as GMG ColorProof supports an automated processing of PDF X
files together with other file types in the same workflow. These color conversion rules apply to all PDF
input files without embedded ICC profiles and to all non-PDF files. In manual jobs, you need to deselect
PDF X Processing to define color conversion rules.

How does PDF X Processing work?

With the option PDF X Processing, colors are automatically converted according to the output intent of the
PDF/X file or in case of a PDF 2.0, to the output intent of the document page. Make sure that the output
intent of the PDF matches the output intent of the Proof Standard. For example, if the output intent of the
PDF is "ISOcoated_v2_300_eci.icc", you should use an "ISO Coated v2" proof standard. If you are not sure
which output intent ICC profile is linked within a proof standard, just double-click the proof-standard in the
Database view and click on the Color Management button on the left side of the configuration dialog.

Tip If the output intent of a PDF page (or document) does not match the Output Intent ICC Profile selected
on the Conversion CT/LW page (which is per default linked to the selected proof standard), you will be
notified by an information message specifying the page number and the used output intent in the Manual
Job Manager. You can then check the document page and select a Proof Standard matching the output
intent of this particular page.

What happens if the PDF output intent and the selected proof standard do not match?

If the output intent and the proof standard did not match, you would simulate how the given separations
would look like if they were printed under the printing condition defined in the proof standard.

Example: If the output intent is "ISOcoated_v2_300_eci.icc" and you select an "ISO Uncoated Yellowish"
proof standard, the proof will show the color appearance of ISO Coated V2 separations printed on
uncoated yellowish stock and the appropriate ink standard on the press.

See also:

l "Conversion CT/LW—Converting Your Files to the Target Color Space" on page 17

3.6 Color Channels

Fig. 6 Image with spot color channels in the Manual Job Manager.

The color channels from the input image are listed in the Channel column (1) in the order of printing from
top to bottom.
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You can change the order by selecting a color channel and clicking the arrow buttons on the left side to
move the channel up or down in the list (2). Note that CMYK is always printed as one set sequence, which
means that you cannot move or swap these channels. On the screenshot you can see a print sequence,
where a white spot color will be overprinted by process channels.

The mapping of channels to spot colors from a spot color database is shown in the Color column (3). You
can manually remap channels by picking a spot color from the selected spot color set or by defining a cus-
tom spot color. You can also define rules for an automatic mapping of image channels (Channels button on
toolbar, 4).

For multicolor proofing with GMG OpenColor, the channel and print order can be defined either by the
selected OpenColor Proof Standard, or dynamically, according to the current requirements (Channels >
Print Order). Supporting the MatchMyColor color plugin system for Adobe Illustrator, GMG ColorProof is
able to read the XMP metadata of the input file, automatically assign the correct measurements, and create
a matching profile on-the-fly.

Channels table
Column Description See also

Channel Channel name from the input image.

An RGB image contains the channels Red, Green, Blue. A CMYK image contains the chan-
nels Cyan, Magenta, Yellow, Black. A multicolor image file has at least one spot color chan-
nel (any channel name). It can have any number of spot color channels, plus Cyan,
Magenta, Yellow, Black. Multicolor RGB + spot color images are not supported.

CMYK and multicolor images only: You can deselect any input channel by removing the
check mark in the first column of a channel row. Deselected channels are not shown in the
preview and are not printed.

Cali. Indicates whether a spot color uses an MX3 printer calibration or not (defined in the spot
color set). Standard process colors (CMYK, RGB) always use the printer calibration. (The
check mark icon shows only that an MX3 is used for processing the channel, but the printer
calibration is not validated. For example, you could use a linear MX3 if you do not want to
use an MX3 for a process color.)

Invert If activated, the color of the channel is inverted. The brightness value of each pixel in the
channels is converted to the inverse value. For example, a pixel in a positive image with a
value of 255 is changed to 0, and a pixel with a value of 5 is changed to 250.

Color The color currently mapped to the original channel of the input image. You can change
color mappings by clicking in the Color cell and choosing a desired color from the drop-
down list. Custom: Instead of using any predefined colors, you can also define a custom
color value (Tonal Value in percent).

If a PDF/PS file contains cut paths, these can also be defined by selecting Define Cutting
from the drop-down list.

"Spot Colors" on
page 21

"Cutting Contours"
on page 45

Gradation You can assign a gradation correction (sfg) file created in GMG SpotColor Editor to a spot
color channel.

"Printing Spot Col-
ors with a Grad-
ation Correction"
on page 173

3.6.1 Spot Colors

CMYK and RGB channels are regarded as process colors. All other channels are regarded as spot col-
ors.

Process colors are color managed via MX or standard ICC proof profiles. Spot colors are color man-
aged via spot color sets or multicolor ICC profiles.

In case of Roland VersaUV LEC2 series, it is recommended to define the color management of both
process and spot colors, including White (a white spot color or the coating channel), in GMG
OpenColor. To do so, you will need a project describing all color channels in the image you want to
print in GMG OpenColor. GMG OpenColor will then calculate a proof profile specifically for the
proof job, containing a color channel for each color channel in the image. For more information,
please refer to the GMG OpenColor helpcenter: https://gmgcolor.com/support/help/opencolor/

https://gmgcolor.com/support/help/opencolor/
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Tip With an OpenColor license, you can proof spot colors with MXN DeviceLink profiles, enhancing the
spot color simulation with printing process and overprint characteristics.

Channel mapping with spot color sets

GMG ColorProof tries to map a channel name in a document to a spot color name in a spot color set. The
Spot Color Priority defines the order of sequence in which the spot color libraries are searched.

The first exact match is used. If no exact match exists, GMG ColorProof tries to map the channel name to a
similar spot color name and uses the "best match". For example, a PANTONE CVC color will be mapped to
a PANTONE C color. If the suffix specifying the media type (U = Uncoated, C = Coated, M = Matte) is miss-
ing, the spot color will be mapped to the best match color for coated media type (C). For example, a
PANTONE CV color will be mapped to a PANTONE C color.

If no "best match" exists either, the job will not be printed. You will need to manually define the mapping
in the Manual Job Manager > Image > Color Management > Channels page.

Tip You have full flexibility to remap channels in the Manual Job Manager. You can manually map a spot
color channel to a specific color, or you can apply self-defined rules for an automatic channels mapping
(see "Alias-Mapping of Color Channels" on page 25).

Overprinting behavior of spot color channels

The color channels list in the Manual Job Manager (Image > Color Management > Channels) visualizes the
printing sequence: The top color is printed first, the next is second, and so on.

The default order is as follows:

Coating channel (customizable extra channel for printers with special inks)

White spot colors

Process colors

Spot colors

GMG ColorProof offers you full flexibility in defining the print sequence and overprinting behavior for spot
color channels. The overprinting behavior of spot colors from a db3 spot color database can be edited in
GMG SpotColor Editor.
The overprinting behavior of custom spot colors (= spot colors you define by tonal values instead of select-
ing them from a spot color set) can be defined in the Manual Job Manager (Color column > Define Spot
Color). For both spot color types, you can define overprint settings.

Overprint settings

Note Spot colors overprinted by process colors (spots above process colors in the Channels list) are always
calculated in Multiply Channels mode.

Option Description

Multiply
Channels

Automatic algorithm developed by GMG for an optimal overprinting behavior. The Multiply Channels mode is used for
calculating GMG spot color sets, resulting in translucent spot colors (solidity = 0). This way, the print sequence does not
need to be considered. When deactivating this option, you can enter a custom Opacity value for the spot color.

Opacity When customizing the Opacity, the print sequence of spot and process color channels is very important for the resulting
color impression. In most cases, the spot color with the highest opacity should be printed last to achieve the desired opa-
city level.

Opacity defines the blending of overprinting spot color channels with all underlying channels. For example, if spot A is
printed with an opacity of 50% over spot B, spot B shows through spot A with an intensity of 50%. If spot C has an Opa-
city of 100%, it will knock out all underlying channels. An opacity of 100% can be useful, for example, for simulating
very opaque spot colors. If a spot color is printed directly onto the print medium (top channel in the list), the spot color
channel is always printed with 100% opacity, regardless of the Opacity value. This is also the case when printing a Coat-
ing Channel.
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Spot color descriptions in the form of CxF/X-4 spectral data

If you are using a GMG OpenColor proof standard, GMG ColorProof automatically detects CxF/X-4 defin-
itions in the document and converts them into temporary spot color sets (db3 profiles with tints). Color man-
agement is processed in the same way as for regular db3 spot color sets. As for other spot colors, you can
add a spot color control strip to verify the spot colors. Color channels with CxF definition are marked as
such in the Channels list (Manual Job Manager > Image > Color Management > Channels).

You can check the spot color profiles generated from the CxF data under Job > Printer Settings > Spot
Color Priority list. Here, you will see the temporary spot color sets. By clicking a set with the right mouse
button, you can open the spot color set in GMG SpotColor Editor.

Note To use this feature, you will need an active connection to GMG OpenColor and a GMG OpenColor
project with published dynamic profiling data. Please read the GMG OpenColor documentation for more
information.

Note This feature requires GMG OpenColor version 2.2 or higher.

See also:

l "Color Channels" on page 20

l "Alias-Mapping of Color Channels" on page 25

l "Printing an Undercoat" on page 44

l "Spot Color Sets" on page 173

l "Verifying Spot Colors" on page 190

l "Spot Colors and Multicolor ICC Profiles" on page 23

3.6.2 Spot Colors and Multicolor ICC Profiles

Generally, spot colors do not follow the restrictions (limited gamut) of the printing process simulated in the
proof. Thus, the full gamut of the proof printer can be used when printing spots. The color management pro-
cess undergone by process colors is generally not applicable to spot colors.

Spot color channels are generally defined in spot color sets in the GMG ColorProof database. If spot color
sets are used, a further color management of spot colors is not required. If an image is opened in the
Manual Job Manager, missing spot color channels (that cannot be found in any of the spot color sets) are lis-
ted in the info pane on the bottom of the dialog box. You can then manually assign a spot color from a spot
color set to a channel or enter a CMYK value.

However, it is possible to use a multicolor ICC profile as a proof profile for color managing spot color
channels instead of using the spot color sets. If a multicolor ICC profile is loaded as a proof profile, the
channels defined in the ICC profile will be matched to the image channel names. Found matches will show
up in the Color column on the Channels tabbed page. Channels are matched by the ink set name in the
profile.

Spot colors from spot color sets can still be assigned (automatically from the spot color set or manually in
the Channels page) to channels that are not defined in the multicolor ICC profile. It is also possible to over-
write an existing channel definition by using a spot color set. (This is not possible if Conversion CT/LW is
used.)
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Fig. 7 Multicolor ICC processing.

When creating a job with a multicolor image and loading a Custom multicolor ICC proof profile, GMG Col-
orProof automatically matches all existing channels in the image (6 c in this example) to existing channels
in the multicolor ICC profile with an identical channel (ink) name (1). If a channel is missing in the profile,
a spot color from a spot color set can be assigned manually (2) or you can directly define a CMYK value. If
a job is generated by a workflow, the program automatically searches for a matching color in the spot color
sets assigned to the workflow.
How to apply a multicolor ICC color management

1. Create a new job or set up a new workflow (or edit the Properties of an existing job or workflow).

2. Click the Color Management button on the navigation panel on the left of the Manual Job Manager /
Workflow Properties dialog box.

3. Click the Proof Output tab.

4. Select either a Proof Standard with multicolor ICC characterization profile or select Custom from the
Proof Standard list.

5. Select Use the following profile, click the browse button and load the desired multicolor ICC profile.
(This is the input profile, describing the image color space. The output profile (Printer ICC Profile) is
defined in the Calibration Set.)

6. Select the Rendering Intent.

7. Click the Channels tab.

8. Check that all input channels could be matched with a profile channel. Reassign channels if necessary
by choosing the appropriate color from the Color drop-down list.

Channel Mismatch options

If channels are missing in the ICC profile for processing a selected CMYK+spot color file, the file cannot be
processed (job in error status).

On the Channels tabbed page in the Manual Job Manager, you can manually correct the channel assign-
ment. It is possible to reassign any input channels to channels in the ICC file. It is also possible to assign the
same ICC channel to multiple input channels.

If a channelexists in the image, but not in the profile, you can do one of the following:

a. Assign a channel existing in the profile. Duplicate channels are possible. Color values of duplicate
channels will be multiplied.

b. Assign a spot color definition from a spot color set.

c. Manually enter a CMYK or Lab value (free spot color).

If a channelexists in the profile, but not in the image, you can do one of the following:

a. Assign a channel existing in the profile to any channel in the image, thus overwriting the current color
definition of this channel.

b. (Do nothing.) Additional (not used) channels in the profile are ignored.
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Label Information

Label information needs CMYK channels for printing. If CMYK channels are not available in the printed
image (either because no CMYK channels were present as input channels in the first place, or because they
were reassigned to spot color channels), the top color channel in the Channels list is used for printing the
label.

Control Strips

The channels present in an image control strip must also be available in the printed image. If not, the con-
trol strip cannot be printed together with the image. For spot colors, you can print the GMG Spot Color
Control Strip, or load custom spot color control strips into the database (Database view > Control Strips).

3.6.3 Alias-Mapping of Color Channels

With the Channel Mapping options in manual jobs and workflows, you can apply self-defined rules for an
automatic mapping of image channels. You can, for example, replace the channel of an image with a dif-
ferent color, or remove diecuts or varnish layers that have been defined as spot colors.

Tip Map to db3: If you are using GMG OpenColor, you can map channels that do not hold color-critical
information to db3 spot colors to save time in dynamic profiling.

All channel mapping rules are bundled into Rule Sets which can be used both for workflows and manual
jobs.

Rule Set Settings

Choose whether you want to replace or deactivate a channel.

You can add multiple rules.

Use the asterisk sign (*) to map multiple input channel names with a single rule. The asterisk can rep-
resent one or more characters of the channel name.

Example Rule Set

Fig. 8 Alias-mapping of color channels via rule sets.

In our example rule set, all objects with the spot color "Diecut" and "Varnish" will not be printed. The spot
color name "Weiß" will be replaced with the spot color name "White". The rather unspecific spot color
name "Orange" will be replaced with the more specific Pantone color. The two spot colors SpecialBlue and
SpecialGreen will be mapped to the Cyan and Magenta channels of the MX4 profile linked in the selected
proof standard. For flexo printing, these CMYK channels are often modified into spot channels to simulate
the specific overprinting behavior of spot colors.

See also:

l "Channel Mapping in Workflows" on page 89
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3.7 Paper Tint Simulation
A paper tint simulation offers full accuracy by simulating the color appearance of the printing stock that
will be used in production. In some cases, however, you might want to remove the paper tint simulation,
for example when printing on transparent or metallic media or when you are more focusing on a proof that
looks good than a proof that is color accurate.

If the profile white point is rather close to the proof media white point, you can easily subtract the paper
tint without distorting the overall impression of the proof. The bigger the difference between these white
points, the more changes are calculated into the proof output, possibly resulting in a failed proof veri-
fication, because the measured values of the control strips are not within the defined tolerances.

The paper tint simulation can be turned off per job or per workflow, not for single images (Printer Settings
> Printer > Use Paper Tint Simulation). When deactivated, the color value of the paper tint in the selected
calibration file (MX3/MX4/MXC) is set to 0/0/0/0. A new proof profile without paper tint simulation is cal-
culated changing the colors in a way similar to a relative colorimetric ICC processing. If you are using con-
trol strips with the job, the modified profile and calibration file are also applied to the strips.

Subtracting the paper tint from the color profile results in a larger color space, as you can see on the fol-
lowing illustration showing two Swop Groundwood (#5) gamuts in GMG GamutViewer.

Fig. 9 Swop #5 gamuts of an Epson Stylus Pro 7900 printer with paper tint (blue) and without paper tint
(red).
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4. Image Processing
GMG ColorProof automatically processes images according to the input (file format, color space) and
according to the desired output (proof mode, simulated printing condition).

The following provides you an overview on how input files are processed and which processing steps are
performed by the program. This knowledge is not required in detail for operating GMG ColorProof, but it
might be helpful to know which parameters must be defined for which file type and application.

Input File Color Space Application Workflow License

contone image (e.
g. TIFF)

CMYK ContoneProof Proof Output: PhotoProof profile or pre-
ceding separation to CMYK (Con-
version CT/LW)

ColorProof

contone image (e.
g. TIFF)

1 RGB ContoneProof RGB: PhotoProof profile or separation
to CMYK (Conversion CT/LW)

ColorProof

contone image (e.
g. TIFF)

CMYK,RGB DotProof conversion to 1-Bit image (1-Bit
Creator) in RipServer

DotProof

halftone image (1-
Bit TIFF), multi-file

CMYK DotProof, FormProof Merge Files > Screen Detection DotProof

lineworks page (e.
g. PDF, PS)

2 CMYK, RGB ContoneProof rasterizing/separating to CMYK in
RipServer

ColorProof

lineworks page (e.
g. PDF, PS)

CMYK, RGB DotProof rasterizing/separating to 1-Bit image
(1-Bit Creator) in RipServer

DotProof

multi-file con-
tone/lineworks
page (e. g. CT/LW)

3 CMYK, RGB ContoneProof,
(DotProof)

Merge Files > rasterizing/separating to
TIFF (1-Bit TIFF for DotProof) in
RipServer

ColorProof, (DotProof)

contone image (e.
g. TIFF)

CMYK (PhotoProof or RGB
to RGB color con-
version)

converting to RGB in RipServer ColorProof

PDF PDF-to-PDF con-
version

PDF-to-PDF conversion in GMG Col-
orServer

ColorServer

File Filter (4)

All input files must first pass the file filter so that the program recognizes the input files.

In a workflow, you can specify the file format, color space, and so on of accepted input files.

For manual jobs, you can filter the input files by selecting a file type from the Files of type drop-down list in
the New Job dialog box. More automated file filters are not required as you will manually select the input
files.
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Merge Files (5)

Multi-file formats only (3): Multi-file images (1-bit TIFFs, CT/LW files) need to be combined to a single
image. This is either achieved by a description file or by using a pattern recognition. In a workflow, you
can select an appropriate pattern recognition on the Merge Files tabbed page. In a manual job, you can
either select an appropriate pattern recognition from the drop-down list in the New Job dialog box or you
can manually load the input files on the Merge Files tabbed page.

Job/workflow parameters: Merge Files > Pattern Recognitions

Separating into CMYK (Conversion CT/LW, 6)

Contone image files in a RGB color space (1) need to be separated to CMYK (except when PhotoProof pro-
files are used).

Of course you can also color convert contone files that are already in a CMYK color space, for example, for
applying an ICC-based color management (according to the output intent of the proof standard).

Job/workflow parameters: Color Management > Conversion CT/LW settings

Rasterizing (RIP, 7)

An input file containing lineworks (2), typically a PDF or EPS, needs to be rasterized by the integrated RIP.
RIP resolution and other RIP settings are automatically optimized for the selected proofer.

Job/workflow parameters: RIP > Advanced RIP Settings

Creating 1-bit files (RIP)

Lineworks or contone image files are converted to 1-bit files by the integrated RIP for printing images in
DotProof mode. Please note that using 1-bit input files from the original imagesetter is strongly recom-
mended for achieving the most realistic simulation in GMG DotProof.

Job/workflow parameters: RIP > 1-Bit Creator, Advanced RIP Settings

Main color management (Proof Output, 8)

Simulation of a target printing condition (for example, ISO Coated 39L), which is defined in the Proof
Standard, on a certain printer–medium combination (for example, Epson Stylus Pro 4900 and GMG
ProofMedia premium semiMatte 250).

Job/workflow parameters: Color Management > Proof Output

Images with spot colors

Color management is handled separately for spot colors. You will need to select (or set up in the system) a
spot color set for a specific printer–medium combination. Spot colors are then automatically matched to
identical channel names. You can also manually assign a spot color from a set to a color channel or dir-
ectly define a color value in the Manual Job Manager.

Job/workflow parameters: Printer > Spot Color Priority; Color Management > Channels

Images with spot colors can also be converted by the use of multicolor ICC profiles. 

Job/workflow parameters: Color Management > Conversion CT/LW settings

Converting into RGB (Conversion CT/LW)

Contone image files in the CMYK color space can also be converted to RGB (by the integrated RIP).

You can use an automated ICC color management in GMG ColorProof. With GMG ColorServer, you can
use the more advanced DeviceLink MX4 technology for color management.

RGB conversion can make sense if further processing by an MX4 PhotoProof or RGB-to-RGB profile in
GMG ColorServer is required. Please note that this would be a somewhat unusual situation, as these pro-
files are generally applied to images that are still in the (original) RGB color space after retouch.

As the gamut is generally clipped when converting images from RGB to CMYK, a conversion from CMYK
back to RGB cannot restore potentially lost color information. For a color conversion of CMYK images, the
use of an MX4 reseparation profile in GMG ColorServer is recommended.

Job/workflow parameters: Color Management > Conversion CT/LW settings
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Workflows with GMG ColorServer

GMG ColorProof and GMG ColorServer can be integrated into one workflow by using cascaded hotfolders.
For example, multiple hotfolders from GMG ColorServer can be linked to a specific GMG ColorProof work-
flow. This way, you can set up integrated and completely automated workflows for all kind of different
applications and printers.

4.1 Supported File Formats

File type Supported formats

PDF/PS
files

PDF up to PDF 1.7, PDF X-1/-3, PS, Photoshop EPS, Photoshop DCS 1.0 and 2.0.

Contone
files

Various contone file formats, for example: TIFF (compression types PackBits, LZW), JPEG, Photoshop EPS, Photoshop
DCS 1.0 and 2.0, TIFF/IT, Scitex CT/LW, Scitex Assign.

EPS and DCS files can also contain vector graphics (PS elements), but not necessarily. These file formats can also contain
only a contone (TIFF) image. In the latter case, it is not required to rip input images before printing.

1-Bit TIFF Various 1-Bit file formats, for example: 1-Bit TIFF, Barco/Esko LEN, Presstek.

With a GMG DotProof license, you can use the program to extract the screening parameters from 1-bit input files and
print screened proofs that closely match the dots on the press sheet and simulate the final color as well. Note that you can
set up custom pattern recognitions in GMG DotProof to print any conventional 1-bit file.

File format recommendations

For achieving the most realistic proof results, the final 1-bit TIFF (especially when using GMG DotProof) or
a file from the latest processing step possible should be used. This way, platesetter problems or other prob-
lems with the source files can be detected already at the proofing stage.

If a resampling is not required, TIFF (with LZW compression) is recommended as a fail-proof and compact
file format. EPS is not recommended for contone images as the EPS file format needs more disk space than
TIFF.

If a contone image needs to be scaled or resampled for the print, it is recommended to use vector graphics
and text as input data for optimum print results.

PDFs (and PS files) are directly supported by GMG ColorProof, that is, use of an external RIP is not
required for this kind of input files. This will also make your workflows very straightforward.

For PDF workflows, the easiest solution might be to directly use PDF (X-1/X-3) as input file format, as you
can use PDF as a universal interchange format and GMG ColorProof is able to directly process PDF files
(without internal PS conversions). The embedded output intent ensures correct normalizing of colors for
embedded images that are not yet in the target color space. Please note that deviations between proof and
final print production cannot be excluded if the output of the platesetter RIP differs from the internal output
of the integrated RIP, especially if the images embedded into the file require a color conversion before ras-
terizing.

Compression recommendations

Use of lossy compression such as JPEG is not recommended. Please note that file formats such as PDF, PS,
EPS, and DCS can contain compressed images. When creating such a file, make sure to use only lossless
compression such as LZW, or use no compression for all images in the file. Check the image compression
of files that were not created in-house. (Also, images subject to JPEG compression suffer information and
quality loss each time they are edited and saved again, regardless whether the file format is JPEG, EPS,
PDF, or TIFF.)

4.2 Image Settings
Image settings can be different for each single image in a job. Therefore, the image settings buttons in the
navigation panel on the left in the Manual Job Manager are available only if at least one image is selected
in the job preview on the right side. Selected images are indicated by a blue frame.
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Tip Multiselect: When multiple images are selected (by holding down the CTRL key), identical settings can
be applied to all selected images.

4.3 Multi-File Images

4.3.1 Multi-File Images

In general, one can distinguish between the following different input file types. Each file type can have dif-
ferent file formats, but all files of the file type show a common way of being processed in GMG ColorProof.

File type Image type Example

Single file Contone, 8/16 bit TIFF, JPEG

Multi-file Halftone, 1 bit TIFF + Sep

Multi-file Contone, 8/16 bit Scitex CT/LW

Multi-page Contone, 8/16 bit PDF

Multi-page and multi-file Contone, 8/16 bit Scitex CT/LW + Assign

The simplest case is a single file image. A single file can be loaded directly as a manual job into GMG Col-
orProof. If the Filter settings in the workflow are correct, it will be recognized, processed according to the
color management settings, and printed by the workflow.

The other file types need more processing steps before they can be printed: 

Merging/combining multi-file images into a single image: Multi-file images need to be recognized as a
single image (by the pattern recognition) and put together (merged).

Splitting up multi-page files into single images: Each page of a multi-page file will be processed in the
same way a single image. When creating a manual job, you can select the pages that should be pro-
cessed.

Input files that are both multi-page and multi-file are a very special case. In this case, the files first
have to be merged to a single multi-page file. Then, the multi-page file will be split up into its pages.

Multi-file images can serve the following purposes:

1 Bit: Each file contains one separation / color channel with 1-bit color depth of the complete image.

8/16 Bit: Each file contains different parts of the complete image. The nature of these parts can be dif-
ferent, according to the file format. Files can contain linework data (and therefore generally need to be
ripped).

General processing of multi-file images

After the input files passed the workflow filter, the files must be recognized as a single image by the work-
flow. In principle, there are two different ways for this.

If the multi-file image is defined in a description file, for example, Sep file (1-Bit) or Assign file (Scitex
CT/LW), pattern recognition settings on the Merge Files page are not required and will be ignored for those
file types. If a description file is not available, the multi-file image must be defined in a pattern recognition.
We deliver predefined pattern recognitions for widely used multi-file images. By defining custom pattern
recognitions, all types of multi-file images can be supported.

Handling of those files is a bit more complicated as settings on the Filters page and on the Merge Files page
are required for correct file type recognition (Filters) and merging of files to the output image (Merge Files).
If the Filters settings are correct, but not the Merge Files settings, the input files may be recognized cor-
rectly, but will then be processed as separate images and not one multi-file image.

If a multi-file image is loaded into a manual job or recognized by a workflow, all files that were added to
the job and recognized as a single image are listed in the Files list on the Merge tabbed page of the Manual
Job Manager. With the Merge feature, you can manually delete or add files that were not recognized and
print the job again from the History view.
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Merging multi-file images by using a description file 

Multi-file images can be defined by a description file that specifies exactly which files will be combined to
the final image. For using such a description file, you need to select the appropriate File Format filter. If the
description file has been recognized by the workflow (or by the New Job dialog box), all image files
described in the file will be automatically combined to the final image.

Definitions in the description file are binding. It is not possible to remove a file that is listed in the descrip-
tion file or to add a file that is not listed in the description file in the Manual Job Manager after the job has
been created.

If there is a description file in a hotfolder, the program waits until all separation files defined in the sep file
have been recognized. The input files defined in the description file will appear in the Files column of the
workflow as soon as the description file passed the filter and is recognized by the workflow. After all image
files defined in the description file have been recognized, the combined image will be added to a job. If
one file is missing, the remaining files will stay unprocessed in the workflow (and have to be deleted manu-
ally from the hotfolder).

All settings on the Merge Files tabbed page (Pattern Recognitions, Fixed Number of Separations, and Wait-
ing Time) will be ignored if a description file is present (and recognized by the filter).

Merging files by using a pattern recognition

If there is no such description file, you need to set up a pattern recognition. A pattern recognition is like a
file naming convention that needs to be met so that GMG ColorProof will recognize and process the sep-
arate image files as a single image.

If a file that passed the filter is recognized by one of the provided pattern recognitions on the Merge Files
tabbed page of a workflow, GMG ColorProof waits for further corresponding files until one of the following
requirements have been met. The combined image (even if not "complete" according to the applied pattern
recognition) is then instantly added to a job (according to Nesting rules).

Fixed Number of Separations: The defined number of separation files has been reached. Use this para-
meter only if you are sure that you will never process more separations for this pattern recognition, for
example, if you have set up a pattern recognition that processes always CMYK.

The maximum Waiting Time has been reached. The Waiting Time is counted again each time a file
that matches the same pattern recognition appears in the hotfolder.

Waiting Time is applied only to multi-file images that are defined by a pattern recognition. For all other
images, the program checks whether the file size is still growing and starts processing as soon as the final
file size has been reached. If the Waiting Time has been reached, the files that follow a pattern recognition
will be merged into the final image, even though elements defined in the pattern recognition, for example,
a color channel in case of a 1-Bit TIFF or the page (P) file in case of Scitex CT/LW, might be missing. 

Tip For manual jobs, pattern recognitions can be selected in the New Job dialog box, Merge files drop-
down list. For example, when selecting the predefined pattern recognition Generic 1-Bit, all selected sep-
arations will be automatically merged into an image when you click Open (or Print).

Conflicting pattern recognitions

As soon as an input file passes the filter and is being recognized by a workflow, the workflow tries to apply
pattern recognitions that were selected for this workflow.

If those patterns have overlapping elements, but also contradict each other in some elements such as would
be the case if Scitex CT/LW with and without Page (.P) file would be both selected, the result will be unpre-
dictable. For example, it could be that the Page file would be used in one case, but not in another (by the
same workflow), depending on which pattern recognition is applied. Therefore, it is recommended to use
separate workflows for different input image types.

See also:

l "Setting up a Pattern Recognition" on page 33

l "Separated Multi-File Images (1 Bit)" on page 32
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4.3.2 Contone Multi-File Images (8/16 Bit)

Some file formats such as Scitex CT/LW and TIFF/IT are always or can be multi-file formats. This means,
that the final image is set up in separate input files. These files need to be merged according to the appro-
priate pattern for this file type to generate the output image.

This chapter explains the handling of multi-file formats that are contone or linework images, but not 1-bit.
(Handling of 1-bit files is explained in the topic "Pattern Recognitions" on page 33.)

General rule: If the multi-file image is defined in a description file, for example, sep file (1-bit) or Assign file
(Scitex CT/LW), pattern recognition settings on the Merge Files page are not required and will be ignored
for those file types. If a description file is not available, the multi-file image must be defined in a pattern
recognition. We deliver predefined pattern recognitions for widely used multi-file images. By defining cus-
tom pattern recognitions, all types of multi-file images can be supported.

The following table gives an overview on possible combinations for different input images. For single
images and multi-file images with a description file, a pattern recognition is not required (— in Merge Files
column).

Image type Filters Merge Files

Single (TIFF) input file in TIFF/IT format TIFF/IT —

Separate contone files (.ct), high-resolution contone files (.hc), and lineworks files (.lw). Files
need to be merged and ripped. The FP file (.fp) defines the merging of the input files, including
the positioning (offset) of elements (similar to a PDF).

TIFF/IT TIFF/IT CT/LW

Single (TIFF) input file in Scitex CT/LW format Scitex
CT/LW

—

Separate contone file (.ct) and lineworks file (.lw), LW generally in a higher resolution. Files
need to be merged and ripped. No offset between CT and LW defined (but can be manually
defined in Manual Job Manager).

Scitex
CT/LW

Scitex CT/LW without
Page (.P) file

Separate contone file (.ct) and lineworks file (.lw), LW generally in a higher resolution. Files
need to be merged and ripped. Page file (.p) defines the merging of the input files, including the
positioning (offset) of elements (similar to a PDF). (Monochrome contone images (MP), binary
picture images (BP), binary lineworks (BL), screened data (SD) are not supported.)

Scitex
CT/LW

Scitex CT/LW with
Page (.P) file

4.3.3 Separated Multi-File Images (1 Bit)

Separated images (one channel per file) are always multi-file formats. Generally, these images are 1-bit
TIFFs, but they can also be 8-bit TIFFs (still only one channel per file). This means that the final image is set
up in separate input files. Each file has exactly one color channel. These files need to be merged according
to the appropriate pattern for this file type to generate the output image.

The following table gives an overview on possible combinations for different input images. With a descrip-
tion file, a pattern recognition is not required (— in Merge Files column).

Image type Filters Merge Files

1-bit TIFF (.tif) TIFF Generic 1-bit, Subfolder as Image, FUJIFILM CelebraNT, or custom pat-
tern recognition

1-bit TIFF (.tif, .tifs) with Sep
(.sep) description file

GMG RipServer
.sep

—

1-bit TIFF Barco/Esko LEN (.len, .tif) Barco LEN Barco Flex RIP

1-bit Presstek Presstek

Merging 1-bit TIFFs by using a description (sep) file

1-bit TIFF images can be defined by a description file that exactly specifies which separations will be
merged to a single image. A description file is basically a text file that lists the exact file names of all sep-
arations. The sep file is automatically generated together with the corresponding 1-Bit TIFFs by the RIP.
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To use a sep file, you need to select GMG RipServer sep in the File Format Filter list of the workflow (see
preceding table). Otherwise, the sep file would be ignored and the 1-bit TIFFs would be processed as sep-
arate images. Under Color Depth Filter, you need to select 1-bit. Otherwise, the workflow would not recog-
nize 1-bit images at all.

You can select the sep file when creating a manual job or adding an image to a job. All 1-bit TIFFs that are
configured in the sep file are automatically loaded into GMG ColorProof.

Merging 1-bit TIFFs by pattern recognition

If there is no such description file, you need to set up a pattern recognition (see "Pattern Recognitions" on
page 33) that defines which files will be combined to the printed image and which file holds the inform-
ation for which color channel. For example, the pattern recognition Generic 1-bit describes separation files
with the naming convention "<file name>_<color channel>", for example "_black.tif" for the black channel.

If multiple workflows are linked to the same hotfolder, the top workflow in the list that uses a 1-bit TIFF file
filter will process the image, regardless of whether this workflow has a suitable pattern recognition or not.
This could lead to printing separations as separate images. Therefore, take care that the Filters and Merge
Files settings of all your workflows do not result in ambiguities or conflicts.

4.3.4 Pattern Recognitions

GMG ColorProof supports all separation file types from any RIP and also widely used multi-file
(combined) image formats such as Scitex CT/LW. The detection of corresponding separations / image files is
based on pattern recognitions. A pattern recognition is like a file naming convention that needs to be met
so that GMG ColorProof will recognize and process the separate image files as a single image.

Several widely used pattern recognitions are already predefined in the program. If you use a RIP that is not
supported by any of the predefined pattern recognitions, you need to set up a pattern recognition. Once set
up, you can easily transfer pattern recognitions via export/import to other workflows (or workstations).

Setting up a Pattern Recognition

A pattern recognition is like a file naming convention that needs to be met so that GMG ColorProof will
recognize, merge, and process multi-file image files as a single image.

A multi-file image file name usually contains the following minimum elements:

The name of the image, for example "MyPicture"

The color channel, for example "Yellow"

The file name extension, for example ".tif"

You need to set up a pattern recognition to capture the elements of the file name and point GMG Col-
orProof to the required information in the file name. Thus, GMG ColorProof will be able to interpret the file
names and merge the final image from all required input files. A pattern recognition is set up via regular
expressions, written in a dedicated syntax that is able to cover almost all possible file name patterns. To
simplify this task, GMG ColorProof comes with a Pattern Recognition Wizard.
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How to set up a pattern recognition

1. On the Workflow menu, click Pattern Recognition.
The Pattern Recognition Wizard is started.

2. Enter a name of your choice for the patter recognition.

3. Click the Open button to select the files that need to be merged.
In our example, we loaded four color separations.

4. Click the Next button to proceed.

5. Select one of the suggested pattern recognitions from the drop-down list, or define your own pattern
recognition.
The File Recognition Preview provides a convenient way to test the selected or defined pattern recog-
nition on the fly.

The preview shows the four 1-bit separation files correctly recognized as a single image according to
the selected pattern recognition "<title>_<color|Cyan|Magenta|Yellow|Black>.tif". As the title is the
same in all separations, the pattern recognition could also be set up as "<*>_<col-
or|Cyan|Magenta|Yellow|Black>.tif".

6. Click Finish to save the pattern recognition.
The pattern recognition will now be available for manual jobs and workflows.
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Pattern recognition elements and syntax

This table lists all pattern recognition elements available in GMG ColorProof. You can combine any ele-
ments to capture the elements of your custom file names. The title and color channel information elements
are mandatory. It is recommended to define the pattern recognition as exactly and as strictly as possible, to
ensure a perfect match with all appropriate input files.

Pattern recognition element
Example
pattern

Example file
name string

Interpretation

XXX .tif .tif File name extension or fixed file
name element, spelled exactly as in
the file name, e.g. “.tif” or “_”

* * MyPicture Variable string with variable length

? or ??? ??? GMG Variable string with fixed length.
The number of ? represents the num-
ber of characters in the string.

<*> <*> MyPicture Variable string, but identical for all
files

<?> or <???> <???> GMG Variable string with fixed length,
but identical for all files

<title> <title> MyPictureHas
aLongName

The job name in GMG ColorProof
will be derived from the title ele-
ment.

<title:N> <title:10> MyPictureH Limits the job name to a length of N
characters

<color|Cyan|Magenta|Yellow|Black> Color channel identifiers

<color|C/Cyan|M/Magenta|Y/Yellow|K/Black> GMG ColorProof will search for C
in the file name and interpret it as
the Cyan color channel, and so on.

<color:4|1000/Cyan|2000/Magenta|3000/Yellow|4000/Black> All (4) color channels are rep-
resented by numbers with 4 digits.
1000 = Cyan, 2000 = Magenta, and
so on.

<color|Cyan|Magenta|Yellow|Black|Orange|PANTONE*|*> GMG ColorProof will search for the
color channel names Cyan, …,
Orange, PANTONE* (with variable
suffix) and *, which can be any
string.

<color|C/Cyan|M/Magenta|Y/Yellow|K/Black|???/P???|*> GMG ColorProof will search for C
in the file name and interpret it as
the Cyan color channel, and so on.
A string with 3 digits is interpreted
as a spot color channel name with
a leading "P" (as in Pantone).

Sample patterns

This table lists some typical examples.with various applications.

Pattern recognition Description/Examples

<title><.nlw|-CT?.nct> Scitex CT/LW from Scitex Brisque RIP, without
Assign file: Altona.nlw; Altona-CT1.nct; Altona-
CT2.nct

<title><color|C/Cyan|M/Magenta|Y/Yellow| K/Black|(*)/*><??>.tif Harlequin RIP, using parentheses in the file
names. Any string in-between the parentheses
will be interpreted as a spot color channel: Alton-
aC00.tif; Altona(P123)00.tif

<title>.<title>.<color|C/Cyan|M/Magenta| Y/Yellow|K/Black|*>.tif Altona.P1.C.tif; Altona.P1.P123.tif

<title>_<color|C/Cyan|M/Magenta|Y/Yellow|K/Black|???/P???|????/P????|*>.tif Altona_C.tif; Altona_123.tif; Altona_1355.tif

<title><color|PANTONE*|C/Cyan|M/Magenta| Y/Yellow|K/Black|*><??>.tif AltonaPANTONE 123C00.tif; AltonaC00.tif
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<title:12>????<color:4|1000/Cyan|2000/Magenta|3000/Yellow|0001/Black|*>* The first 12 characters in the file name will be
interpreted as the job name (title), followed by
four variable characters, followed by four digits
that encode the color channel: Alton-
a123456yyyy 1000.tif; Altona123456 xxxx1123.-
tif

4.3.5 Manual Merging of Images

With the Merge feature of the Manual Job Manager, you can manually merge 1-bit images that were not
correctly recognized, or you can merge contone pixel images that have identical dimensions and res-
olution. This might be handy, for example, if you have separate images with text for different localizations
of one image. You can then use the merge feature to overlay the "background" image with the "text" image.

The color channels of merged images are kept separate. If you have a Black channel in image A and a
Black channel in image B, you will have two Black channels for the merged image (displayed on the Chan-
nels page). You could, for example, assign two different spot colors to these channels.

Corresponding color channels are then multiplied (as in Multiply channels in Adobe Photoshop, for
example) before color management is applied.

4.3.6 Identifying the Screening Parameters

If you create a job with a 1-bit file, GMG ColorProof automatically analyzes the separations and extracts
the screening parameters. You can check and correct the screening parameters in the Manual Job Manager
(Image Settings > Screening tab).

In workflows, you can predefine the screen detection with the following options (Input Settings > Screen
Detection tab).

Option Short description See also

Automatic Screen
Detection

Automatic detection of the screening parameters. The original screening is auto-
matically extracted from the input files according to the search mode you select.

"Automatic Screen
Detection—Search
Modes" on page 36

Custom If the input files always come from the same imagesetter (with identical screening
parameters), it is not necessary to search for the screening parameters. Instead, it is
recommended to enter fixed screening parameters to speed up the image pro-
cessing.

Print Spot Color as
Solid Color

As the automated search can be quite time consuming, you have the possibility to
print spot colors as solid colors. Use this option if you want your spot color sep-
arations not screened, but printed as solid 100% color.

(It is not possible to enter custom screening parameters for spot colors in workflows,
because the program does not know how many spot colors will be in an image and
the order in which spot colors will be detected.)

Automatic Screen Detection—Search Modes

In workflows, the screening parameters of 1-bit files can be detected automatically with the following
search modes. The screening parameters of Esko 1-bit TIFF files, for example, can be read from the XMP
metadata in the search modes Standard or Adaptive (Full Search).

Search
Mode

Description

Standard The 1-bit data is decompressed and the search for an angle is finished as soon as a screen set can be identified. This is the
most common and quickest search method. It can lead to wrong results if the image has very fine structure elements that
could be misinterpreted as raster dots.

Full
Search

The 1-bit data is decompressed and analyzed completely. This search method is the most accurate and time consuming,
depending on the size of the data file.

Adaptive
(Full
Search)

Searches until the screen information for two channels could be identified. The screen information for the rest of the
color channels is then assumed according to standard screen sets.
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Checking the Screening Parameters in the Manual Job Manager

If the screening parameters of a 1-bit file cannot be clearly determined, the Screening state will be dis-
played as Undefined and you will be informed by a warning message in the info pane. In the Manual Job
Manager, you can check the screening parameters manually (Image Settings > Screening tab).

Tip It is recommended to visually check the dots and the grid for each channel separately.

Fig. 10 Enlarged view of the Cyan separation.

If the screening parameters are correct, the grid must be aligned with the raster dots as shown in the screen-
shot. If the grid does not fit, you can correct the screen values manually until they fit.

How to manually check the screening parameters of a 1-bit image

1. In the preview pane on the right side of the of the Manual Job Manager dialog, select the image that
you want to analyze.

2. Click the Image button on the navigation panel on the left.

3. Click the Screening tab.

4. Check the Screen Ruling and screen Angle settings that have been detected automatically.

5. Under Check Screening Parameters, click the Manual button.
The dialog for checking the screening parameters is displayed..

6. To validate the screening parameters, select a color channel on the left to display the original dot
shape and the screening.
Use the arrow buttons to move the grid onto the dots to see if the angle and spacing in between the
dots matches the grid. If the grid does not fit, modify the Screen Ruling and Angle on the left.

7. Optional: For a deeper analysis of the screening, click the Automatic button.

8. Click OK to confirm the settings.

4.4 PDF

4.4.1 Multi-Page Documents

When creating a job with a multi-page document, each page will be loaded as a separate image
frame into the job.

Each page will be handled exactly like a separate image, so you could apply different color man-
agement settings, image labels, and so on to each page.
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Note A job is limited to 128 images. Therefore, it is not possible to add a document with more than 128
pages to a job. Documents with more than 128 pages will be ignored.

4.4.2 PDF Page Boxes

A PDF page may define as many as five separate boundaries to control various aspects of the image pro-
cessing. The option Use PDF Bounding Box enables you to set various page boxes in the Manual Job Man-
ager (Layout tab > Crop) as well as in your workflow (Image Processing).

The Art Box defines the extent of the meaningful content in a page (including potential white space),
for example, a graphical element, as intended by the document creator.

The Bleed Box information refers to the bleed settings in the marks and bleeds section of the print dia-
log box.

Unlike the other boxes, the Crop Box has no defined meaning in terms of physical page geometry or
intended use. It only defines where the page should be clipped. The default Crop Box is identical with
the Media Box.

The Media Box size is defined by the size of the page on which you choose to print your file. If the
page size is not changed, the Media Box is identical with the original size of the page or image file.

The Trim Box is taken from the document setup and defines the intended final size of the printed page
after trimming. The Trim Box may be smaller than the Media Box if the page includes additional pro-
duction-related information, such as printing instructions, cut marks, or control strips. The default
Trim Box is identical with the Crop Box.

4.4.3 Raster Image Processing

The RipServer integrated into GMG ColorProof is based on the latest PDF Print Engine technology from
Adobe Systems Incorporated, and as such based on the same PDF technology as Adobe Acrobat® and
Adobe Creative Suite software. The new speed optimized technology leads to enhanced output consistency
and quality, and an excellent RIP stability. This leads to excellent printing results (for proofing or pro-
duction) in GMG ColorProof and thus to an improved overall print productivity and profitability. The integ-
rated Adobe® Color Management Module (CMM) provides methods to transform colors using industry-
standard International Color Consortium (ICC) color profiles (as defined under Conversion CT/LW).

Key features See also

Latest PDF Print Engine technology from Adobe Systems Incorporated

Direct processing of PDFs (without intermediate PS conversion) reflecting the on-going ori-
entation from PS towards PDF as an universal interchange file format in print and prepress

Full support of PDF up to PDF 1.7 "Supported File Formats" on page
29

GMG 1-Bit Creator (for GMG DotProof): A user-defined assignment of predefined screening
angles to color channels offers more flexible screen options combined with the highest screen-
ing quality.

"1-Bit Creator for PDF/PS Files" on
page 41

See also:

l "Proof Modes" on page 41

l "RIP Settings" on page 38

l "1-Bit Creator for PDF/PS Files" on page 41

l "Advanced RIP Settings" on page 40

RIP Settings

The settings for raster image processing such as the RIP resolution, anti-aliasing or font replacement are
defined task-dependent in several places in GMG ColorProof. The following table provides you with an
overview on the various RIP settings and where to look for them.
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RIP Settings Where to find

Manual Job Manager Image Settings >RIP Settings tab

Workflow, printer-specific Print Settings > Printer tab

Workflow, general Print Settings > RIP > RIP Settings

Default RIP Settings System view> General > RIP Settings

About EPS/DCS Files

Often EPS/DCS input files are TIFF images. In this case, ripping is not required and not recommended
(option Do not Rip Photoshop EPS/DCS Files). Deselect this option only if input files contain vector graph-
ics or text elements that need to be rasterized.

Print (and RIP) Resolution

Generally, the ideal print (and RIP) resolution is half the resolution of the print mode of the proof printer.
Thus, for most proofs and printers (with a printing resolution of 720 dpi), a RIP resolution of 360 dpi is suf-
ficient. Higher resolution will not necessarily result in a higher quality. Please note that a higher resolution
will result in a longer RIP and print time. The default resolution is 360 dpi for Epson Stylus Pro printers and
300 dpi for all other printers.

Anti-Aliasing

Aliasing effects occur whenever a vector graphics element is ripped into a raster image, or when a raster
image is downsampled to a lower resolution. The higher the downsampling, the higher the aliasing effects,
because several pixels are reduced to one. Without anti-aliasing, these edges would not appear smooth, but
as jagged lines.

Fig. 11 Contone image without and with anti-aliasing

This image was rasterized in GMG ColorProof without anti-aliasing (1) and with anti-aliasing level 4 (2),
Supersampling method. (Output resolution was 72 dpi.) You can see that the edges appear much smoother
with anti-aliasing.

Anti-aliasing is a method for reducing aliasing effects, resulting in a smoothing of image edges by partially
filling the edge pixels with intermediate color tones. In GMG ColorProof, supersampling is used as an anti-
aliasing method, that is, image elements are ripped at a higher internal resolution. The image is then down-
sampled to the final output resolution afterwards. The extra pixels gained by the supersampling are used for
a smooth rendering of edges.

The higher the quality level, the higher is the supersampling resolution. For example, an output resolution
of 720 dpi and a quality level of 4 results in a supersampling resolution of 2880. The stronger the smooth-
ing effect, the stronger is also the impact on the colors, for example, darkening of edges and lightening of
small elements such as text. For an optimum GMG ColorProof performance and short processing time, it is
therefore recommended to use a low anti-aliasing level, especially when a high output resolution is
desired.
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Different filter types applied during downsampling represent different methods for calculating the final
pixels from the supersampled image. For example, when using the Box Filter, the color intensity of a final
pixel is proportional with the area of overlap of the final pixel with the original image element. Whereas
the Box Filter is applied to the whole image, the Text Filter only renders the edges of all text objects in a
PDF/PS file, providing clear high-quality text. The text anti-aliasing is applied to plain text, not to lineworks
objects. If you want to process files with many images and linework objects, the Text Filter may be an
optimal choice to speed up the RIP processing.

Standard settings for a resolution of 360 dpi would be an anti-aliasing level of 4 and a Box Filter. Max-
imum RIP resolution is 5760 without anti-aliasing and 2880 with anti-aliasing. Maximum quality level for
anti-aliasing is 8.

See also:

l "Advanced RIP Settings" on page 40

Advanced RIP Settings

In the Manual Job Manager (Image Settings > Rip Settings) and on the Print Settings > RIP tab of the Work-
flow Properties dialog box, you can customize those settings that are not used on a regular basis, for
example, overprint settings or font replacement rules for missing fonts.

In this chapter, a general description of the concept behind those settings is provided. A more detailed
explanation of all settings can be found in the info pane at the bottom of the dialog box in GMG
ColorProof. Click an option to update the info pane with the related information.

Overprint settings 

If the option Force Black Overprint is selected, the Black overprint rules defined in the input file are
ignored. Instead, the Black overprint settings defined under Overprint Settings in GMG ColorProof are
used. You can define a threshold for overprinting black, separately for vector graphic elements, and text ele-
ments. The same settings are also applied for Device Gray overprint.

If Force Black Overprint is not selected, the Black (and Device Gray) overprint settings (if any) defined in
the input file will be applied and the overprint settings specified in GMG ColorProof will be ignored. Over-
print settings of other colors, for example, spot colors, always remain unchanged, as specified in the input
file.

A recommended default value is 95 % Black Overprint, for text elements as well as vector graphics. For-
cing Black Overprint leads to a higher reproducibility of the proofs, as overprint settings might be incon-
sistent between different input files from different input sources. On the other hand, using the same
overprint rules for proofing and plate making may lead to proofs that are nearer to the final output of the
printing machine.

Font replacement

All fonts that are not embedded in the input file are replaced by a font with matching name from the
Default Font Folder specified in the System settings (System > General > RIP Settings). If no matching font
name can be found in the Default Font Folder, the missing font is replaced with the (same) Default Font
specified under General Settings in the job/workflow. If fonts are missing and Use Font Replacement was
not selected, the job will be canceled with an error message.

Note Generally, fonts should always be embedded into the input files before ripping, and font replacement
during the ripping process is not recommended, as the replaced fonts might have a different appearance
than was intended by the user. Also, depending on the font replacement settings of the RIP that will later be
used in the plate making process, the result of the proof and the final RIP might not be equivalent, espe-
cially, when multiple fonts are missing.

Separation types

The Separation Type is automatically preselected according to the color space of the input image and the
target color space according to the selected proof standard.
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Available
options

Description

CMYK +
spot color
channels

Input file is ripped into a multi-channel contone image, with CMYK and spot color channels.

All to CMYK Input file is ripped into a CMYK contone image. Spot colors are also converted to CMYK.

All to RGB Input file is ripped into an RGB contone image. Spot colors are also converted to RGB. RGB input files can be con-
verted from one standard RGB color space to another (gamut mapping) with the All to RGB separation rule, for printing
with a PhotoProof standard.

Note Please note that according to the PDF X-1/X-3 specification, only CMYK is allowed as output color
space for a PDF X conversion and spot colors are always maintained. Therefore, only the Separation mode
CMYK + spot color channels is available if the option PDF X Processing was selected on the Conversion
CT/LW pages.

All to CMYK

Generally, you will want to maintain the spot color channels for proofing, to simulate the final result as
close as possible.

Please note that you need to set up an appropriate spot color database with a profile for each spot color in
GMG SpotColor Editor and link the correct spot color set to the calibration set in GMG ColorProof for an
automated proofing of files containing spot colors.

If the required spot colors cannot be found in the database, you will be asked to manually assign color val-
ues to spot color channels for each job in GMG ColorProof. In this case, it might make more sense to con-
vert all color channels to CMYK. Please note that if spot colors are converted to CMYK, the limited gamut
(reflecting the limited gamut of the printing machine) of the proof printer will be used, that is, the desired
ability of spot colors to extent the gamut of the printing machine will not be taken into account.

Note Preseparated PS or PDF files: When ripping a preseparated PS or PDF file, spot color channels are
always maintained. Conversion of the spot color channels into CMYK (options All to CMYK) is not sup-
ported.

Proof Modes

In ContoneProof mode, the input image file in a job is automatically ripped into a CMYK contone image.
GMG ColorProof supports different resolutions and quality levels, affecting ripping and printing speed.

See also:

l "RIP Settings" on page 38

In DotProof mode, PS/PDF files are ripped into 1-bit files. GMG ColorProof supports different predefined
screen sets. When separating into 1-bit, you can select a screen set. Please ask the printing company for
the screen set that will be used for plate making, to achieve a result as close to the final output as possible.

See also:

l "1-Bit Creator for PDF/PS Files" on page 41

1-Bit Creator for PDF/PS Files

Note Some of the features described in the following may not be included in the standard GMG ColorProof
version and require an additional license (GMG DotProof, GMG FlexoProof, GMG ProfileEditor, GMG
ProofControl Inline, or GMG OpenColor). Please contact your local dealer for details.

If the input file is not a 1-bit TIFF and DotProof mode is used as proof mode (on the Proof Output page),
PDF/PS files are automatically ripped into 1-bit TIFFs by GMG 1-Bit Creator.
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Please note that there might be differences in the 1-Bit Creator results between GMG ColorProof and the
external RIP that is later used in the plate making process. For simulating ink dot patterns in the printing pro-
cess with GMG DotProof, the use of the same 1-bit TIFFs from an imagesetter RIP for proofing and for plate
making is recommended for a reliable prediction of effects such as moiré.

Even if the same screen is used in GMG ColorProof, the resulting dot pattern cannot be 100 % identical to
the RIP output during the plate making process, because the RIP engine and the underlying algorithms
might be different.

Defining the screening parameters

Please ask the printing company for the screening that will be used for plate making, to achieve a result in
the proof as close to the final output as possible.

The screening angles are predefined in the screen set, but you can change the assignment of the screening
angle to the color channel in the Screen Set Parameters grid. Other parameters defined in the screen set
such as the screening frequency are shown for your information, but cannot be changed.

Group Short description See also

Screen Set A screen set defines the screen frequency, the screening type, the dot shape, and
the angle of the grid for each color channel separately. The RIP resolution is fixed
and cannot be changed.

If the final screen set that will be used for plate making is unknown, an often-used default screen set is 150
lpi, Euclidian, Cyan 75°, Magenta 15°, Yellow 0°, Black 45°. The screen angles of the separate channels
should be shifted at least by 15° towards each other for avoiding moiré effects.

4.5 Image Preview
The Image Preview shows an individual image placed in a job without the frame (i.e. without image label
or extended paper tint area).

In the Jobs and History list, you can bring up the preview by selecting the listed image name with the
mouse and selecting Image Preview from the context menu (right mouse click).

In the Manual Job Manager, you can preview an image by selecting the image on the Layout tab and
selecting Preview from the context menu.

Soft-proof colors

Note An appropriate interpretation of the soft proof colors is only possible if your monitor is calibrated.

System view > General > Default View Settings: Enable Soft Proof

Images file formats such as TIFF and JPG are per default shown as a soft proof in the Manual Job Manager.
This means they are color-managed for the installed monitor.

For PDF/PS/EPS files, a soft-proof is available only after the file has been ripped by the integrated RIP (see
"Image Preview of PDF/PS/EPS Files" on page 42).

In cases where soft-proofing is not possible, you will see a small information box above the image.

How does the soft-proofing work?

The color management for the soft-proofing is based on the ICC profile of the selected proof standard (input
profile) and the monitor ICC profile (output profile). If no Output Intent ICC is defined in the proof stand-
ard, a temporary ICC profile is created on the fly from the MX4/MX5 profile of the proof standard, provided
that it contains target values for the printing condition.

4.5.1 Image Preview of PDF/PS/EPS Files

Before a PDF/PS/EPS is ripped, the image preview is based on Adobe Acrobat ActiveX Control (available
only if Acrobat Reader 7 or Professional is installed on the same computer as GMG ColorProof) and shows
the Source File.
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After the RIP procedure, you need to put the job on hold (via the context menu) to bring up the Output pre-
view (soft proof). This allows you to switch between Output and original Source File view as illustrated on
the screenshot below.

Tip You can use the Nesting option Hold Finished Jobs (see "Automatic Nesting" on page 93) to create all
workflow jobs (created by the corresponding nesting template) in status Held. You can then open the Image
Preview for a selected image in the Jobs list directly from the context menu or open the job in the Manual
Job Manager.

Note As printed jobs in the History list contain the original input file (not the ripped image), the output pre-
view is not available in the History list.

View and zoom settings
Option Description See also

Select the Zoom mode by clicking the magnifying glass button. The mouse pointer
becomes a magnifying glass with a + or – sign in its center. Click in the center of the area
that you want to magnify or reduce. Hold down the ALT key to switch to the opposite
Zoom mode. Each mouse click magnifies or reduces the view.

Fit on Screen Allows you to view the entire image.

Fit to Width Adjusts the image to the available width of the window.

Original Size Displays the image in its original size.

Click the Pipette to determine the amount of the different inks used in a certain pixel area
(e.g. 3 x 3 pixel) of an image. The percent values of the selected pixel area are displayed
on the Current tab of the color box and refer to the input values of the image, not the
color–managed values.

The Filter function can be used to highlight undefined spot colors.

DotProof Mode Only for 1-bit files. Use this option to toggle between Contone and DotProof view.

Clicking the Channel Palette brings up a color box on the right side which lists inform-
ation about the current (mouse pointer) and total amount of the different inks in the
image. To hide one or more separations, deselect the box to the left of each separation
name.

If Transparent Background is selected, a transparency checkerboard is shown as a back-
ground for transparent areas in an image. If the option is not selected, paper white is
shown for transparent areas.

"Printing
an Undercoat"
on page 44
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4.6 Special Processing

4.6.1 Printing an Undercoat

Note Only available for printers with special inks such as white, gloss, or silver.

If you want to print an extra coating which is not defined in an image, for example a white undercoat (to
increase the opacity of images on transparent or metallic foil) or a finishing varnish layer, you can add a
customizable coating channel on the Channels page. This way, it is not required to add a spot color chan-
nel to the original image. The coating functionality is available for CMYK images and PDF/PS files.

How to add a Coating Channel in manual jobs

1. Create and open a job in the Manual Job Manager.

2. Job > Printer Settings > Printer: Select a printer with a special ink such as white or varnish.

3. Select a Calibration Set that supports the inks needed to print the image.

4. Printer Settings > Print Layers: Define the print order and activate the layers you want to print (see
"Printing Multiple Layers with Special Inks" on page 58).
(Please note that you first need to define the Layer (e.g. White) to be able to define the corresponding
coating channel on the Channels page.)

5. Image > Color Management > Channels: Activate the option Add Coating Channel.

6. Choose a coating Mode and Intensity.

7. Define the coating by picking an option from the Color list.
(Choose a predefined spot color from a spot color database, define a custom spot color by value, or, if
you are using an MX profile with white information, select mx white from the list.)

8. Click Print to print the job.

Fig. 12 Adding a customizable coating channel in the Manual Job Manager.

Coating Modes

The top image (1) will be printed without coating.

The bottom image (2) will be printed with a coating. The mode Full Frame is used. As you can see, all ori-
ginally transparent areas are shown as white areas in the preview area, to visualize the white undercoat.
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Fig. 13 Coating mode Full Frame.

Coated Area Description

Full Frame The dimensions of the coated area are determined by the full image frame, including paper tint area,
image label, and control strip. Use this feature if you want to print an undercoat or a finishing varnish
layer.

Only Non-Transparent
Areas

The coating is printed only behind non-transparent objects. You can use this feature, for example, if you
want to increase the opacity of the image when printing on a transparent foil, preserving the transparent
areas of the image.

Coating Intensity

You can define the intensity of the coating in percent. Depending on the Color you selected for the coating
channel, the intensity can also depend on the spot color settings, as described in the following.

Pure ink: An Intensity of 100% means the highest density of the ink within technical limitations. (The
White color, for example is handled as a white spot color with C0, M0, Y0, K0 and an area coverage
of 100%.)

Special inks from spot color databases (db3): An Intensity of 100% means the highest density of an
ink as defined in the Special Inks settings and the highest density of CMYK as defined by the 100% ful-
crum in the spot color database. For example, if a white spot color in a spot color database is set to
50% and this spot color is printed as undercoat with an Intensity of 50%, the printed white ink cov-
erage will be 25%.

Custom spot color defined in Manual Job Manager: An Intensity of 100% means the highest density
as defined by the Tonal value in %.

4.6.2 Cutting Contours

The upcoming trend to combine print and cut technology provides the market with a streamlined pro-
duction process which reduces time and cost. In GMG ColorProof, you can create mockups with your print
& cut inkjet, coming out printed & cut, ready to apply or show to your customers.

How do I use the cutting functionality?

To begin with, you need to open your PDF/PS file in a vector graphics editor such as Adobe Illustrator and
set a cut path. After saving the cut path as a spot color channel, you open the file in the Manual Job Man-
ager in GMG ColorProof and define the Cutting Settings, as described in the following.

When processing the job, GMG ColorProof extracts the cut path information from each PDF/PS page and
generates a cutting processing step which is automatically started after printing. Individual cut channels can
be used to combine regular cutting and perforation cutting.



GMG ColorProof User Manual

46 / 209

How to create cut paths in Adobe Illustrator

In the following, you will learn how to add a cut path as a vector graphic to a document, using Adobe Illus-
trator CS4. Of course, this is only an example and you can also use any other vector graphics program.

After adding the cut path to the document, you will assign a spot color to it which is required to allow
GMG ColorProof to recognize the path and determine where the cutter is applied. For help on creating
paths for more complex graphics, please refer to the Adobe Illustrator Help.

Note The cut path should have no open ends, but form a closed contour. If you, for example, drew a half
circle, the cutter would not only cut along the half circle line, but also close the gap, returning to the start
point.

Note After creating the cut path, take care not to convert the vector object to a pixel based image, for
example by ripping the file in another software, because GMG ColorProof needs vector information for the
cutting functionality.

1. Open your document in Adobe Illustrator.

2. Draw a vector object as cut path by using the drawing or shape tools shown on the Tools panel on the
left.
(If the Tools panel is not displayed, select Tools from the Windows menu.)

3. On the Windows menu, select Swatches.
The Swatches panel is displayed.

4. On the Windows menu, click Color and select the Stroke button to be able to assign a spot color to
your path in the following steps.

5. Click the New Swatch button on the bottom of the Swatches panel to create a new swatch.
The New Swatch dialog is displayed.

6. Enter any name for the swatch.
(The exact name is not relevant for GMG ColorProof.)

7. Under Color Type, select Spot Color.
(Just as with the name, the color is not relevant. GMG ColorProof only needs a spot color assignment
to recognize the cut path.)

8. Click OK to confirm your changes.

9. Save the file.
The file is now ready for print and cut processing in GMG ColorProof.

How to define the Cutting Settings in GMG ColorProof

Note The cutting settings are grouped into Presets. When changing a preset and exporting the associated
job, it will not be possible to maintain the preset changes on the other system (the settings will be reset to
the default values). Therefore, it is recommended to check the cutting settings after the import.
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1. Open a file with cutting information in the Manual Job Manager.

2. Click the Color Management button on the navigation panel on the left and select the Channels tab.

3. In the Color column of the spot color channel with the cutting information, select Define Cutting from
the drop-down list.
The Define Cutting dialog is displayed.

4. Select or create a Preset from the drop-down list.

5. Define the cutting parameters such as the Blade Pressure or Cutting Speed.

6. Click OK to confirm your choice.

7. Optional: Repeat step 3 to 6 for each spot color channel with cutting information.

8. Print the job.
The job is printed according to the selected parameters. After printing, cutting starts automatically.
The cutter uses the vector cut paths within a spot color channel as a contour line for cutting.
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5. Jobs
A single processing of a file is considered a Job and listed as such in the Jobs view, regardless whether the
process was started by a manual job or by a workflow (defined in the Workflows view). All jobs are listed
in the Jobs view until they are finished.

Fig. 14 Job information in the Jobs list.

A preview of the job (with control strips, label, and so on) selected in the Jobs list (1) is shown in the Info
pane on the right side of the main window (2). The job item in the list also shows all images in the job (3)
below the job info. When an image (and not the job info) is selected in the Jobs list, the Info pane is
updated with a preview of the selected image (not shown).

Several job status messages, including a countdown of the selected number of copies, keep you informed
about the current state of proceedings.

PDF/PS files are ripped first by the integrated RipServer. Jobs in status In RIP are added to the RIP Queue
(4).

Ripped jobs (or jobs that do not need to be ripped first) are added to the Print Queue of the printer they will
be printed on (5). Jobs in the print queue are highlighted by a different color bar, according to the job
status, see following table.

You can select a job in RIP Queue and Print Queue with the mouse. The corresponding job in the Jobs list
will be automatically selected and the Info pane will be updated.

All steps are logged during processing and listed in the Information tabbed page of the Info pane. The Log
file can be exported.

If a job could not be processed, for example, because a required parameter is missing or invalid, an error
message will show up in the Jobs view. The job is considered to be in Error or Waiting for User Action
state. You can then edit the job properties to resolve the problem, and start the job again. If the problem is
resolved by changing not the job itself, but the printer status, for example, changing the print medium
loaded in the printer, the job will be automatically printed afterwards.

Job status information

A file can be in one of the following status in the Jobs/History view. The Color refers to the color of the job
in the Print Queue or in the RIP Queue.

Status Color Description

Waiting Green Job waits in the job queue for further validation and processing. Jobs can be in Waiting
status for a longer time if there are many jobs in the job list and the CPU load is high.
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Status Color Description

Waiting For User
Action

Orange Job requires a user action before it can be printed, for example, changing the print medium
loaded in the printer. The job will be automatically printed after the problem has been
resolved.

Ready Green Job is ready for printing and waits in the job queue for the printer to be ready.

In Rip Gray PDF/PS images are ripped by the integrated RipServer, including Conversion CT/LW.

Preprocessing Green Conversion CT/LW (for non-PDF/PS image files)

Processing Green Images are processed, for example, color management is applied.

Printing Green Job is being printed.

Held Blue Job has been put on hold by the user or saved to the Jobs list for later use. Steps before
status Ready, for example, job validation and Waiting for User Action, Nesting, or In Rip
are completed before a job goes into the Held status. In Held status, the Image Preview is
available for PDF/PS files. You can continue/start the processing a held job by clicking
Print.

Canceled Job has been manually canceled by the user.

Canceled on
Printer

Job has been manually canceled by the user on the printer panel.

Error Red Job cannot be processed with the current settings. You can edit the job properties to resolve
the problem, and start the job again.

Nesting Violet Job was created by workflows. Multiple images are nested by applying a nesting template.
Job will remain in Nesting state until one of the finishing rules (Finish Job and Start
Printing) of the Nesting template is met or until the printing is manually started by the user
by clicking Print.

Printing Nested
Job

Violet A job in Nesting state that has been started by the user by clicking Print.

Nesting Canceled Violet A job in Nesting state that has been canceled by the user.

Nesting Deleted A job in Nesting state that has been deleted by the user. It can take a while until the job is
removed from the job list.

Drying GMG AutoCali Wizard or GMG CaliWizard job. Test chart is being dried according to the
specified drying time.

Preparing To Meas-
ure

GMG AutoCali Wizard or GMG CaliWizard job, before test chart is being measured.

Measuring GMG AutoCali Wizard or GMG CaliWizard job. Test chart is being measured.

Finished Finished jobs are moved to the History view. Cleanup/backup routines for printed images
apply to finished jobs.

Finished, Images
Deleted

Finished jobs in the History list, of which the images have already been deleted by
cleanup/backup routines for printed images. Jobs in this status cannot be printed anymore.

5.1 Job Toolbar and Menu
The Job menu and toolbar allow you to set up and manage manual jobs and to pause, resume, remove,
duplicate or export any listed job that is not yet being printed.

Tip Main program features are accessible by different methods, so that users can choose which way is most
convenient to them. This documentation generally refers only to the toolbar or menu, even though there
may be alternative methods.

Click a button on the toolbar. Move the mouse over a button (without clicking) to display a tooltip.

Click a command on a menu.

Right-click on an item and click a command on the context menu.

Press a shortcut key. Shortcut key combinations are listed next to the corresponding command on the
menu.

Double-click an item (for example, a job or a workflow) to open the corresponding dialog box and
edit settings.
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Tip The import of jobs can be started from the File menu, automatically creating a new job from the impor-
ted *.job archive, with new job and image IDs.

Toolbar and menu commands
Icon Command Shortcut Meaning

New Job CTRL+N Adds a new manual job to the Jobs list. You can directly print a fast job by clicking
the Print button (only one proof standard, with default settings). If you want to use
multiple proof standards or custom settings, click the Open button to open the job
in the Manual Job Manager.

Properties CTRL+O Opens selected job in the Manual Job Manager. You can change the settings in the
job and print it again, for example.

Print CTRL+P Prints the selected job (again).

Hold CTRL+H Puts the selected jobs on hold. Only available for queued jobs that have not been
started yet. The job stays in the Jobs view and is marked as Held. You can start a
job in status Held by clicking Print.

Cancel ESC Cancels the processing of the selected job. The job stays in the Jobs view and is
marked as Canceled.

Delete DEL Permanently removes the selected job. No undo possible. You will be asked
whether to also delete the image file(s) associated with the job.

Save As The selected job is saved as a *.job archive with all settings and images.

Send To The selected job is sent to a defined remote location (System view > Remote Proof-
ing).

Image Preview Shows the processed and color managed TIFF output image as it will be printed on
the target printer. Before the RIP procedure of PDF/PS/EPS files, the image preview
displays the Source File. After the RIP procedure, you can switch between the ori-
ginal Source File view and the ripped TIFF Output Preview.

Duplicate CTRL+D Duplicates job. A new job will be created with the same settings and a new Job ID
and image IDs.

Increase Priority CTRL+UP Increases the priority of the selected job. (Manual Job Manager: Job > Printer Set-
tings > Job Priority; Workflow Properties: General > Job Priority)

Decrease Priority CTRL+DOWN Decreases the priority of the selected job. (Manual Job Manager: Job > Printer Set-
tings > Job Priority; Workflow Properties: General > Job Priority)

Collapse All Collapses all jobs in the Jobs view (if they are not yet collapsed).

Expand All Expands all jobs in the Jobs view (if they are not yet expanded).

Delete All Jobs CTRL+X Can only be used in the History view. Permanently removes all jobs in the History
view without affecting Jobs in the Jobs view. No undo possible.

5.2 Job List View

Selecting jobs

Jobs can be selected in the list with the mouse or by pressing the ARROW UP or DOWN key. You can also
select multiple jobs while holding down the CTRL key. Selected jobs are highlighted by a different border
and background color. To deselect all currently selected jobs, press the SPACE key. To quickly navigate to
the beginning or end of your job list, use the POS1 or END key.
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Job commands

Job commands such as editing job properties or printing a job (again) can be selected from the Jobs/History
menu or from the context menu (by right-clicking on a job) and are applied to the selected job(s).

Image commands

Image commands such as Image Preview can be selected from the Jobs/History menu or from the context
menu (by right-clicking on an image in a job) and are applied to the selected image. The Image Preview
offers a high-resolution preview of the original image (without image processing such as cropping). You can
zoom into the preview without quality loss.

Log file

On the Info pane on the right side, you can review and export the log file as an XML file. This is especially
useful for troubleshooting. Please have the log file available when contacting the support.

5.3 Customizing the Jobs or History View
Jobs can be sorted alphabetically by different properties according to the column headers of the job list.
Click a column header for sorting the job list by the property listed in this column; click the header again
for sorting the list the other way round. Jobs with an identical property are listed in the order of processing.

A filter can be used for filtering the jobs listed in the Jobs/History view, for example, to list only jobs with a
specific name. You can either select a predefined filter from the drop-down list on the toolbar, or you can
enter custom filter terms into the text box on the toolbar.

You can customize the way columns are displayed in the Jobs and History view. For example, you can
hide or show certain columns, change the order of sequence of columns, or increase the width for a
column. The Jobs and History view can be customized independent from each other.

Column information
Column
header

Description

Status Status icon indicating processing, finished processing, canceled processing (error file)

Created Output file creation date and time

ID A unique ID is assigned to each job and image

Name Input file name

Printer Printer name and proof standard name

Type Indicates whether a job was manually created or by a workflow

Priority Job priority (as defined by the user in the Input Settings dialog box)

Copies Number of copies of a job

Width Width of image or total width of printed job

Height Height of image or total height of printed job

Nesting Indicates whether a job uses a nesting strategy or not

How to hide a column

1. Right-click any column in the Jobs or History view.

2. Remove the check mark next to the column header that you want to hide in the interface. Add the
check mark next to the column header that you want to show.

How to resize a column

1. Point to the border between two columns until the mouse pointer changes to an arrow.

2. Click and drag to resize the width of the column left of the arrow.
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How to change the order of columns

1. Click the column header of the column that you want to move.

2. Hold down the mouse button and drag the column to the new position. The column header will get a
transparent appearance. When you point to a border in-between two columns, this border will be
highlighted in blue to indicate a possible new position.

3. Release the mouse button at the desired new position.

5.4 Creating New Jobs
Jobs can be created by workflows or manually in the Manual Job Manager. When creating a manual job,
you can either directly print the job (QuickProof) or you can configure the job settings and/or check the lay-
out by opening the job in the Manual Job Manager.

Tip In the Jobs view, you can also create new jobs by drag-and-drop from Windows Explorer. In the Work-
flows view, you can also add new jobs to a hotfolder by drag-and-drop from Windows Explorer. The
image files are physically copied into the hotfolder and processed according to the hotfolder/workflow set-
tings.

You can later review the settings of finished jobs in the History view. You can reprint a job from the His-
tory with the same or changed settings.

How to create a new job

1. On the File menu, click New Job or click on the toolbar.

2. Select the input file type, for example, TIFF or PDF. If you want to select input files in different file
formats or if you want to see all files, select All Files (1).
The browse box filters the files in the selected folder and displays only images in the selected input
file format.

3. Select an input file (2). It is also possible to select multiple files (by holding down the CTRL or SHIFT
key).
All recognized images will be shown in the Image Files info box (3) at the bottom of the dialog box,
each image in a separate row. Unrecognized files are also listed below the recognized files.

4. Select a Proof Standard, Printer, Medium, and Calibration Set.

5. Click Print to print the selected files directly without user interaction or click Open to edit the job in
the Manual Job Manager (4).

Fig. 15 New Job dialog box.

The screenshot shows the job settings described in the preceding instructions.
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Creating a job with multiple images

You can create a job with multiple images in various ways:

Select multiple images (multiselect) in the New Job dialog box.

Duplicate an existing image in the job by selecting the image and pressing CTRL+D.

Create multiple duplicates by selecting the image and defining a number of copies on the Multiple
Copies tabbed page below the preview.

Add new images to a job by clicking the Add Image button on the toolbar of the Manual Job
Manager.

Workflow, Nesting: Collect multiple images from separate workflows/hotfolders by defining a nesting
template.

Creating a job from a job template

You can export jobs with all relevant settings and files and reuse them as templates for a faster creation of
similar jobs.

1. Configure a job in the Manual Job Manager and select Save As from the Job menu.
The Save As dialog is displayed.

2. Select a location to save the job to and click Save to save the job.
The job is saved as *.job file. Import the job when you need it as a template for a similar job.

3. On the File menu, click Import Job.
The Import Job dialog is displayed.

4. Select the exported job you want to use as a template and click OK to open it in the Manual Job Man-
ager.

5. Right-click on the image you want to replace and select Replace Image from the context menu.
The former image is replaced and the job can be printed with the new image, without having to be
configured from scratch.

See also: 

l "Jobs" on page 48

l "Job Toolbar and Menu" on page 49

l "Supported File Formats" on page 29

l "Multi-File Images" on page 30

l "Restarting Jobs" on page 70

5.5 Manual Job Manager
In the Manual Job Manager, you can manage all general job settings and all images to be printed together
in one job (that is, on a single sheet of paper).

The Manual Job Manager is opened when you create a new manual job. You can also open any job in the
History (regardless of how a job was created, manually or from a workflow) in the Manual Job Manager,
change any settings, and print the job again.

The Manual Job Manager is divided into two major areas:

Job Settings (1)

Image Settings (2)
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Fig. 16 Manual Job Manager, Image Settings area.

For an easy orientation, the two areas are visually separated by the white and blue and background of the
navigation panel. The active area is indicated by a white background color (2); the inactive area has a blue
background (1). An area automatically becomes active as soon as you click a button (3).

You can change any settings that affect the whole job in the Job Settings area (1).

The preview area on the right side of the Manual Job Manager (4) shows the complete job with all images,
label, and control strips. Images are soft-proofed based on the ICC profile from the proof standard.

Images that are selected in the preview are highlighted by a blue border. You can change the settings of
selected images in the Image Settings area (2).

To resize the settings and preview pane, point to the border between the settings and preview pane until
the mouse pointer changes to a handle (5). Click and drag to resize the width.

In our example, the Proof Output page is shown, where you can change the proof standard and define
sharpening effects. All displayed settings can be changed for multiple images at once.

The toolbar (6) provides quick access to often-needed software features such as adding a new image to a
job and creating multiple copies of an image. The status of the job is clearly indicated with a green, orange
or red color (7), giving instant visual feedback .

If you want to print several manual jobs in a similar line, you can save all settings that are not color/printer
relevant (such as job labels, control strips, cleanup/backup settings) as default settings (Job menu > Save as
Default Settings). The default settings automatically apply with the next job being opened in the Manual
Job Manager.

Job and Image Settings
Group Short description

Job Settings The Job Settings affect the global parameters of a job. Here, you can define the job name, print medium,
the job label and control strips, the printer and printer settings, and the calibration set that will be used for
this job.

Image Settings The Image Settings affect all images currently selected in the image preview. Therefore, the Image Settings
area is only available if at least one image in the job is selected.

All changes done in the Image Settings area will be applied to all selected images. If images have different
settings, the corresponding software control will be unavailable. You can only change settings that are
identical. This helps to avoid mistakes, for example, reset different proof standards in a job to the same
proof standard.

Settings that can be defined individually for each image are the pattern recognition and screening detection
parameters for 1-Bit TIFFs, the raster parameters for PDF/PS files, color management settings, sharpening
effects, image label and control strips (that will be printed together with each image), image marks, and
cleanup and backup rules.
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See also: 

l "Creating New Jobs" on page 52

l "Restarting Jobs" on page 70

l "Layout" on page 65

5.6 Job Settings

5.6.1 Media Settings and Job Layout

All media sizes that are supported by at least one of the installed printers are available in the Size drop-
down list. An error message will inform you if the selected media size is not supported by the printer that
was selected for this job.

Job orientation settings Portrait and Landscape are available only for sheet media.

If Fixed Length (only available for roll media) is selected, the job length is limited to the specified length
(similar to sheet media). If Automatic Cut is selected in the Job Defaults of a printer (Job Defaults >
Advanced > Automatic Cut), the medium is cut at the fixed length value. Otherwise, the job length is auto-
matically defined by the area filled with images.

Margins and bleed 

The Printable Area is defined by the media size minus the defined margins. The printable area is shown in
the job preview area on the right side of the Manual Job Manager and can be filled with images (and con-
trol strips).

Some printers support borderless printing. Some printers allow borderless printing horizontally and ver-
tically, some only in combination.

When Borderless Print is selected, margin settings are automatically changed to bleed settings. Printer
prints the bleed in mm/inch over the border of the print medium. This way, a neat borderless printing
without a white space is achieved and a possible misalignment of the medium in the printer is com-
pensated.

Example:

In the example screenshot, the job is based on 17 inch roll media. Therefore, the printable area, without
any margins or bleed, is 17 inch wide.

The used printer supports a bleed of up to 0.12 inch. As the option Borderless Print > Horizontal is selec-
ted, you can add a bleed of 0.12 inch to the print. This means, an image with a width of 17 inch + 0.12
inch bleed on the left and + 0.12 inch bleed on the right can be printed. This results in a total maximum
printable area of 17.24, meaning, you could print an image with a width of up to 17.24 inch. As default,
the Left bleed is set to 0, to avoid that an image is unintentionally clipped by the bleed settings.
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Available options Description

Borderless Print Hori-
zontal

Job is printed with 0 left and right margins. Only available for printers that support borderless printing.

Borderless Print Vertical Job is printed with 0 top and bottom margins. Only available for printers that support (vertical) borderless
printing. When a single job is printed, the medium is not cut. The medium is cut after the printer has prin-
ted the next job. Bleed is not available for vertical borderless print.

2 Cut Mode Defined in the printer (Output > Change Media > Advanced), Manual Job Manager (Job > Printer Settings
> Advanced), or Workflow (Workflow > Print Settings > Advanced). Only available for Epson printers, for
Borderless Print Vertical. To avoid that a small part of the next job is cut together with the first job in a
row (or vice versa), the printer prints a white area in-between jobs. Jobs are then cut borderless.

5.6.2 Job Label

A job label is printed at the end of a job and presents job-specific information such as the job creation time,
or the used printer calibration. If you want to include information on individual images in a job, you can
use image labels.

Job Label Settings

Option Description

Label Type You can choose between preconfigured labels or set up your own label by clicking the Edit Label button.

Format Decide in how many rows you want the label to be printed.

Position Job labels can be printed beneath or to the right side of a job.

Font Settings Font type, size and color can be customized to your preferences. The gray text preview box shows you
how your label text will look like.

Comment Include a comment into the label by clicking into the text box and entering the desired information. The
maximum size is 256 characters.

Label Types
Label Type Description

Basic Label Preconfigured label with basic label elements such as the image name, printing date and proof standard
name. The GMG logo in the Basic Label is smaller compared to the one in the GMG Label.

GMG Job / Image Label Preconfigured label with recommended label elements.

GMG Full Label Contains all available label elements.

ISO 12647-7 Label The ISO 12647-7 Job Label is a preconfigured label that covers the requirements for proof systems accord-
ing to the ISO 12647-7 standard.

Custom label To create a custom label, you can either duplicate and edit a preconfigured label, or create a new label
(Tools menu > Edit Labels: New).

Label elements
Label Information Description

General General label information comprises very basic information such as the date, time of printing, job number
or software version the file was printed with.
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Label Information Description

Color Color label information contains all information referring to the used color management settings such as
the color profile (proof standard) or date of the last calibration.

The GMG Standard Proof Logo is printed only if a GMG proof standard has been used and the
printer calibration is in the range of the Quality Criteria defined in the GMG calibration set.

GMG Proof Standard Logo

Manual jobs: When using multiple proof standards in a job, information relating to the proof stand-
ard such as Proof Standard Name is not available for the job label. Instead, this information will be
printed automatically together with the image control strips.

To include the Printing condition simulated in the proof, for example "PSO, PT 1/2 [ISO 12647-
2:2004 / Amd 1", select the option Proof Standard Description. The information is automatically
extracted.

To include the name of the ink set as given by the manufacturer, for example "Epson UltraChrome
K3 Ink with Vivid Magenta", select the option Calibration Set Description. This information is auto-
matically extracted.

Only the first paragraphs (up to the first paragraph mark / hard line break) of the Proof Standard Descrip-
tion and Calibration Set Description are used for the label. If you are using custom proof standards and
calibration sets that do not contain this information, you can use the Comment box and enter the data
manually.

Format Only for files that are not ripped: If you scaled an image, you can include this information in the label
together with the image dimensions before and after scaling (Image Format / Original Format). If you used
crop marks ( > Image Marks), you can add information on where the crop marks have been placed.

Printer The printer type and the user defined printer name can be printed into the label lines.

5.6.3 Job Control Strips

Job Control Strips are printed at the end of a job to verify the color accuracy of the print output.

Strip
Type

Description Use of Sharpening Use of Coating

Proof
Control
Strip

Printed per proof standard used in the job.
Example: If there are three images with three dif-
ferent proof standards, a separate job control
strip is printed for each proof standard. Each con-
trol strip will get its own label with the proof
standard name.

Printed with sharpening.
MX4 color management is
fully applied, including noise
and missing dots simulation
(if defined).

Proof control strips use the coating
defined for the image. If several images
with different coating settings have been
added to a job, the settings of the first
image are used.

Note Please note that job control strips cannot be used for GMG OpenColor jobs.

See also: 

l "Using Control Strips" on page 188

l "Verifying Spot Colors" on page 190

l "Adding a Custom Control Strip" on page 177

l "Image Control Strips" on page 63

5.6.4 Printer Settings

Group Short description See also

Printer (and loaded
medium)

The Printer list contains all printers that have been set up in the Output view. Next
to the available printers in the drop-down list, the loaded medium is shown in par-
entheses. The loaded medium is the print medium that you selected when setting up
the printer.

"Media Syn-
chronization between
Printer and Software"
on page 121
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Group Short description See also

Medium You can select a print medium that is currently not loaded in the printer for the job
from the Medium list. The job will be created in the status Waiting for User Action.
The job will be automatically printed after you have changed the medium in the
printer configuration in the Output view (select printer and click the Change Media
button).

"Media" on page 157

"Changing the Print
Medium" on page
101

Calibration Set Only calibration sets are available that support the selected printer–medium com-
bination. The print mode is defined in the calibration set. White ink printers: The
undercoat mode (Front or Reverse print) is also defined by the print mode in the cal-
ibration set.

"Interplay of Color
Management Items"
on page 156

"Calibration Sets" on
page 161

"Epson Stylus Pro
WT7900 Print
Modes" on page 138

Paper Tint Simulation Paper tint option which can be turned off to print proofs without a paper tint sim-
ulation. Please note that removing the paper tint simulation affects the color accur-
acy. The option Fill Gaps fills the gaps between images with paper tint simulation so
that the proof job appears more homogenous and is easier to cut. Also, irritating
visual effects due to differences between the simulated paper tint and the original
paper tint of the proof paper are avoided. This option is supported only if the same
proof standard is used for all images in the proof job, as the paper tint is dependent
on the proof standard.

"Paper Tint Sim-
ulation" on page 26

Spot Color Priority When an image with spot colors is added to a job, GMG ColorProof automatically
searches the spot color sets linked to the database for the spot color channel names
in the image. The Spot Color Priority defines the order of sequence in which the
spot color libraries are searched.

Especially useful for power users using multiple printers and load balancing: You
can easily and fast "copy and paste" spot color settings including activ-
ation/deactivation status and priority from one printer to another and from one
workflow to another by using the corresponding toolbar buttons. You can also
apply the settings to all connected printers. This feature also helps to keep your set-
tings synchronized, for example, when a new spot color database is added. This fea-
ture is available even across different printer types, as long as the printers are in the
same printer family (as defined in the calibration set).

"Spot Colors" on page
21

5.6.5 Printing Multiple Layers with Special Inks

Note Only for production printers that support multi-layer printing with special inks such as white, metal-
lic, and clear.

With some printers, you can print single or multiple ink layers. The white ink can, for example, be used as
an undercoat to increase the opacity of images when printing on a transparent media type. Metallic ink can
be printed full tone or combined with CMYK to produce a wide range of metallic and pearlescent colors.
Providing you with a PANTONE Metallic spot color sets, GMG ColorProof enables easy-to-use and highly
accurate spot color simulations including gold, silver and bronze colors.

Instead of configuring separate jobs for each layer of white or clear ink, you can conveniently define print
layers on the Layers tab (Job > Printer Settings > Print Layers). The print medium is automatically pulled
back to its initial position after each layer to print the next layer. The order in which the layers are printed
can be freely modified. All settings on the Layers tab are saved with each job and are restored for the next
compatible job to reduce the configuration time.

Examples for multi-layer printing: 
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Fig. 17 Different print layers for special inks can be configured in a single job.

Note For more information on producing mockups with GMG ColorProof, please see our printer specific
Best Practices.

Automated multi-layer printing

Let's assume you want to proof an image with 6 image channels: CMYK, white andclear ink. To view the
channels of a selected image, you can click on the Color Management > Channels page. On the Printer
Settings > Printer page, you can check the preselected calibration set. As for technical reasons white and
clear ink cannot be printed at the same time, you need to either choose a calibration set with a CMYK Only
color mode or include white and select a W|CMYK color mode instead. The remaining layers can be selec-
ted on the Layers tab, as shown on the following screenshot.
The Main Job Layer includes all colors covered by the selected calibration set on the Printer tab, in this
case CMYK. In addition to the main layer, White and Gloss will be printed in our example (1). The Order
column (2) reflects the order in which the layers will be printed which can be changed by clicking the
arrow buttons on the left. In our example, we want to print a white coating onto the print medium before
applying CMYK. If a validator message prompts you to select a different color mode for a layer, click on the
respective Change Settings buttons (3) to open the layer settings. The layer settings can also be used to
change the resolution of a layer, for example, you can print some layers in a faster 360 dpi print mode.
With Number of Copies and Overprint you can multiply the selected layer. When selecting several copies
of a layer, this layer will be printed several times one layer after the other with drying in between, whereas
when selecting overprint passes, the print head will print the same line several times right on top of each
other.

Note The print sequence is not visualized in the job or image preview so that potential output issues (such
as printing a white undercoat on top of CMYK) will not be shown in the preview.



GMG ColorProof User Manual

60 / 209

Fig. 18 Manual Job Manager: Automated multi-layer printing.

How does the spot color handling work?

Special inks are handled as spot colors in GMG ColorProof. A spot color can be defined with up to three
special inks. If a spot color contains color data for multiple image channels, white takes precedence and
the spot will be displayed on top of the Channels list (Color Management > Channels). The image channel
order can be changed according to your requirements. If you, however, redefine a spot color after the chan-
nel list has once been arranged, it is not automatically updated accordingly.

Special inks are all printed in a separate layer except Silver (Blended) which is printed together with the
CMYK layer. The spot color sets that simulate spot colors with special inks have been suffixed with the
respective ink (for example Silver or Silver Blended). This way, the appropriate sets (Printer tab > Spot
Color Priority list) can be easily recognized and the search sequence customized (see "Spot Colors" on
page 21).

Manual multi-layer printing in separate jobs

If you want to manually define your layers or need a special layering not supported by the Print Layers
functionality, you need to enable the option Print Images on Top of Each Other as shown on the following
screenshot, so that the print medium is automatically pulled back to its initial position, ready to print the
next layer.

Fig. 19 Manual Job Manager: Printing Images on Top of Each Other.
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5.7 Image Settings

5.7.1 Proof Output—Defining the Simulation Color Space

On the Proof Output page, you define the simulation color space (target printing condition) for your
printer-medium combination. Furthermore, you can configure sharpening effects to make edges more clear
and distinct.

Proof Output settings

Group Short description See also

Proof Standard All information required for the color management of a certain printer–medium
combination and for a specific print standard is tied into a proof standard.

RGB proof standards contain PhotoProof profiles which have been designed
for photo printing applications and aim at printing particularly brilliant "RGB"
prints.

With a GMG OpenColor licence, you can also set up OpenColor proof stand-
ards with multicolor profiles for simulating spot color overprints.

"Proof Standards" on
page 166

"Printing Photographic
and Fine Art Prints with
PhotoProof" on page 16

"OpenColor Proof Stand-
ards" on page 168

Proof Mode In ContoneProof mode, the input image file in a job is automatically ripped
into a CMYK contone image. With a DotProof license, you can also print
halftone proofs in DotProof mode, either using 1-bit imagesetter data or 1-bit
files created by the built-in GMG 1-Bit Creator.

"Proof Modes" on page
41

"Printing Halftone Proofs
with DotProof" on page
15

Sharpen 3D Sharpness: Highly efficient and easy-to-use sharpening tool. Use the slider
to set an intensity from 0-20.

Unsharp Mask (USM): Use USM sharpening if you want to have more control
on sharpening effects. USM sharpens by increasing contrast along the edges,
making light pixels even lighter and dark pixels darker. The Threshold specifies
how far apart pixels must differ in value before they are considered to be an
edge. The Amount is like a volume control, increasing the contrast (how much
darker/lighter the edge borders become) by a specific percentage. The Radius
controls how wide the edge rims become—the wider the radius the larger the
edge rims.

Configuration dependencies
Dialog box Short description See also

New Job The selected proof standard (Proof Output) defines the supported printer set-
tings (Calibration Set). It is only possible to select a single proof standard dur-
ing job creation, when loading the input file(s). Multiple proof standards per
job can be defined in the Manual Job Manager.

"Creating New Jobs" on
page 52

"Using Multiple Proof
Standards in a Job" on
page 61

Manual Job Manager The selected calibration set (Printer Settings) defines the supported proof stand-
ards (Proof Output).

"Proof Output—Defining
the Simulation Color
Space" on page 61

"Printer Settings" on page
57

5.7.2 Using Multiple Proof Standards in a Job

You can simulate a different print standard for each image in the job. For example, you can duplicate an
image in the job and then assign a different proof standard to each copy. Thus you can show your clients
how the print result could possibly be altered under different target printing conditions.

Usually, when creating a job, you can select only a single proof standard for all images.

In the Manual Job Manager, you have the following possibilities to print a job with multiple proof stand-
ards:

Add a new image to the job and select a new proof standard.

Select an existing image in the job and select a new proof standard for this image.
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How to use multiple proof standards in a job

1. Set up a job in the Manual Job Manager.

2. Select an image in the job preview area on the right side.
The Image Settings become available.

3. On the toolbar, click the Add Image button.
The Add Images dialog is displayed, offering the same settings as the New Job dialog, except that
printer, medium, and calibration set cannot be changed, because these are global settings that can
only be changed for the whole job.

4. Select an input file. It is also possible to select multiple files (by holding down the CTRL or SHIFT
key).

5. Select a different Proof Standard.

6. Click the Add Images button to add the image to the job.

7. Repeat steps 2 to 6 for all proof standards you want to support.

See also: 

l "Creating New Jobs" on page 52

l "Proof Output—Defining the Simulation Color Space" on page 61

5.7.3 Image Label

An image label is printed together with an image. For each image in a job, an individual image label can
be defined. It can include information specific for an image such as the image name or format, and inform-
ation on color such as the used color profile.

Note An image label is considered to be part of the image frame, which is important for nesting.

Image Label Settings

Option Description

Label Type You can choose between preconfigured labels or set up your own label by clicking the Edit Label button.

Format Decide in how many rows you want the label to be printed.

Position Job labels can be printed beneath or to the right side of a job.

Font Settings Font type, size and color can be customized to your preferences. The gray text preview box shows you
how your label text will look like.

Comment Include a comment into the label by clicking into the text box and entering the desired information. The
maximum size is 256 characters.

Label Types
Label Type Description

Basic Label Preconfigured label with basic label elements such as the image name, printing date and proof standard
name. The GMG logo in the Basic Label is smaller compared to the one in the GMG Label.

GMG Job / Image Label Preconfigured label with recommended label elements.

GMG Full Label Contains all available label elements.

ISO 12647-7 Label The ISO 12647-7 Job Label is a preconfigured label that covers the requirements for proof systems accord-
ing to the ISO 12647-7 standard.

Custom label To create a custom label, you can either duplicate and edit a preconfigured label, or create a new label
(Tools menu > Edit Labels: New).

Label elements
Label Information Description

General General label information comprises very basic information such as the date, time of printing, job number
or software version the file was printed with.
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Label Information Description

Color Color label information contains all information referring to the used color management settings such as
the color profile (proof standard) or date of the last calibration.

The GMG Standard Proof Logo is printed only if a GMG proof standard has been used and the
printer calibration is in the range of the Quality Criteria defined in the GMG calibration set.

GMG Proof Standard Logo

Manual jobs: When using multiple proof standards in a job, information relating to the proof stand-
ard such as Proof Standard Name is not available for the job label. Instead, this information will be
printed automatically together with the image control strips.

To include the Printing condition simulated in the proof, for example "PSO, PT 1/2 [ISO 12647-
2:2004 / Amd 1", select the option Proof Standard Description. The information is automatically
extracted.

To include the name of the ink set as given by the manufacturer, for example "Epson UltraChrome
K3 Ink with Vivid Magenta", select the option Calibration Set Description. This information is auto-
matically extracted.

Only the first paragraphs (up to the first paragraph mark / hard line break) of the Proof Standard Descrip-
tion and Calibration Set Description are used for the label. If you are using custom proof standards and
calibration sets that do not contain this information, you can use the Comment box and enter the data
manually.

Format Only for files that are not ripped: If you scaled an image, you can include this information in the label
together with the image dimensions before and after scaling (Image Format / Original Format). If you used
crop marks ( > Image Marks), you can add information on where the crop marks have been placed.

Printer The printer type and the user defined printer name can be printed into the label lines.

5.7.4 Image Control Strips

In contrast to job control strips that are printed for the complete job, image control strips are printed
together with the image. Therefore, you can select image control strips for each image separately.

If multiple proof standards are used in a single manual job, the proof standard name is printed
together with each image control strip.

Note Printers supporting an integrated measuring device: When selecting the Measuring Device, you
decide whether you want to perform a fully automated measurement with the integrated measuring device
or whether you prefer a manual measurement with an external spectrophotometer

Load balancing and nesting: If you have configured an image control strip for a printer supporting an
integrated measuring device in a workflow, for example, an Epson Integrated Measuring Device, and
the image is sent to a printer that does not support this measuring device type, the image control strip
will not be printed. [When load balancing and nesting is used, it is recommended to use job control
strips instead of image control strips, as job control strips can be configured individually for each
installed printer.]

The proof control strip is printed with sharpening. MX4 color management is fully applied, including
noise and missing dots simulation (if defined in the MX4 profile).

Printing image control strips with white ink channels

If an image is printed with white ink, it generally makes sense to print the control strip with a white under-
coat. Otherwise, it might be difficult or even impossible to measure the patches, especially on foil.

Tip If the document does not contain a white channel or if you do not want to print it, you can add an addi-
tional empty channel to the document in your preferred image editor and map this channel to white.

Therefore, GMG ColorProof automatically prints image control strips with a white undercoat if the fol-
lowing criteria are met:
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The image has an activated white color channel.
—OR—
The image uses a white Coating Channel added by GMG ColorProof.

The white channel is mapped to "mx white" from the proof profile ("standard" MX profiles as well as
GMG OpenColor profiles).
—OR—
The white channel is mapped to a db3 spot color with the name "white".

Note If the white channel is mapped to a custom spot color (defined either in the Manual Job Manager or
in the Workflow), the control strip will be printed without white undercoat.

See also:

l "Using Control Strips" on page 188

l "Verifying Spot Colors" on page 190

l "Adding a Custom Control Strip" on page 177

l "Adding a Custom Control Strip" on page 177

l "Job Control Strips" on page 57

5.7.5 Image Marks

Note The option Outside Image (for Image Format, Crop Marks, and Middle Line) is available only if an
extended Paper Tint Area is defined.

The consistency of the marks settings with the image size is validated. If you enter invalid values, for
example, so that the Left crop mark would be outside the image (including paper tint area), you will be
informed by a warning message. For example, if the image is 5 cm wide and the paper tint area is extended
1 cm to the right side, you can enter a maximum of 6 cm for the Left value. Over 6 cm, the left crop mark
would be outside the right border of the image.

Crop Marks

Crop marks indicate where you want the printed image to be cut. The values for Left, Right, Top, and Bot-
tom define the crop box for an image, that is, the distance of the crop marks to the image border (from
inside the image).

Inside Image means the crop marks are printed on top of the image. Outside Image means the crop marks
are printed outside the image, directly next to the image borders, but the crop box is still inside the image.

As Frame (Inside) means that the crop marks are printed as a continuous line (not as separate crop marks in
the image corners) on top of the image.

Fig. 20 Crops marks printed inside the image, as a frame, and outside the image (from left to right).

5.7.6 Setting up Backup and File Removal Routines

The options provided in GMG ColorProof to delete files after processing or backup allow you a smooth
workflow, which is not interrupted by a limited capacity of the hard disk.

We recommend backing up the files first before deleting them (either manually or automated), ideally to a
high volume network drive on a connected server. For each GMG ColorProof workflow, you need to spe-
cify a separate backup folder. This ensures that the workflow is kept concise and you can easily track the
data flow.



5. Jobs

65 / 209

Tip You can use backup folders also for setting up more complex workflows. If a backup folder is selected
as an input folder of another workflow, you can automatically process a single source image file into mul-
tiple output files.

Note Files deleted by GMG ColorProof will not be moved to the Windows Recycle Bin, but permanently
removed from the hard disk. Therefore, please set up these routines in GMG ColorProof workflows with
great care. You can omit these options and choose a manual removal of files from the hard disk to avoid
unintended data loss. In this case, please make sure that data is deleted before the maximum capacity of
the hard disk is reached.

Note When using the Cleanup option for unprocessed files, make sure that the correct folder path is
assigned to the hotfolder and that only copies (not valuable original files) of image files are moved into the
hotfolder to avoid data loss. All unrecognized files will be deleted, even files that are not supported by
GMG ColorProof or that are no image files, for example, Adobe Photoshop or Microsoft Word files. For
example, if you would by accident assign the path c:\ to a hotfolder and use the option Recursive, this
would result in deleting all files from the c partition of your computer (that can be accessed by the Win-
dows user that has logged onto the computer).

It is advisable to backup input files to a separate hard disk drive, and delete the files automatically after a
certain amount of time has passed, to avoid that the maximum capacity of the hard disk is reached, and all
following jobs are stopped.

Cleanup/Backup options

Available options Description

Hotfolder: Clean up
Unrecognized Files

Files that did not pass the filter of any linked workflow are deleted.

Hotfolder: Backup Unre-
cognized Files

Files that did not pass the filter of any linked workflow are copied to a user-defined error files folder.

Workflow: Clean up Pro-
cessed Input Files

Processed input files are deleted after processing.

Workflow: Back up Pro-
cessed Input Files

Input files are copied to a user-defined backup folder when finished. Files in the backup folder can be
automatically deleted after a user-defined period of time (after processing).

5.8 Layout

The layout area on the right side of the Manual Job Manager shows the complete job with all images,
labels, and control strips. The cutting line is marked by a dotted horizontal line at the end of the job (1).
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The complete area of an image is also referred to as an image frame. The image label, control strips, image
and crop marks, and the extended paper tint area (Image > Label/Strips/Marks) belong to the area of the
corresponding image. Frames that are selected are highlighted by a blue border (2).

Selecting one or multiple images

To select one or multiple images, do either of the following:

Click an image. Hold down the CTRL key to select multiple images.

With the mouse, drag a marquee around part or all of one or more images.

Handling of multiple images

Images added to the job are automatically positioned in a free space inside the printable area (Job > Set-
tings) of the job. The printed job length is extended automatically, within the user-defined media limits (for
example, sheet format or Fixed Length).

All settings that are applied to all selected images are updated in the settings pane on the left. You can
change any setting, for example the proof standard, for all selected images with a single click.

See also:

l "Image Preview" on page 42

l "Image Preview of PDF/PS/EPS Files" on page 42

5.8.1 Layout Tools

Image positioning with guides and margins.

Guides help you to align image elements to the horizontal or vertical axis. Guides appear as nonprinting
lines that float over the job. You can move and remove guides from the preview area.

You can place a new guide by clicking into the vertical ruler on the left side or into the horizontal ruler on
the top. You can then move the guide to a position in the job area by holding down the left mouse button
and dragging the cursor with the mouse. Likewise, you remove a guide by dragging it outside the job area.

Guides are only active if the option Guides is selected in the tools pane beneath the preview area. Like-
wise, the job margins are only active as guides if the option Margins is selected.

Below the Guides check box, you can define to which sides of the selected image the guides will 'respond'
by activating the corresponding check boxes. The left part of the option refers to horizontal guides, the right
part to vertical guides. So, if you select the option Top - Left Guide, the top border of the selected image
frame will stick to a horizontal guide, the left border will stick to a vertical guide. If you select Middle -
Center Guide, the guide will serve as an axis of reflection. Margins are handled in the same way as guides.

You can resize the margins by entering values into the edit boxes in the settings pane on the left (Job > Set-
tings > Margins).



5. Jobs

67 / 209

In a similar way as with guides, you can align one image to another. Enter a desired Image Spacing to
define the distance to the other image. The defined distance is maintained by a (hidden) guide. This way,
you can manually place one image next to the other always keeping a precise distance.

View and zoom settings

Click the Zoom button in the tools pane beneath the preview area.

Option Description See also

Fit View to Width Fits the media width in the preview area.

Fit View to Height Fits the job length in the preview area.

Select the Zoom mode by clicking the + or the – magnifying glass button. The mouse
pointer becomes a magnifying glass with a + or – sign in its center. Click in the center of
the area that you want to magnify or reduce. Hold down the ALT key to switch to the
opposite Zoom mode. Each mouse click magnifies or reduces the view.

Show Transparent
Background

If Show Transparent Background is selected, a transparency checkerboard is shown as a
background for transparent areas in an image. If the option is not selected, paper white is
shown for transparent areas.

"Printing
an Undercoat"
on page 44

Automatic Image Placement

When creating a job with multiple images or PDF pages (manual or workflow job), GMG ColorProof auto-
matically optimizes the job layout for a minimum paper usage.

However, if you manually add a new image to a job, the new image is placed following the existing
images, to avoid messing up your layout. You can always use the Automatic Image Placement feature to
rearrange and thus optimize the layout.

You can choose the orientation mode and a horizontal and vertical spacing between the images.

Orientation mode Description

Original Keeps the original orientation of the image or PDF page as defined in the input file.

Keep Current Keeps the current orientation of all images. Images will be repositioned to optimize the lay-
out, but not rotated. This option is especially helpful if you need a specific orientation or if
you have a multi-page PDF and you want to keep all pages in a portrait orientation.

Automatic Rotates images and PDF pages to minimize paper usage.

Portrait Rotates images and PDF pages to Portrait orientation, i. e. so that the height is greater than
the width.

Landscape Rotates images and PDF pages to Landscape orientation, i. e. so that the width is greater than
the height.

See also:

l "Optimizing the Layout for Cutting" on page 67
Cropping and PDF page boxes

Click the Crop button in the tools pane beneath the preview area. You can crop images from the borders,
two points (which are displayed on a thumbnail image), or from width/height. Use Crop to Fit to crop the
image to fit to the media width. This crops the part of the image which is exceeding the roll width.

The option Use PDF Bounding Box allows you to define the boundaries of a PDF document. There are five
page boxes in the drop-down list you can choose from.

See also:

l "PDF Page Boxes" on page 38

5.8.2 Optimizing the Layout for Cutting

If you want to print multiple images or PDF pages in one proof job, for example to save media, and then
separate the images by cutting, GMG ColorProof optimizes the layout for horizontal or vertical cut lines, or
both. Images are automatically rearranged so that you will need a minimum number of horizontal and/or
vertical sections to separate the images. You can control the orientation and whether GMG ColorProof is
allowed to rotate the images or not by choosing an appropriate Method from the drop-down list.



GMG ColorProof User Manual

68 / 209

How to optimize the job layout for cutting

1. Open the Manual Job Manager and load all images you want to print into the job.

2. On the Layout toolbar on the right side, below the job preview, click the Automatic Placement tab.

3. Under Optimize Layout for Cutting, add a check mark to the Horizontal Cut Lines or Vertical Cut
Lines, or both, and click the Apply button.

GMG ColorProof rearranges the job layout.

Fig. 21 Image placement optimized for horizontal cutting.

You will now be able to cut the printed job along horizontal cut lines (not shown in GMG ColorProof, but
shown as dashed lines in this screenshot). The images have been rotated to find the optimal positioning,
because Automatic has been chosen as the Method.
Vertical cutting

Fig. 22 Image placement optimized for vertical cutting.

You can now cut the images along a vertical cut line. The positioning is not optimal for horizontal cutting.

5.9 Moving Jobs Between Printers

5.10 History
Finished jobs are moved to the History view. To visualize the finished status of the jobs, all jobs are shown
with a green check mark.
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An additional comment informs you if and when a file will be automatically deleted (according to the set-
tings defined in the job or workflow).

Selecting jobs

Jobs can be selected in the list with the mouse or by pressing the ARROW UP or DOWN key. You can also
select multiple jobs while holding down the CTRL key. Selected jobs are highlighted by a different border
and background color. To deselect all currently selected jobs, press the SPACE key. To quickly navigate to
the beginning or end of your job list, use the POS1 or END key.

Job commands

Job commands such as editing job properties or printing a job (again) can be selected from the Jobs/History
menu or from the context menu (by right-clicking on a job) and are applied to the selected job(s).

Info pane and preview

The info pane of the History view (Layout tabbed page) shows a preview of the printed job or image in the
job (depending on what is selected in the job list).

Deleting jobs

Jobs can be deleted manually from the History view, or they can be deleted automatically as specified by
the user in the System settings.

5.10.1 History Toolbar and Menu

The History toolbar and menu can be used to review and restart already processed jobs (manual jobs and
jobs from workflows).

Tip Main program features are accessible by different methods, so that users can choose which way is most
convenient to them. This documentation generally refers only to the toolbar or menu, even though there
may be alternative methods.

Click a button on the toolbar. Move the mouse over a button (without clicking) to display a tooltip.

Click a command on a menu.

Right-click on an item and click a command on the context menu.

Press a shortcut key. Shortcut key combinations are listed next to the corresponding command on the
menu.

Double-click an item (for example, a job or a workflow) to open the corresponding dialog box and
edit settings.

Toolbar and menu commands
Icon Command Shortcut Meaning

New Job CTRL+N Adds a new manual job to the Jobs list. You can directly print a fast job by clicking
the Print button (only one proof standard, with default settings). If you want to use
multiple proof standards or custom settings, click the Open button to open the job
in the Manual Job Manager.

Properties CTRL+O Opens selected job in the Manual Job Manager. You can change the settings in the
job and print it again, for example.

Print CTRL+P Prints the selected job (again).

Hold CTRL+H Puts the selected jobs on hold. Only available for queued jobs that have not been
started yet. The job stays in the Jobs view and is marked as Held. You can start a
job in status Held by clicking Print.

Cancel ESC Cancels the processing of the selected job. The job stays in the Jobs view and is
marked as Canceled.
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Icon Command Shortcut Meaning

Delete DEL Permanently removes the selected job. No undo possible. You will be asked
whether to also delete the image file(s) associated with the job.

Save As The selected job is saved as a *.job archive with all settings and images.

Send To The selected job is sent to a defined remote location (System view > Remote Proof-
ing).

Image Preview Shows the processed and color managed TIFF output image as it will be printed on
the target printer. Before the RIP procedure of PDF/PS/EPS files, the image preview
displays the Source File. After the RIP procedure, you can switch between the ori-
ginal Source File view and the ripped TIFF Output Preview.

Duplicate CTRL+D Duplicates job. A new job will be created with the same settings and a new Job ID
and image IDs.

Increase Priority CTRL+UP Increases the priority of the selected job. (Manual Job Manager: Job > Printer Set-
tings > Job Priority; Workflow Properties: General > Job Priority)

Decrease Priority CTRL+DOWN Decreases the priority of the selected job. (Manual Job Manager: Job > Printer Set-
tings > Job Priority; Workflow Properties: General > Job Priority)

Collapse All Collapses all jobs in the Jobs view (if they are not yet collapsed).

Expand All Expands all jobs in the Jobs view (if they are not yet expanded).

Delete All Jobs CTRL+X Can only be used in the History view. Permanently removes all jobs in the History
view without affecting Jobs in the Jobs view. No undo possible.

5.10.2 Restarting Jobs

You can restart a finished or canceled job any time as long as the corresponding input file is still physically
present and has not been moved, regardless, whether it is a manual job or a job created by a workflow.
You can keep or change the output settings for the second proof.

How to restart a job

1. Click the History button on the navigation panel on the left of the main window. In case of a canceled
job (error file), click the Jobs button, because the job is not moved to the History view.

2. Select the job that you want to restart.
(You can sort the jobs in the jobs list by clicking the column headers or you can filter the jobs by
applying the filters in the drop-down menu.)

3. On the toolbar, click the Print button to restart the job.
A new job (with a new ID) is created, and will be sent to the print queue according to its priority. The
job will be displayed in the Jobs view, and then be sent to the History view when finished.

5.10.3 Job Reports

In the History view, you can archive job information in HTML format. In contrast to the job log XML file
that can be generated via the System menu (> Export Job Report), this report contains only information for
the selected job. This is very convenient when troubleshooting the RIP of a single file.
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How to save a Job Report

1. Click the History button on the navigation panel on the left of the main window.

2. Select the job that you want to save the job information of.
(You can sort the jobs in the list by clicking the column headers or you can filter the jobs by applying
filters from the drop-down list .)

3. On the info pane on the right side of the main window, click the Information tab.

4. Click the Save Job Report button.

5. Browse to the target folder and click Save to archive the report.
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6. Workflows
You can automate proofing by setting up input folders (referred to as hotfolders) or by defining print spool-
ers in the Workflows view. All image processing parameters such as color management, printer and media
are predefined in one or multiple workflows connected to a hotfolder.

Fig. 23 Workflow overview.

Basically, you have the same options for defining the job options in a workflow as you have in the Manual
Job Manager. Exception to this rule is, for example, the possibility to manually switch off a color channel in
the image, which is available only in the Manual Job Manager.

It is possible to set up various workflows according to different input data or to different proof standards.
You can name workflows according to your custom naming convention for an easy identification (for
example for sorting and filtering) in the Workflows, Jobs, and History view. Multiple printers (printer pool)
can be assigned to each workflow. Load balancing then automatically assigns a new image in the linked
hotfolder to an idle printer from the printer pool.

Image files copied into the specified hotfolder (1) or sent to the specified print spooler are automatically
filtered by the connected workflows (2). The first workflow (from top to bottom) that accepts the input
image according to the File Filter settings processes the image and creates a job that is added to the Jobs
list.

The number of recognized and unrecognized files is shown below the workflows (3) in the list. Files that
are not processed by any connected workflow will show up under Unrecognized Files. (Unrecognized
Files either do not follow the input filter settings of any workflow connected to the hotfolder or are gen-
erally not supported by GMG ColorProof.)

The Files column (4) shows you the files that are already analyzed by the program and the total number of
all files in the hotfolder. When the Files column (4) is selected with the mouse, the info pane (5) provides
more information on the processing status of all files in the hotfolder.

The printer columns show the number of files processed by a specific workflow and printed on a specific
printer (6). In the screenshot, for example, 5 files are processed by the workflow PDF to 39L and are prin-
ted on printer MyPrinter.
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See also:

l "Filtering and Processing Sequence" on page 88

l "Status of Input Files in a Hotfolder" on page 80

l "Jobs" on page 48

l "History" on page 68

6.1 Workflow Toolbar and Menu
In GMG ColorProof, you can set up multiple workflows to reflect different workflows in your company.

The Workflow toolbar and menu provide various useful functions to manage your workflows efficiently.

Tip Main program features are accessible by different methods, so that users can choose which way is most
convenient to them. This documentation generally refers only to the toolbar or menu, even though there
may be alternative methods.

Click a button on the toolbar. Move the mouse over a button (without clicking) to display a tooltip.

Click a command on a menu.

Right-click on an item and click a command on the context menu.

Press a shortcut key. Shortcut key combinations are listed next to the corresponding command on the
menu.

Double-click an item (for example, a job or a workflow) to open the corresponding dialog box and
edit settings.

Toolbar and menu commands

Icon Command Description

New Hotfolder Adds a new hotfolder. You can define the input folder (hotfolder) and print spooler settings in the
hotfolder dialog box. Processing parameters are defined in the connected workflows.

Duplicate Hotfolder Duplicates the selected hotfolder and all connected workflows. All settings are maintained. The hot-
folder dialog box is opened so that you can select a new input folder.

Import Hotfolder Imports a previously exported hotfolder into GMG ColorProof.

Export Hotfolder Exports the selected hotfolder with all settings into a file with the extension hotfolder.

New Workflow Adds a new workflow. A workflow is linked to a hotfolder. You can connect multiple workflows to
the same hotfolder.

Duplicate Workflow Duplicates the selected workflow. All settings are maintained.

Import Workflow Imports a previously exported workflow into GMG ColorProof.

Export Workflow Exports the selected workflow with all settings into a file with the extension workflow.

Activate Workflow Activates a previously deactivated workflow.

Deactivate Workflow Deactivates a workflow. Deactivated workflows are handled as if they were not there at all (no file
filtering, no processing). They can, however, still be opened and edited.

Move Up Moves the selected workflow up in the list of workflows connected to the hotfolder. Input files are
filtered and assigned to workflows from top to bottom in the list.



GMG ColorProof User Manual

74 / 209

Icon Command Description

Move Down Moves the selected workflow down in the list of workflows connected to the hotfolder. Input files
are filtered and assigned to workflows from top to bottom in the list.

Continue Continues the processing of all jobs in the selected hotfolder or assigned to the selected workflow.

Hold Puts the selected hotfolder or workflow on hold. Click Continue to continue the job processing.

Delete Permanently deletes the selected hotfolder (including all linked workflows) or the selected work-
flow.

Properties Opens the selected hotfolder or workflow. You can change the settings in Administration Mode.

Pause All Pauses all hotfolders and workflows. This is useful if you need to edit all workflows and want to
ensure no new jobs are generated meanwhile. Click Continue to continue the job processing,

Pause ProofControl
Inline

Pauses all workflows for a short time and automatically exchanges any selected control strip for an
integrated measuring device with the equivalent for an external i1 measuring device. This is useful
when you have many jobs to print and little time for drying and measuring.

6.2 Workflow List View

Selecting a hotfolder or workflow

A hotfolder or workflow can be selected in the list with the mouse or by pressing the ARROW UP or
DOWN key. A selected hotfolder or workflow is highlighted by a different border and background color.

Hotfolder/workflow commands 

Hotfolder/workflow commands such as editing or duplicating can be selected from the Hotfolder/Work-
flows menu or from the context menu (which appears when you right-click on a hotfolder/workflow) and
are applied to the selected item.

6.3 Input Control: Hotfolder, Print Spooler, Drag-and-Drop
Hotfolders and workflows are used whenever a larger number of image files needs to be converted accord-
ing to the same rules and output settings. Setting up hotfolders also leads to a higher degree of consistency
and reproducibility. You can assign any number of input folders (referred to as hotfolders) to a single work-
flow. Each file physically present in a hotfolder automatically generates a separate job and is processed as
specified in the Output Settings and Color Management settings. 

The hotfolder defines only the input control itself. Which images are recognized and how they are pro-
cessed is defined in the Workflow Properties dialog box. The workflow parameters are organized into sev-
eral pages for defining the Input Settings, Color Management, Load Balancing and Nesting strategy, Print
Settings, Image Processing, Image Label and Control Strips, Cleanup and Backup of printed images. 

You can either set up a Windows Print Spooler or a Hotfolder as an input control of a GMG ColorProof
workflow.

For processing in GMG ColorProof, it does not matter which input control you use. It depends on which
input control is supported by (or more convenient to use) from third-party programs that should be integ-
rated into the GMG workflow. In most cases, use of hotfolders is more versatile and supported by all pro-
grams (as a hotfolder is only a standard file folder). Hotfolders are also more convenient if the data is not
generated or retouched in-house, but rather sent to you by an agency or client. Then you just need to copy
the data into the appropriate GMG ColorProof hotfolder.

Hotfolders can also be accessed by drag-and-drop: You can select one or multiple image files with the
mouse and drag-and-drop them onto a hotfolder. The image files are then physically copied into the hot-
folder.
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Note Using two separate hard disk drives connected to two separate buses, one for the input data / hot-
folders, and one for the System GMG ColorProof processes the data and prints the proofs), can improve the
software performance. Please note that two HDDs connected to the same bus or two partitions on the same
HDD do not improve the performance. 

Tip It is recommended to work out an appropriate naming scheme for all hotfolders so that you can easily
identify the folders later.

See also:

l "Hotfolder Input Settings" on page 76

l "Windows Print Spooler" on page 79

6.4 Creating a New Hotfolder
Before the first hotfolder is set up, the Workflow list is empty. You will need to install a printer first, then set
up a hotfolder, and then a workflow.

Tip With hotfolder technology, you can easily integrate the proofing process into other workflows, for
example, a file conversion in GMG ColorServer and a following printing from GMG ColorProof. This can
be achieved by using the output folder of a GMG ColorServer workflow as an input hotfolder for a GMG
ColorProof workflow, thus cascading the hotfolders. It is also possible to use a backup folder (for backing
up printed files) as a hotfolder, thus printing the input files to multiple outputs.

How to create a new hotfolder

1. Click the Workflows button on the navigation panel on the left of the main window.

2. Click the Overview tab.
The workflow list is displayed. After a new program installation, the list is empty.

3. On the Hotfolder menu, click New Hotfolder.
The Hotfolder/Spooler Properties dialog box opens.

4. Type a name into the Hotfolder Name box, for example, ContoneProof. This name serves as an iden-
tifier in the Workflows view in GMG ColorProof (and as default name of the Windows print spooler).
The workflow name is specified later.

5. Click the Input Folder browse button to open the browse dialog and make a new input folder, or
select an already existing folder.

6. Select Normal as Hotfolder Type .

7. Click OK.
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Fig. 24 Hotfolder with general input settings.

Fig. 25 Hotfolder listed on the Overview tab (without workflow yet).

The Overview shows the newly created hotfolder. The input folder is defined, but not, which input files
should be processed, how they should be processed, and on which printer they should be printed. This is
defined in the associated workflow.

See also:

l "Hotfolder Input Settings" on page 76

l "Creating a New Workflow" on page 81

6.4.1 Hotfolder Input Settings

General Input Settings

Group Short description See also

Hotfolder Name The Hotfolder Name helps you to search and filter jobs in the Jobs and History
view.

Input Folder You need to choose an existing or create a new input file folder. Images in this input
folder will be filtered by the workflows that are linked to the hotfolder.

Hotfolder Type You can choose between three hotfolder types. The regular hotfolder type (Normal)
serves most purposes and uses fixed settings, defined by the linked workflow. Smart
and the Job Ticket hotfolders allow to use variable settings (different proof
standards or custom profiles per workflow) by applying rules or XML parameters ref-
erenced in the image name.

"Smart Hotfolder" on
page 77

"Smart Hotfolder Rule
Sets" on page 78

"Job Ticket Hotfolder"
on page 79

Windows Print Spooler In addition to an input folder, you can also set up a Windows print spooler as an
input control for the linked workflows. If Windows Print Spooler is selected, a
printer with the Spooler Name will be installed under the Windows operating sys-
tem. You always need to set up a hotfolder, because all print spooler jobs are first
sent as physical printer (prn) files into the hotfolder before processing in GMG Col-
orProof.

"Windows Print
Spooler" on page 79

Advanced Input Settings
Available options Description

Search Subfolders Not only the input folder itself, but also subfolders of the input folder will be scanned for input files. You
can define the level, how deep in the folder hierarchy will be looked for input files. For example, with a
Depth of 2, the following folder path would be scanned: C:\Data\CP05_Input\level1\level2\, whereas
C:\Data\CP05_Input\ is the hotfolder, and level1is subfolder of the hotfolder, and level2 is subfolder of
level1.
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Available options Description

Ignore File Creation
Time

This option is recommended for processing files on a UNIX file systems from Apple and SUN (UNIX or Mac
OS operating system). It avoids that input files are processed twice. If this option is not selected, input files
are regarded as new and will be processed when either the name, creation date, or modification date is
changed. If this option is selected, the Created date of files is ignored.

Ignore File Modi-
fication Time

Similar to the option Ignore File Creation Time. If this option is selected, the Modified date of files is
ignored. Please note that if this option is selected, files that were changed intentionally by the user will also
be ignored and need to be renamed before processing.

Wait before Processing If input files are moved to hotfolder(s) via a slow network connection, you might want to use the option
Wait before Processing and enter a delay time that reflects the time the file needs to be completely moved
into the hotfolder. If this option is not selected and the connection is slow, GMG ColorProof immediately
starts processing the incomplete file, resulting in canceling the job.

Note Hidden system files created by Mac OS X operating systems such as Desktop Services Store ds_store
files and _resource forks in hotfolders are automatically ignored by GMG ColorProof. Such files are
moved/deleted when the corresponding image files are also moved/deleted (by using the backup routines
configured in the hotfolder and workflow.

6.4.2 Smart Hotfolder

Note This hotfolder type is not included in the standard GMG ColorProof version and requires an addi-
tional license. Please contact your local dealer for details.

Fig. 26 Smart Hotfolder with Smart Hotfolder Rule Set.

A Smart Hotfolder allows you to process files with different proof standard requirements with just one
workflow connected. This way, you can reduce 1:1 Hotfolder and Workflow combinations which often use
the same parameters and only differ with regard to the proof standard or profile.

To use different proof standards with just one workflow, a Rule Set can be defined, comprising rules on
how the proof standard or profile should be selected automatically from the image file name or file loc-
ation. Basically, this approach is similar (though less complex) to using a job ticket, and may come in
handy for workflow systems that do not output XML job tickets, or at least as a less cost-intensive altern-
ative.

Tip Migrate your hotfolder to a Smart Hotfolder via the context menu.
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6.4.3 Smart Hotfolder Rule Sets

All rules in a Smart Hotfolder Rule Set are based on the image file name or its location in the input folder
structure. When an image is recognized in the hotfolder, the assigned rule set is checked for matches with
the assigned subfolder or the image name. If no rule can be applied to an image, the proof standard defined
in the connected workflow is used as a fallback for the color management.

Rule Set Settings

Choose whether you want to use custom profiles or proof standards with the rule set. (If you decide
for custom profiles, add the folder where the custom profiles can be found.)

You can add multiple rules.

You can also use wildcards such as the asterisk (*) for many characters. Wildcards are convenient if
you have a high proofing volume and need to apply a huge number of profiles.

You can define the spot color set priority.

You can test the rule set and get immediate feedback from the system.

Example Rule Set

In the following example, all images located in the input subfolder named 39L beginning with 009 are pro-
cessed according to the proof standard ISO Coated v2.

Fig. 27 Setting up a Smart Hotfolder Rule Set.

The defined rule overrides the proof standard that has been selected in the connected workflow.
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Fig. 28 Fallback Proof Standard in the connected workflow.

6.4.4 Job Ticket Hotfolder

Note This hotfolder type is not included in the standard GMG ColorProof version and requires an addi-
tional license. Please contact your local dealer for details.

A Job Ticket Hotfolder provides an XML interface for an easy integration of GMG ColorProof into any
workflow system which is able to write a definable XML output file. All you need to do is copy your input
file in a Job Ticket Hotfolder along with the XML job ticket created by your workflow system.

The job ticket can contain specific color management parameters to define the processing, for example, the
proof standard name. This way you can use multiple proof standards with just one connected workflow.

How to use multiple proof standards with one workflow

1. Create a Job Ticket Hotfolder in GMG ColorProof, defining an input folder for your files.

2. Create a workflow in GMG ColorProof and connect it to the Job Ticket Hotfolder.

3. Drop the files you want to proof and XML job tickets with proof standard information referencing the
input files via file name into the defined Job Ticket Hotfolder.
The referenced input files are processed according to the defined parameters of the job tickets and the
connected workflow.

Fig. 29 XML job ticket with proof standard information.

Tip This way, you can automate your color management system and reduce the administrative effort of set-
ting up and managing a large number of different proof workflows.

6.4.5 Windows Print Spooler

If you prefer to access GMG ColorProof hotfolders/workflows directly from your custom image editor, you
can use a Windows print spooler. When selecting the Windows Print Spooler option in a hotfolder, a Win-
dows printer with the Spooler Name is automatically set up on the computer on which GMG ColorProof is
running.

Note A Windows Print Spooler name with more than 12 characters can cause problems under Mac OS X.
It is therefore recommended not to exceed this limit.
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You can then select this printer from any custom application and print the image of interest on this printer.
Here, printing means converting the image into a PostScript (PS) file and sending the file to a GMG Col-
orProof hotfolder for processing. The resulting PS files are handled by the connected workflows as any
other PS input file. Make sure to select the PS File Format Filter in the workflow that you would like to use
for processing spooler files. Otherwise, the files would not be recognized and would be moved to the Unre-
cognized Files list.

Available options Description

PPD File The default PPD file is GMG 05 and should generally not be changed. This PPD version offers more print
spooler options, especially more supported standard file formats, than GMG 04, which is identical to the
default PPD of previous program versions and is provided only for compatibility reasons.

You can add custom PPD files by simply copying the file into the drivers subfolder of the GMG ColorProof
program folder (default path: <installation path>\PPD\ ). The PPD name displayed in the drop-down list is
taken from the header (Product string) of the PDD file.

How to set up a print spooler

Note If you want to access a print spooler from a separate computer via network, you need to share the
printer to the network in the Windows operating system.

1. Select the option Windows Print Spooler.
A printer with the hotfolder name will be installed under Windows. You can change the default name
if you want. You can access the print spooler via the standard print dialog of your custom application.

2. Select GMG 05 from the PostScript Printer Description (PPD) list. This PPD was optimized for use
with GMG ColorProof 5 and supports various standard file formats.

6.4.6 Hotfolder Cleanup / Backup

The options provided in GMG ColorProof to delete or back up unrecognized files backup allow for a
smooth workflow without interruptions caused by a limited capacity of hard disk.

How to set up backup and file removal routines for unrecognized files

1. On the navigation panel of the Hotfolder / Spooler Properties dialog box, click Cleanup/Backup.

2. Select the option Clean up Unrecognized Files and select a time.
Input files that are not accepted by the filter settings of any connected workflow will be deleted from
the hotfolder after this time.

3. Select the option Back up Unrecognized Files and click the browse button next to the empty text box.

4. Select the desired backup folder or create a new one, for example, CP05_Backup_Unrecognized.
Unrecognized files from this hotfolder are copied to the backup folder. If you have selected both the
Cleanup and the Backup option, this will result in a Move file action.

5. Select the option Number if File Already Exists.
This option prevents already existing files from being overwritten by new files with the same name via
adding an incremented number to the name of each file.

6. Select the option Delete Backup Files after and enter the number of hours after which a file moved to
the backup folder will be deleted from the hard disk.

6.4.7 Status of Input Files in a Hotfolder

Recognized and Unrecognized Files

Recognized files are all files that have been recognized by the program, that is, the file type is known.
Recognized files can be in status Recognized, Processing, or Finished. A recognized file can change to an
unrecognized file after passing the workflow filters in case that it is not accepted by any workflow.

Unrecognized files are all files that have not been recognized by the program, that is, the file type is not
supported or the file is damaged, or the file is not accepted by any workflow assigned to this hotfolder.
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Fig. 30 Example hotfolder with recognized and unrecognized files.

In the Files column, our example hotfolder "ContoneProof" shows the number "17/23", 17 being the num-
ber of recognized plus unrecognized files, and 23 the total number of files. The difference ("6" in this
example) are files that are either still in status In Hotfolder or already in status Finished.

Processing status

When a hotfolder cell in the Files column is selected with the mouse, the info pane on the right side of the
main window shows more information on the processing status for each file in the hotfolder as described in
the following table.

Icon Status Description

In Hotfolder First status of an input file after it has been copied into the input folder. The file has been found by the pro-
gram, but the file type has not yet been recognized. The file type is still being analyzed by the program.

Recognized The file type is known to the program and will be passed through the workflow filters.

Unrecognized The file has passed the filters of all workflows, but no matching workflow has been found. The file will not
be processed. Cleanup/backup rules for unrecognized files will be applied.

Processing The file has been accepted by a workflow filter and is being processed by the corresponding workflow. In
case of a multi-page input file (PDF), the file will be split into single pages, referred to as Images in GMG
ColorProof. Each image will be added to a job. Load balancing and nesting rules are applied when adding
images to jobs. The exact status of each image can be checked in the Jobs list view.

Finished The image was printed and the corresponding job has been added to the History list. Cleanup/backup
rules for printed files will be applied.

6.5 Creating a NewWorkflow

How to create a new workflow 

1. Click the Workflows button on the navigation panel on the left of the main window.

2. Click the Overview tab.
The workflow list is displayed. After a new program installation, the list is empty.

3. On the Workflows menu, click New.
The Workflow Properties dialog box opens.

4. Type a name into the Workflow Name box, for example, PDF to 39L.

5. From the Connect to Hotfolder list, select the hotfolder you want to use as input folder / spooler for
this workflow.
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How to define filter settings

Tip With the Embedded ICC Profile / Output Intent Filter, you can automatically apply different proof
standards according to the embedded ICC profile (PDF output intent) of a file. This way, you can use mul-
tiple workflows using the same hotfolder.

In the following steps, you will learn how to configure a strict workflow that accepts only PDF X compliant
files with an ISO Coated v2 (39L) output intent.

1. Click the Filters tab.

2. On the right side of the Embedded ICC Profile / Output Intent Filter group, click the + button.

3. Select an ISO Coated v2 (39L) ICC profile. This filter accepts only files that are tagged with this ICC
profile or have this ICC profile as output intent.

4. Under Color Space Filter, select CMYK (+ Spot Colors).
This filter accepts only CMYK files. PDFs that are not entirely RGB are also accepted.

5. Under Color Depth Filter, select 8/16 Bit.
This filter accepts all files that are not halftone (1-Bit). PDF/PS files are always 8/16 Bit files.

6. Under File Format Filter, select PDF.
This filter accepts all PDF files.

7. Under PS/PDF Settings, select PDF X Compliant.
This filter accepts only PDF files that are compliant with PDF X (i. e. have a PDF X output intent).

Fig. 31 Workflow Filter settings.

All criteria set in the filters have to be fulfilled for a file to be accepted as an input file for this workflow. In
total, this means that only PDF X files with an ISO Coated v2 (39L) output intent and that are not com-
pletely RGB files (all images and linework elements in RGB) will be processed by this workflow.

Now the Input Settings are completely defined and you can proceed with the Color Management settings.
(Merge Files is required only for composed images, for example, 1-Bit separations or CT/LW files. Screen
Detection is required only for 1-Bit input files.)

How to define color management settings

1. Click the Color Management button on the navigation panel on the left of the dialog box.

2. From the Proof Standard list, select ISO Coated v2 (39L).

The gray info box shows installed printers and media supporting the selected proof standard.
How to define conversion CT/LW settings

1. Click the Color Management button on the navigation panel on the left of the dialog box.

2. Click the Conversion CT tab.

3. Select option PDF X Processing if possible.
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Prior to the color management for the proof output, PDF X images and lineworks will be converted accord-
ing to the embedded ICC profile and output intent information in the document. In this example workflow,
all RGB images and elements in the PDF will be converted to the ISO Coated v2 (39L) output intent. (If this
workflow supported input files that are not PDF X, these input files would not be converted. But according
to the workflow Filter settings, only PDF X files are accepted as input files.)
How to select a printer and printer medium

1. Click the Load Balancing and Nesting button on the navigation panel on the left of the dialog box.

2. Select the printer that you would like to add to the printer pool for this workflow. If you have only one
installed printer, you do not have to change the settings.

3. For each printer, select the printer medium from the drop-down list, for example, GMG ProofMedia
premium semiMatte 250.

All other workflow settings are optional. You are now ready to use your hotfolder/workflow configuration.
You can copy input files into the hotfolder, drag-and-drop them onto the hotfolder in GMG ColorProof, or
use the ContoneProof Windows printer from your custom application.

Tip Try out the workflow with a test file. If everything works out for you, you can duplicate the workflow
and use it as a basis for setting up additional workflows, for example, for different printing conditions
/ proof standards.

See also:

l "Workflow General Input Settings" on page 84

l "How Does the Color Management Work?" on page 14

l "Load Balancing and Nesting" on page 90

l "Printer Settings" on page 57

6.5.1 Duplicating a Workflow

You can use an existing workflow as a template to set up similar workflows. In the following example, one
hotfolder is set up with three duplicated workflows using the same parameters, but different proof standards
(according to the different output intents of the PDFs).

How to duplicate a workflow

1. Select the workflow that you would like to duplicate in the workflow list.

2. On the Workflows menu, click Duplicate.
An identical copy of the workflow (except the name) will be created.

3. Double-click the new workflow to change the settings.
You need to change only the settings that will be different from the original workflow, for example,
the name and target printing standard.

4. Change the Workflow Name to PDF to 29L.

5. Click the Filters tab.

6. On the right side of the Embedded ICC Profile / Output Intent Filter group, click the + button.

7. Select an ISO Uncoated (29L) profile.
Each file is processed by the correct workflow according to the PDF output intent.

8. Click the Color Management button on the navigation panel on the left of the dialog box.

9. From the Proof Standard list, select ISO Uncoated (29L).

10. Repeat steps 1 to 9 for all proof standards you want to support.
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Fig. 32 Hotfolder with three connected workflows supporting different proof standards.

See also:

l "Overview of File Filtering and Processing in Workflows" on page 86

6.5.2 Workflow General Input Settings

General Input Settings

Group Short description See also

Workflow Name The Workflow Name helps you to search and filter jobs in the Jobs and History
view.

Connect to Hotfolder Defines the input folder for the workflow.

Pages to Print Instead of printing All Pages, you can also choose to print the Odd Pages Only, or
the Even Pages Only.

Priority Jobs are processed in order of priority, that is, the higher the priority number of a
job in the queue, the earlier the job is processed. The highest priority is 10. Jobs
with the same priority are processed in the order in which they were created.

Copies Number of copies that will be printed. You can define multiple copies of each input
image. If you, for example, select three copies, each input file that is processed by
this workflow will be placed three times within a job.

If you do not want the selected number of copies to be placed in one job, but in
separate jobs, select the Create Separate Job for Each Copy.

6.5.3 Workflow Filter Settings

Filtering means that only images that have the selected properties (except Ignore File Name Filter) are
accepted and processed by a workflow.

File filter settings are only applied to the whole file, not to elements of a file. For example, Embedded ICC
Profile filters are applied to embedded ICC profiles of single image files (representing the output intent of
the image) or to the output intent of a PDF file. They are not applied to ICC profiles embedded in images
inside a PDF.

Workflow filter groups

Multiple filter groups are provided, filtering the input files on the basis of different criteria such as the file
name, color space, and file format.

Filters from different groups are connected with a logical AND. This means, a file is processed only if all
requirements are met. For example, if CMYK is selected as a Color Space filter and TIFF as an image format
filter, only TIFFs in CMYK color space will be processed.
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Filters from the same group are connected with a logical OR. This means, a file is processed if any one of
the requirements are met. For example, if CMYK and RGB is selected as a Color Space filter, input files in
CMYK and RGB color space will be processed.

Tip You can save your filter settings and share them with others or reload them whenever needed (Filter Set-
tings > Export / Import).

Group Short description See also

Embedded ICC Profile
/ Output Intent Filter

Only images with an embedded ICC profile or PDFs with a defined Output Intent
are accepted by this workflow.

The Embedded ICC Profile / Output Intent filter is only active if at least one
Embedded ICC Profile / Output Intent filter is defined.

To ensure a fail-safe conversion, an exact match with the ICC profiles that are spe-
cified in the list is required. (The values in the profile are checked via a check-
sum.) If the profile was changed in any way and differs from the standard profile, it
will not be matched with the profile selected for the filter, even though, for
example, the profile name is the same.

When printing a PDF with page specific output intents, this filter extracts the pages
with the matching output intent and sends them to the workflow.

Note If there are multiple workflows connected to the same hot-
folder, PDF pages are processed only by the first workflow in the
list with a matching output intent. The PDF is not recognized by
following workflows even if some pages have a matching output
intent. You will not be notified if some pages are not printed.

If you want to print PDFs with page specific output intents, you need to create mul-
tiple hotfolders, each connected to a workflow with a matching output intent filter.
Then copy the same PDF to all hotfolders. Each workflow will process only the
pages with the matching output intent. Nesting is possible if the same proof
medium is used.

Tip You can still see the page numbers from the original doc-
ument in the Manual Job Manager > Image List.

File Name Filter The Include/Ignore File Name Filter is only active if at least one Include/Ignore
File Name filter is defined. If it is active, only files with the specified file naming
convention are recognized by this workflow.

If the Include File Name Filter is active, only input files having the defined char-
acters or text strings in the file name will be processed.

If the Ignore File Name Filter is active, input files having the defined characters or
text strings in the file name will not be processed.

You can define, where a name tag is positioned in the file name (begin, end, any-
where).

Characters not supported in (Windows) file names (such as "?") are also not sup-
ported in file name filters.

Color Space Filter Only images in the selected color space are accepted by this workflow.

The color space filter is not applied to PDF and PS files. For processing PDF and
PS files, color space CMYK (+ Spot Colors) need always to be selected, regardless
of the true color space of the input file.

Color Depth Filter Only images with the selected color depth are accepted by this workflow.

Select 1-Bit for halftone input data (DotProof, FormProof).

Select 8/16 Bit for input files that include multiple color channels (contone image
files).

The color depth filter is not applied to PDF and PS files.
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Group Short description See also

File Format Filter This filter defines which input file formats are accepted by the workflow.

These input files are not necessarily the files that are actually processed. Some of
the available File Formats, for example, GMG RipServer.sep, are merely image
description files that are not processed (printed) themselves. Rather, these files
describe the image files that need to be merged to build the image itself. For
example, if GMG RipServer.sep is selected, all TIFF files described in the sep file
will be processed, even though TIFF is not selected in the filter settings.

If a sep file is available, Merge Files settings are not required and are ignored.

File Format Filters are also used in the New Job dialog box, Files of type drop-
down list. For example, if GMG RipServer.sep is selected as file type when cre-
ating a manual job, you need to select only the sep file in the browse box. All
image files referenced in the sep file will be recognized automatically and loaded
into the Manual Job Manager when you click Open (or printed when you click
Print).

"Pattern Recognitions"
on page 33

PS/PDF Settings PDF X Compliant: Only PDF X compliant PDFs are accepted by this workflow.

Not PDF X Compliant: Only input PDFs not compliant to the PDF X standard are
accepted by this workflow.

If both PDF X Compliant and Not PDF X Compliant filters are set, all PDFs are
accepted by this workflow.

Preseparated PS/PDF: Activate this filter if you want to process preseparated
PS/PDF files.

Conversion CT/LW is not supported for preseparated PS/PDF files.

Filter compatibility

Logics behind Filter settings are not validated by the program. It is possible to set up workflow filters that
are not compatible to each other, for example, RGB and 1-Bit, and will therefore result in accepting no
input files at all. Please check the settings carefully before closing the workflow dialog box.

Likewise, the compatibility of Filter settings with other settings in the workflow is not validated by the pro-
gram. For example, if you want a fail-proof processing of images tagged with an embedded ISO Coated v2
(39L) ICC profile, you will need to select the corresponding Proof Standard on the Color Management
page. If you want to set up a PDF X workflow, you will need to select PDF X Processing on the Conversion
CT/LW page. The Filter defines only which input files are processed by the workflow, but not how they are
processed.

6.5.4 Overview of File Filtering and Processing in Workflows

Filtering means that only images or PDF with the selected properties are processed. (Any input files with file
names matching the Ignore File Name Filter rules are excluded.)

The following illustration shows how input PDF files with different output intents are filtered and processed
by different workflows. Different color management settings are used, according to the printing condition
defined by the PDF output intent.
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Fig. 33 Workflow filter.

The illustration shows an example of a hotfolder linked to two workflows: One for processing PDF X with
an output intent of ISO Coated v2 (39L) and one for processing PDF X with an output intent of ISO
Uncoated (29L).

Both PDFs are dropped into the same hotfolder. In this example, the PDFs can be identical, apart from the
output intent. This can be the case, for example, if the same print sample is going to be printed under dif-
ferent printing conditions.
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Both files will be sent to the top workflow below the hotfolder in the workflow list (39L). All filter para-
meters such as File Format, Color Space, Output Intent, and so on, will be checked for both files. (Not all
are shown in this illustration, but all are always checked.) The PDF X with the ISO Coated v2 (39L) output
intent matches all filter settings. The other input file with the ISO Uncoated (29L) output intent does not
match the Embedded ICC Profile / Output Intent Filter settings.

Therefore, only the ISO Coated v2 (39L) PDF file will be processed by this workflow. In the 39L workflow,
color management settings are defined for simulating the ISO Coated v2 (39L) printing condition in the
proof. The ripped and color managed output image will be printed on an idle printer from the printer pool
assigned to this workflow.

The other input file with the ISO Uncoated (29L) output intent rejected by the 39L workflow is accepted
and processed by the second workflow, 29L.

The third input file is not accepted by any workflow. Therefore, it is sent to the Unrecognized Files list. It
will be cleaned up by the Cleanup/Backup settings of the hotfolder.

6.5.5 Filtering and Processing Sequence

You can connect multiple workflows to the same hotfolder. Workflows connected to the same hotfolder are
cascaded. This means that the workflow list sequence also shows the sequence of file filtering. The top
workflow in the list is the first to scan an input file in the hotfolder according to the Filter Settings, and the
bottom workflow is the last. The File Filter settings decide which workflow recognizes and processes which
input file. The first workflow (from top to bottom) that recognizes the input image according to the File Fil-
ter settings will process the image. The number of files in progress (in the Files column) and the cor-
responding information in the info pane are updated accordingly.

The workflow sequence of filtering/processing is important, because one workflow processes only a subset
of the input images, for example, only PDFs. The next workflow processes a different subset, for example,
only images with a specific file name convention, or only images that are in a specific color space (embed-
ded ICC profile), and so on. It can be useful to configure the last workflow in the list so that it will print all
remaining files.

Files that are not recognized by the File Filter settings of any workflow will show up under Unrecognized
Files.

Tip You can change the File Filter settings in a workflow and select the command Rescan from the hot-
folder context menu to rescan the hotfolder. All input images that are not already assigned to a workflow
are filtered according to the updated workflow settings.

When a file is recognized by the File Filter of a workflow, the following actions are performed. The para-
meters for these actions are defined in the corresponding Input Settings pages of the workflow.

Tab Short description See also

Merge Files It is checked whether the input file is a single image that can be processed "as is" or
whether there is a sep file that defines a group of separations or whether any avail-
able Pattern Recognition should be applied to the input files.

"Pattern Recog-
nitions" on page 33

Screen Detection (Only 1-Bit TIFFs, DotProof mode) Automatic or Custom screen detection occurs. "Separated Multi-File
Images (1 Bit)" on
page 32

The resulting job is added to the Jobs list. If the printer is put on hold or the Nesting template puts the nes-
ted job itself on hold, you can open the created job in the Manual Job Manager and edit the job and image
settings manually before printing.
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6.6 Color Management

6.6.1 Proof Output—Defining the Simulation Color Space

On the Proof Output page, you define the simulation color space (target printing condition) for your
printer-medium combination. Furthermore, you can configure sharpening effects to make edges more clear
and distinct.

Proof Output settings

Group Short description See also

Proof Standard All information required for the color management of a certain printer–medium
combination and for a specific print standard is tied into a proof standard.

RGB proof standards contain PhotoProof profiles which have been designed
for photo printing applications and aim at printing particularly brilliant "RGB"
prints.

With a GMG OpenColor licence, you can also set up OpenColor proof stand-
ards with multicolor profiles for simulating spot color overprints.

"Proof Standards" on
page 166

"Printing Photographic
and Fine Art Prints with
PhotoProof" on page 16

"OpenColor Proof Stand-
ards" on page 168

Proof Mode In ContoneProof mode, the input image file in a job is automatically ripped
into a CMYK contone image. With a DotProof license, you can also print
halftone proofs in DotProof mode, either using 1-bit imagesetter data or 1-bit
files created by the built-in GMG 1-Bit Creator.

"Proof Modes" on page
41

"Printing Halftone Proofs
with DotProof" on page
15

Available Printers,
Media, and Versions for
selected Proof Standard

All available printers and media compatible with the selected proof standard
are listed. If you want to use a specific printer–medium combination not shown
on the Printer page, check whether you have defined a proof standard for the
combination.

Sharpen 3D Sharpness: Highly efficient and easy-to-use sharpening tool. Use the slider
to set an intensity from 0-20.

Unsharp Mask (USM): Use USM sharpening if you want to have more control
on sharpening effects. USM sharpens by increasing contrast along the edges,
making light pixels even lighter and dark pixels darker. The Threshold specifies
how far apart pixels must differ in value before they are considered to be an
edge. The Amount is like a volume control, increasing the contrast (how much
darker/lighter the edge borders become) by a specific percentage. The Radius
controls how wide the edge rims become—the wider the radius the larger the
edge rims.

Configuration dependencies
Dialog box Short description See also

Workflow The selected proof standard (Proof Output) defines the supported printer set-
tings (Calibration Set). It is only possible to select a single proof standard per
workflow. Multiple proof standards per job can be defined via Nesting across
multiple workflows, or via Smart and Job Ticket hotfolders.

Custom mode: Custom proof standard has to be defined first before a custom
calibration can be selected.

Available Printers, Media, and Versions for selected Proof Standard: On the
Color Management > Proof Output page, all available printers and media com-
patible with the selected proof standard are listed. Only printers and media lis-
ted here will also be available for load balancing and nesting.

"Proof Output—Defining
the Simulation Color
Space" on page 61

"Load Balancing and
Nesting" on page 90

"Hotfolder Input Settings"
on page 76

6.6.2 Channel Mapping in Workflows

With the workflow option Channel Mapping, you can apply self-defined rules for an automatic mapping of
image channels.
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Fig. 34 Alias-mapping of spot colors in a workflow.

On the screenshot, you can see example rules defined in a customer-related set. To use and show the
defined rule sets in a workflow, you need to enable the option Automatic Channel Mapping (1). To edit or
create a new rule set, click the Edit button (2) next to the drop-down list. The top left shows the name of the
channel mapping rule set (3). The Input Channel Name (4) is the spot color channel name as it appears in
the input file. The Rule (5) defines how the spot color will be handled (either not printed or replaced by an
alias color). For example, you can map a spot color named "Blue" to "Pantone Reflex Blue".

See also:

l "Alias-Mapping of Color Channels" on page 25

6.7 Load Balancing and Nesting

6.7.1 Load Balancing and Nesting

As a GMG ColorProof administrator, you have full control over each step of the complete process by defin-
ing workflow parameters. The smart logic behind the software allows you to combine load balancing
together with nesting strategies. This way, you can use the full capacity of all your printers while saving
media by combining "compatible" images to a single job. It might take a while to optimize the system for
your printer pool and internal workflow, but once set up, you will greatly benefit from the high degree of
automation.

The following illustration will give you an idea of how load balancing and nesting works in GMG Col-
orProof. The following information will describe the behavior in more detail.

Fig. 35 Load balancing and nesting.
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In this example, three workflows (A, B, and C) are set up to process images according to different proof
standards. (For load balancing and nesting, it does not matter which workflow is linked to which hotfolder
and which file filters are used for each workflow.)

One image is processed by each workflow (for example, by separate hotfolders or different file filter set-
tings). Each workflow processes its image in a different way according to the workflow parameters, for
example, using different proof standards. To give a specific example: if tagged with different ICC profiles,
the three images would be identified by the Embedded ICC Profile filters defined in the workflow.

After color-managing the images, the software distributes them among the printers in the printer pool (load
balancing). Two of the three images use the same nesting strategy (template 1, > 60 % image-filled space)
and also have compatible printer settings (for example, both proof standards support the loaded medium
GMG ProofPaper semimatte 250). These two images will be collected into the same job. The job will
remain in Nesting state (in the Jobs view) until 60 % of the defined roll length is filled; with 60% filled, the
job will be printed.

The image in workflow C uses a different nesting strategy (template 2). It is sent to a different printer from
the pool, centered horizontally on the printer medium, and printed directly as a single image.
More information on Load Balancing

In the Manual Job Manager, you can directly define a job with multiple images and different proof stand-
ards. Idle printers can be manually selected from the list of available printers.

In a workflow, you view a similar list of available printers and supported media for the specific workflow
settings on the Load Balancing and Nesting page. You can select the printer medium to be used for all jobs
generated by this workflow and you can select the printers for load balancing.

Load balancing automatically assigns a new image in the linked hotfolder to an idle printer from the printer
pool. The smart load balancing algorithm also takes the image sizes and the media sizes supported by the
different printers from the pool into account. It picks the printer that either directly supports the image size
without resizing the image or that requires the smallest change of the image size (if Image Processing rules
have been defined by the user). If no printer in the printer pool supports the image size (after Image Pro-
cessing is applied), an error job will be created that can be manually edited in the Jobs view and then sent
to the printer.

When an image is placed into a hotfolder, it is immediately sent to an idle printer provided that the fol-
lowing requirements are met:

The printer assigned to the job is part of the printer pool for this workflow.

All printer settings (loaded medium, print mode) match the workflow settings.

The image size fits onto the media size or there is no other printer available requiring less changes of
the image size (Image Processing).

A job is created and appears in the job list. If no printer in the printer pool supports the image size (after
Image Processing is applied), an error job assigned to the largest format printer is created and can be manu-
ally edited in the Jobs view and sent to the printer again.

Available printer-medium combinations

In the Workflow dialog box > Color Management > Proof Output page, all available printers and media
compatible with the selected proof standard are listed. Only printers and media listed here will also be
shown on the Load Balancing and Nesting page. If you want to use a specific printer–medium combination
not shown on the Load Balancing and Nesting page, check whether you have defined a proof standard for
the combination.

More information on Nesting

Nesting makes the situation a little bit more complicated, but also greatly enhances the automation cap-
abilities of the program. Let us start with a basic situation—nesting without load balancing, that is, with
only one printer in your printer pool.
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Nesting allows you to automatically create jobs with multiple images, just as you would manually create
jobs in the Manual Job Manager. This saves valuable proof media and can simplify your internal work-
flows, for example, if you collect all images for a certain client or for a certain print standard, printing them
in a single job.

Every Nesting Template contains a set of nesting rules (a so-called nesting strategy). Several predefined nest-
ing templates for common tasks are already provided by GMG Color GmbH & Co. KG, but you can also set
up custom templates to fit your needs. For example, you can use a nesting rule requiring 60% of a defined
roll length to be filled with images before printing. For the digital print production of photographic images
with PhotoProof profiles, you could use a nesting rule requiring all images to be automatically centered,
rotated to Portrait orientation, and printed as single images.

You can collect images across multiple hotfolders and workflows. The Nesting page in the Workflows view
provides you with an overview of all nesting strategies currently used by your system. It shows which work-
flows and printers participate in which nesting strategy.

If load balancing and nesting are used in combination, GMG ColorProof looks for an idle printer first (load
balancing) as soon as the first image is recognized in the linked hotfolder. The program checks whether the
image size fits onto the medium size, and whether all other printer settings (loaded medium, print
mode) are compatible with the workflow parameters according to the rules explained above.

A job in the status Nesting is created and appears in the job list. If multiple images with compatible print
settings are in the hotfolder at the same time, the images are distributed on the sheet or roll for minimized
media usage.

If a new image is placed into the hotfolder, it will be added to an already existing job in status Nesting
provided that all requirements for load balancing (see above) are met. An new optimized image placement
on the sheet or roll (to reduce media costs) is computed each time a new image is added to a Nesting job.

If one of the requirements is not met, a new job in status Nesting (assigned to another printer from the
pool) will be created. If no printer in the printer pool supports the image size (after Image Processing is
applied), an error job assigned to the largest format printer will be created.

Putting finished jobs automatically on hold after nesting

Activating the option Hold Finished Jobs, jobs created by a nesting template are automatically put on hold
after the finishing rule defined in the nesting template is met.

This feature is very convenient if you want to check the final job in the Manual Job Manager before print-
ing. Alternatively, you can use the Image Preview for PDF/PS files, as PDF/PS files are automatically put on
hold after being ripped.

6.7.2 Nesting Strategies

Nesting is a process whereby as much width of the paper as possible is utilized by aligning or rotating
many separate images before the job is printed.

Available
options

Description

Automatic
Nesting

Images are placed automatically according to the minimum paper usage (similar to the command Automatic Placement
in the Manual Job Manager). Disadvantage: Less control on the job layout (only predefined settings for image rotation
available). Advantage: Useful for nesting images in different sizes and orientations, maximum savings on print media.

Print Single
Image per
Job

Strictly speaking, this option is not a real nesting strategy, as only one image is placed per print job. This method is not
used for saving print media, but is especially useful for production of photographic prints or for large-format printing
(for example, newspaper proofs), where nesting would be inappropriate. Centered images are centered not only hori-
zontally, but also vertically. This way, you are able to create sheet-like jobs such as DIN A4 or letter on roll media to
ensure a uniform and pleasant visual appearance of proof jobs.

Single Line
Nesting

Images are placed automatically according to the minimum paper usage, but only up to a single row of images in the
nested job. The job is printed as soon as the defined percentage of paper width has been filled with images. Dis-
advantage: Offers less savings on print media than the Automatic Nesting mode. Advantage: You do not need to cut the
print medium manually to separate multiple rows of nested images.

One Input
File per Job

For multipage PDFs. All pages of one PDF document are printed in one proof job. Each page of a PDF is considered to
be a separate image. The job is printed as soon as all pages of the document have been placed.
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Nesting strategies that handle multiple images such as Automatic Nesting have two components:

Rules for the automatic placement of images on the print medium, including automated image trans-
formations such as scaling or cropping

Rules for finishing the nesting state and printing the job: Either time based (job is printed after a pre-
defined time) or after a predefined paper usage is reached. Rules are validated after all new images
from the hotfolder have been placed in the job.

Tip You can check the layout of a job in Nesting status in the info pane and prematurely start printing by
using the Print command from the context menu of a selected job.

6.7.3 Automatic Nesting

Group Short description See also

Automatic Placement Images are placed automatically according to the minimum area the resulting lay-
out requires on the print medium. You can define the spacing in-between images
and the orientation of images. Automatic means the image is rotated in a way that
a maximum number of images fits onto a minimum space. If Portrait (or Land-
scape) is selected, images are always rotated to portrait (or landscape) orientation,
even though this orientation could lead to a higher paper usage.

Maximum Job Age The job is printed after it reaches the predefined time (counted after creation of the
job in Nesting state). All jobs are printed after the predefined maximum time has
been reached; this option cannot be deselected.

Percentage % The percentage of the printable area that is filled with images is checked after new
images are added to a job in Nesting state. When it reaches the predefined
threshold, the job is printed. You can define separate rules for roll and for sheet
media.

If you always want to reach a specific roll length rather than filling a specific per-
centage of the paper width, you can deactivate the percentage by defining a per-
centage of 100%. As 100% paper usage cannot be reached even under ideal
circumstances, the job will stay in Nesting state until the Maximum Roll Length
has been filled.

Illustration below

Fig. 36 Roll Media Settings for automatic nesting.
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When using roll media, an imaginary cut line (1) is calculated each time a new image is added to a job in
Nesting state. The border of the printable area is then defined by this cut line. The calculation of the paper
usage area is then identical to the calculation for sheet media. (For sheet media, the printable area is
defined by the media size minus the non-printable borders.)

The required percentage (60% in this example) of the printable area is shaded in gray in the illustration (2).
Note that this is a simplification for illustration purposes. For fulfilling the rule, it does not matter where the
images are placed on the printable area. Only the sum of the area occupied by images counts for cal-
culating the percentage of paper usage. As soon as 60% of the printable area are filled with images, the job
will be printed.

If the Roll Maximum Paper Length is reached, the job is printed immediately, regardless of the percentage
of space filled with images. In the illustrated example 2, the images are too wide to fit two images next to
each other, but not wide enough to cover the required percentage of the printable area. Therefore, the max-
imum length is reached without reaching the required percentage (4).

6.7.4 Single Line Nesting

Group Short description See also

Automatic Placement Images are placed automatically according to the minimum area the resulting lay-
out requires on the print medium. You can define the spacing in-between images
and the orientation of images. Automatic means the image is rotated in a way that
a maximum number of images fits onto a minimum space. If Portrait (or Land-
scape) is selected, images are always rotated to portrait (or landscape) orientation,
even though this orientation could lead to a higher paper usage.

Maximum Job Age The job is printed after it reaches the predefined time (counted after creation of the
job in Nesting state). All jobs are printed after the predefined maximum time has
been reached; this option cannot be deselected.

Paper Width The percentage of the paper width that is filled with images is checked after new
images are added to a job in Nesting state. When the filled percentage reaches the
predefined threshold, the job is printed.

Illustration below

Fig. 37 Single Line Nesting.

The required percentage (60 % in this example) of the paper width is shaded in gray in the illustration (1).
As soon as images (from workflows using this nesting template) fill at least 60 % of the paper width, the job
will be completed and sent to the printer.

Different from Automatic Nesting, the used area is not regarded. Each line filled with images is printed as a
separate job.

6.8 Image Processing
Workflows offer the same image processing functionalities you have access to from the Manual Job Man-
ager. Thus you can fully automate GMG ColorProof without compromising on flexibility. With the Pro-
cessing of Images Larger than Media Size in Printer feature, you can automate the printing process of
larger images, replacing a manual rotation and placement of images by automated image processing rules.
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Feature Short description See also

Processing of Images
Larger than Media
Size in Printer

Automated image processing rule applied to images that do not fit onto the media
size defined for the printer in the Workflow dialog box > Print Settings > Printer
Advanced. Load balancing: If printers with different media sizes are assigned to a
workflow, the image is preferably sent to a printer where the image fits on the
medium without rotation or resizing, if available. Nesting: Processing of Images Lar-
ger than Media Size in Printer is applied before the Automatic Placement rules
from the nesting template (Rotate).

Scale Fixed scaling of images. Same functionality as in the Manual Job Manager > pre-
view area > Scale. Scale is applied before Processing of Images Larger than Media
Size in Printer.

Mirror (Flip Hori-
zontally)

Same functionality as in the Manual Job Manager > preview area > Rotate > Mirror
(Flip Horizontally).

Invert All Channels Same functionality as in the Manual Job Manager > Image > Color Management >
Channels > Invert.

Use PDF Bounding
Box

Same functionality as in the Manual Job Manager > preview area > Crop > Use PDF
Bounding Box.

"PDF Page Boxes" on
page 38

"Layout" on page 65

Order of sequence

Image Processing rules defined in a workflow can interact with Nesting rules, defined in a nesting template
assigned to the same workflow. This way, you can create a complex and fully automated image processing
workflow.

The order in which the different image processing features are applied by the program is as follows.

1. The image is resized as defined in the workflow > Image Processing > Scale.

2. A frame is created from the image: Image label and control strips are added to the image.

3. The frame is assigned to a compatible printer, preferably to a printer with a media size that is large
enough for the original size of the image. If the job settings of an existing nesting job are compatible,
the frame is added to an existing job. Otherwise, a new job is created.

4. The frame is rotated as defined in the nesting template > Automatic Placement > Rotate.

5. The program checks whether the frame fits on the printable area of the job. The frame is rotated, res-
ized, or cropped as defined in the workflow > Image Processing > Processing of Images Larger than
Media Size in Printer.

6. The job will be processed and printed. (In case the frame still does not fit on the media size after
image processing, the job will stay in status Error in the Jobs list. To resolve the issue, you can manu-
ally edit the job.)

Note If a fixed orientation (Portrait or Landscape) is defined in the nesting template and the Processing of
Images Larger than Media Size in Printer rules allow a rotation to fit the media size, the placement of the
frame on the media size takes precedence over the fixed orientation from the nesting template. This beha-
vior helps to ensure an automated workflow with a minimum number of error jobs.

Example:

An image is in A1 format and Portrait orientation, that is, the image is 23.39'' wide and 33.11'' high. The
image is added to a job that will be printed on a 24'' roll. With a width of 23.39'' in portrait orientation, the
image fits on the roll width.
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According to the nesting template, the rule Rotate = Landscape will be applied: The image will be rotated
to landscape. In landscape, the image does not fit on the roll anymore.

According to the rule Processing of Images Larger than Media Size in Printer = Rotate, the image will be
rotated back to portrait.

The job can now be processed and printed.

6.9 Workflow Cleanup / Backup
The options provided in GMG ColorProof to delete or backup input files after processing allow for a
smooth workflow without interruptions caused by a limited capacity of hard disk.

How to set up backup and file removal routines for printed images

1. On the navigation panel of the Workflow Properties dialog box, click Cleanup/Backup.

2. Select the option Clean up Processed Input Files and select a time.
Printed input files will be deleted from the hotfolder after this time.

3. Select the option Back up Processed Input Files and click the browse button next to the empty text
box.

4. Select the desired backup folder or create a new one, for example, CP05_Backup_39L.
All input files processed by this workflow are copied from the hotfolder to the backup folder when fin-
ished. If you have selected both the Clean up and the Back up option, this will result in a Move file
action.

5. Select the option Number if File Already Exists.
This option prevents already existing files from being overwritten by new files with the same name via
adding an incremented number to the name of each file.

6. Select the option Delete Backup Files after and enter the number of hours after which a file moved to
the backup folder will be deleted from the hard disk.

Nesting

In a workflow, cleanup/backup settings are defined for images. If nesting across multiple workflows (with
different settings) is used, cleanup/backup settings according to the workflow generating the image are
applied to an image in a nesting job.
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7. Output—Printers
In the Output view, you can configure and calibrate your printers on the Printers (1) tabbed page.

Fig. 38 Output view with one installed printer.

In the Available Printers (2) list, all printers are shown with the relevant hardware settings such as the ink
set and the loaded print medium.

Click on a printer to update the list of Available Printer Calibrations (3). All calibrations for the selected
printer and hardware parameters are shown together with the latest calibration date. You can check the cal-
ibration and calibrate the printer by clicking the respective buttons on the right side of each printer cal-
ibration.

The info pane (4) shows more information on the selected printer and printer calibration. For printers that
support a bidirectional communication, you can also check the Ink Status (5) and printer status on-the-fly.
When selecting a printer calibration, the Printer Calibration tab is added to the info pane, presenting all rel-
evant information such as the supported Print Modes or the measuring device used the last time when cal-
ibrating the printer.

Each printer is visualized with a Print Queue (6) and a RIP Queue in the lower section of the Output view.
The Printer info box in the left corner summarizes the workload of the printer and allows the user to Hold
and Continue the job processing of the printer.

Every time you select a printer (2), the available printer calibrations (3) and maintenance functions (7) are
immediately updated. Please note that the maintenance functions vary according to the printer type.

See also:

l "Maintenance" on page 103

l

7.1 Output Toolbar
You can configure existing printers and set up new printers on the Printers tabbed page of the Output view.

Tip Main program features are accessible by different methods, so that users can choose which way is most
convenient to them. This documentation generally refers only to the toolbar or menu, even though there
may be alternative methods.
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Click a button on the toolbar. Move the mouse over a button (without clicking) to display a tooltip.

Click a command on a menu.

Right-click on an item and click a command on the context menu.

Press a shortcut key. Shortcut key combinations are listed next to the corresponding command on the
menu.

Double-click an item (for example, a job or a workflow) to open the corresponding dialog box and
edit settings.

Toolbar commands

Icon Command Shortcut Description

Hold CTRL+H Puts all jobs assigned to the selected printer that are not yet processed on
hold. Click Continue to continue the job processing.

Continue CTRL+P Continue the job processing by a printer that is currently set on hold.

New Printer CTRL+N Set up a new printer.

Duplicate Printer CTRL+D Duplicates the selected printer. You need to enter a different name for the
new printer. This feature is useful if you have multiple instances of the same
printer type in use.

Delete Printer DEL Permanently removes the selected printer. No undo possible.

Add Custom Printer Cal-
ibration

Add a custom printer calibration if you want to calibrate a printer without
using a predefined calibration set (not recommended).

Remove Custom Printer
Calibration

Remove a custom printer calibration.

Change Media Opens the Change Media dialog allowing you to change the selected print
medium.

Configure Printer Opens the Configuration dialog of the selected printer.

7.2 Printer Control
After processing the input image (separation, rip, color management), the data finally needs to be converted
into data the printer can "understand" or interpret. The color information needs to match the ink colors in
the printer.

When printing from GMG ColorProof, this is generally done by printer drivers developed by GMG Color
GmbH & Co. KG (GMG Driver). The reason for developing proprietary printer drivers is to be able to get
more control over the print output, allowing to linearize each channel, change ink limits and accurately
define spot colors (which ensures a more realistic overprinting with spot colors).

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.
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7.3 Setting up a New Printer

Note The number of printers is limited by the software license on your dongle. If you cannot add a printer,
please check the license. See also chapter "Where Can I View and Update My Licenses?". If your license
does not support an additional printer, you will need to delete one of your existing printers first before set-
ting up a new one. This way, you can switch between different printers that are not needed to be run in par-
allel.

GMG color management works with color profiles that target printer−media combinations, including print-
ing parameters such as the print mode, resolution, and used inks. When setting up a printer, you are also
setting up a Proofing Condition (see "Database—Managing Color Managements Items" on page 154).

How to set up a new printer

1. Click the Output > New Printer button on the toolbar.
-OR-
On the Database menu, point to Printers, and click New.
The Add Item dialog is displayed.

2. Select a printer type from the Printer list.
The Printer list shows all supported printer types and all printers found on the network.

3. Click the Printer Properties button on the right side of the Printer list.
If you selected a printer found on the network, the printer properties are automatically filled in.

4. Printer Properties: Enter a Name for the printer.
This name serves as an identifier in the Output view. You can also filter and sort jobs according to the
printer name in the Jobs and History view.

5. Printer Properties: Select a Connection Type.
Select TCP/IP or USB if you want to use a direct printer connection without spooler. Select Spooler if
you set up a Windows spooler for this printer.

6. Click OK to confirm the Printer Properties and close the Printer Properties dialog.

7. Select the currently loaded Media Type and the appropriate Media Size from the Media list.

8. Select a Calibration Set for the defined printer-medium combination.

9. Optional: Select the Proof Standards you want to support.

10. Click OK to add the selected items to the database.

Fig. 39 Setting up a new printer with printer-specific color management sets.
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Direct printer connection and bidirectional communication

Note Some connection modes such as USB are supported only by certain printer types. Please refer to the
documentation of your printer for more information.

A bidirectional communication is supported by many (but not all) printers. In contrast to a printer con-
nection via a Windows spooler, a bidirectional communication allows the application to send requests dir-
ectly to and get responses from a printer. A bidirectional communication supports advanced features such
as checking ink levels and printer status from within the application. A disadvantage, however, could be
the fact that data loss can occur if the image file size of sent print jobs exceeds the internal memory of the
printer.

We recommend connecting printers via TCP/IP in a network. Via TCP/IP, you can access the printer dir-
ectly from within GMG ColorProof. You do not need to install anything on the operating system.

How to connect a printer via a Windows spooler

If you do not want to use a direct TCP/IP and USB connection, you can also set up a Windows print
spooler instead. A spooler connection is often installed automatically together with the printer driver, so in
most cases you will be able to directly select it in the Printer Property > Connection dialog. If it is not avail-
able, do the following to set it up first.

1. Open the Windows Control Panel.

2. Double-click the Printers icon.

3. Click Add a printer on the toolbar.

4. Click Add a local printer (can also be used for printers connected via intranet) and select the port or
create a new one.

5. Click Next.

6. Select the printer from the list that you want to connect and click Next.

7. Select the driver and click Next.

8. Enter a printer name and click Next.

9. Select Do not share this printer and click Next.
The printer will be connected to a Windows printer spooler.

10. Confirm by clicking Finish. (You do not need to print a test page now. Print a test image from GMG
ColorProof after setting up the printer in the software.)

7.4 Defining the Printer Properties

Note It is recommended to regularly check that the printer properties in GMG ColorProof match with the
actual configuration of your printer.

In the Output view, double-click a printer to call up the Printer Properties OR click the Configure Printer
button on the right side of each printer.

General Settings

The General Settings tabbed page contains the basic parameters for setting up a printer. Click on the dif-
ferent parameters to show a description in the description box. The validator messages will help you to fill
in the necessary information.

If printers can be equipped with different ink sets (for example, Epson Stylus Pro with Photo Black or Matte
Black), you need to define which ink set is currently used by the printer. When changing the ink set, the
printer automatically switches the calibration set. A recalibration might be required if the last calibration for
this set is not valid anymore.

HP Z printers: From the 8 color ink set HP 70 Vivera (LM, M, LC, C, Y, LG, PK, MK) pigment inks, 7 colors
are used in a print job. Depending on the printer media settings, either Matte Black (for GMG NewsPaper
or other media that support only a low TAC) or Photo Black is used automatically. 
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Fig. 40 General Settings in the Printer Properties dialog box.

Advanced Settings

On the Advanced Settings page, you have access to parameters that are not used on a regular basis. You
need to adjust the settings only in case the connected printer hardware exhibits any individual variations
that need to be compensated.

Advanced printer settings can also be defined in the Manual Job Manager and Workflow dialog box. In the
Manual Job Manager and Workflow dialog box, the advanced settings also comprise job specific printer set-
tings such as the Print Mode and Resolution. If you are using a GMG calibration set, these settings are
grayed out, because they are defined by the selected calibration set. To change these settings, first switch
to custom mode (Calibration Set > Custom) and select a custom calibration file.

Job Defaults

To save job configuration time, you can define printer specific job defaults that will be preselected for all
jobs. All settings on this page can also be changed for each job in the Manual Job Manager (Printer Settings
> Advanced) or in the Workflow properties (Print Settings > Printer Advanced).

Tip Media and media specific settings such as the respective drying time or paper feed adjustment can be
changed in the Change Media dialog box.

See also:

l "Changing the Print Medium" on page 101

l "Advanced Media Settings" on page 158

7.5 Changing the Print Medium

Note Some printers with a bidirectional connection can send information about the currently loaded print
medium to GMG ColorProof. If the media synchronization is activated, the software will be automatically
updated after a media change in the printer.

When setting up a new printer, you need to define a print medium which you are going to use with the
printer. If you change the print medium in your printer, it is very important to also change the medium in
GMG ColorProof to make sure you are using the correct profiles for printing.
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How to change the print medium

1. Click the Output button on the navigation panel on the left of the main window.

2. Select the printer that you want to change the printer medium for from the Available Printers list.

3. Click the Change Media button on the right side of the printer.

4. Select the currently loaded Media Type and the appropriate Media Size from the list. If a sheet type
Media Size is selected, you need to define the Orientation of the sheet in the printer as well.

5. Optional: Change the proof media names.

6. Optional: Customize the Media Specific Printer Settings for the selected printer (e.g. the drying time).

Fig. 41 Changing the print medium in the Output view.

See also:

l "Media Synchronization between Printer and Software" on page 121

l "Media" on page 157

7.5.1 Media Specific Printer Settings

Note Some of the displayed settings are grayed out and can only be changed for the generic printer and
media type combination in the Database view (see figure "10.3.2" on page 158) .

The Media Specific Printer Settings are valid only for the selected printer. When customizing the default
values, these will be stored separately for the selected printer and media type, not for the generic printer-
media type combination in the system database. This way, the custom settings are automatically restored
when switching back to a certain media. To retrieve the (factory) default values of the generic combination,
click the Reset button.

Available options Printer Type Description See also

Roll Tension Epson x890, x900,
Epson WT7900

If you are experiencing unreliable print quality and patterning
effects, it is recommended to adjust the Roll Tension (pre-
ceding a paper feed adjustment).

"Roll Tension Adjust-
ment" on page 143

Vacuum Epson Printers If you are experiencing artifacts due to ink deflection and splat-
ter, this might be caused by a too high vacuum, which
increases the distance the ink has to travel before it reaches
the medium (because the suction is distorting the medium).

Platen Gap Epson x890, x900,
Epson WT7900

You can adjust the distance between the print head and
medium. Normally, leave the Platen Gap to Standard for
standard media types. If you find that printed images are
smeared, increase the Platen Gap.
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Available options Printer Type Description See also

Paper Feed
Adjustment Mode

Epson Printers The optimum Paper Feed depends on the media weight and
thickness. To evaluate the Paper Feed, you can print and meas-
ure an image with a vertical length of 1000 mm. The meas-
ured length is entered as Paper Feed Adjustment.
Alternatively, you can download test forms and visually check
the printed images to fine-tune the paper feed.

"Manual Paper Feed
Adjustment" on page
145

Drying Method Printers with integrated
measuring device

You can choose between Active Drying (with a fan) and Air
Drying. When using Active Drying, the chart or strip is moved
to the drying area after printing and is actively dried for 120
seconds (per default) to ensure all patches are evenly dried
before being moved further down to the measuring device.

7.6 Media Synchronization between Printer and Software
Some printers with a bidirectional connection can send information about the currently loaded print
medium to GMG ColorProof. For these printers, you can synchronize the print medium selected in the soft-
ware printer with the print medium selected on the printer panel. This feature minimizes paper usage and
ensures reliable print results.

For printers without this synchronization capability, you need to manually select the correct media.

Canon imagePROGRAF printers

1. Set up your Canon imagePROGRAF printer in the Output view > Available Printers. Make sure you
have established a bidirectional communication (TCP/IP).

2. Click the Configure Printer button to open the printer configuration settings.

3. Click the Advanced Settings view on the left and select the option Synchronization with Medium in
Printer.
GMG ColorProof will now automatically use the print medium selected on the printer panel. If the
print medium is not available in the database, a warning will be shown.

HP Z printers

The media synchronization for HP Z printers offers three options to ensure identical media settings.

Available options Description

Put Jobs on Hold In case that the print medium selected in the software printer does not match with the print medium
loaded in the paper tray, all jobs for the printer will be put on hold and are restarted automatically after
paper change.

Use Loaded Medium Synchronization with the printer is activated. The print medium loaded in the paper tray is used. An error
message will inform you if the medium cannot be found in the GMG ColorProof database.

Ignore Loaded Medium Synchronization with the printer is deactivated. The media type selected in the software printer is used.
(not recommended)

7.7 Maintenance
All printers need an occasional tune-up. The maintenance functions, such as the cleaning of the nozzles or
a print head alignment, can be accessed via the printer panel or the printer driver and have been included
for ease-of-use in GMG ColorProof.

In the following table, you will find all maintenance utilities listed in the Output view, including the printer
types and a general description.
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Maintenance Function Printer Type Description
See
also

Print Nozzle Pattern Epson 4000, x400,
x450, x600, x800, x880,
x890, x900, WT7900,
SC-Px000,Canon iPF,
Canon iPFs

If the printing quality is declining, for example, faint or streaked in different
colors, print a nozzle check pattern to see if any print head nozzles are
clogged. Examine the nozzle check pattern. Each line should be complete,
with no gaps. If the pattern is incomplete, click Clean Print Heads to
unclog the nozzles. You should also print a nozzle check after every print
head cleaning to see if the cleaning was successful.

You may need to clean the print heads several times to get a clean nozzle
check pattern.

Clean Print Heads Epson 4000, x400,
x450, x600, x800, x880,
x890, x900, WT7900,
SC-Px000, Canon iPF,
Canon iPFs, Roland Ver-
saUV LEC

Unclogs the print head nozzles, so they can deliver ink properly. The clean-
ing takes several minutes to complete. If printing does not improve after the
first cleaning, repeat the process two or three times. If the print quality still
does not improve, start the Power Clean Print Heads service.

Do not start this service while any printing is in progress.

Every print head cleaning consumes ink. To avoid wasting ink, you should
only clean the print head if the print quality declines.

Clean Print Heads
(Cyan, Magenta)

Roland VersaUV LEC Instead of cleaning all print head nozzles, you can save ink and clean only
those that are causing problems. The cleaning may take a few minutes to
complete.

Clean Print Heads (Yel-
low, Black)

Roland VersaUV LEC Instead of cleaning all print head nozzles, you can save ink and clean only
those that are causing problems. The cleaning may take a few minutes to
complete.

Power Clean Print
Heads

Epson 4000, x400,
x450, x600, x800, x880,
x890, x900, WT7900,
SC-Px000

If the normal cleaning process is not sufficient to clear the nozzles, perform
a power cleaning. The power cleaning should not be performed more often
than necessary as it consumes a lot of ink.

Check and Clean Epson 4000, x400,
x450, x600, x800, x880

This service combines the nozzle check and subsequent
cleaning cycle. A nozzle pattern is printed and evaluated by
a built-in sensor. If some sections of the pattern are faint or
incomplete, the nozzles are clogged. In this case, the print
heads will be automatically cleaned and another test pattern
will be printed to determine whether the cleaning was suc-
cessful.

Check and Clean can be scheduled to be performed at a spe-
cific day and time (> Automatic Maintenance Scheduler).

Automatic Nozzle Clean Epson x890, x900,
WT7900, SC-Px000

Based on an automatic nozzle verification technology, the nozzle status is
checked by a built-in sensor, requiring no media. If the nozzles need to be
cleaned, the printer automatically runs a print head cleaning. The whole
process requires very little ink and takes less than 15 seconds to complete.

Print Nozzle Pattern in
Job, before Images

Epson 4000, x400,
x450, x600, x800, x880,
Canon iPF, Canon iPFs

When activating this option, a nozzle check pattern is printed with every
job. Using this option, the nozzle check precedes the image(s).

Print Nozzle Pattern in
Job, after Images

Epson 4000, x400,
x450, x600, x800, x880,
x890, x900, WT7900,
SC-Px000, Canon iPF

When activating this option, a nozzle check pattern is printed with every
job. Using this option, the nozzle check follows the image(s).

Clean Print Heads after
Number of Jobs

Epson 4000, x400,
x450, x600, x800, x880,
x890, x900, WT7900,
SC-Px000, Canon iPF

You can specify a number of jobs for an automatic head clean every time
you finish printing that quantity.

Print Nozzle Pattern
after Number of Jobs

Epson 4000, x400,
x450, x600, x800, x880,
x890, x900, WT7900,
SC-Px000, Canon iPF,
Canon iPFs

You can specify a number of jobs for an automatic nozzle check every time
you finish printing that quantity.
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Maintenance Function Printer Type Description
See
also

Check and Clean after
Number of Jobs

Epson 4000, x400,
x450, x600, x800, x880,
SC-Px000

You can specify a number of jobs for an automatic nozzle check and head
clean every time you finish printing that quantity. A nozzle pattern is prin-
ted and evaluated. If the nozzles are clogged, the print heads are auto-
matically cleaned.

Calibrate Paper Feed HPZ2100, HPZ3200,
HPZ6200

Automatically calibrates the paper feed and prints a paper feed calibration
image. The calibration procedure takes approximately three minutes. It is
recommended to perform a paper feed calibration for each newly intro-
duced media type and if you notice horizontal banding.

Color Calibration HPZ2100, HPZ3200,
HPZ6200

When printing with GMG Driver, a color calibration is not necessary.
When printing with HP Driver, or after a print head has been replaced or a
new paper type has been introduced, the printer has been turned off for a
longer period of time, or the environmental conditions have changed notice-
ably, it is recommended to perform a Color Calibration.

The calibration process runs fully automatically and requires no user inter-
action. The process takes about 8–10 minutes and includes the printing of a
calibration test chart which is measured by the integrated spec-
trophotometer.

Align Print Heads HPZ2100, HPZ3200,
HPZ6200

Precise alignment between print heads is essential for accurate colors and
smooth color transitions. If your prints look grainy or blurry, click the Align
Print Heads button. Also use this function whenever a print head has been
replaced. If you have experienced a paper jam, it is recommended to rein-
sert the print heads and then start the alignment process.

Do not use transparent or semi-transparent media to align the print heads.

Align Print Heads after
Number of Jobs

HPZ2100, HPZ3200,
HPZ6200

You can specify a number of jobs for an automatic print head alignment
every time you finish printing that quantity.

Paper Feed Adjustment Canon iPF, Canon iPFs If your prints show banding in different colors, it is recommended to adjust
the paper feed. This involves printing a test pattern. After measuring the pat-
tern, the printer automatically adjusts the feed amount.

A paper feed adjustment should be performed every time a new medium is
introduced.

Print Head Alignment
(Standard)

Canon iPF, Canon iPFs Automatic print head alignment, which fixes slight distortions and color mis-
alignment.

Print Head Alignment
(Advanced)

Canon iPF, Canon iPFs If the Standard mode does not improve the printing quality, use the
Advanced mode.

A print head alignment (Advanced and/or Expansion) should be performed
every time a new medium is introduced.

Print Head Alignment
(Expansion)

Canon iPF, Canon iPFs Use this mode if vertical lines are warped or colors are out of alignment
while the printer driver option High-Precision Printing or Priority on dot
placement accuracy is selected.

Color Calibration Canon iPF 6450 When printing with Canon print modes, it is recommended to perform a
Color Calibration from time to time.

The calibration process runs fully automatically and requires no user inter-
action. The process includes the printing of a calibration test chart which is
measured by the integrated densitometer.
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8. Printer Calibration
Combined with MX proof profiles, a regular printer calibration ensures a consistent representation of colors.
Undesired printer deviations caused by varying environment conditions such as temperature and humidity
are counterbalanced. We recommend you to calibrate your printer(s) on a regular basis to ensure the
highest production stability and color quality.

You can calibrate your printer easily by using a calibration wizard integrated into the main application.
GMG ColorProof uses multiple iteration cycles, similar to a control loop, to optimize and update the cal-
ibration. The steps of each cycle are visualized in the wizard.

Printer calibration procedure

With the calibration set concept, printer calibration is as easy as it could possibly be: The target values are
linked to the corresponding printer–medium combination and the measuring device in the GMG Col-
orProof database.

After connecting the measuring device to the computer and starting the Calibration Wizard (GMG CaliW-
izard), GMG ColorProof automatically detects all connected measuring devices and you simply have to
select the spectrophotometer you want to use for the calibration. If the printer features an integrated meas-
uring device, the calibration can be completely automated by using the GMG AutoCali Wizard.

The initial calibration file (MX3, MXC, or MX4) is defined in the calibration set. The appropriate target val-
ues are automatically extracted from the database. When calibrating a printer–medium combination for the
first time, the Initial Calibration from the calibration set will be used.

For all following calibrations, the last saved printer calibration file is used as a basis for a recalibration.
Each time a calibration is started, the output values are taken from the last saved printer calibration file.
This way, the number of iterations you need for a successful printer calibration is minimized (saving valu-
able time and media).

The threshold values that need to be reached for a successful printer calibration are defined in the cal-
ibration set: The target values are specified in the printer calibration file linked to the calibration set and
the tolerances for the target values are defined on the Quality Criteria page in the Calibration Set dialog
box.
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8.1 Measuring Device Settings
Measuring flexibility when calibrating the printer

The printer calibration file settings can be independent from the proof profile. This means, you can create a
printer calibration file for a different measuring device than the one you use for calculating the proof pro-
file. This way, you can use any measuring device that suits your needs for calibrating the printer on a reg-
ular basis. The achieved calibration status will be valid for all proof standards based on the same printer–
medium configuration, independent of the measuring device settings.

Use of a UV cut filter

UV light affects color measurements made with spectrophotometers. Therefore, spectrophotometers can
have integrated UV cut filters that may achieve more reproducible results in the visible color space. The
software is capable of working with UV and non-UV measuring devices.

The Epson Stylus Pro x900 series can be equipped with an integrated measuring device with custom Filter
and Backing settings.

The HP Designjet Z series features an integrated measuring device (HP embedded spectrophotometer) with
UV cut filter and black backing.

Backing methods

As most print media are not 100% opaque, the color of the substrate, for example, the measuring table,
underneath the test chart also affects the measurement values and thus the color profile.

For general purpose applications and according to the ISO 12647-7 standard, it is recommended to use
white backing for single-sided prints.

Tip In case white backing is not available on your measuring device, you can place a highly opaque sheet
(or multiple layers if the opacity is not sufficient) of white medium underneath the test chart. Preferably, the
medium should have a lightness (L*) value between 92 and 97. The saturation value (C*) should not exceed
2.4.

8.2 Resetting a Printer Calibration
All calibrations listed under Available Printer Calibrations can be reset any time, making sure you can
always return to the initial calibration file defined in the calibration set.

If you modify an initial printer calibration file linked within a calibration set, you can use the reset function
so that the modifications become effective.

How to reset a printer calibration

1. Click the Output button on the navigation panel on the left of the main window.

2. Under Available Printer Calibrations, right-click a calibration set to bring up the context menu.

3. Click Reset Calibration.

4. You will be asked whether you want to reset the calibration or not. Click Yes if you want to use the ini-
tial calibration file as a new starting point.

See also:

l "Modifying a Calibration Set" on page 164

8.3 Calibration Tips

What to do if the pre-linearization or the printer calibration fails

If you experience problems getting a printer calibrated, please consider the following:
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1. Check if the correct medium is loaded in the printer.

2. Shake the ink cartridges and replace expired ink cartridges.

3. Perform a nozzle check and print head cleaning.

4. Do a paper feed adjustment and print head alignment.

See also:

l "Printer Specific Information" on page 121

8.4 Calibration Check

8.4.1 Calibration Check

For Epson SureColor P printers and Epson Stylus Pro x900 and x890 printers with integrated measuring
device ILS30, the validity of the printer calibration can easily be verified by printing a GMG Calibration
Control Strip. The control strip is automatically measured by the printer in GMG ColorProof.

Note Some of the features described in the following may not be included in the standard GMG ColorProof
version and require an additional license (GMG DotProof, GMG FlexoProof, GMG ProfileEditor, GMG
ProofControl Inline, or GMG OpenColor). Please contact your local dealer for details.

The calibration control strip is verified against the target values from the printer calibration file linked to the
corresponding calibration set. The result of the calibration check will help you to decide whether the
printer needs to be recalibrated or not, thus saving valuable production time, ink, and media for unne-
cessary recalibrations.

Depending on the results, you can do one of the following:

1. Results are within your tolerances. No action required.

2. Additional printer checks such as printing a nozzle pattern and cleaning the print heads. Then, repeat
the calibration check.

3. A printer recalibration is required.

Additional printer checks

In addition to checking the printer calibration, GMG recommends to print a Nozzle Pattern on a regular
basis. This can be done manually or automatically with the Automatic Maintenance scheduler in GMG Col-
orProof (Output > Printers > Automatic Maintenance).

If the lines of the nozzle test pattern cannot be clearly distinguished, the print heads should be cleaned with
the Maintenance features supported by the printer in GMG ColorProof (Clean Print Heads, Check and
Clean, Power Clean).

See also:

l "Maintenance" on page 103

l "Printer Calibration" on page 106

8.4.2 Calibration Check Methods

In GMG ColorProof, the calibration check can be conveniently started in three ways, as described in the fol-
lowing.

Trigger Short description Where? See also

Manually You can manually print a calibration control strip
from time to time to check the current status of your
printers.

Output > Printers >
Available Printer Cal-
ibrations > Check Cal-
ibration

"Manual Calibration
Check" on page 109
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Trigger Short description Where? See also

Automatically, per sched-
uler

You can automatically print a calibration control strip
in regular intervals. For each printer, a scheduler can
be configured.

Output > Printers >
Automatic Calibration
Check

"Calibration Check
Scheduler" on page 110

Automatically, when
printing a job

You can print a calibration control strip as a Job Con-
trol Strip.

Manual Job Manager >
Job > Label/Strips > Job
Control Strips > Cal-
ibration Control Strip

Workflows > Job Con-
trol Strips > Calibration
Control Strip

Printing a calibration control strip manually or per scheduler

If you print the calibration control strip without a job, i. e. manually or per scheduler, the strip will be prin-
ted 12 cm below the start, with additional white space and a noise border. This extra space is added to
avoid that printer instabilities will show up in the control strip. According to GMG tests, print results are
very stable after the first 12 cm.

Note Printer stability could be an issue if you add the strip to very short jobs. In such cases, it is recom-
mended to add white space to the job, for example, by moving the images down using the Layout tools in
the Manual Job Manager until the strip is 12 cm away from the top.

Fig. 42 Screenshot of the calibration control strip in the Manual Job Manager.

This screenshot shows how the calibration control strip will be printed if it is printed outside a job. When
adding the strip to a job, it will be printed without the white space and noise border.

8.4.3 Manual Calibration Check

You can print a calibration control strip without printing a job, for quickly checking the printer calibration
during the working day, in-between jobs. Based on the results of the calibration check, you can decide
whether to calibrate the printer or not. In comparison to scheduling the printer calibration in fixed intervals,
this helps you saving valuable production time, ink, and media.



GMG ColorProof User Manual

110 / 209

How to perform a manual calibration check

1. Click the Output button on the navigation panel on the left of the main window.

2. Click the Printers tabbed page.

3. From the Available Printers list, select the printer for which you want to check the calibration status.
The Available Printer Calibrations list is updated accordingly.

4. Select the Printer Calibration from the list you want to check.

5. Click the Check Calibration button on the right side, next to the printer calibration.

A calibration control strip is printed automatically.

8.4.4 Calibration Check Scheduler

Using this feature, you can automate the printer calibration check. You can define a regular interval in
which the Calibration Check will be automatically started. You can use this feature to document the sta-
bility of your printer during the normal production workflow, eliminating the need to remind yourself to
manually check the calibration.

How to schedule an automatic calibration check

1. Click the Output button on the navigation panel on the left of the main window.

2. Click the Printers tabbed page.

3. From the Available Printers list, select the printer for which you want to schedule the automatic cal-
ibration check.

4. Navigate to the Automatic Calibration Check group below the printer list. Select the calibration set
that you want to check.

5. Select the calibration check interval.

See also:

l "Calibration Check" on page 108

8.5 CaliWizard (External Spectrophotometer)

8.5.1 GMG CaliWizard

GMG CaliWizard is used to calibrate printers with an external measuring device (for printers not supporting
an integrated measuring device).

During the printer calibration process, the last saved printer calibration file is used as a basis for a recal-
ibration of the printer. During the following iterative cycle, the output values in the printer calibration file
will be optimized to reach the target values within the defined tolerances. The existing printer calibration
file will then be replaced with the modified file.

The wizard will lead you through all steps required for the calibration. You can use other printers in the
meantime. You can also set up jobs for the same printer that currently runs the calibration. They will be
printed after the calibration will have been finished.

GMG ColorProof uses multiple iteration cycles, similar to a control loop, to optimize the calibration. The
steps of a cycle are visualized in the wizard. The currently active step is highlighted by a white background
color.
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How to start GMG CaliWizard

1. Click the Output button on the navigation panel on the left of the main window.

2. Select the printer you want to calibrate from the Available Printers list.

3. Select the calibration set you want to use from the Available Printer Calibrations list.

4. Click the CaliWizard button on the right side of the calibration set.

The GMG CaliWizard is started.

5. Follow the instructions of the wizard.

8.5.2 Iteration Cycle: Printing, Measuring, Evaluating

The aim of the iteration cycle is to match the Target values as closely as possible, within the tolerances
defined in the calibration set. Following each iteration cycle, the program computes new CMYK output val-
ues based on the deviation between the target values and the measured current values. The new output val-
ues are used in the next Printing step. Thus, the Current values will become closer to the tolerances with
each iteration, that is, Printing, Measuring, and Evaluating.

In the Printing step of the iteration cycle, you will print a color patch for each fulcrum in the corresponding
data table. In the Measuring step, you will measure the color values of each patch as Current values. In the
Evaluating step, you will compare the Current values with the Target values.

Step 1: Printing Test Charts

Test charts with color patches for spectrophotometric measurements are used for the following steps. Test
charts have a different layout and size depending on the printer calibration they are used for and depending
on the measuring device.

When calibrating a printer, a printer calibration test chart is printed with a separate color patch for each ful-
crum in the printer calibration file. During the first printer calibration, the output color values cor-
responding to the input color values are taken from the printer calibration file linked as Initial Calibration
within the calibration set. For all following calibrations, the output values are taken from the last saved
printer calibration file.

The test chart job will be added to the job list with highest job priority. It is handled like any other job. The
job name shows the number of the iteration cycle.

Pre-linearization: When the calibration is based on an MXC printer calibration, the input–output behavior
of additional non-CMYK inks in the printer is analyzed and standardized first. To achieve this, a Pre-Lin test
chart is printed and measured in an iteration cycle, just like a printer calibration test chart. The Pre-lin-
earization data is saved in the MXC calibration file. If the pre-linearization cycle fails, the printer calibration
will be canceled. (In this case, you might need to replace the inks.)
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Step 2: Measuring Test Charts

The color values of the printed patches are measured (as Current values) with a spectrophotometer. Each
color patch on a test chart represents a fulcrum (data point) in the corresponding data table within the
printer calibration. By measuring patches, the data table is filled with data points.

(In case an MX3 printer calibration with no K values is used—No Key Mode (CMY Only) in GMG Pro-
fileEditor)—black patches on the test chart are not measured. Values that have not been measured are
marked with the following character: "–".)

Note Before you start measuring a test chart page, check that it is not visibly damaged, for example, by
scratches. In case that a page cannot be used for measuring, go back to the Printing page and print the
page again.

Fig. 43 Measuring page before starting the measurement.

Each test chart page is shown on a separate tabbed page (1) in the Measuring window.

Click Start Measurement (2) to start measuring the test chart page shown on the front tabbed page.

The measuring progress of the page is shown in the visualization of the test chart on the tabbed page. You
can point to a color patch with the mouse to show a popup with more information. You can also measure
single patches in this view.

After you have successfully measured all test chart pages, click Next to proceed to the next step (3).
How to measure test charts with multiple pages

Each test chart page is shown on a separate tabbed page in the Measuring window.

1. To measure a page, insert it into the measuring device, select the corresponding tabbed page, and
click Start Measurement.

2. Repeat this procedure for all pages.

If there are too many test charts to fit in the window, you can click the small arrow on the top right side of
the tabbed pages to bring hidden test charts or the Measuring Device Settings page to the front.

How to measure a single patch

This can be helpful, for example, if the measuring device cannot automatically scan the test chart.

1. In the test chart image, select a patch with the mouse and right-click it to show the context menu.

2. On the context menu, click the command Measure Single Patch.

Measuring Device Settings

You can click the Measuring Device Settings tabbed page to see the currently used measuring device para-
meters.
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Depending on the used measuring device, some measuring parameters can be changed from within the soft-
ware, for example, switching from Scan mode to Single Patch readings. Read-only parameters are grayed
out and provided only for your information.

When using an X-Rite Eye-One, the software automatically switches to Single Patch mode if a row cannot
be measured after three attempts.

Note Please check the hardware parameters such as Standard Observer Angle, Illumination Type, and Fil-
ter to ensure the software settings are correct and match the hardware configuration of the connected meas-
uring device. Otherwise, this will result in wrong measurement values.

Step 3: Evaluating Measurement Results

In the Printing step, you have printed a color patch for each fulcrum in the printer calibration or color pro-
file. In the Measuring step, you have measured the color values of each patch as Current values. In the
Evaluating step, you will now compare the Current values with the Target values.

The aim of the iteration cycle is to match the Target values as closely as possible, within the tolerances
defined in the calibration set. Following each iteration cycle, the program computes new CMYK output val-
ues based on the deviation between the target values and the measured current values. When creating a
printer calibration file, the full gamut file linked within the printer calibration will be used as a reference to
calculate the new output values. The new output values are used in the next Printing step. Thus, the Cur-
rent values will become closer to the tolerances with each iteration, that is, Printing, Measuring, and Evalu-
ating.

You can repeat the iteration cycle until the values are either within the tolerances or until you decide to
end the cycle by accepting the best iteration.

Fig. 44 Evaluating page after successful iteration cycle.

Accepting a successful iteration

The Evaluating page provides you with an overview on the results of the ongoing iteration cycle. The res-
ults of each Iteration (printing and measuring the test charts) are listed in a table (1).

If the current values of the first cycle (Iteration 1) are already within the tolerances (indicated by a green
status lamp in the Results column), you can click the Accept Iteration 1 button to accept the results. In the
screenshot, the results of Iteration 1 have not been within the tolerances (failed iteration).

Repeating a failed iteration

A failed iteration will be indicated by a red status lamp in the Results column. If an iteration fails, steps 1
and 2 will be repeated to further improve the calibration: The test chart will again be printed with the new
output values and measured.
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Generally, it makes sense to repeat the iteration cycle from the last iteration. However, you can also select
a different one from the list and continue the iteration cycle from this iteration, thus ignoring the following
iterations.

To continue the cycle, click the button Improve further (2). The label Iteration 2 next to the button shows
that Iteration 2 will be repeated when the button is clicked.

You can show a table with all measured and target values for all patches by selecting an Iteration from the
list and clicking the Details button (3). This can give you a hint on where to look for the problem if the
printer cannot be calibrated.

Tip For example, if there are prominent color deviations in a specific color channel, you might need to
replace the ink or clean the print heads. If the paper tint values (0, 0, 0, 0) are out of tolerances, you might
have loaded the wrong media type into the printer.

Ending the iteration cycle by accepting a failed iteration

The iteration cycle can be repeated until the measured values are within the tolerances of the target values.
However, if you are satisfied with the results of an iteration, you can also decide do end the iteration cycle
and to proceed, thus ignoring the tolerances. To do so, select the iteration you are satisfied with from the
list and click the Accept Iteration button to proceed.

Finalizing

The Finalizing page shows you a short summary of the Results. Please check the results carefully before
clicking Finalizing.

When clicking Finalizing, you will accept the Results of the iteration cycle and save the new output CMYK
values and the Current values from the last iteration within the printer calibration file.

Note This action cannot be undone. After leaving the Finalize calibration page by clicking the Finalizing
button, you will not be able to go back to a previous step.

8.6 AutoCali Wizard (Integrated Spectrophotometer)

8.6.1 Automated Calibration with GMG AutoCali Wizard

GMG AutoCali Wizard is used to calibrate printers featuring an integrated measuring device. With the
integrated measuring device, the whole process is fully automated, without user interaction required. You
can use the scheduler to run the calibration in regular intervals (Output view > Automatic Calibration
Scheduler).

Note Not all media types are recommended for using GMG AutoCali Wizard. GMG AutoCali Wizard will
only be available if a supported medium is loaded into the printer. For example, in combination with
NewsPaper media, GMG AutoCali Wizard is not available for a printer of the HP Designjet Z series. In this
case, the grammage of the medium is not supported by the auto-calibration process. We recommend using
an external measuring device for calibrating printer–medium combinations that are not supported by GMG
AutoCali Wizard.

During the printer calibration process, the last saved printer calibration file is used as a basis for a recal-
ibration of the printer. During the following iterative cycle, the output values in the printer calibration file
will be optimized to reach the target values within the defined tolerances. The existing printer calibration
file will then be replaced with the modified file.

The wizard will lead you through all steps required for the calibration. You can use other printers in the
meantime. You can also set up jobs for the same printer that currently runs the calibration. They will be
printed after the calibration will have been finished.

GMG ColorProof uses multiple iteration cycles, similar to a control loop, to optimize the calibration. The
steps of a cycle are visualized in the wizard. The currently active step is highlighted by a white background
color.
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(HP only) Printer Maintenance Feature: Color Calibration

The printer maintenance feature Color Calibration makes sure that the system is reset to a stable and repro-
ducible state before starting the calibration. In this step, the printer prints a small test chart and calibrates
the colors against internal reference values. This feature can be manually run from the front panel of the
printer. It is automatically run when GMG AutoCali Wizard is started.

How can I start an automatic calibration?

There are multiple ways to start GMG AutoCali Wizard.

Method Short description See also

Time based scheduling An automatic calibration of one specific calibration set is started in regular
intervals.

"Automatic Calibration
Scheduler" on page 116

Calibration set is invalid The calibration set needs to be recalibrated. "Calibration Sets" on page
161

Manual action You can start GMG AutoCali Wizard manually any time you want.

How to start GMG AutoCali Wizard manually

1. Click the Output button on the navigation panel on the left of the main window.

2. Select the printer that you want to calibrate from the Available Printers list.

3. Select the calibration set that you want to use from the Available Printer Calibrations list.

4. Click the AutoCali Wizard button on the right side of the calibration set.

The GMG AutoCali Wizard is started.

5. Follow the instructions of the wizard.

8.6.2 GMG AutoCali Wizard Settings

If a printer selected in the Available Printers list supports an integrated measuring device, features specific
to GMG AutoCali Wizard will be available in the context-sensitive area below the Available Printer Cal-
ibrations list.

Option Short description See also

Automatic Actions if Cal-
ibration Set Status is
Changed to "Not Cal-
ibrated"

Actions triggered if a proof standard verification failed. The action is
triggered only for the calibration set that was used when printing the job.

If you are sharing printers in your work group, please note that the cal-
ibration can occupy the printer and thus delay print jobs from other
instances of GMG ColorProof on other computers.

"Calibration Sets" on page
161

"GMG ProofControl Inline
Settings" on page 184

Automatic Calibration You can use the default tolerances for a successful printer calibration as
defined in the calibration set or you can enter custom criteria that will be
applied to the printer selected in the list.

"Customizing Quality Cri-
teria for GMG AutoCali
Wizard" on page 118

Automatic Calibration
Scheduler

Using this feature, you can fully automate the printer calibration process. "Automatic Calibration
Scheduler" on page 116
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Fig. 45 Scheduling the recalibration and using custom criteria when calibrating a printer with GMG
AutoCali Wizard.

Scheduler: You can automatically calibrate a printer featuring an integrated measuring device only for one
calibration set at a time. You can select the calibration set that will be used by the scheduler under Auto-
matic Calibration Scheduler > Automatic Calibration (2).

Custom quality criteria: If you want to use custom criteria instead of the quality criteria defined in the cal-
ibration set, you can select the option Use Custom Criteria (1) (Automatic Calibration > Tolerances > Use
Custom Criteria). (Custom criteria apply not only to the scheduler, but to the Automatic Calibration in gen-
eral, for example, if it is started manually.)

See also:

l "Quality Criteria" on page 163

Fig. 46 Starting a recalibration automatically if the calibration is not valid anymore.

A recalibration will be started automatically for a calibration set as soon as its status changes to "Not Cal-
ibrated".

See also:

l "Calibration Sets" on page 161

8.6.3 Automatic Calibration Scheduler

Using this feature, you can fully automate the printer calibration process. You can define a regular interval
in which GMG AutoCali Wizard will be automatically started, without user interaction required.
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Tip Configure the Automatic Calibration Scheduler to start each night to achieve the most stable print res-
ults without compromising the production throughput of your facility.

How to schedule an automatic calibration

1. Click the Output button on the navigation panel on the left of the main window.

2. Click the Printers tabbed page.

3. From the Available Printers list, select a printer with an integrated measuring device.

4. Expand the Automatic Calibration Scheduler group in the bottom grid.

5. Under Automatic Calibration, select the Calibration Set you want to have calibrated. If you select All,
all listed calibration sets will be calibrated one after the other.

6. Select the Repeat Interval and the Day of the Week as time interval for the automatic calibration.

7. Select the point of time when the calibration should be started (24-hour format).

8.6.4 Iteration Cycle: Printing, Measuring, Evaluating

The aim of the iteration cycle is to match the Target values as closely as possible, within the tolerances
defined in the calibration set. Following each iteration cycle, the program computes new CMYK output val-
ues based on the deviation between the target values and the measured current values. The new output val-
ues are used in the next Printing step. Thus, the Current values will become closer to the tolerances with
each iteration, that is, Printing, Measuring, and Evaluating.

In the Printing step of the iteration cycle, you will print a color patch for each fulcrum in the corresponding
data table. In the Measuring step, you will measure the color values of each patch as Current values. In the
Evaluating step, you will compare the Current values with the Target values.

Final Step: Evaluating and Finalizing the Calibration

The iteration cycle is iterated until one of the following occurs:

The measured values are in the tolerances of the target values. Printer status = calibrated. The printer
calibration file with the new output values is automatically saved after a successful calibration.

The maximum number of iterations is reached. Printer status = not calibrated.

The next time a calibration is started for the same printer–medium configuration, the output values are
taken from the last saved printer calibration file. This way, the number of iterations you need for a suc-
cessful printer calibration is minimized (saving valuable time and media).

See also:

l "Resetting a Printer Calibration" on page 107
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GMG AutoCali Wizard after successful calibration.

The measured (current) values of the first iteration cycle (1) were outside the tolerances defined in the Qual-
ity Criteria of the calibration set. Therefore, Print and Measure steps have been repeated in a second iter-
ation cycle.

The output values calculated after evaluation of the second cycle resulted in correct measured values in the
third iteration. The printer status is set to "calibrated" and the printer can be used for printing. The updated
calibration file is saved.

You can click the Details button (2) to show all results.

8.6.5 Customizing Quality Criteria for GMG AutoCali Wizard

The threshold values that need to be reached for a successful printer calibration are defined in the cal-
ibration set. You can customize the quality criteria in calibration sets (or switch them off completely for a
given calibration set) on the Quality Criteria page in the Calibration Set dialog box.

Alternatively, you can also keep the quality criteria defaults in the calibration sets, and change the quality
criteria before calibrating the printer with GMG AutoCali Wizard in the Output view > Printers > Auto-
matic Calibration.

See also:

l "GMG AutoCali Wizard Settings" on page 115

l "Quality Criteria" on page 163

8.7 About Remote CaliWizard
GMG Remote CaliWizard is an easy to use calibration client for GMG ColorProof allowing you to calibrate
your printers from a remote location.

Rather than unplugging, plugging or moving the measuring device every time you want to calibrate your
printers, have one measuring device connected to a computer within your local network and calibrate mul-
tiple printers by logging into a host GMG ColorProof application. After measuring a test chart, the meas-
urement results are automatically transferred to the host system which performs the necessary adjustments.

GMG Remote CaliWizard is fully compatible with all printers and measuring devices supported by GMG
ColorProof.
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8.7.1 Installing Remote CaliWizard

GMG Remote CaliWizard is part of the installation volume and requires no additional license. It is included
in the GMG ColorProof setup.

Note Please check to ensure you are installing a compatible version. Both client and host component
should have the same version number.

How to install GMG Remote CaliWizard

You can choose between three methods to install the application, depending on whether the computer on
which you install the application will have an active internet connection or not.

Available options Description

Web-based setup This method is recommended if the computer on which you install the application has an
active internet connection. You need to download only a very compact setup file. All
required resources will be downloaded automatically from a GMG server via the internet.
The setup file can be found in the download area of the GMG support website.

From DVD If you received a DVD, this is the easiest way. All resources will be installed automatically
from the DVD.

Downloaded ZIP archive If the computer has no active internet connection and you have no DVD, you can download
the setup and all resources as a ZIP archive (from a different computer) and then transfer the
ZIP archive to the computer on which you want to install the application. The ZIP archive
can be found in the download area of the GMG support website.

1. If you downloaded the ZIP archive from the GMG website, copy the setup folder to a local directory
and extract all compressed files.

2. Double-click the CP5_OS_5.x.x.exe file to start the installation.

3. Select the program feature GMG Remote CaliWizard.

4. As you probably do not want to install the main GMG ColorProof application on the same computer,
deselect all other program features. (It will of course not hurt to install them. It is just not required and
will consume disk space.)

5. If you started the web-based setup, the installation wizard will automatically download the required
resources from a GMG server via the internet.

6. When the installation is complete, click the Finish button to close the wizard.

8.7.2 Calibrating Your Printer from a Remote Location

Like GMG CaliWizard integrated in GMG ColorProof, the remote client conveniently guides you through
every calibration step.

Setting up the GMG ColorProof host system for remote calibration

1. Double-click the GMG ColorProof program icon on the Windows desktop or click GMG ColorProof
on the Windows Start menu

2. Click the System button on the navigation panel on the left of the main window.

3. Click the General tab.

4. Under Remote CaliWizard Settings, select the option Start Host Service Automatically to allow for
remote access.
The GMG ColorProof system is now ready to be used for remote calibration.
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How to calibrate your printer at a remote site

1. Click GMG Remote CaliWizard on the Windows Start menu of the client computer.
The Remote Calibration login dialog is displayed.

2. Under Host Name, enter the IP address the GMG ColorProof host system.

3. Click the Connect button to establish the connection to the host system.
The client connects to the given host address and shows the start dialog of GMG Remote CaliWizard.

4. Select the printer you want to calibrate from the Available Printers list.

5. Select the calibration set you want to use from the Available Printer Calibrations list.

6. Click the CaliWizard button on the right side of the calibration set.

The GMG CaliWizard is started.

7. Follow the instructions of the wizard.

For further information on the individual steps performed in an iteration cycle, please see the following
chapters.
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9. Printer Specific Information
In the printer specific chapters, you can find further information on printers from specific printer series.
Please note that the information is rather specific and cannot be applied to all types of printers.

9.1 Supported Printers

Manufacturer Model See Also

Canon Canon imagePROGRAF iPF 6300, 6300S, 6350, 6400, 6400S, 6410, 6410S,
6450, 6460, 8300, 8300S, 8310, 8310S, 8400, 8400S, 8410, 8410S

"Canon imagePROGRAF" on
page 123

"Canon imagePROGRAF x300S,
x400S Speed Series" on page
126

Epson Epson Stylus Pro 4000, 4400, 4450, 4800, 4880, 4900, 7400, 7450, 7600,
7800, 7880, 7890, 7900, WT7900, 9400, 9450, 9600, 9800, 9880, 9890,
9900, 10600, 11880, Epson SureColor SC-P6000/8000, 5000/7000/9000 V +
LLK, 10000/20000, P75x0/P95x0, Epson SC-S80600

"Epson Stylus Pro WT7900" on
page 135

"Epson Stylus Pro 7890, 9890"
on page 133

"Epson Stylus Pro 4900, 7900,
9900" on page 129

"Epson SC-P6000, 8000 and SC-
P5000, 7000, 9000 Printers" on
page 139

"GMG ColorProof Tutorials"

HP HP Designjet Z2100, Z3100, Z3200, Z5200, Z6100, Z6200 "HP Designjet Z3200 Photo" on
page 146

"HP Designjet Z5200 PostScript
Printer" on page 148

"HP Designjet Z6200 Photo" on
page 149

Mimaki Mimaki UJF-706 "Mimaki UJF-706" on page 152

Roland Roland VersaUV LEC-330, 540

Roland VersaUV LEC2 series
Roland VersaUV LEJ-640

Roland VersaCAMM VS-300, 420, 540, 640

Roland VersaCAMM VSi-300, 540, 640

"Roland VersaUV LEC 330/540,
LEJ 640" on page 150

"Roland VersaCAMM VS/VSi
Series" on page 151

9.2 Media Synchronization between Printer and Software
Some printers with a bidirectional connection can send information about the currently loaded print
medium to GMG ColorProof. For these printers, you can synchronize the print medium selected in the soft-
ware printer with the print medium selected on the printer panel. This feature minimizes paper usage and
ensures reliable print results.

For printers without this synchronization capability, you need to manually select the correct media.

Canon imagePROGRAF printers

1. Set up your Canon imagePROGRAF printer in the Output view > Available Printers. Make sure you
have established a bidirectional communication (TCP/IP).

2. Click the Configure Printer button to open the printer configuration settings.

3. Click the Advanced Settings view on the left and select the option Synchronization with Medium in
Printer.
GMG ColorProof will now automatically use the print medium selected on the printer panel. If the
print medium is not available in the database, a warning will be shown.

../../../../../Content/tutorials.htm
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HP Z printers

The media synchronization for HP Z printers offers three options to ensure identical media settings.

Available options Description

Put Jobs on Hold In case that the print medium selected in the software printer does not match with the print medium
loaded in the paper tray, all jobs for the printer will be put on hold and are restarted automatically after
paper change.

Use Loaded Medium Synchronization with the printer is activated. The print medium loaded in the paper tray is used. An error
message will inform you if the medium cannot be found in the GMG ColorProof database.

Ignore Loaded Medium Synchronization with the printer is deactivated. The media type selected in the software printer is used.
(not recommended)

9.3 Measurable Areas of Integrated Measuring Devices
The measurable area of some integrated measuring devices can be smaller than the printable area of the
printer. If a control strip is placed outside the measurable area, the measuring device will technically not be
able to measure it, as shown in the following illustration of the measurable area of an Epson integrated
measuring device.

Fig. 47 Sketch illustrating the technical limitation.

The sketch illustrates that the problem is more likely to occur if multiple images are positioned in landscape
orientation. Two pages are placed next to each other in the job. The gray area is out of range for the integ-
rated measuring device. The second page in the job (and thus also the image control strip which is placed
directly beneath the image) exceeds the measurable area and cannot be measured.

One strategy to solve this problem is to open the printed job from the History, rearrange the images and
print the job again. The following table provides you with information which may help you in rearranging
the images so that all control strips are placed within the measurable area.

Overview on the measureable areas

Epson printers:



9. Printer Specific Information

123 / 209

Printer Paper Width (mm) Measurable Area (mm)
Non-Measurable
Area (mm)

Non-Measurable
Area (inch)

Epson Stylus Pro 4900 432 395 37 1.46

Epson Stylus Pro 7900 / WT7900
Epson SC-P 6000/7000

610 470 140 5.51

Epson Stylus Pro 9900
Epson SC-P 8000/9000

1118 991.45 126.55 4.98

Epson Stylus Pro 7890 610 470 140 5.51

Epson Stylus Pro 9890 1118 991.45 126.55 4.98

Canon iPF printers:

The measurable area of the Canon iPF 6450 series is limited to the left, right and top side, so that control
strips should always be placed at the bottom of an image.

Printer Paper Width (mm) Left Margin Right Margin Top Margin

Canon imagePROGRAF 6450 < 550 30 30 110/170

Canon imagePROGRAF 6450 >= 500 30 87 110/170

Other strategies to ensure that a printed control strip can be measured

Use job control strips instead of image control strips. Job control strips are always printed within the
measurable area.

Note Please note that job control strips cannot be used for GMG OpenColor jobs.

Workflow jobs: Use a nesting template and activate the option Place Control Strips within Meas-
urable Area.

If you are using an Epson Stylus Pro 7900 printer, use a 17'' roll. The measurable area completely cov-
ers the roll width.

9.4 Canon

9.4.1 Canon imagePROGRAF

The Canon imagePROGRAF printer series has been developed by Canon Inc. specifically with high-quality
printing of photographic and fine art and contract-proofing in mind. From a very early stage of devel-
opment, GMG and Canon formed a strong cooperation in the field of color management. Together, both
companies have been able to achieve impressive results.

With GMG DotProof or GMG FlexoProof, you can be sure to take full advantage of the latest printing tech-
nology. With a GMG DotProof XG or GMG FlexoProof XG license, you can fully exploit the extended
color space of the Canon LUCIA EX inks with additional Red, Green, and Blue for producing highest qual-
ity halftone proofs with highly realistic spot color simulations.
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Printer features

This high-quality printer prints a very large color space by using Canon LUCIA EX Ink with additional
Red, Green, and Blue inks.

Canon imagePROGRAF iPFx3x0, iPFx4x0 can print 12 colors (12c) in total: Cyan, Photo Cyan,
Magenta, Photo Magenta, Yellow, Photo Gray, Gray, Photo Black, Matte Black, Red, Green, Blue.
Depending on the selected media type, either Photo Black (PK) or Matte Black (MK) is used. [Pre-
installed print modes based on the GMG Driver state the used ink set in the print mode name.]

4 picoliter ink droplets ensure the smoothest color gradations, the highest resolution and accuracy.

Prints show an excellent scratch resistance.

The Canon imagePROGRAF iPF 6450 series is equipped with an integrated measuring device from X-
Rite. Together with GMG AutoCali Wizard, printer calibration becomes very easy and fully auto-
mated.

Media information can be downloaded onto the printer via the imagePROGRAF Media Configuration
Tool provided by Canon. You can also upload custom media from the Canon printer to GMG Col-
orProof. For further information, please refer to the "Media Configuration Tool Guide" from Canon.

Create job copies by the printer: Canon imagePROGRAF iPFx3x0, iPFx4x0 have an integrated hard
disk. When creating a manual job with the Number of Copies feature (Manual Job Manager > Job >
Printer Settings > Printer), job copies are created directly by the printer hardware. This feature greatly
increases your production speed.

Note Job copies created by the printer are identical copies, with identical label information. The job cre-
ation time printed in the label is the point of time when the job was created in GMG ColorProof.

Drying times

The drying time before spectrophotometric measurements is very important for achieving correct meas-
urement results. Different settings are recommended for different types of measurement.

Measurement Type Drying Time

Measuring a control strip 5 min

Recalibrating (GMG CaliWizard) 5 min

Measuring a Full Gamut test chart 5 min

Measuring a Gamut test chart 15 min

Optimizing an MX4 Profile 15 min

See also:

l "Media Synchronization between Printer and Software" on page 121

Printer Drivers for Canon iPF x3x0, 64x0 Printers

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.

Note DotProof is supported only for GMG Driver.

GMG Driver using MXC calibration data

Note Please note that GMG ProfileEditor does not support MXC calibration files. It is not possible to create
custom printer calibrations for this combination of printer type and driver.
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Fig. 48 Color management process using GMG Driver and MXC printer calibration file.

Following the main color management step, an MXC printer calibration file is used to reseparate the CMYK
color data to the multicolor space of the printer with additional inks such as RGB or OG. To ensure a con-
sistent print quality and repeatability, a printer linearization file is part of this reseparation, adjusting the
input-output behavior of the additional non-CMYK inks according to a predefined printer status. Data is
optimized for the color space of the printer-medium combination and processed further by the printer
driver.

Spot colors are processed separately and are merged with the process color channels in the driver. The
printer driver then processes all color data and directly controls the printer, defining at which places each
nozzle releases ink onto the print medium.

The MXC calibration file also includes the full gamut data of the printer. Therefore, no separate full gamut
file is provided for this printer calibration type and you cannot view the full gamut in GMG GamutViewer.

Canon Driver using MX3 calibration data (No Key)

Fig. 49 Color management process using a driver from the printer manufacturer and an MX3 printer cal-
ibration file.

As with most high-quality photo printers, the driver supplied by the printer manufacturer is an RGB driver.
An RGB driver accepts only three input channels (either RGB or "virtual CMY"). Thus the MX4 profile used
in the color management step needs to separate the input data from CMYK to CMY (Separation Mode: No
Key). The driver then reseparates the three input channels to the output inks of the printer.

The driver and the MX3 printer calibration should only be used together with an appropriate MX4 that has
been created for this particular printer–medium combination and print mode. Using an MX4 that sends K
channel data to the MX3 and finally to the printer may lead to undesired print results.

As with the process colors, it is important that spot colors are also reseparated to CMY before entering the
processing chain. This reseparation step is done in the spot color profile from the spot color database (db3).
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Using Canon Calibration Link Technology with GMG ColorProof

Note It is recommended to use the GMG calibration technology for high quality proofing. As GMG cal-
ibration files cannot be shared among multiple printers, they do not support the Canon calibration link tech-
nology.

Note When using Canon Calibration Link, the printer status in GMG ColorProof will be shown as "not cal-
ibrated". All jobs will be paused and remain unprocessed in the printer queue. You will need to start each
job manually by selecting the job and clicking the Print button. Furthermore, the Load Balancing feature in
GMG ColorProof workflows will not be available, as it works only with calibrated printers.

The following describes the interplay of GMG ColorProof and Canon printers which can be calibrated via
Canon Calibration Link instead of the GMG calibration technology.

After loading the media information to GMG ColorProof, you need to set up a custom calibration set with
Canon print modes as a formal requirement of the software. The calibration set will not be used for cal-
ibrating the printer, it is just required for job processing.

The calibration target created with the Canon Media Configuration Tool will be used and recalibrated via
the Color Calibration functionality which can be started from the printer panel or from within GMG Col-
orProof. There is no direct calibration file exchange from GMG ColorProof. So you will use the Canon
Media Configuration Tool to manage the printer calibration files and load them onto a printer.

Whenever you create a proof job with the print mode specified within the calibration set, the Canon cal-
ibration file stored on the printer will be automatically used by GMG ColorProof.

The following checklist provides you with a summary showing all steps required for using the Calibration
Link technology with GMG ColorProof. Please follow the referenced topics or documents in the See also
column for detailed step-by-step instructions.

Checklist
Step Short description See also

Create a calibration file Create a calibration file with the Canon Media Configuration
Tool as described in the Canon documentation and load the file
onto all printers you want to calibrate using the Calibration Link
technology.

Canon Calibration Link Setup
Guide

Exchange media information Make sure the Canon Media Configuration Tool is installed on
the same computer as GMG ColorProof.

GMG ColorProof: Set up your printer with an TCP/IP connection
to be able to exchange the media information between printer
and software.

"Exchanging Media Information
between Printer and Software"
on page 129

Set up a custom calibration set GMG ColorProof: Set up a calibration set with a linear MX3 cal-
ibration file as Initial Calibration (default path:<GMG ColorProof
installation path>\Profiles_Linear\linear.mx3).
Use this set for all proofing jobs.

This calibration set is needed only as a required component of the
processing chain in GMG ColorProof, it will not be used for cal-
ibrating the printer.

GMG-ColorProof-5_Tutorial_
CustomMediaSupport_en.pdf

"Adding a Custom Calibration
Set" on page 165

Calibrate the printer via Color
Calibration

GMG ColorProof: Select the printer in the Output view and start
the Color Calibration in the Maintenance section.
Color Calibration prints a test chart, measures it with the integ-
rated densitometer and compares the measured values with the
calibration target.

The function can also be started manually on the printer panel.

9.4.2 Canon imagePROGRAF x300S, x400S Speed Series

The Canon imagePROGRAF speed printer series combine quality and efficiency to get print jobs done
nearly three times faster than equivalent quality printers.
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Note The Canon imagePROGRAF iPF8310S , 6410S, 8410S printers are only available in China.

Printer features

The Canon imagePROGRAF iPF6300S, iPF8300S, iPF6400S, and iPF8400S printers come with speed-
oriented print modes and print a large color space using Canon LUCIA EX inks.

The speed series can print 8 colors (8c) in total: Cyan, Light Cyan, Magenta, Light Magenta, Yellow,
Gray, Photo Black, Matte Black. Instead of additional colors (such as RGB), these printers have double
nozzles for Cyan, Light Cyan, Light Magenta and Gray.

4 picoliter ink droplets ensure the smoothest color gradations, the highest resolution and dot accur-
acy.

The prints show an excellent scratch resistance.

Create job copies by the printer: Canon imagePROGRAF iPF6300S, iPF8300S, iPF6400S, and
iPF8400S have an integrated hard disk. When creating a manual job with the Number of Copies fea-
ture (Manual Job Manager > Job > Printer Settings > Printer), job copies are created directly by the
printer hardware. This feature greatly increases your production speed.

Note Job copies created by the printer are identical copies, with identical label information. The job cre-
ation time printed in the label is the point of time when the job was created in GMG ColorProof.

The Canon imagePROGRAF iPF6400S can be optionally equipped with an integrated measuring
device from X-Rite.

Media information can be downloaded onto the printer via imagePROGRAF Media Configuration
Tool provided by Canon. For further information, please refer to the "Media Configuration Tool
Guide" from Canon.

24” and 44” models available

Drying times

The drying time before spectrophotometric measurements is very important for achieving correct meas-
urement results. Different settings are recommended for different types of measurement.

Measurement Type Drying Time

Measuring a control strip 5 min

Recalibrating (GMG CaliWizard) 5 min

Measuring a Full Gamut test chart 5 min

Measuring a Gamut test chart 15 min

Optimizing an MX4 Profile 15 min

See also:

l "Media Synchronization between Printer and Software" on page 121

Print Modes for Canon imagePROGRAF x300S, x400S

In GMG ColorProof, print modes are defined in the Calibration Set comprising information on how many
colors are supported, which ink set will be used, the resolution and printing direction. The Calibration Set
is, in turn, determined by your choice of Printer and Print Medium.

Note All available Calibration Sets are filtered according to the printer and the print medium you select.

If you select a custom print medium, you might have to create a custom Calibration Set (using a fixed print
mode). If you need more flexibility, you can also select the required print settings manually for each job
(only possible in Custom mode).

In the following table, you can find a brief description of the available Canon imagePROGRAF x300S,
x400S print modes categorized according to their quality level.
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Available Print Modes

Quality Level Resolution
Passes/Inch per
Second

Description

Normal Quality 2400 x 1200
dpi

8 p /33 ips (40 ips) Fastest print modes for good proofing quality. The iPF 8x00S prints
slightly faster (40 ips) in Normal Quality print modes than the 6x00S
(33ips) due to faster carriage speed.

Higher Quality
(Fast)

2400 x 1200
dpi

8 p/25 ips Second-fastest print modes (same speed/quality balance with both printer
models).

High Quality 2400 x 1200
dpi

16 p /33 ips Print modes for high-quality proofing tasks.

Higher Quality 2400 x 1200
dpi

16 p /25 ips Print modes for extra high quality proofs which also require the com-
paratively longest printing time.

Comparison of Printer Drivers for Canon iPF x300S, x400S Printers

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.

Note DotProof is supported only for GMG Driver.

GMG Driver using MX3 calibration data

Fig. 50 Color management process using GMG Driver and an MX3 printer calibration file.

Many inkjet printers feature more than four inks, often adding light versions of the usual CMYK such as
Light Cyan or Light Magenta. As the hues of both ink versions are very closely matched, the printer uses the
lighter versions of Cyan or Magenta when printing lighter colors and progressively moves to the darker (nor-
mal) ink when printing midtones and darker areas.

Regarding channel control in profiling, these printers are CMYK printers. Therefore, MX4 profiles and
gamut file formats based on CMYK channels are used to convert the input CMYK color space to the printer
color space. Following the color profile, a three-dimensional MX3 printer calibration profile is applied to
fine-tune the CMY channels. The K channel is linearized separately which allows for smaller test charts.

Spot colors are converted to CMYK by the corresponding spot color profile from the spot color database
(db3) and are merged with the process color channels before the color channels enter the MX3 printer cal-
ibration file.
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Canon Driver using MX3 calibration data (No Key)

Fig. 51 Color management process using a driver from the printer manufacturer and an MX3 printer cal-
ibration file.

As with most high-quality photo printers, the driver supplied by the printer manufacturer is an RGB driver.
An RGB driver accepts only three input channels (either RGB or "virtual CMY"). Thus the MX4 profile used
in the color management step needs to separate the input data from CMYK to CMY (Separation Mode: No
Key). The driver then reseparates the three input channels to the output inks of the printer.

The driver and the MX3 printer calibration should only be used together with an appropriate MX4 that has
been created for this particular printer–medium combination and print mode. Using an MX4 that sends K
channel data to the MX3 and finally to the printer may lead to undesired print results.

As with the process colors, it is important that spot colors are also reseparated to CMY before entering the
processing chain. This reseparation step is done in the spot color profile from the spot color database (db3).

9.4.3 Exchanging Media Information between Printer and Software

Canon imagePROGRAF iPFx3x0, iPFx4x0 printers can establish a bidirectional (TCP/IP) connection with
GMG ColorProof and exchange media information so that GMG print media can be downloaded to the
printer and custom media from the printer uploaded to GMG ColorProof.

The media information exchange requires the Media Configuration Tool provided by Canon. The tool is
not included in the GMG ColorProof setup and can be found on the driver CD that comes with the printer
or can be downloaded from the Support area of the Canon website: (http://www.canon.com/). For further
information, please refer to the Media Configuration Tool Guide or the software help from Canon.

As soon as the TCP/IP connection to the printer is established, the installed Media Configuration Tool auto-
matically downloads all GMG print media to the printer. Following that, any custom print media (created
with the Media Configuration Tool) are uploaded from the printer to the GMG ColorProof database. You do
not have to launch the tool for starting the transfer, this will take place fully automatically in the back-
ground.

In the Available Printers list, select the printer and check the status of the media information on the info
pane on the right side.
If the transfer was successful, the status Download onto Printer Successful is displayed.

Note Before first use of a newly added print medium, it is strongly recommended to perform a print head
alignment and paper feed adjustment.

9.5 Epson

9.5.1 Epson Stylus Pro 4900, 7900, 9900

Note If not mentioned otherwise, the Epson Stylus Pro WT7900 uses the same color management tech-
nology and supports the same features as the Epson Stylus Pro 4900, 7900, 9900 series. For further inform-
ation, see also "Comparison of Printer Drivers for Epson Stylus Pro x900 Printers" on page 137.

http://www.canon.com/
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Printer features

These high-quality printers made by Epson print a very large color space by using Epson UltraChrome
HDR Ink with additional Orange and Green inks. Due to the light gray inks, very smooth gradations
can be achieved in the highlights.

Depending on the Epson print mode, either Photo Black (PK) or Matte Black (MK) are used. [Pre-
installed print modes based on the GMG Driver state the used ink set in the print mode name.]

GMG Driver print modes for compatibility with Epson x880 series calibrations and profiles: With
these 4c and 8c print modes, you can use all GMG and custom MX3 printer calibrations and MX4
proof profiles you might have in use for printers of the Epson Stylus Pro x880 series. Available Com-
patibility Mode print modes are: GMG Driver - Photo Black - 8c - 720 x 720 dpi, GMG Driver - Matte
Black - 4c - 720 x 720 dpi

Epson Driver print modes for custom calibrations and profiles: GMG also supports custom printer cal-
ibrations based on Epson Driver print modes. You can use the GMG starter kit to easily create your
own printer calibration and proof profile for support of custom print media.

The Epson Stylus Pro 4900, 7900, 9900 can optionally be equipped with an integrated measuring
device (embedded SpectroProofer). Together with GMG AutoCali Wizard, printer calibration becomes
very easy and fully automated. GMG AutoCali Wizard supports sheet media on Epson Stylus Pro 4900
printers. Due to the small sheet size, the test chart will be divided in two. The two test charts will then
be printed and measured one after the other.

To make the transition between different measurement conditions more convenient, GMG ColorProof
has been equipped with an auto-switch for M0, M1, and M2. Reading the measurement condition
from the selected calibration set or proof standard, the correct measurement mode is automatically
applied.

Printer hardware settings

For using GMG ProofMedia, select the correct media type, for example GMG ProofPaper semimatte
250, in GMG ColorProof and select Epson Proofing Paper White Semimatte in the printer panel.

Preinstalled calibration sets support only white backing. Please make sure that you use SpectroProofer
with white backing plates.

Drying times

For printers with an embedded SpectroProofer, the drying time after printing is very important for achieving
correct measurement results. Different settings are recommended for different types of measurement. Dry-
ing settings can be changed in the Change Media dialog for each printer (> Media Specific Printer
Settings).

Measurement Type Drying Method Drying Time

Measuring a control strip Air Drying 5 min

Recalibrating (GMG AutoCali Wizard) Air Drying 5 min

Measuring a Full Gamut test chart Air Drying 5 min

Measuring a Gamut test chart Air Drying 15 min

Optimizing an MX4 Profile Air Drying 15 min

Printer maintenance

The nozzle status is checked by embedded sensors without using media. The check is performed fully
automatically, without user interaction required.
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Comparison of Printer Drivers for Epson Stylus Pro x900 Printers

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.

Note DotProof is supported only for GMG Driver.

GMG Driver using MXC calibration data

Note Please note that GMG ProfileEditor does not support MXC calibration files. It is not possible to create
custom printer calibrations for this combination of printer type and driver.

Fig. 52 Color management process using GMG Driver and MXC printer calibration file.

Following the main color management step, an MXC printer calibration file is used to reseparate the CMYK
color data to the multicolor space of the printer with additional inks such as RGB or OG. To ensure a con-
sistent print quality and repeatability, a printer linearization file is part of this reseparation, adjusting the
input-output behavior of the additional non-CMYK inks according to a predefined printer status. Data is
optimized for the color space of the printer-medium combination and processed further by the printer
driver.

Spot colors are processed separately and are merged with the process color channels in the driver. The
printer driver then processes all color data and directly controls the printer, defining at which places each
nozzle releases ink onto the print medium.

The MXC calibration file also includes the full gamut data of the printer. Therefore, no separate full gamut
file is provided for this printer calibration type and you cannot view the full gamut in GMG GamutViewer.

Epson Driver using MX4 calibration data
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Fig. 53 Color management process using a driver from the printer manufacturer and an MX4 printer cal-
ibration file.

To ensure control of the K channel, a four-dimensional MX4 printer calibration file needs to be used with
the manufacturer driver.

The MX4 printer calibration file adjusts the CMYK data according to a predefined printer status and hands it
to the printer driver. The driver then reseparates the CMYK color data to the multicolor space of the printer
with additional inks such as RGB or OG.

Spot colors are converted to CMYK by the corresponding spot color profile from the spot color database
(db3) and are merged with the process color channels before the color channels enter the MX4 printer cal-
ibration file.

Note The MX4 file format offers advanced profile parameters such as Dot Gain or Missing Dots, which can
be used in proof profiles. Profiles with advanced profile parameters cannot be used as printer calibrations.

Epson x880 Series Compatibility Mode

When using Compatibility Mode print modes for Epson Stylus Pro 4900, 7900, 9900, the color man-
agement is performed in exactly the same way as for the Epson x880 printer series.

The following print modes are supported in version 5.0 and later versions:

Print Mode ContoneProof DotProof x880 Comp.

GMG Driver – Photo Black – 10c – 720 x 1440 dpi x

GMG Driver – Matte Black – 10c – 720 x 1440 dpi x

GMG Driver – Photo Black – 8c – 720 x 720 dpi x x x

GMG Driver – Matte Black – 8c – 720 x 720 dpi x x x

GMG Driver – Matte Black – 4c – 720 x 720 dpi x x x

GMG Driver – Photo Black – 4c – 720 x 720 dpi x x x

Note When printing on uncoated media, it is recommended to use uni-directional printing.

The 10c print modes are standard print modes using all 10 inks of the ink set. They support MXC printer cal-
ibrations and MX4 proof profiles.

The 4c and 8c print modes feature a compatibility mode for printer calibrations and proof profiles for the
Epson Stylus Pro x880 series. With these print modes, you can use all preinstalled and custom MX3 printer
calibrations and MX4 proof profiles you might have in use for printers of the Epson Stylus Pro x880 series.

Note Compatibility Mode print modes do not support the wider gamut of the Epson Stylus Pro 4900, 7900,
9900 printers. Negligible color deviations might occur between printers of the Epson Stylus Pro x880 series
and 4900, 7900, 9900.

Note Compatibility Mode for DotProof is to be considered as the best possible match. For optimum color
accuracy, it is recommended to use an existing MX5 profile for an Epson Stylus Pro x880 printer as a basis
and optimize the profile with 1 or 2 iterations in GMG ProfileEditor.

Note In DotProof mode, it is strongly recommended to use uni-directional printing.

Roll Tension Adjustment

In most cases, a roll tension adjustment is not required (Roll Tension = Standard). A roll tension adjustment
is required only if you experience problems passing the tolerances of a control strip despite a successful
printer calibration. As the roll tension affects the paper feed adjustment, it should always be performed first,
followed by a validation of the paper feed adjustment (see "Manual Paper Feed Adjustment" on page 145).



9. Printer Specific Information

133 / 209

9.5.2 Epson Stylus Pro 7890, 9890

Printer features

These high-quality printers made by Epson print twice as fast as their predecessors and deliver super-
ior print quality using Epson UltraChrome K3 Ink with Vivid Magenta, a unique formulation of
Magenta pigments for extreme blues and purples.

Epson Stylus Pro 7890, 9890 can print 8 colors (8c) in total: Cyan, Light Cyan, Vivid Magenta, Vivid
Light Magenta, Yellow, Light Black, Light Light Black, Photo Black / Matte Black.

Depending on the Epson print mode, either Photo Black (PK) or Matte Black (MK) are used. [Pre-
installed print modes based on the GMG Driver state the used ink set in the print mode name.]

GMG Driver print modes for compatibility with Epson x880 series calibrations and profiles: With
these 4c and 8c print modes, you can use all GMG and custom MX3 printer calibrations and MX4
proof profiles you might have in use for printers of the Epson Stylus Pro x880 series. Available Com-
patibility Mode print modes are: GMG Driver - Photo Black - 8c - 720 x 720 dpi, GMG Driver - Matte
Black - 4c - 720 x 720 dpi

Epson Driver print modes for custom calibrations and profiles: GMG also supports custom printer cal-
ibrations based on Epson Driver print modes. You can use the GMG starter kit to easily create your
own printer calibration and proof profile for support of custom print media.

The Epson Stylus Pro 7890, 9890 can optionally be equipped with an integrated measuring device
(embedded SpectroProofer). Together with GMG AutoCali Wizard, printer calibration becomes very
easy and fully automated.

Control strips can be printed together with the proof and are automatically verified by GMG ProofCon-
trol.

Printer hardware settings

For using GMG ProofMedia, select the correct media type, for example GMG ProofPaper semimatte
250, in GMG ColorProof and select Epson Proofing Paper White Semimatte in the printer panel.

Preinstalled calibration sets support only white backing. Please make sure that you use SpectroProofer
with white backing plates.

Printer maintenance

The nozzle status is checked by a built-in sensor and does not require printing. The check is per-
formed fully automatically, without user intervention required (Output > Maintenance > Automatic
Nozzle Clean).

Comparison of Printer Drivers for Epson Stylus Pro x890 Printers

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.

Note DotProof is supported only for GMG Driver.
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GMG Driver using MX3 calibration data

Fig. 54 Color management process using GMG Driver and an MX3 printer calibration file.

Many inkjet printers feature more than four inks, often adding light versions of the usual CMYK such as
Light Cyan or Light Magenta. As the hues of both ink versions are very closely matched, the printer uses the
lighter versions of Cyan or Magenta when printing lighter colors and progressively moves to the darker (nor-
mal) ink when printing midtones and darker areas.

Regarding channel control in profiling, these printers are CMYK printers. Therefore, MX4 profiles and
gamut file formats based on CMYK channels are used to convert the input CMYK color space to the printer
color space. Following the color profile, a three-dimensional MX3 printer calibration profile is applied to
fine-tune the CMY channels. The K channel is linearized separately which allows for smaller test charts.

Spot colors are converted to CMYK by the corresponding spot color profile from the spot color database
(db3) and are merged with the process color channels before the color channels enter the MX3 printer cal-
ibration file.

Epson Driver using MX4 calibration data

Fig. 55 Color management process using a driver from the printer manufacturer and an MX4 printer cal-
ibration file.

To ensure control of the K channel, a four-dimensional MX4 printer calibration file needs to be used with
the manufacturer driver.

The MX4 printer calibration file adjusts the CMYK data according to a predefined printer status and hands it
to the printer driver. The driver then reseparates the CMYK color data to the multicolor space of the printer
with additional inks such as RGB or OG.

Spot colors are converted to CMYK by the corresponding spot color profile from the spot color database
(db3) and are merged with the process color channels before the color channels enter the MX4 printer cal-
ibration file.
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Note The MX4 file format offers advanced profile parameters such as Dot Gain or Missing Dots, which can
be used in proof profiles. Profiles with advanced profile parameters cannot be used as printer calibrations.

Available Print Modes for Epson Stylus Pro 7890, 9890

GMG ColorProof provides you with several print modes each optimized for a certain quality and through-
put.

Note Print modes for GMG Driver should be used for GMG ProofMedia. Print modes for Epson Driver
should be used for custom media.

Print Mode Colors Printing Resolution Calibration File Format DotProof

GMG Driver – 8c – Photo Black – 720 dpi CcMmYKkk 720x720 MX3 x

GMG Driver – 8c – Matte Black – 720 dpi CcMmYMBkk 720x720 MX3 x

GMG Driver – 4c – Photo Black – 720 dpi CMYK 720x720 MX3 x

GMG Driver – 4c – Matte Black – 720 dpi CMYMB 720x720 MX3 x

Epson Driver – Photo Black – 2880 x 1440 dpi CcMmYKkk 2880x1440 MX4

Epson Driver – Matte Black – 2880 x 1440 dpi CcMmYMBkk 2880x1440 MX4

Epson Driver – Photo Black – 1440 dpi CcMmYKkk 1440x1440 MX4

Epson Driver – Matte Black – 1440 dpi CcMmYMBkk 1440x1440 MX4

Epson Driver – Photo Black – 720 x 1440 dpi CcMmYKkk 720x1440 MX4

Epson Driver – Matte Black – 720 x 1440 dpi CcMmYMBkk 720x1440 MX4

Epson Driver – Photo Black – 720 dpi CcMmYKkk 720x720 MX4

Epson Driver – Matte Black – 720 dpi CcMmYMBkk 720x720 MX4

Epson Driver – Photo Black – 360 x 720 dpi CcMmYKkk 360x720 MX4

Epson Driver – Matte Black – 360 x 720 dpi CcMmYMBkk 360x720 MX4

9.5.3 Epson Stylus Pro WT7900

The Epson Stylus Pro WT7900, developed by Seiko Epson Corporation, has been designed specifically for
proofing flexographic and gravure print jobs that require the color white. The Epson UltraChrome™ HDR
White Ink is based on a breakthrough clear organic resin technology, which forces light to scatter ran-
domly, producing a very pure white with high density. Furthermore, the white ink has optimum capabilities
to mix it with colored inks to produce tinted white tones and pastels.

In comparison to alternative methods, proofing for flexography applications with the Epson Stylus Pro
WT7900 is really easy and does not require expert skills.

As the Epson Stylus Pro WT7900 is based on the same technology and inks as Epson Stylus Pro 7900,
9900, the technical capabilities of the white ink printer are comparable with Epson Stylus Pro 7900, 9900.

Note If not mentioned otherwise, the Epson Stylus Pro WT7900 uses the same color management tech-
nology and supports the same features as the Epson Stylus Pro 7900, 9900 series. For further information,
see also "Comparison of Printer Drivers for Epson Stylus Pro x900 Printers" on page 137. Note that printer
calibration files and proof profiles for use with the Epson Stylus Pro 7900, 9900 are not compatible with
Epson Stylus Pro WT7900.
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Printer features

As the Epson Stylus Pro 7900, 9900 series, this high-quality printer made by Epson prints a very large
color space by using Epson UltraChrome HDR Ink with additional Orange and Green inks. Fur-
thermore, this revolutionary inkjet printer can print water-based White ink, which is ideal for flexo
packaging business applications.

The Light Gray and Light Light Gray inks used by the Epson Stylus Pro 7900, 9900 are replaced with
White ink and cleaning liquid. The printing qualities of both printer series are comparable and are
both excellent. Due to the light gray inks, gradations in the highlights might appear a little bit
smoother when printing on the Epson Stylus Pro 7900, 9900.

Epson Stylus Pro WT7900 can print 9 colors (9c) in total: Cyan, Light Cyan, Magenta, Light Magenta,
Yellow, Photo Black, Orange, Green, White.

With the Epson Stylus Pro WT7900, it is possible to print images with a white undercoat. This is use-
ful, for example, to increase the opacity of images when printing on a transparent foil such as GMG
ProofFilm transparent 139 or Epson ClearProof™.

When printing white undercoat on transparent media, the color space is slightly smaller in the high-
lights in comparison to printing on GMG ProofMedia, because the luminance of the Epson
UltraChrome™ HDR White Ink is slightly lower than the white point of GMG ProofMedia.

When selecting the print mode Reverse Print, the print job is mirrored and the white ink is printed on
top of the other inks. This results in the impression that the image is printed "behind" the foil.

Epson Driver print modes for custom calibrations and profiles: GMG ColorProof also supports custom
printer calibrations based on Epson Driver print modes. You can use the GMG starter kit to easily cre-
ate your own printer calibration and proof profile for support of custom print media.

The Epson Stylus Pro WT7900 can optionally be equipped with an integrated measuring device
(embedded SpectroProofer). Together with GMG AutoCali Wizard, printer calibration becomes very
easy and fully automated.

Control strips can be printed together with the proof and are automatically verified by GMG ProofCon-
trol.

Special ink channels

Special inks (white, metallic, and clear inks as supported by the printer) are handled as spot colors in GMG
ColorProof (unless you are using an MX profile with white ink information which allows you to map the
image white channel to the profile white channel). You can fine-tune the behavior of the spot color chan-
nel by adjusting the Area Coverage or by using a spot color gradation (sfg) file. You can also control the
color composition by defining the tonal value and opacity of each ink, for example defining the amount of
metallic ink used in a spot color.

See also:

l "Color Channels" on page 20

l GMG-SpotColorEditor_QuickStartGuide_en.pdf
Printer hardware settings

For using GMG ProofMedia, select the correct media type, for example GMG ProofPaper semimatte
250, in GMG ColorProof and select Epson Proofing Paper White Semimatte in the printer panel.

GMG calibration sets support only white backing. Please make sure that you use SpectroProofer with
white backing plates.



9. Printer Specific Information

137 / 209

Printer maintenance

The nozzle status is checked by a built-in sensor and does not require printing. The check is per-
formed fully automatically, without user intervention required (Output > Maintenance > Automatic
Nozzle Clean).

Print heads are filled with a cleaning liquid when the printer is switched off. This is required to avoid
clogging due to the higher viscosity of the white ink.

The white ink cartridge must be shaken once a week to prevent sedimentation of the pigments. To
ensure a fail-proof production and long print head life, GMG ColorProof will automatically remind
you to agitate the white ink cartridge in regular intervals: A warning sign will be shown in the info
pane in the Output view seven days after setting up the printer in GMG ColorProof. You can click on
the warning sign to bring up a message box telling you to shake the white ink cartridge. By clicking
OK, you confirm that you have manually shaken the cartridge.

Comparison of Printer Drivers for Epson Stylus Pro x900 Printers

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.

Note DotProof is supported only for GMG Driver.

GMG Driver using MXC calibration data

Note Please note that GMG ProfileEditor does not support MXC calibration files. It is not possible to create
custom printer calibrations for this combination of printer type and driver.

Fig. 56 Color management process using GMG Driver and MXC printer calibration file.

Following the main color management step, an MXC printer calibration file is used to reseparate the CMYK
color data to the multicolor space of the printer with additional inks such as RGB or OG. To ensure a con-
sistent print quality and repeatability, a printer linearization file is part of this reseparation, adjusting the
input-output behavior of the additional non-CMYK inks according to a predefined printer status. Data is
optimized for the color space of the printer-medium combination and processed further by the printer
driver.

Spot colors are processed separately and are merged with the process color channels in the driver. The
printer driver then processes all color data and directly controls the printer, defining at which places each
nozzle releases ink onto the print medium.
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The MXC calibration file also includes the full gamut data of the printer. Therefore, no separate full gamut
file is provided for this printer calibration type and you cannot view the full gamut in GMG GamutViewer.

Epson Driver using MX4 calibration data

Fig. 57 Color management process using a driver from the printer manufacturer and an MX4 printer cal-
ibration file.

To ensure control of the K channel, a four-dimensional MX4 printer calibration file needs to be used with
the manufacturer driver.

The MX4 printer calibration file adjusts the CMYK data according to a predefined printer status and hands it
to the printer driver. The driver then reseparates the CMYK color data to the multicolor space of the printer
with additional inks such as RGB or OG.

Spot colors are converted to CMYK by the corresponding spot color profile from the spot color database
(db3) and are merged with the process color channels before the color channels enter the MX4 printer cal-
ibration file.

Note The MX4 file format offers advanced profile parameters such as Dot Gain or Missing Dots, which can
be used in proof profiles. Profiles with advanced profile parameters cannot be used as printer calibrations.

Epson Stylus Pro WT7900 Print Modes

With the print mode Reverse Print, you can mirror the print job reversing the order of the print sequence of
all color channels. This results in the impression that the image is printed "behind" the foil. This behavior
depends on the print mode used, which is defined in the calibration set. Colors appear highly vivid and
clear. The gamut is larger. The print is highly resistant to scratches.

In the Manual Job Manager, the calibration set is selected under Job > Printer Settings > Printer > Cal-
ibration Set.

In the Workflow dialog box, the calibration set is selected under Print Settings > Printer > Calibration Set.
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9.5.4 Epson SC-P6000, 8000 and SC-P5000, 7000, 9000 Printers

Printer features

These high-quality printers made by Epson print a very large color space by using next generation
Epson Ultrachrome inks with new chemical composition for higher durability and improved black
density.

The Epson SC-6000, 8000 and SC-P5000, 7000, 9000 models are the direct successors of the Epson
Stylus Pro x890 and x900 series. GMG ColorProof supports the Epson SC-P5000, 7000, 9000 with
violet and LLK ink setup. Due to the new ink configuration, profiles and spot color sets created for
Stylus Pro x900 printers need to be converted for use on SC-P printers.

The printers can optionally be equipped with an integrated measuring device (ILS 30, no support for
ILS 20). The mounter and measurement unit of the Spectroproofer ILS 30 is interchangeable between
old and new printer series.

To make the transition between different measurement conditions more convenient, GMG ColorProof
has been equipped with an auto-switch for M0, M1, and M2. Reading the measurement condition
from the selected calibration set or proof standard, the correct measurement mode is automatically
applied.

To create printer calibrations and proof profiles for 3rd party media, you can download Starter Kits
from our website (Support > Download Area).

Recommended drying times

For printers with an embedded SpectroProofer, the drying time after printing is very important for achieving
correct measurement results. Different settings are recommended for different types of measurement. Dry-
ing settings can be changed in the Change Media dialog for each printer (> Media Specific Printer
Settings).

Measurement Type Drying Method Drying Time

Measuring a control strip Air Drying 5 min

Recalibrating (GMG AutoCali Wizard) Air Drying 5 min

Measuring a Full Gamut test chart Air Drying 5 min

Measuring a Gamut test chart Air Drying 15 min

Optimizing an MX4 Profile Air Drying 15 min

Printer maintenance

The nozzle status is checked by embedded sensors without using media. The check is performed fully
automatically, without user interaction required.

Comparison of Printer Drivers for Epson SC-P5000,7000,9000 Printers

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.

Note DotProof is supported only for GMG Driver.

GMG Driver using MXC calibration data

Note Please note that GMG ProfileEditor does not support MXC calibration files. It is not possible to create
custom printer calibrations for this combination of printer type and driver.
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Fig. 58 Color management process using GMG Driver and MXC printer calibration file.

Following the main color management step, an MXC printer calibration file is used to reseparate the CMYK
color data to the multicolor space of the printer with additional inks such as RGB or OG. To ensure a con-
sistent print quality and repeatability, a printer linearization file is part of this reseparation, adjusting the
input-output behavior of the additional non-CMYK inks according to a predefined printer status. Data is
optimized for the color space of the printer-medium combination and processed further by the printer
driver.

Spot colors are processed separately and are merged with the process color channels in the driver. The
printer driver then processes all color data and directly controls the printer, defining at which places each
nozzle releases ink onto the print medium.

The MXC calibration file also includes the full gamut data of the printer. Therefore, no separate full gamut
file is provided for this printer calibration type and you cannot view the full gamut in GMG GamutViewer.

Epson Driver using MX4 calibration data

Fig. 59 Color management process using a driver from the printer manufacturer and an MX4 printer cal-
ibration file.

To ensure control of the K channel, a four-dimensional MX4 printer calibration file needs to be used with
the manufacturer driver.

The MX4 printer calibration file adjusts the CMYK data according to a predefined printer status and hands it
to the printer driver. The driver then reseparates the CMYK color data to the multicolor space of the printer
with additional inks such as RGB or OG.

Spot colors are converted to CMYK by the corresponding spot color profile from the spot color database
(db3) and are merged with the process color channels before the color channels enter the MX4 printer cal-
ibration file.
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Note The MX4 file format offers advanced profile parameters such as Dot Gain or Missing Dots, which can
be used in proof profiles. Profiles with advanced profile parameters cannot be used as printer calibrations.

Comparison of Printer Drivers for Epson SC-P 6000,8000 Printers

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.

Note DotProof is supported only for GMG Driver.

GMG Driver using MX3 calibration data

Fig. 60 Color management process using GMG Driver and an MX3 printer calibration file.

Many inkjet printers feature more than four inks, often adding light versions of the usual CMYK such as
Light Cyan or Light Magenta. As the hues of both ink versions are very closely matched, the printer uses the
lighter versions of Cyan or Magenta when printing lighter colors and progressively moves to the darker (nor-
mal) ink when printing midtones and darker areas.

Regarding channel control in profiling, these printers are CMYK printers. Therefore, MX4 profiles and
gamut file formats based on CMYK channels are used to convert the input CMYK color space to the printer
color space. Following the color profile, a three-dimensional MX3 printer calibration profile is applied to
fine-tune the CMY channels. The K channel is linearized separately which allows for smaller test charts.

Spot colors are converted to CMYK by the corresponding spot color profile from the spot color database
(db3) and are merged with the process color channels before the color channels enter the MX3 printer cal-
ibration file.
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Epson Driver using MX4 calibration data

Fig. 61 Color management process using a driver from the printer manufacturer and an MX4 printer cal-
ibration file.

To ensure control of the K channel, a four-dimensional MX4 printer calibration file needs to be used with
the manufacturer driver.

The MX4 printer calibration file adjusts the CMYK data according to a predefined printer status and hands it
to the printer driver. The driver then reseparates the CMYK color data to the multicolor space of the printer
with additional inks such as RGB or OG.

Spot colors are converted to CMYK by the corresponding spot color profile from the spot color database
(db3) and are merged with the process color channels before the color channels enter the MX4 printer cal-
ibration file.

Note The MX4 file format offers advanced profile parameters such as Dot Gain or Missing Dots, which can
be used in proof profiles. Profiles with advanced profile parameters cannot be used as printer calibrations.

Connecting Your Epson SC-P Printer via SNMP

GMG ColorProof supports the latest version of Simple Network Management Protocol (SNMP) version 3 to
connect your printer. This version offers enhanced data security. Authentication is used to ensure that only
authenticated applications can connect to the printer. The SNMP data will be encrypted so that it cannot be
read by unauthorized users. This ensures the security of your data and the data of your clients, especially if
a printer is connected via the internet.

If the connection settings of your hardware printer have been set to SNMPv3, all applications connecting to
your printer such as GMG ColorProof will need to provide the correct authentication, i. e. user name and
password stored on the printer to be able to connect. Otherwise, the printer will refuse the connection.

For more information how to enable SNMPv3 on your printer, please refer to the documentation of the
printer manufacturer.

Note If you cannot establish a printer connection, check if SNMPv3 has been enabled on the hardware
printer and if so, check the authentication settings in GMG ColorProof.

How to enter the authentication

1. On the Output tabbed page, under Printers, click the Configure Printer button next to your Epson SC-
P printer.

2. On the General Settings tabbed page, expand the Connection group and fill in the User Name,
Authentication, and Encryption settings matching the settings of your hardware printer.

3. Confirm with OK.

GMG ColorProof will establish a connection to the printer.
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Roll Tension Adjustment

In most cases, a roll tension adjustment is not required (Roll Tension = Standard). A roll tension adjustment
is required only if you experience problems passing the tolerances of a control strip despite a successful
printer calibration. As the roll tension affects the paper feed adjustment, it should always be performed first,
followed by a validation of the paper feed adjustment (see "Manual Paper Feed Adjustment" on page 145).

9.5.5 Epson SC-P10000, 20000

Printer features

The Epson SC-P10000, 20000 models are the successors of the Epson Stylus Pro 11880. These 44"/64"
printers are primarily designed for photo printing and proofing.

The high-quality models print a very large color space by using next generation Epson Ultrachrome
inks with high-density Photo and Matte Black inks.

The printers run on Epson Driver print modes for which GMG also supports custom printer cal-
ibrations.

GMG ColorProof provides an MX4 calibration set for GMG ProofMedia premium semiMatte 250.

Available proof standards are Adobe RGB, sRGB, ECIRGBv2 and ISO Coated v2 (39L).

Only ContoneProof mode is supported.

Recommended drying times

For printers with an embedded SpectroProofer, the drying time after printing is very important for achieving
correct measurement results. Different settings are recommended for different types of measurement. Dry-
ing settings can be changed in the Change Media dialog for each printer (> Media Specific Printer
Settings).

Measurement Type Drying Method Drying Time

Measuring a control strip Air Drying 5 min

Recalibrating (GMG AutoCali Wizard) Air Drying 5 min

Measuring a Full Gamut test chart Air Drying 5 min

Measuring a Gamut test chart Air Drying 15 min

Optimizing an MX4 Profile Air Drying 15 min

Printer maintenance

The nozzle status is checked by embedded sensors without using media. The check is performed fully
automatically, without user interaction required.

9.5.6 Paper Feed Adjustment

A paper feed adjustment helps with inaccurate feeding of certain media types. It is mandatory to perform a
paper feed adjustment when setting up a new printer and for each new media type you want to use.

If you experience problems to calibrate a printer or to pass the tolerances of a control strip despite a suc-
cessful printer calibration, we also recommend to check the paper feed.
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Fig. 62 Paper Feed Adjustment value (Change Media dialog box).

Please use the Automatic Paper Feed Adjustment if your printer can be used with this feature. You can
find a list of supported printers and further information under the following link: "Automated Paper Feed
Adjustment" on page 144

If your printer is not one of the supported models, please perform a manual paper feed adjustment. You can
find further information under the following link: "Manual Paper Feed Adjustment" on page 145

Automated Paper Feed Adjustment

The automatic paper feed adjustment can only be used with GMG media and is available for the following
printers:

l Epson Stylus Pro 4900

l Epson Stylus Pro 7900

l Epson Stylus Pro 9900

l Epson SureColor SC-P5000

l Epson SureColor SC-P7000

l Epson SureColor SC-P9000

For the automatic measurement, you need an Epson SpectroProofer with the internal measurement unit
ILS30.

During the automated paper feed adjustment, a small test pattern is printed and measured a few times by
the integrated measuring device. The paper feed is adjusted accordingly in GMG ColorProof. This feature
helps to ensure a fail-safe calibration process and an optimal print quality. It is highly recommended to per-
form this procedure if you experience any print quality or calibration issues.
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How to start a automated paper feed adjustment

You just need to start the procedure. The GMG Paper Feed Adjustment wizard will perform the adjustment
automatically in iteration cycles until an optimal value is found.

1. Click the Output button on the navigation panel on the left of the main window.

2. Under Printers > Available Printers, click the Start Paper Feed Adjustment button on the right side of
the printer name.
The GMG Paper Feed Adjustment wizard is started. The GMG Paper Feed Adjustment Strip V1 will
be printed and measured automatically until an optimal value is found. This value will be saved as the
Paper Feed Adjustment value under Media Specific Printer Settings. The wizard will close auto-
matically.

3. To see the result, you can click the Change Media button on the right side of the printer name.

Fig. 63 GMG Paper Feed Adjustment.

In the screenshot, you see the result of the completed process. The wizard has run seven iteration cycles
shown in the graph on the right side. The lower the column in the graph, the better is the adjustment. The
paper feed behavior adjustment with each cycle until 0.4. 0.5 was not as good as 0.4, so the value will be
set to 0.4.

Manual Paper Feed Adjustment

Please only perform a manual paper feed adjustment if your printer cannot be used with the Automated
Paper Feed Adjustment feature. The automated paper feed adjustment is easier to perform and ensures
optimal adjustment. You can find a list of supported printers and further information under "Automated
Paper Feed Adjustment" on page 144.

To perform a manual paper feed adjustment, please proceed as follows.

1. Print and measure the linked test image with a ruler.
If the Paper Feed Adjustment is adjusted correctly, the result should be exactly 280.00 mm.

2. Adjust the Paper Feed Adjustment value as described in the test image.

https://sdla.webservice.gmgcolor.com/Printer Utilities/Epson SureColor P paper feed adjustment/GMG_Epson_Print_Quality_Check_V1.pdf
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9.6 HP

9.6.1 HP Designjet Z3200 Photo

Proofing to industry standards is extremely simple with the HP Designjet Z3200 due to the integrated meas-
uring device tightly meshing with the automatic calibration, monitoring and recalibration functionality in
GMG ColorProof.

Printer features

This high-quality printer prints a very large color space by adding additional Red, Green, and Blue
inks.

HP Designjet Z3200 Photo printers can print 10 colors (10c) in total: Light Cyan, Magenta, Light
Magenta, Yellow, Light Gray, Gray, Photo Black / Matte Black, Red, Green, Blue, (Gloss Enhancer).
Depending on the selected media type, either Photo Black (PK) or Matte Black (MK) is used. Some
print modes also use Gloss Enhancer (E). [Preinstalled print modes based on the GMG Driver state the
used ink set in the print mode name.]

The integrated measuring device allows for convenient and fully automated working procedures,
ensuring that each proof turns out 100% color-accurate.

Control strips can be printed together with the proof and are automatically verified by GMG ProofCon-
trol.

Available Color Management Sets

GMG ColorProof supports the profiles of all common industry standards such as ISO, GRAcOL, SWOP,
3DAP and offers color management sets for various HP, GMG and other print media.

If you want to use a different print medium, you first need to add the print medium in the Database view
(Database > Media). You can then proceed to the next step and create a calibration set and a proof stand-
ard for the new printer-medium combination.

All these steps are explained step for step in our printer-specific Starter Kits which are available in the Sup-
port Area of our website.

Note Custom media should be thoroughly tested before use to ensure optimum quality.

See also:

l GMG-ColorProof-5_Tutorial_StarterKit_HPZ3200_HP-Driver_en.pdf
Drying times

The drying time before spectrophotometric measurements is very important for achieving correct meas-
urement results. Different settings are recommended for different types of measurement.

Measurement Type Drying Time

Measuring a control strip 5 min

Recalibrating (GMG AutoCali Wizard) 5 min

Measuring a Full Gamut test chart 15 min

Measuring a Gamut test chart 15 min

Optimizing an MX4 Profile 5 min
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Comparison of Printer Drivers for HP Designjet Z3200 Photo Printers

If you want to use custom media and create your own printer calibrations, you can in some cases also use
the printer driver of the printer manufacturer as an alternative to GMG Driver. GMG Driver and man-
ufacturer drivers may require different calibration file formats and processing steps. For example, multicolor
printers with additional inks may require an MXC calibration file format. MXC calibrations are not sup-
ported in GMG ProfileEditor so that you need to create a calibration with the driver of the printer man-
ufacturer instead.

Note DotProof is supported only for GMG Driver.

GMG Driver using MXC calibration data

Note Please note that GMG ProfileEditor does not support MXC calibration files. It is not possible to create
custom printer calibrations for this combination of printer type and driver.

Fig. 64 Color management process using GMG Driver and MXC printer calibration file.

Following the main color management step, an MXC printer calibration file is used to reseparate the CMYK
color data to the multicolor space of the printer with additional inks such as RGB or OG. To ensure a con-
sistent print quality and repeatability, a printer linearization file is part of this reseparation, adjusting the
input-output behavior of the additional non-CMYK inks according to a predefined printer status. Data is
optimized for the color space of the printer-medium combination and processed further by the printer
driver.

Spot colors are processed separately and are merged with the process color channels in the driver. The
printer driver then processes all color data and directly controls the printer, defining at which places each
nozzle releases ink onto the print medium.

The MXC calibration file also includes the full gamut data of the printer. Therefore, no separate full gamut
file is provided for this printer calibration type and you cannot view the full gamut in GMG GamutViewer.

HP Driver using MX3 calibration data in No Key Mode



GMG ColorProof User Manual

148 / 209

Fig. 65 Color management process using a driver from the printer manufacturer and an MX3 printer cal-
ibration file.

As with most high-quality photo printers, the driver supplied by the printer manufacturer is an RGB driver.
An RGB driver accepts only three input channels (either RGB or "virtual CMY"). Thus the MX4 profile used
in the color management step needs to separate the input data from CMYK to CMY (Separation Mode: No
Key). The driver then reseparates the three input channels to the output inks of the printer.

The driver and the MX3 printer calibration should only be used together with an appropriate MX4 that has
been created for this particular printer–medium combination and print mode. Using an MX4 that sends K
channel data to the MX3 and finally to the printer may lead to undesired print results.

As with the process colors, it is important that spot colors are also reseparated to CMY before entering the
processing chain. This reseparation step is done in the spot color profile from the spot color database (db3).

9.6.2 HP Designjet Z5200 PostScript Printer

The HP Designjet Z5200 is a very easy-to-use large format printer which has been designed for small copy
shops and burgeoning print providers who are interested in bringing large format printing into their busi-
ness.

Printing to industry standards is extremely simple with the HP Designjet Z5200 due to the integrated meas-
uring device tightly meshing with the automatic calibration, monitoring and recalibration functionality in
GMG ColorProof.

Printer features

The HP Designjet Z5200 can print 8 colors (8c) in total: Cyan, Magenta, Yellow, Light Cyan, Light
Magenta, Light Gray, Photo Black / Matte Black. Depending on the selected media type, either Photo
Black (PK) or Matte Black (MK) is used.

The integrated measuring device allows for convenient and fully automated working procedures,
ensuring that each proof turns out 100% color-accurate.

Control strips can be printed together with the proof and are automatically verified by GMG ProofCon-
trol.

Available Color Management Sets

GMG ColorProof supports the profiles of all common industry standards such as ISO, GRAcOL, SWOP,
3DAP and offers color management sets for various HP, GMG and other print media.

If you want to use a different print medium, you first need to add the print medium in the Database view
(Database > Media). You can then proceed to the next step and create a calibration set and a proof stand-
ard for the new printer-medium combination.

All these steps are explained step for step in our printer-specific Starter Kits which are available in the Sup-
port Area of our website.

Note Custom media should be thoroughly tested before use to ensure optimum quality.

See also:

l GMG-ColorProof-5_Tutorial_StarterKit_HPZ5200_en.pdf
Drying times

The drying time before spectrophotometric measurements is very important for achieving correct meas-
urement results. Different settings are recommended for different types of measurement.

Measurement Type Drying Time

Measuring a control strip 5 min

Recalibrating (GMG AutoCali Wizard) 5 min

Measuring a Full Gamut test chart 15 min
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Measurement Type Drying Time

Measuring a Gamut test chart 15 min

Optimizing an MX4 Profile 5 min

9.6.3 HP Designjet Z6200 Photo

The HP Designjet Z6200 photo printer has been especially designed for photo print shops, design com-
panies, advertising agencies and commercial printing, delivering high-quality photo prints with an excep-
tional grayscale and color accuracy.

Proofing to industry standards is extremely simple with the HP Designjet Z6200 due to the integrated meas-
uring device tightly meshing with the automatic calibration, monitoring and recalibration functionality in
GMG ColorProof.

Printer features

This high-quality printer prints a very wide color space by adding chromatic red and two black tones
for smooth shading transitions.

HP Designjet Z6200 Photo printer can print 8 colors (8c) in total: Light Cyan, Magenta, Light
Magenta, Yellow, Light Gray, Photo Black / Matte Black and Chromatic Red. Depending on the selec-
ted media type, either Photo Black (PK) or Matte Black (MK) is used.

The integrated measuring device allows for convenient and fully automated working procedures,
ensuring that each proof turns out 100% color-accurate.

Control strips can be printed together with the proof and are automatically verified by GMG ProofCon-
trol.

Available Color Management Sets

GMG ColorProof supports the profiles of all common industry standards such as ISO, GRAcOL, SWOP,
3DAP and offers color management sets for various HP, GMG and other print media.

If you want to use a different print medium, you first need to add the print medium in the Database view
(Database > Media). You can then proceed to the next step and create a calibration set and a proof stand-
ard for the new printer-medium combination.

All these steps are explained step for step in our printer-specific Starter Kits which are available in the Sup-
port Area of our website.

Note Custom media should be thoroughly tested before use to ensure optimum quality.

See also:

l GMG-ColorProof-5_Tutorial_StarterKit_HPZ6200_HP-Driver_en.pdf
Drying times

The drying time before spectrophotometric measurements is very important for achieving correct meas-
urement results. Different settings are recommended for different types of measurement.

Measurement Type Drying Time

Measuring a control strip 5 min

Recalibrating (GMG AutoCali Wizard) 5 min

Measuring a Full Gamut test chart 15 min

Measuring a Gamut test chart 15 min

Optimizing an MX4 Profile 5 min
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9.7 Roland

9.7.1 Roland VersaUV LEC 330/540, LEJ 640

GMG's key concepts—standardization and repeatability—and the versatility of the Roland printer allow for
highly individual digital mockups. While the color management in GMG ColorProof ensures accurate pro-
cess and spot color reproduction, the printer is kept in tight tolerances by the calibration and recalibration
capabilities of the software.

Printer features

The VersaUV LEC series developed by Roland, features powerful print and cut UV inkjets designed for
high quality package prototyping and short-run production with the ability to print on a vast range of
media.

With the VersaUV LEJ-640 Roland introduces a UV inkjet flatbed with the ability to print on both roll
media and rigid substrates up to 13mm (0.51”) thick and a media width up to 64”.

Printing CMYK, Opaque White and Clear inks in both gloss and matte, at resolutions up to 1440 dpi
with six high-precision print heads, the VersaUV allows for unmatched versatility and remarkably rich
special effects ranging from high gloss finishes to custom-textured three-dimensional effects—you can
choose any combination of matte and gloss and layer them for interesting patterns - even Braille.

Featuring the new environmentally friendly Roland ECO-UV inks, the VersaUV produces brilliant
graphics that can be flexed and stretched across both curved surfaces and sharp edges without feath-
ering or cracking.

Roland Intelligent Pass Control technology enables smooth gradations and flawless solid colors.

Safe, low heat UV LED lamps allow printing on heat-sensitive and pressure sensitive media such as
shrink foils without any risk of damage. The LED curing technology can be turned on and off instantly
for on-demand operation, requiring no warm up time.

Special ink channels

Special inks (white, metallic, and clear inks as supported by the printer) are handled as spot colors in GMG
ColorProof (unless you are using an MX profile with white ink information which allows you to map the
image white channel to the profile white channel). You can fine-tune the behavior of the spot color chan-
nel by adjusting the Area Coverage or by using a spot color gradation (sfg) file. You can also control the
color composition by defining the tonal value and opacity of each ink, for example defining the amount of
metallic ink used in a spot color.

See also:

l "Color Channels" on page 20

l GMG-SpotColorEditor_QuickStartGuide_en.pdf
Contour cutting

With the integrated cutting technology, these printers offer a one-step operation which is also supported in
GMG ColorProof. This way, you can create mockups already cut into shape.

See also:

l "Cutting Contours" on page 45
Available Proof Standards and Calibration Sets

GMG proof standards and calibration sets for VersaUV printers are available for the following print media:

GPPG Photo Paper Gloss

UV Clear Polyester

If you want to use a different print medium, you first need to add the print medium in the Database view
(Database > Media). You can then proceed to the next step and create a calibration set and a proof stand-
ard for the new printer-medium combination.
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All these steps are explained step for step in our printer-specific Starter Kits which are available in the Sup-
port Area of our website.

See also:

l GMG-ColorProof-5_Tutorial_StarterKit_Roland-LEC-LEJ_en.pdf
Printer hardware settings

To achieve maximum print quality, we recommend that a Roland technician adjusts the print head
position by 0.6 mm (from 2.2 mm low/3.2 mm high to 1.6 mm low/2.6 mm high).

The VersaUV LEC series is available with three different ink configurations: CMYK+White+Gloss ,
CMYK+Gloss+Gloss, CMYK+White+White.

Printer maintenance

Due to the Intelligent Ink Circulation System, the white and clear inks are circulated every eight
hours to keep the tube system in the printer clean. The white ink cartridge, however, still needs to be
shaken prior to use each day to achieve homogeneous print results.

Tip For more information on producing mockups with GMG ColorProof, please see our printer specific
Best Practices.

9.7.2 Roland VersaCAMM VS/VSi Series

The VersaCAMM VS/VSi printer series, developed by Roland, enters the printing market with powerful print
and cut inkjet printers designed for high quality package mockups and short-run production. With the cap-
ability to print CMYK, Light Cyan, Light Magenta, White and Metallic ink, at resolutions up to 1440 dpi,
these printers allow for unmatched versatility and remarkably rich special effects, offering a whole new
metallic color palette.

Ready-to-use color managements sets

GMG provides ready-to-use proof standards and calibration sets for VersaCAMM VS printers for the fol-
lowing print media:

Coated vinyl white self-adhesive foil: Roland SCM-GVWG

Transparent PET film: Solvent Clear Film

Coated Paper: TriSolv Paper 3684

Custom color management sets

If you want to use a different print medium, you first need to add the print medium in the Database view
(Database > Media). You can then proceed to the next step and create a calibration set and a proof stand-
ard for the new printer-medium combination.

All these steps are explained step for step in our printer-specific Starter Kits which are available in the Sup-
port Area of our website.

Note Custom media should be thoroughly tested before use to ensure optimum quality. Though solvent ink
printers can technically print to uncoated media, it is recommended to use specially treated media to
enhance color and quality.

See also:

l GMG-ColorProof-5_StarterKit_Roland VersaCAMM_en.pdf
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Special ink channels

Special inks (white, metallic, and clear inks as supported by the printer) are handled as spot colors in GMG
ColorProof (unless you are using an MX profile with white ink information which allows you to map the
image white channel to the profile white channel). You can fine-tune the behavior of the spot color chan-
nel by adjusting the Area Coverage or by using a spot color gradation (sfg) file. You can also control the
color composition by defining the tonal value and opacity of each ink, for example defining the amount of
metallic ink used in a spot color.

See also:

l "Color Channels" on page 20

l GMG-SpotColorEditor_QuickStartGuide_en.pdf
Contour cutting

With the integrated cutting technology, these printers offer a one-step operation which is also supported in
GMG ColorProof. This way, you can create mockups already cut into shape.

See also:

l "Cutting Contours" on page 45
Printer maintenance

Due to the Intelligent Ink Circulation System, the white and metallic ink are circulated every eight hours to
keep the tube system in the printer clean. The cartridges, however, still need to be shaken prior to use or
when prompted by the printer to achieve homogeneous print results.

Tip For more information on producing mockups with GMG ColorProof, please see our printer specific
Best Practices.

9.8 Mimaki

9.8.1 Mimaki UJF-706

Note To access the printer via USB, you need to install the latest printer driver provided by the printer man-
ufacturer on the same computer you installed GMG ColorProof on. The printer driver can be downloaded
from the website of the manufacturer.

Note A Windows print spooler is not supported by the Mimaki UJF-706.

Printer features

The Mimaki UJF-706 is a UV curing flatbed printer with a large print area (70 x 60 cm) designed for
prototyping, proofing and personalized short-run production with the ability to print on flexible and
rigid media up to 15 cm thickness such as metal, tin, glass, styrene, shrink foil, PET or OPP.

Printing CMYKLcLm (with Light Cyan and Light Magenta), White and Clear ink, at resolutions up to
1200 dpi, the UJF-706 allows for superb detail, vibrant colors and rich special effects with gloss fin-
ishes. Due to a sophisticated print head arrangement, white and full color inks can be printed sim-
ultaneously without slowing down the printing speed. All inks can be applied in multiple layers
enabling three-dimensional printing.

Equipped with a Spray Suppressor System, which prevents satellite ink drops, the UJF-706 ensures
higher print reliability and quality.

The UV lamp allows printing on heat-sensitive and pressure sensitive media such as shrink foils
without any risk of damage.

Sheet by sheet or optional roll-to-roll functionality

Of the two available UV inks for hard and for flexible print applications, GMG ColorProof only sup-
ports the hard ink type, as it reflects a wider gamut and can be used with clear ink (which is not the
case with the flexible ink).
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Special ink channels

Special inks (white, metallic, and clear inks as supported by the printer) are handled as spot colors in GMG
ColorProof (unless you are using an MX profile with white ink information which allows you to map the
image white channel to the profile white channel). You can fine-tune the behavior of the spot color chan-
nel by adjusting the Area Coverage or by using a spot color gradation (sfg) file. You can also control the
color composition by defining the tonal value and opacity of each ink, for example defining the amount of
metallic ink used in a spot color.

See also:

l "Color Channels" on page 20

l GMG-SpotColorEditor_QuickStartGuide_en.pdf
Available Proof Standards and Calibration Sets

GMG proof standards and calibration sets for UJF-706 printers are available for the following print media:

Luminor 25 S10 Clear Foil (with curing intensity set to 50%)

If you want to use a different print medium, you need to add the print medium in the Database view (Data-
base > Media) and assign the printer to the medium. You can then proceed to the next step and create a cal-
ibration set and a proof standard for the new printer-medium combination. All these steps are explained in
detail in our printer-specific Starter Kits.

See also:

l GMG-ColorProof-5_Tutorial_StarterKit_Mimaki UJF-706_en.pdf
Media Handling

The Mimaki UJF-706 offers an optional roll unit to support roll media. Roll media is, however, used just
like sheet media, with a fixed size (maximum and default size = 70 x 60 cm). To feed the roll media, you
can enable an automatic feed after each job (Job > Printer Settings > Advanced > Paper Feed after
Printing). You can furthermore specify a Spacing between Jobs in millimeters, so that the print medium is
advanced by the job length plus the defined spacing before the print head returns to the starting point and
prints the next job.

Tip For more information on producing mockups with GMG ColorProof, please see our printer specific
Best Practices.
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10. Database—Managing Color Managements Items
In the Database view, you set up your working space.

Fig. 66 Database view with one installed printer.

Your working space can be individually arranged by adding printer, media, calibration set and proof stand-
ard combinations (= Proofing Conditions, 1). In the example screenshot, you can see three Proofing Condi-
tions representing the color space of an Epson Stylus Pro x900 printing on GMG ProofPaper semimatte 250
with a GMG 10c print mode, to simulate three target printing conditions (GRACol 2006, ISO Coated v2
and Japan Color 2011).
You can add Proofing Conditions by clicking the Add link (2) in each column. Spot Color Sets and Control
Strips can be added on separately tabbed pages (3).
Click the arrow button on the column headers (4) to quickly filter the data in the column lists.
The info pane (5) provides more information on an item that is currently selected in a list, for example, the
proof profiles linked within a proof standard.

All color profiles, printer calibration files, and spot color profiles used in GMG color management sets are
linked with each other in the database. When setting up a manual job or workflow, all required profiles are
automatically extracted from the database when printing the job. The file administration of application
data is thus completely automated and offers the unmatched advantage of a fail-proof color management:
All important parameters and profiles such as the proof standard and printer calibration are validated before
printing a job. It is not possible to create a job with a color profile not compatible to the printer or medium.

Note GMG color management sets are read-only and can be edited only after duplication. Files linked to
those color management sets such as printer calibration files, proof profiles, spot color databases and ICC
profiles should not be edited by the user. Modifications might lead to unwanted results. Modified files
might be overwritten by the installer without notice when updating the software.

10.1 Database Toolbar and Menu
The Database toolbar and menu provide various useful functions to manage your color management data.
The Database submenus are described in separate topics.

Tip Main program features are accessible by different methods, so that users can choose which way is most
convenient to them. This documentation generally refers only to the toolbar or menu, even though there
may be alternative methods.
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Click a button on the toolbar. Move the mouse over a button (without clicking) to display a tooltip.

Click a command on a menu.

Right-click on an item and click a command on the context menu.

Press a shortcut key. Shortcut key combinations are listed next to the corresponding command on the
menu.

Double-click an item (for example, a job or a workflow) to open the corresponding dialog box and
edit settings.

Toolbar commands

Icon Command Shortcut Description

Collapse All Collapses all items in the tree (if they are not yet collapsed).

Expand All Expands all items in the tree (if they are not yet expanded).

Import CTRL+I Imports a previously exported item into GMG ColorProof.

Export CTRL+E Exports the selected item with all settings into a file with the extension
caliset/standard/spot/media/strip. All color profiles /spot color databases linked to the
item are exported as well.

Delete / Delete
Unused Items

DEL Deletes the selected / unused items. Custom items are permanently deleted, GMG
items can be recovered any time (Database > Add).

Properties CTRL+O Opens selected item. GMG color management sets are read-only and can be edited
only after duplication.

Download From Folder: Starts the Download Wizard for detecting differences between two
folders containing color management files (files with the extension
caliset/standard/spot). New and changed color management files are listed and can be
downloaded from the specified source folder.

From GMG OpenColor: With a GMG OpenColor connection license, you can access
a defined OpenColor Server and download project files that automatically generate
new OpenColor proof standards.

The file comparison and download can also be scheduled (System > General > Cen-
tralized Color Management Settings: Automatic Download).

Change Media
Names

If you are using the new GMG ProofMedia, you can correspondingly change the media
names.
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10.2 Interplay of Color Management Items

Fig. 67 Color management items and how they are linked.

When setting up your printer in GMG ColorProof, you see all media and media sizes supported for this
printer. Each printer–medium combination, for example, Epson Stylus Pro 4880 and GMG ProofPaper semi-
matte 250, (1) is grouped into Print Settings within a calibration set (2). A calibration set contains all files
and information required to calibrate a set of printer and media types, for all supported measuring devices.
In other words, each calibration sets contains multiple printer calibrations, one for each measuring device.

As you can see, the calibration set (2) plays a central role in the database and links the different kinds of
files that hold the information for color management. When printing a job, your specific selection of a
printer, medium, and print mode points to the required calibration set.

In the same way, a spot color set (5) is also linked to a calibration set in the database. Proof standards (3)
contain the proof profiles for a given printer–medium combination (MX4 for ContoneProof,MX5 for
DotProof,MXN for OpenColor, ICC for ICC based color management and soft-proofing). Proof standards are
linked to the calibration sets in the database (4).

Each calibration set is generally linked to multiple proof standards, for example, ISO Uncoated Yellowish
(30L)and ISO Coated v2 (39L). This reflects the fact that you need to calibrate a printer–medium con-
figuration only once for proofing all kind of different print standards. There is a separate Proof Standard
item for each printer–medium combination in the list in the Database view. If you open a proof standard
item in the list, you see a list of all calibration sets that are supported by this proof standard.

See also:

l "Media" on page 157

l "Proof Standards" on page 166

l "Calibration Sets" on page 161

l "Spot Color Sets" on page 173
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10.3 Media
GMG ColorProof comes with predefined GMG ProofMedia for all commonly used proof printers. These
media cannot be edited. You can duplicate GMG ProofMedia and use them as a template for custom
media, though. For using a custom medium, you need to create a printer calibration file in GMG Pro-
fileEditor and to add a calibration set for this printer calibration. You also need a color profile for the cus-
tom medium.

For each media type, for example, GMG ProofMedia premium semiMatte 250, you can define available
media sizes. You cannot assign a specific media size to a specific printer, you can only set up media sizes
globally for all printers. When closing the dialog box, GMG ColorProof validates the media sizes for the
selected printers. Only sizes that are supported by the selected printer are displayed in the Media list and
can be selected for a job.

You can set up or remove custom media sizes. Standard media sizes such as roll 13'' or A4 cannot be
deleted.

Automated Media Management

Some printers such as HP Z and Canon imagePROGRAF iPFx3x0, iPFx4x0 support an automated media
management.

HP Z: The GMG ColorProof database holds all HP Z printer media that are currently available on the mar-
ket. You can also set up custom media in GMG ColorProof. Synchronization works in two directions, from
GMG ColorProof to the printer and vice versa.

Canon imagePROGRAF: For enabling the synchronization, it is required that imagePROGRAF Media Con-
figuration Tool provided by Canon is installed on the computer. (The tool is not included in the GMG Col-
orProof setup. For further information, please (see "Exchanging Media Information between Printer and
Software" on page 129).)

Already existing and new custom printer media are downloaded automatically via TCP/IP from the GMG
ColorProof program onto the printer.

If a print medium cannot be loaded from the program to the printer, it is listed in the Info pane, on the right
side of the main window, also informing you on the reasons why the download failed (for example, no par-
ent paper has been defined for a certain print medium as illustrated in the following screenshot).

Only HP Z: Printer media information is also uploaded from the printer into the GMG ColorProof database.
The information, which print modes are supported by which printer medium is also uploaded. This way,
you have always a broad range of media available for your printers. However, We recommend using GMG
ProofMedia for best proofing results. Please note that GMG ColorProof supports only the most important
print modes for these printers that will either result in an excellent quality (for proofing or production) or in
a fast print speed. By selecting the appropriate print mode, print quality and speed are up to your pref-
erences or requirements.

10.3.1 Media Menu

The Media list in the Database view shows all print media that have been set up for use. You can add pre-
defined GMG proof media and custom media. Custom media can be set up from scratch, or by duplicating
GMG media.

Tip Main program features are accessible by different methods, so that users can choose which way is most
convenient to them. This documentation generally refers only to the toolbar or menu, even though there
may be alternative methods.
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Click a button on the toolbar. Move the mouse over a button (without clicking) to display a tooltip.

Click a command on a menu.

Right-click on an item and click a command on the context menu.

Press a shortcut key. Shortcut key combinations are listed next to the corresponding command on the
menu.

Double-click an item (for example, a job or a workflow) to open the corresponding dialog box and
edit settings.

Menu commands

Icon Workflow command Shortcut Meaning

New CTRL+N Adds a new print medium to the database.

Duplicate CTRL+D Duplicates the selected print medium.

All settings except the name of the medium are maintained. The Parent
Paper information is also copied from the duplicated medium. You can
duplicate GMG media and then customize the duplicate.

Import CTRL+I Imports print media (*.media) into GMG ColorProof.

Export CTRL+E Exports the selected print medium with all settings.

Properties CTRL+O Opens the selected print medium. (Please note that GMG media are
read-only.)

Delete DEL Permanently deletes the selected print medium..

Advanced You can define advanced media settings such as media thickness and
Paper Feed Adjustment here. For some print media, you need to define
a Parent Paper.

Size You can define supported media sizes for each media type here. The set-
tings refer to all printer–medium combinations of the same media type.
Supported media sizes are also automatically validated for each printer
type.

10.3.2 Advanced Media Settings

The Advanced Media Settings are default settings for printer–medium combinations. When changing the
medium in the software, the new defaults are automatically extracted from the database.

Tip When creating a new medium, it is recommended to duplicate an existing printer–medium com-
bination with a comparable media type and use this as a template.

Available options Printer Type Description See also

Parent Paper HP Z, Canon
imagePROGRAF
iPFx3x0,
iPFx4x0,Canon
imagePROGRAF
iPF6300S, iPF8300S,
iPF6400S, and
iPF8400S, Roland Ver-
saUV LEC-330,
Mimaki UJF 706.

You need to define a Parent Paper for each new medium.
New media for the named printers without a Parent Paper
will not be available for setting up a calibration set, proof
standard, or printer.
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Available options Printer Type Description See also

Drying time per
Print Head Pass

Epson The drying time per pass is the time the printer carriage
remains (after one pass is printed) at one side of the printer
before the printing of the next pass begins. In other words the
printer waits the specified time until it prints the next line.
This ensures that the print medium is completely dry and
avoids ink running from one line to another. The ideal drying
time depends on the print medium and ink set. Generally, a
drying time per pass may range between about zero and two
seconds. GMG ColorProof provides default drying times for
each supported printer–medium combination. If you are exper-
iencing problems with ink pooling, you can increase the dry-
ing time between print head passes.

Drying time per
Page

Epson 7600, 9600,
4000, x450, x800,
x880

After printing a job, the printer waits the specified drying time
until the printed job is fed out of the printer (or cut from the
roll) and the next job is started. This ensures that the print
medium is completely dry and avoids ink smudging from one
page to another. The ideal drying time depends on the print
medium and ink set. GMG ColorProof provides default drying
times for each supported printer–medium combination.

Drying time
before meas-
urement

For printers that have an integrated measuring device, the dry-
ing time is also very important for the calibration results, as
the measurement results can differ significantly if the ink is not
completely dry. On the other hand, convenience does not
always allow waiting until the ideal point of time. Therefore,
the drying time might be a compromise between quality and
speed.

Media Thickness Epson Thickness/caliper of the print medium in mm. Use the Media
Thickness as specified by the manufacturer of the print
medium. As a rule of thumb, you can also use the grammage
of the medium in micrometers (µm), rounded up to 1/10 of a
mm or [Grammage / 1000] mm for standard weight media.
For example, GMG ProofPaper semimatte 250 has a caliper of
about 250 µm = 0.3 mm.

10.3.3 Custom Media Support

Note Use of custom media is supported only by GMG ColorProof 5 Standard Version or higher licenses.
GMG ProfileEditor is included only in GMG ColorProof 5 Pro Version or higher licenses.

GMG ColorProof offers predefined proofing conditions comprising color management sets for all GMG
ProofMedia. If you want to use your own custom print media, you need to create corresponding color pro-
files with GMG ProfileEditor and (in case of spot colors) GMG SpotColor Editor.

Tip Further information on how to proof with custom media can be found in the tutorial GMG-ColorProof-
5_Tutorial_CustomMediaSupport_en.pdf.

The following table lists all printers and printer drivers supporting custom media in ContoneProof mode.

Note DotProof can only be supported with GMG Driver.

Printer series Driver DotProof

Canon iPF Canon Driver

Canon iPFs Canon Driver

Canon iPFs GMG Driver x

Epson 40-76-96 GMG Driver x

Epson x400 GMG Driver x

Epson x450 GMG Driver x

Epson x800 GMG Driver x
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Printer series Driver DotProof

Epson x880 GMG Driver x

Epson x890 Epson Driver

Epson x890 GMG Driver x

Epson 11880 GMG Driver x

Epson x900 Epson Driver

Epson SC-P7000, 9000 Epson Driver

Epson SC-P6000, 8000 GMG Driver x

Epson WT7900 Epson Driver

HP 5000 GMG Driver x

HP 5500 GMG Driver x

HP Z3200 HP Driver

HP Z6200 HP Driver

Roland VersaUV LEC-330, 540 GMG Driver x

Roland VersaUV LEJ-640 GMG Driver x

Roland VersaCAMM VS-300, 420, 540, 640 GMG Driver x

Mimaki UJF 706 GMG Driver x

10.3.4 Adding a Custom Medium

Duplicate an existing media type and use this as a template.

Fig. 68 Adding a custom print medium to the GMG ColorProof database.

You can set up custom media types under any name (1). You can then define available media sizes as a
global property of this media type, for all printers (2). You can also define new custom media sizes (3) or
delete sizes (for all printers).

The media type (with all sizes) needs to be assigned to printer types (4). In our example, the print medium
is assigned to all available printer types.

Select Show All Printers (5) to update the list with all printers supported in GMG ColorProof.
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How to add custom media

1. On the navigation panel on the left of the main program window, click Database.

2. On the Proofing Conditions tab, right-click an existing media type in the list and select Duplicate.
—OR—
Create a new media type from scratch by clicking Database menu > Media > New .

3. Enter a Media Name.

4. In the Available Media Sizes list, select the media sizes that you want to support with this print
medium.

5. In the Available Printers list, select all printers you want to use with this medium.

6. Click OK to confirm the settings.
The new media type is added to the database. In the next step, you need to define the Advanced
Media Settings.

How to define the Advanced Media Settings

In the Database view, right-click the new print medium in the Media list and select Advanced from
the context menu.
Define parameters such as the media thickness. If you are unsure, keep the default settings and
change the settings only if you experience any problems. For all printers using a Parent Paper
parameter, select a Parent Paper from the drop-down list.

See also:

l "Advanced Media Settings" on page 158

l "Media Synchronization between Printer and Software" on page 121

10.4 Calibration Sets
A calibration set contains all files and information required to calibrate a set of printer and media types, for
all supported measuring devices. Due to different printing technologies, there are different calibration file
formats (MX3, MXC, or MX4).

Each time a printer is calibrated, the corresponding MX printer calibration file is updated in the database. If
no valid calibration file is available, the printer shifts into status Not Calibrated and all jobs are put on hold
until the printer is calibrated again.

For a reliable and good print quality, a printer should be calibrated in regular intervals. Each calibration set
contains Quality Criteria to validate and determine the calibration status.

Calibration Set settings

Page Description See also

Properties General data such as the name and the version number. The Printer ICC Profile
has been included for an optional ICC based color management, defining the con-
version from the intermediate Lab color space to the printer color space.

Print Settings List with all printer-medium and print mode combinations covered by the cal-
ibration set. Select an item in the list to show the details on the right side of the
page. Each printer type within a calibration set has been assigned with a Reference
Print Mode. After calibrating the reference mode, it is possible to switch the print
medium or print mode without having to calibrate the new combination. Changing
the Reference Print Mode will not change the calibration set ID, so that you can
conveniently use the same calibration set with different print settings on different
computers.
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Page Description See also

Measurement The Measurement tabbed page of a calibration set lists all printer calibration files
for all supported measuring devices.
The Initial Calibration file serves as a starting point of a calibration containing aver-
aged output values to reduce the number of iterations otherwise required. After cal-
ibrating the printer for the first time, the link to the initial calibration file is broken
and an updated system copy is used for all following calibrations. You can restore
the link to the initial calibration file by resetting a calibration.
The gamut and full gamut file play a key role in the process of calibrating a printer.
The full gamut file is saved within the calibration file and thus not visibly linked in
the calibration set. The gamut is linked to the calibration set in the GMG Col-
orProof database and represents the color space of the printer-medium com-
bination.

"Printer Calibration"
on page 106

"Resetting a Printer
Calibration" on page
107

Quality Criteria The Calibration Tolerances in each calibration set have been defined with care to
ensure predictable and accurate colors. All criteria can, however, be changed or
deactivated. With the Reset button, you can reset your changes again to GMG
default values.
Maximum Age is the time span after which a recalibration is required, set to ensure
a regular recalibration process for premium proof quality.
Delta E is the distance between output and target color. The higher Delta E, the
stronger is the deviation from the target color.
Delta L refers to the luminescence, that is, to the Black (K) channel. The higher
Delta L, the stronger is the deviation of the luminescence from the target color.

"Quality Criteria" on
page 163

"GMG ProofControl
Inline Settings" on
page 184

"GMG AutoCali Wiz-
ard Settings" on page
115

10.4.1 Print Settings

Instead of calibrating each print mode, print medium and printer type separately, you can unite similar
printer-medium and print mode combinations (which share a similar gamut) and assign Reference Print Set-
tings which are used in the calibration procedure for printing and measuring calibration test charts. After
calibrating the printer with the selected reference settings, the linked printer calibration file is updated and
valid for all print settings: if the Reference Print Settings are in status "calibrated", all other print settings are
calibrated, too.

Example: a successful calibration for the color mode W|CMYK will at the same time validate the cal-
ibration for the color mode CMYK Only (provided both print modes are linked to the same calibration file).
This will reduce the time and effort to calibrate by hours.

The functionality is available for GMG calibration sets as well as for custom calibration sets. You can indi-
vidually configure which media and print modes shall use the same calibration file.

Note By using different media types within a custom calibration set, you may not achieve the proof quality
required by a print standard. If you want to proof according to a standard, it is recommended only to group
media types with close to identical properties.

Advantages of using multiple print settings

Easier configuration and update of customized application data

The same calibration file can be used for a whole printer series (e.g. Epson x900) instead of just one
printer type

Printers with special inks such as white or metallic ink can use the same calibration file for multiple
color modes

Possibility to use several media types within a calibration set, for example media with similar prop-
erties

Simplified remote proofing: mapping of imported and exported application data much easier due to
shared components
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Multiple Print Settings example:

The following screenshot shows a typical example of the grouping concept: all printer types of a certain
series are listed with a media type and a subset of Print Settings (1). Each group has been assigned with
Reference Print Settings (2) which are used when calibrating the corresponding printer type. If you select a
Print Setting, all associated parameters are listed on the info pane (3) on the right side, showing exactly
which settings have been defined.
In the present case, Print Settings for calibrating CMYK for bidirectional printing have been defined as
Reference Print Settings. After calibrating these Reference Print Settings, all other Print Settings are also in
status "calibrated" without affecting the proof quality. The increase in flexibility without loss of quality is
due to the fact that the Print Settings defined in GMG calibration sets only differ in terms of printing dir-
ection, resolution and color mode (as the special inks of this printer type, e.g. metallic ink, do not need to
be calibrated, they are completely covered by the reference settings) and not in terms of color-relevant cri-
teria.

Fig. 69 Example for multiple Print Settings within a calibration set.

10.4.2 Quality Criteria

The interval when a recalibration is scheduled and the tolerances for meeting the target values are defined
in the calibration set.

The defined Calibration Tolerances need to be reached for a successful printer calibration. Use higher val-
ues if you want to speed up the calibration process (less steps) on the cost of color accuracy.

Customizing quality criteria

Note The GMG Standard Proof Logo is only printed to the label if factory-default sets with unmodified qual-
ity criteria were used or if custom quality criteria were defined in the calibration set that are stricter. When
lowering the quality criteria, the GMG Standard Proof Logo will not be printed in the label.

Note Changing the quality criteria of a calibration set will turn the status of the same to "not calibrated", dis-
playing the date of the last calibration. This status change is intentional and accords to our concept of pro-
duction security.

You can customize the quality criteria in factory-default calibration sets (or switch them off completely for
a given calibration set) on the Quality Criteria page in the Calibration Set dialog box. For example, if your
printer shows an exceptionally stable printing behavior, you can increase the Maximum Age of a cal-
ibration set or do not use this criterion at all. This helps to save valuable time and resources. On the other
hand, you can also use stricter quality criteria to reflect the very high quality standards in your facility.

By clicking the Reset button, you can reset the Quality Criteria to defaults (overwriting your customized set-
tings).
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Calibration sets with modified quality criteria can be easily identified by the tag GMG customized in the
Calibrations Sets list. Unmodified (factory-default) calibration sets are denoted as GMG; custom calibration
sets (created by the user) are denoted as Custom, as shown in the following screenshot.

Alternatively, you can also keep the quality criteria defaults in the calibration sets, and change the quality
criteria when calibrating the printer in the GMG CaliWizard dialog box. When using GMG AutoCali Wiz-
ard for printers with integrated measuring device, you can change the quality criteria in the Output view >
Printers > Automatic Calibration.

See also:

l "Quality Criteria for White Ink Printers" on page 164

l "Customizing Quality Criteria for GMG AutoCali Wizard" on page 118

10.4.3 Quality Criteria for White Ink Printers

As for CMY Color and Black, there are additional Calibration Tolerances referring to the white ink channel,
available for white ink printers. Per default, they are deselected, because for most applications, a cal-
ibration control of the white ink is not required.

Note Depending on the ink technology, printing with white ink can take a relatively long drying time
(approximately 30 minutes for each test chart).

Coating for calibration

Printer calibrations for white ink printers are valid for prints with and without coating. However, if most of
your prints are generated with a white undercoat, it is strongly recommended to print a white undercoat
when calibrating the printer.

To do so, select the option Add Coating Channel and enter the Intensity you will mainly use when printing
jobs later. When calibrating a printer, the coating is always printed in Full Frame mode. (You can change
both settings on a job-to-job basis later, independent of the settings for calibration.)

See also:

l "Printing an Undercoat" on page 44

10.4.4 Modifying a Calibration Set

GMG ColorProof provides you with ready-to-use calibration sets for GMG and other proof media. Except
for the quality criteria, GMG sets are read-only and cannot be modified. If you duplicate a GMG set, it
automatically has the same properties as the original except that it is not read only anymore and can be
modified in any way you like.

Modifying a duplicated calibration set

When modifying a duplicated set, you also need to consider the following:

Link the new calibration set to all proof standards linked to the original calibration set.

Calibrate the printer with the new calibration set.

Select the new calibration set for the Automatic Calibration Scheduler.

Select the new calibration set for all workflows using the original calibration set.

Remember to use the new calibration set when creating manual jobs.

Modifying a custom calibration set (already calibrated)

Custom calibration sets (which are not read-only) can be directly modified, without making a duplicate. If
the calibration set is already in use by a printer (you already calibrated the printer with the set), you need to
reset the calibration set for your modifications to become effective. The reason for this is that GMG Col-
orProof uses a system copy of the Initial Calibration file right after the first printer calibration which is used
for all following printer calibrations. The link to the calibration set is broken after the first calibration and
can only be reestablished by using the Reset functionality. Thus, your modifications will be ignored until
you reset the calibration set.



10. Database—Managing Color Managements Items

165 / 209

For all printers using the calibration set, reset the calibration set in the Output view > Available
Printer Calibrations list.

Calibrate all printers using the calibration set.

See also:

l "Resetting a Printer Calibration" on page 107

10.4.5 Adding a Custom Calibration Set

Note GMG color management sets are read-only and can be edited only after duplication. Files linked to
those color management sets such as printer calibration files, proof profiles, spot color databases and ICC
profiles should not be edited by the user. Modifications might lead to unwanted results. Modified files
might be overwritten by the installer without notice when updating the software.

Before you can set up a calibration set, you need to create a printer calibration for your printer-medium
and print mode combination. For more information on custom printer calibrations, please see our printer-
specific Starter Kit tutorials available on our website (Support Area > Downloads > Printer Utilities
>Starter Kits).

You need to set up one calibration set for each printer-medium combination and hardware parameter (such
as the ink set) that directly affects the colors you are going to use. You can create a new calibration set by
duplicating and modifying an existing calibration set or create a calibration set from scratch. In this chapter,
you will learn how to create a new calibration set from scratch.

How to add a custom calibration set

1. On the Database menu, point to Calibration Sets, and click New.
The New Calibration Set dialog is displayed.

2. On the Properties page, enter a Name for the calibration set.

3. Enter a version number.
The version number serves as a unique identifier if you have several versions of the same set. It is
advisable to use a naming convention, for example, V1, V2, V3, and so on, but you can enter any
string you like.

4. Optional: Select an ICC Printer Profile if you want to use an ICC based color management.
How to define the Print Settings

1. Click the Print Settings page.

2. On the toolbar, click the + button to add new print settings.

3. Select the Printer you want to use from the drop-down list on the right side.
The printer type is displayed in the tree view on the left side.

4. In the tree view on the left, click the next node (< undefined >) to bring up the Medium drop-down
list and select the print medium you want to use.
The default Print Settings for the printer-medium combination are displayed as end node.

5. In the tree view, click the Print Settings (print mode) node to show the properties of the printer-
medium combination on the right side.

6. Adjust the default properties (e.g. the print mode) as required.

7. Optional: Add as many Print Settings as you like and choose a Reference Print Mode for calibration.
Due to this functionality, you can use the same printer calibration file for multiple color modes or
media with similar properties.
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How to add printer calibration files to the calibration set

1. Click the Measurement page.

2. Click the + button to add a measuring device and the corresponding printer calibration and gamut
file.

3. Select the measuring device that you will use for this printer from the list.

4. In the Initial Calibration column, click the browse button, browse your folders, and select the printer
calibration file.

5. In the Gamut column, click the browse button, browse your folders, and select the corresponding
gamut (CSC) file. (Do not select the full gamut file.)

6. To set up more measuring devices, repeat steps 2 to 5.
How to set up quality criteria for the printer calibration

1. Click the Quality Criteria page.

2. Select the quality criteria for this calibration set. If the quality criteria are not met anymore, print jobs
using this calibration set will be put on hold until the printer is successfully recalibrated.

3. If you are calibrating a color mode with White for printing a white undercoat, activate the option Add
Coating Channel.
When calibrating a printer, the coating is always printed in Full Frame mode.

See also:

l "Calibration Sets" on page 161

l "Modifying a Calibration Set" on page 164

10.5 Proof Standards
The introduction of standardized characterization data opened the possibility to offer optimized DeviceLink
profiles for diverse printer-medium combinations. These profiles are the core of our proof standards which
hold all information required for the color management of certain printer–medium combinations, each com-
plying with a specific print standard, for example, ISO Offset 39L.

GMG ColorProof provides you with all world-wide accepted standards and a wide range of printer-medium
combinations. In case your combination is not supported, you can easily set up your own standards with
custom MX DeviceLink profiles (created in GMG ProfileEditor and GMG OpenColor), or, alternatively, use
ICC profiles.

All proof standards are protected via a checksum: If a profile used in a proof standard has been altered,
jobs based on this proof standard will not be printed anymore and you will be informed by a job error mes-
sage.

Tip With a GMG OpenColor licence, you can also set up GMG OpenColor proof standards to dynamically
calculate n-channel profiles on the fly (see "OpenColor Proof Standards" on page 168).

Color Management settings
Group Short description See also

MX Based (Default) DeviceLink profiles for ContoneProof (MX4) and DotProof (MX5) are used
for the color management. Soft-proofing is based on the Output Intent ICC profile. If
no Output Intent ICC profile is defined in the proof standard, soft-proofing will be
based on the MX profile.

"Printing Halftone
Proofs with
DotProof" on page
15

ICC Based ICC profiles are used for the color management (only ContoneProof mode available).
The Output Intent ICC profile from the proof standard defines the input color space
and the Printer ICC profile from the calibration set defines the output color space.
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Group Short description See also

MXN/MXD Based OpenColor profiles are used for the color management. In OpenColor proof stand-
ards, the profile cannot be manually selected, but is automatically retrieved from the
OpenColor database, or calculated "on demand".

To manually select a specific OpenColor profile, we added this function in a regular
proof standard to use ContoneProof (MXN) and DotProof (MXD) profiles for the
color management.

"OpenColor Proof
Standards" on page
168

Linked calibration sets

The Calibration Sets page shows all calibration sets linked to the proof standard. Together with the proof
standard, a calibration set ensures a consistent representation of colors, counterbalancing deviations caused
by varying environment conditions.

Select a calibration set in the list to display all relevant information such as the Print Settings on the info
pane on the right. You can link or remove calibration sets by using the buttons on the toolbar.

Tip You can also link custom calibration sets to GMG proof standards without the need to duplicate the
standards first. Please note that the GMG Standard Proof Logo will not be printed within a job or image
label when you are using a custom calibration set.

GMG ProofControl Inline print standards

GMG proof standards are already preconfigured with all GMG ProofControl print standards, ready-to-use
for a proof verification with GMG ProofControl Inline . If you want to use custom GMG ProofControl print
standards, you can easily generate them directly within a proof standard as described in topic "Adding a
Custom GMG ProofControl Standard" on page 171.

See also:

l "Proof Verification" on page 187

10.5.1 Checksum Protection of Profiles

All proof standards are protected via a checksum: A checksum is created from the linked color profile in
the moment a new proof standard is created and added to the database or if an existing proof standard is
changed and saved in the Database view.

Jobs using this proof standard are printed only if the profile is still exactly the same. This is verified by the
software which is comparing the current checksum of the linked profile with the checksum provided in the
database. If the checksum is not matching, the profile has been changed. In such a case, the job will not be
printed and the user will be informed by a job error message. This prevents that a profile is changed by acci-
dent and jobs are printed with the wrong profile.

If you changed a profile deliberately, you need to open the proof standard referencing the changed profile
in the Database view. Select the changed profile type on the Color Management tab and confirm by click-
ing OK. The profile checksum is then updated in the database and the proof standard is ready-to-use again.
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Fig. 70 MX profile checksums in GMG proof standards.

10.5.2 OpenColor Proof Standards

With GMG OpenColor, you can easily calculate multichannel profiles, for example, based on 5, 6, or 7
process colors instead of just CMYK. The software uses a new proofing technology that precisely predicts
the color appearance of printed inks, particularly spot color overprints.

GMG ColorProof can connect to GMG OpenColor and request a profile for a specific proofing condition.
The connection to GMG OpenColor is defined in each OpenColor proof standard.

OpenColor proof standards can be created manually, like normal proof standards, or automatically, by
scheduling a download of new OpenColor projects.

Note OpenColor proof standards support only GMG ProofMedia. You can reference only calibration sets
that use GMG media types. OpenColor proof standards do not support custom media types.

Tip For more information on multicolor proofing, please see the separate documentation available for
GMG OpenColor.



10. Database—Managing Color Managements Items

169 / 209

How to automatically create an OpenColor proof standard

1. In GMG OpenColor, create a new project.

2. In GMG ColorProof, System view > General > Centralized Color Management Settings: OpenColor
Server Address: Enter the IP address of the computer GMG OpenColor is running on.

3. Optional: OpenColor Keyword Filter: Enter keywords as a filter to download only projects that
include the defined keywords.

4. Activate the option Automatic Download and schedule the update.

5. Activate the option Automatic Installation.
Any new or changed projects are downloaded, automatically generating a matching OpenColor proof
standard.

How to manually create an OpenColor proof standard

1. On the Database menu, point to Proof Standards, and click New.
The New OpenColor Proof Standard dialog is displayed.

2. Properties: Enter a name for the proof standard.

3. Enter a Version number.
The version number serves as a unique identifier if you have several versions of the same proof stand-
ard. It is recommended to use a naming convention, for example, V1, V2, V3.

4. Database Connection: Enter the IP Address of the computer GMG OpenColor is running on.
(Please note that the connection requires the Web Service defined in the Preferences of GMG
OpenColor.)

5. Printing Process: Select a Project from the drop-down list.
(The Project list contains all projects that have been published.)

6. Optional: Available Printing Inks: Check to ensure all inks you need are listed and available for pro-
filing.

7. Calibration Sets: On the toolbar, click the + button to link a calibration set to the proof standard.
It is recommended to use the Custom Filter to show Calibration Sets for Installed Printers Only and
select the recommended calibration set for the printer-medium combination you are using.

8. Click OK to confirm your choice.

Recommended calibration sets for use with OpenColor profiles

It is strongly recommended to use a calibration set that corresponds to the respective Proofing Condition in
GMG OpenColor. Using a calibration set with fewer colors or less resolution would be contrary to the
proof quality GMG OpenColor is capable of achieving.
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Epson Stylus Pro x900: GMGDriver - 10c – Photo Black – 720 x 1440 dpi – Unidir – V1 GMG

Epson Stylus Pro WT7900: GMG Driver – 6c + OG – Reverse Print – 720 x 1440 dpi - Unidir - V1
GMG

HP Designjet Zx200: GMG: Driver - 10c – PhotoBlack – 1200 dpi – 14 Pass – Bidir – V1 GMG

Canon imagePROGRAF iPF x3x0, x4x0: GMGDriver - 11c – 2400 x 1200 dpi – Bidir – Higher Quality
(Fast) – Canon LUCIA EX Ink – V1 GMG

10.5.3 Adding a Custom Proof Standard

Note GMG color management sets are read-only and can be edited only after duplication. Files linked to
those color management sets such as printer calibration files, proof profiles, spot color databases and ICC
profiles should not be edited by the user. Modifications might lead to unwanted results. Modified files
might be overwritten by the installer without notice when updating the software.

You can add a custom proof standard by duplicating and modifying an existing proof standard or create a
new proof standard from scratch. In this chapter, you will learn how to create a proof standard from
scratch.

Before you can set up a custom proof standard, you need to create a printer calibration and calibration set
for your printer-medium combination (see "Adding a Custom Calibration Set" on page 165).

How to add a custom proof standard

1. On the Database menu, point to Proof Standards, and click New.
The New Proof Standard dialog is displayed.

2. On the Properties page, select a print standard from the Name drop-down list, for example, ISO
Coated v2 (39L), or enter a custom name.

3. Enter a Version number.
The version number serves as a unique identifier if you have several versions of the same proof stand-
ard. It is advisable to use a naming convention, for example, V1, V2, V3, and so on, but you can enter
any string you like.

4. On the Color Management page, select the color management mode you would like to use for this
standard.
(MX based color management is recommended for highest-quality prints.)

5. For MX based color management, select an MX4 proof profile for ContoneProof or PhotoProof.

6. Optional: For DotProof mode, select an MX5 proof profile.
(DotProof is supported only by MX based color management.)

7. Select an ICC Output Intent profile for soft-proofing.

8. Optional: For an ICC based color management, select an ICC Output Intent profile to define the input
color space and the rendering intent.
The output color space is defined by the ICC Printer profile from the calibration set.

9. On the Calibration Sets page, click the + button on the toolbar to link a calibration set to the proof
standard.
(A proof standard can also be linked to multiple calibration sets. Use the Custom Filter to show only
calibration sets for your printer and/or calibration sets that share the same printer and media type.)

10. Click OK to confirm your choice.
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10.5.4 Adding a Custom GMG ProofControl Standard

The GMG ProofControl Print Standard XML files linked to a proof standard on the Proof Verification
tabbed page provide the target values and the tolerances for a verification by printing a control strip
together with the proof job. This control strip will be measured either automatically by the measuring
device integrated into the printer (requires a GMG ProofControl Inline license) or manually in GMG
ProofControl. GMG ColorProof and GMG ProofControl will automatically compare the measured colors
with the target values as defined in the proof standard and show the results to you. If the differences
between measured values and target values are within the tolerances, the proof is ok. You can use official
target values and tolerances provided by organizations such as FOGRA or you can easily create and use
your own criteria.

Note Make sure that the Filter and Backing settings of the GMG ProofControl print standard match the
measurement condition when measuring the control strip. Otherwise, proof verification will not be pos-
sible.

How to link an existing GMG ProofControl print standard to a proof standard

You can use this option if you want to use an already existing GMG ProofControl print standard XML.

Tip To support different measuring conditions, for example, different control strips or measuring devices
with and without UV cut filter, you can link multiple print standards to the same proof standard. You can
then flexibly select one of the defined control strips in the proof job.

1. On the Proof Verification page, click the Add button on the toolbar to add a new empty slot for a
print standard XML to the Target Values table.

2. In the Target Values table, ProofControl Standard column, click the browse button and select the cor-
responding XML file.

3. Optional: In the Target Values > Filter column, select the filter settings used when measuring the con-
trol strip. This information will be read out from the print standard if available.

4. Optional: In the Target Values > Backing column, select the backing method used when measuring
the control strip. This information will be read out from the print standard if available.

5. To set up more measuring conditions, repeat steps 1 to 5.

Tip You can also easily generate custom GMG ProofControl standards for verification from the selected MX
profile. For more information on this, please see chapter "Adding a Custom GMG ProofControl Standard"
on page 171.

How to create a new custom GMG ProofControl print standard

GMG Products offer you three methods:

In GMG ColorProof, you can automatically generate custom GMG ProofControl standards from the
color profile linked within the proof standard.

If you are using the GMG ProofControl Inline option in GMG ColorProof, you can also automatically
generate a custom GMG ProofControl standard from previous control strip measurements (jobs in the
History).

With the separate application GMG ProofControl, you can create new or modify existing GMG
ProofControl print standard XML files. Please follow the link for more information: Creating a Custom
Print Standard

How to generate a custom GMG ProofControl standard from the profile in GMG ColorProof (Generate
from Proof Standard)

GMG ColorProof uses the Default Control Strip and calculates target values for each patch from the color
space of the profile.

../../../../../Content/GMG_Text/ProofControl/UseCases/PC_DefineStandard_HowTo.htm
../../../../../Content/GMG_Text/ProofControl/UseCases/PC_DefineStandard_HowTo.htm
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Note Make sure that the profile includes all color channels that are used in the control strip. For example, if
the selected control strip uses CMYK, the profile also needs to include CMYK channels.

1. Make sure a Default Control Strip is selected.

2. Optional: In the Target Values > Filter column, select the same measurement condition that was used
for profile creation.

3. Proof Standard > Proof Verification: Click the Generate from Proof Standard button and select the
profile you want to use the Lab target values from.
(The options in the menu relate to the profiles linked on the Color Management tabbed page of the
proof standard.)

4. Add as many GMG ProofControl standards as required.
The generated GMG ProofControl standard is automatically added to the Target Values list. The XML
file is saved to the following default path: <installation path>\ProofControlAddOnData\Standards.

When creating a job using this proof standard and the control strip you selected as default control strip, the
generated GMG ProofControl standard will be used for verification.

How to generate a custom GMG ProofControl standard from previous measurements

GMG ColorProof uses the Default Control Strip and calculates target values for each patch from previously
measured control strips. To do so, you will need at least one job in the History that used the same control
strip and was measured with an integrated measuring device, regardless whether the proof verification of
this job failed or not. For example, you could generate a first version of the GMG ProofControl standard
XML from a proof profile, which might lead to a failed verification. This is usually the case when the Cur-
rent Values of the profile have been edited manually. Then you can generate a new version of the GMG
ProofControl standard XML from the measured job. As the new target values are derived from the actual
measurement values of the control strip in the job, the target values will fit perfectly to your printing con-
dition, and you can expect a passed verification when printing under the same condition.

1. Make sure a Default Control Strip is selected.

2. Proof Standard > Proof Verification: Click the Generate from Measured Jobs button and select the
control strip measurements from jobs in the History you want to use.
GMG ColorProof calculates target values for each patch from the measurement data. Multiple meas-
urement values will be averaged. The generated GMG ProofControl standard is automatically added
to the Target Values list. The XML file is saved to the following default path: <installation
path>\ProofControlAddOnData\Standards.

When creating a job using this proof standard and the control strip you selected as default control strip, the
generated GMG ProofControl standard will be used for verification.

See also:

l "Using Control Strips" on page 188

10.5.5 Updating Proof Profiles in GMG ProfileEditor

With the proof profile conversion feature in GMG ProfileEditor, you can update existing proof profiles for
use with new printers or new media.

How to convert Proof Profiles

1. Start GMG ProfileEditor .

2. On the File menu, click Open and select the proof profile you want to convert.

3. On the Tools menu, click Convert Profile. The Convert Profile dialog box is displayed.

4. Select the printer and medium combination you want to convert the profile to and confirm with OK.

5. The profile is updated according to the new printer and medium combination.

6. On the File menu, click Save as and save the profile under a new file name.
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10.6 Spot Color Sets

Note You can set up your own spot color sets and spot color profiles in the separate program GMG SpotCo-
lor Editor. For more information on spot color profiles, gradation corrections or calibrated spot colors,
please see the separate documentation available for GMG SpotColor Editor.

A spot color set contains all information required for the color management of spot colors for a certain set
of printer and media types. Each spot color set in GMG ColorProof is linked to a spot color database
(*.db3). GMG ColorProof provides you with spot color databases for widely used spot colors, for example,
from Pantone, DIC, or HKS.

Example: The spot color set PANTONE® GOE coated - Ex880 GMGsemimatte250 includes all spot colors
of the PANTONE® GOE coated set for Epson Stylus Pro x880 printers and GMG ProofMedia premium
semiMatte 250.

As spot colors extend the limited gamut of the printing machine and the print result is considered to be
independent of the printing condition, the print standard is not relevant for spot colors and thus not linked
within a set. Each spot color set is, however, linked to at least one calibration set.

See also:

l "Adding a Custom Spot Color Set" on page 175

l "Spot Colors" on page 21

10.6.1 Printing Spot Colors with a Gradation Correction

For most spot color applications, it is only required to print the spot color as full-tone (100%) color. You
can, however, create spot color gradations (*.sfg) in GMG SpotColor Editor which can be applied to a spot
color in two ways, as described in the following.

Link the sfg file to one or multiple spot colors in the db3 spot color database (using GMG SpotColor
Editor). For more information on how to do this, please see the separate documentation available for
GMG SpotColor Editor.

Link the sfg file to a spot color set if you prefer flexibility, applying one gradation correction per GMG
ColorProof workflow. You can load a gradation correction (sfg file) in the Workflow dialog box. A
gradation correction loaded in the workflow takes precedence over gradation files that might be
linked to spot colors in the spot color set.

How to link a gradation correction to a spot color set in a workflow

1. On the navigation panel on the left of the main window, click Workflows.

2. Open a workflow.

3. On the navigation panel of the Workflow Properties dialog box, click Print Settings.

4. Select a spot color set on the Spot Color Priority list and click Choose Gradation File on the Grad-
ation list.

5. Close the Workflow Properties dialog box. The gradation file is now used for all jobs created by this
workflow that use spot colors from this spot color set. A conflicting gradation linked to any spot color
from this set in the spot color database will be ignored.
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Fig. 71 Assigning a gradation file in a workflow.

How to link a gradation correction to a spot color in a manual job

1. On the navigation panel on the left of the main window, click Jobs and create a new job.

2. On the navigation panel of the Manual Job Manager dialog box, click Color Management.

3. Click the Channels tab.

4. Select a spot color channel and click Choose Gradation File in the Gradation list.

5. Browse for the *.sfg file you want to use and click Open to load the file.
A conflicting gradation linked to the same spot color in the spot color database will be ignored.

10.6.2 Optimizing Spot Colors

Note This feature requires a GMG ProofControl Inline license and a proof printer with an integrated meas-
uring device.

Note GMG spot color sets are read-only and can only be optimized after being duplicated. When duplic-
ating an already existing spot color set, the linked db3 database (> Import) is also duplicated to avoid
unwanted changes in the original spot color database. You can edit the name of the db3 copy in the
SpotColors program subfolder.

Spot colors can be challenging to proof. There are several reasons why you may want to adjust the default
values in the spot colors libraries. Maybe you need to modify spot colors to better match a customer’s pref-
erence. Or you need to produce spot colors based on your particular print environment. With GMG Col-
orProof, you can simply select a range of spot color swatches to print using your selected printer, MX
profile, and media. The integrated Spot Color Optimization wizard will guide you through the optim-
ization, helping you to conveniently achieve the desired output values.

For optimizing the spot colors, the wizard prints spot color patches, measures them, compares the meas-
urement values with the lab target values and recalculates the CMYK values in the db3 until the defined tol-
erance range or maximum number of iterations is achieved.

When printing the spot colors, the paper tint defined in the selected color profile is used to simulate the
paper tint effect of the final output paper you usually print with. All optimized spot colors will, however, be
saved as paper tint neutral spot colors in the database (db3) so that you can use the spot colors with more
than just one proof standard. This is done by subtracting the paper tint from the spot color profile when
updating the spot color database. If you then use an optimized (and paper tint neutral) spot color in a proof
job, the paper tint from the selected color profile (proof standard) is used for printing the spot colors.
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This in turn means that since optimized spot colors are optimized for a certain proof standard, you might
find unwanted color deviations when using proof standards with strongly varying paper tints, for example
ISO Coated v2 and ISO Uncoated Yellowish.

How to optimize spot colors

1. In the Database view > Spot Color Sets tab, right-click a (custom) spot color set and select Optimize
from the context menu.
The Spot Color Optimization wizard is started.

2. Select the printer and print settings you want to use for printing the patches.

3. Click Next.

4. Select a proof standard or load an MX profile.
The proof standard or profile contains the paper tint values required to simulate the paper type you
plan to use. This is important because different media generate different color results.

5. Click Next.

6. Select the Proof Mode and a test chart template.
You can choose between templates for full tone and gradient spot colors.

7. Select the spot colors you want to print and measure.

8. Click Next.

9. Define the tolerance range for the acceptable deviation of output and target values (delta E).

10. Select an optimization mode (automatic or manual).
Clicking the Next button, GMG ColorProof prints the selected spots, one patch for each fulcrum,
using the paper tint value of the selected MX profile.

11. Run optimization cycles until you are satisfied with the results.
(Click the Details button for more detailed information on the measured values.)
When finishing the optimization, the spot color database is updated with the calculated output values.
The measured values and color names are printed next to the color patches.

Fig. 72 Spot color swatches with measured delta E values.

10.6.3 Adding a Custom Spot Color Set

You can manage and set up your own spot color databases in the GMG SpotColor Editor, a separate pro-
gram integrated in GMG ColorProof. You can then import spot color sets from the custom spot color data-
base into GMG ColorProof. GMG SpotColor Editor is a profile editor for spot colors and has a very similar
functionality as GMG ProfileEditor has for CMYK process colors. Creating custom spot colors requires sim-
ilar steps as for creating a custom MX4 proof profile.
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How to add a custom spot color set

1. On the Database menu, point to Spot Color Sets, and click New.
The New Spot Color Set dialog box is displayed

2. On the Properties page, enter a Name for the spot color set.

3. Enter a Version number.
The version number serves as a unique identifier if you have several versions of the same spot color
set. It is recommended to use a naming convention, for example, V1, V2, V3, and so on, but you can
enter any string you like.

4. On the Import page, click the browse button and select a spot color database (db3).
(The Information tab provides more information and a preview of the spot color set. You can browse
all spot color sets in the spot color database and select the one that includes the desired spot colors.)

5. On the Calibration Sets page, click the + button on the toolbar to link a calibration set to the spot
color set.
(A spot color set can also be linked to multiple calibration sets. Use the Custom Filter to show only
calibration sets for your printer and/or calibration sets that share the same printer and media type.)

6. Click OK to confirm your choice.
The new spot color set is displayed in the Spot Color Set list in the Database view.

Tip For more information on custom spot colors, please refer to our separate Quick Start Guide of GMG
SpotColor Editor: GMG-SpotColorEditor_QuickStartGuide_en.pdf.

10.7 Control Strips

10.7.1 Control Strips Menu

The Control Strips tabbed page in the Database view shows all control strips available in the GMG Col-
orProof database. You can, of course, also set up your own, custom control strips.

Tip Main program features are accessible by different methods, so that users can choose which way is most
convenient to them. This documentation generally refers only to the toolbar or menu, even though there
may be alternative methods.

Click a button on the toolbar. Move the mouse over a button (without clicking) to display a tooltip.

Click a command on a menu.

Right-click on an item and click a command on the context menu.

Press a shortcut key. Shortcut key combinations are listed next to the corresponding command on the
menu.

Double-click an item (for example, a job or a workflow) to open the corresponding dialog box and
edit settings.
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Menu commands

Icon Workflow command Shortcut Meaning

New Control Strip CTRL+N Adds a new control strip to the data-
base. A control strip of type Proof
Standard is used for controlling that the
printed proof is in the tolerances (as
defined, for example, by FOGRA) with
GMG ProofControl. Type Printer Cal-
ibration is used for controlling that the
printer is still calibrated according to
the tolerances defined in the cal-
ibration set or according to custom cri-
teria by using the Check Calibration
feature.

Import CTRL+I Imports a previously exported control
strip into GMG ColorProof.

Export CTRL+E Exports the selected control strip into a
file with the file name extension strip.

Delete DEL Permanently deletes the selected con-
trol strip. Note that the control strip
image file is not deleted. Only avail-
able for custom control strips (added
by the user).

10.7.2 Adding a Custom Control Strip

GMG ColorProof provides you with control strips for all widely used print standards. You have furthermore
the possibility to create custom control strips for contone and 1-bit proofing, or create DotProof strips from
existing contone strips.

To create a custom control strip, you need a suitable image (TIFF) file and optionally a control strip XML
file for GMG ProofControl (containing the patch definitions).

Control strip images for ContoneProof

Control strip image files for ContoneProof must meet the following requirements. After the import, the con-
trol strip can be used in vertical and horizontal orientation.

8-Bit CMYK TIFF

Control strip images for DotProof

For each screen ruling, raster dot shape, and screening angle that you are going to print, a separate control
strip is required. For example, you need to import two separate custom control strips for printing one image
with 50 lpi screen ruling and another image with 100 lpi screen ruling.

Because it is possible to use control strips in horizontal and vertical orientation in GMG ColorProof, you
need to import two separate control strip image files for one DotProof control strip: One image in hori-
zontal and one in vertical orientation.

Control strip image files for DotProof proof mode must meet the following requirements. The images should
be produced by the same imagesetter used for the plate making of the images that will be proofed together
with the control strip. The RIP and the RIP settings used directly affect the color and visual appearance of
the printed image.
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1-Bit CMYK TIFF

Two images with the following naming convention are required for a DotProof control strip. <name>
is a placeholder for any custom name. The <name> must be identical for both files. <color channel>
is a placeholder for the color channel of the separated 1-bit file: Cyan, Magenta, Yellow, Black.

<name>_<color channel>_K0.tif: control strip in the desired layout

<name>_<color channel>_K90.tif: the same image, but rotated by 90 degrees. The image needs
to be rotated in the RIP program that is used for the plate making, do not use an image editor.

All files with identical image size and resolution

How to add a custom control strip

1. Click the Database button on the navigation panel on the left of the main window.

2. On the toolbar, click the New Control Strip button.

3. Enter a Name for the control strip.

4. Under Import Control Strip, click the browse button and select all image files that are required for the
new control strip (one 8-bit file for ContoneProof, eight 1-bit files for DotProof).

5. Select the Measuring Device you are going to use for measuring this control strip from the drop-down
list.

6. Select a Control Strip Type from the drop-down list.
Control strips of the Proof Standard type are used for verifying the color accuracy of a proof. Control
strips of the Printer Calibration type are used for checking the printer calibration.

7. Optional: Select a GMG ProofControl control strip XML for verification in GMG ProofControl.

8. Check the preview and click OK to import the image files and add the control strip to the database.

Fig. 73 Custom DotProof control strip ready for import.

The screenshot shows an example for a DotProof control strip consisting of eight files. The eight 1-bit TIFF
separations for the DotProof control strip have been successfully loaded.

Following the confirmation by clicking OK, the control strip will be added to the GMG ColorProof data-
base.

You can then use the new control strip for a manual job or workflow.

See also:

l "Creating DotProof Strips from Contone Strips" on page 179
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10.7.3 Creating DotProof Strips from Contone Strips

For verifying the color accuracy of a halftone proof, you will need a screened version of a control strip,
matching the screening of the image to be proofed. You can either screen an existing contone control strip
such as Ugra/Fogra Media Wedge CMYK, a spot color strip, or import a screened custom control strip
"Adding a Custom Control Strip" on page 177.

GMG ColorProof features an easy-to-use control strip generation for 1-bit proofs which allows for indi-
vidually screened control strips. The DotProof strip is generated from a selected Contone strip which is
either exported and screened with an external imagesetter RIP (recommended) or with the integrated GMG
1-Bit Creator.

How to create a DotProof from a Contone control strip (External RIP)

1. On the Tools menu, select New 1-Bit Control Strip.
The New 1-Bit Control Strip for DotProof dialog box is displayed.

2. Select the Measuring Device you are going to use for measuring this control strip from the drop-down
list.

3. Select a contone strip template from the drop-down list.

4. Under Screening Settings, select Screen with Imagesetter RIP.

5. Click the Export Contone Strip button to export the strip and screen it in your imagesetter RIP.
The screening in the RIP will result in four 1-bit files. This ensures that the strip is screened in the
same way as your images.

6. Click the Import Screened 1-Bit Strip button to import the screened files.
GMG ColorProof imports the 1-bit files and automatically assigns each file to a channel. You can
check and edit the channel assignment in the Separation column.

7. Enter a Name for the control strip.

8. Click Add to System to add the DotProof control strip to the GMG ColorProof database.

How to create a DotProof from a Contone control strip (Internal Screening)

1. On the Tools menu, select New 1-Bit Control Strip.
The New 1-Bit Control Strip for DotProof dialog box is displayed.

2. Select the Measuring Device you are going to use for measuring this control strip from the drop-down
list.

3. Select a contone strip template from the drop-down list.

4. Under Screening Settings, select Screen with GMG 1-Bit Creator.

5. Select the appropriate screen set from the drop-down list.

6. Enter the screening angles for the CMYK channels.

7. Enter a Name for the control strip.

8. Click Add to System to add the DotProof control strip to the GMG ColorProof database.
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11. System View
On the General settings tab of the System view, you define global settings such as the measuring units used
in the program or the temporary file folder required for ripping jobs.

You can also define default settings for required parameters in manual jobs and workflows, for example, a
scaling method or default font for font replacement. The default settings are suggested each time when you
set up a manual job or hotfolder. You can still change settings in the Manual Job Manager or in a workflow,
if required.

On the Color Conversion tab, you can set up default conversion rules for manual jobs (only required for
files that are not in the target color space yet). If you want to use WebClient, ProofControl Inline, or Col-
orProof GO, you need to configure these applications on the respective tabs. On the Remote Proofing tab,
you can configure your system for sending proof jobs to remote sites and receiving proof jobs from remote
sites.

11.1 System Menu
You can toggle between standard and Administration mode and password-protect the Administration
mode in the System menu. You can set up database files such as proof standards, calibration sets, printer
media, control strips, and spot color sets. You can also edit general system settings and default settings.
You will find more details on submenu items such as proof standards in the corresponding chapters.

Tip Main program features are accessible by different methods, so that users can choose which way is most
convenient to them. This documentation generally refers only to the toolbar or menu, even though there
may be alternative methods.

Click a button on the toolbar. Move the mouse over a button (without clicking) to display a tooltip.

Click a command on a menu.

Right-click on an item and click a command on the context menu.

Press a shortcut key. Shortcut key combinations are listed next to the corresponding command on the
menu.

Double-click an item (for example, a job or a workflow) to open the corresponding dialog box and
edit settings.

Menu commands

Command Shortcut Description

General CTRL+S Opens the General system settings tabbed page. You can change all global pro-
gram settings and defaults in the General view.

Check Database To find database file structure errors, you can run a Database Consistency
Check. If one of the checks does not complete successfully, the Error Log will
provide you with a clear message on the problem.

Administration Mode CTRL+SHIFT+A Switches from the standard (non-secure) operating mode to Administration
Mode. Users can change system settings and workflows only in Administration
Mode.

Administrator Pass-
word

You can set up or change the password for Administration Mode here.

No Password Pro-
tection

Use this command to remove the password protection for the Administration
Mode.

Environment Backup >
Create

CTRL+B Creates a backup of the entire GMG ColorProof system, including all folder
paths (hotfolders, backup folders), all program settings, and all linked files such
as color profiles.

Environment Backup >
Restore

CTRL+R Restores the entire GMG ColorProof system from a previously saved backup file.
Note that the Restore command will overwrite your current system and that this
action cannot be undone.
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Command Shortcut Description

Language You can change the language of the program here. The user interface will be
updated after program restart.

Remote Proofing >
Manage Remote Sites

Opens an overview on all FTP and network accounts for defining new remote
sites or editing already existing ones. Also includes an e-mail notification ser-
vice.

Remote Proofing > File
Upload

Shows and tracks the status of proof jobs that are uploaded to an FTP account.

Export Job Report Exports the Job Report (containing all relevant information on processed jobs) as
XML file.

Reset Job Report Clears the Job Report, deleting all entries.

Calibration Override Allows you to load and overwrite printer calibration files (Output view > Avail-
able Printer Calibrations: Open Calibration File button).

11.2 Administration Mode

11.3 General System Settings
On the General settings tab of the System view, you define global settings such as the measuring units used
in the program or the temporary file folder required for ripping jobs. You can also define default settings for
required parameters in manual jobs and workflows, for example, a scaling method or default font for font
replacement. The default settings are suggested each time when you set up a manual job or hotfolder. You
can still change settings in the Manual Job Manager or in a workflow, if required.

Group Short description See also

Productivity Activate the option Set Duplicated Jobs on Hold if you want to use duplicated jobs
as templates and need an auto-store to edit them before printing. When the option is
not activated, duplicated jobs are immediately queued and printed.

With the option Move Job to Another Printer if Printer Cannot Print pending jobs
are automatically moved to another printer in case the initially assigned printer fails
to print the job. Both printers need to use the same calibration set.

Environment Backup
Scheduler

Schedule the system to automatically backup your data in regular time intervals.

Automatic Image
Placement

Image spacing / keyboard increment that is applied when moving an image manu-
ally by keyboard commands in the Manual Job Manager.

Default Settings You can deactivate the automatic check for software updates and usage tracking
here.

Default Settings

Default Cleanup Set-
tings

Routines that delete jobs automatically from History list.

Default View Settings Settings for the job preview in Manual Job Manager, info pane, and print queue.

Remote CaliWizard
Settings

Network settings and automatic start of the host service for the integrated remote cal-
ibration tool.

"About Remote CaliW-
izard" on page 118

E-Mail System Noti-
fications

GMG ColorProof supports e-mail alerts to inform you of job errors and printer / cal-
ibration issues. To receive alerts, you need to configure the SMTP server settings (Sys-
tem view > Remote Proofing tab: Outgoing E-Mail Notifications).

"Remote Proofing Set-
tings" on page 198

File System Watcher The File System Watcher is a behind-the-scenes utility monitoring all files in the file
system (used by manual or workflow jobs) to trigger job status changes. You can con-
figure the scan interval in milliseconds, the default value being 500 ms and the min-
imum value 200 ms.

ICC Defaults Color Management Engine used for ICC based color conversion / color man-
agement.

Job Report Settings Storage location and clean up settings for job reports. "Job Report" on page
182

Folder for Manually
Imported Jobs

Jobs that have been imported manually (File > Import Jobs) will be imported to this
folder.

../../../../../Content/system/default-settings.htm
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Group Short description See also

Advanced RIP Settings Default RIP settings. Can be changed in Manual Job Manager and Workflow dialog.

l RIP Temporary Folder: During the RIP, temporary files are generated that will
be deleted when a job is finished. These files are temporarily saved in the spe-
cified folder. It is recommended to assign the temporary folder to a hardware
drive that is separate from the hardware drive that holds the output folder.
Please make sure that enough disk space is available for the output folder as
well as the temporary folder.

l Default RGB/CMYK ICC Profile: If neither an embedded ICC profile is avail-
able, nor an ICC profile was assigned to the job for Conversion CT/LW in
GMG ColorProof, the default CMYK or RGB ICC profiles specified here will
be used for a conversion from RGB to CMYK or vice versa. This applies only
to PDF/PS input files that are ripped by the integrated RipServer. (Please note
that ICC settings defined in the job or workflow always overrule the default
color spaces defined in the System settings.)

Scale Images to Fit Method used for scaling images. Default is Supersampling. If you want to maintain
sharp edges, Repeat Pixel can be used instead.

General Measuring
Units

Measuring units used globally in the program. Different units are used for defining
the print resolution, the screening resolution, and for all other settings such as the
preview or the paper width.

Centralized Color Man-
agement Settings

One-way file synchronization control settings for distributing color management
data across multiple GMG ColorProof instances. The synchronization functionality
distributes new and changed files from a "source" location, for example a folder in a
local network, to a "target" location. You can use the scheduler to run the syn-
chronization automatically in regular intervals.

"Database Toolbar
and Menu" on page
154

"Interplay of Color
Management Items"
on page 156

Job Ticket Report Creates a report for each job created by a job ticket, providing you with a complete
list of all processing steps.

11.4 Reports

11.4.1 Job Report

GMG ColorProof automatically creates a system log file report providing you with an overview of all pro-
cessed jobs. This job report holds all user relevant information such as the print date, media and ink usage
per job and image (for printers that support tracking of media and ink usage), dimensions, and PDF output
intent. The job report can, for example, be used by a system operator to monitor the job processing. It is
also an ideal basis for billing, cost controlling, and resource planning. Furthermore, the job report can be
read by external systems to track the processing status. The universal XML format allows an easy exchange
with your MIS.

The job report can be configured in the System view, on the General tabbed page. It is saved as Col-
orProofLog.xml into the specified Job Report Folder. The job report is updated immediately after a job has
been processed (job status Finished, Canceled, or Error).

You can export and reset the job report in the System menu. The tracking interval can be defined by the
Report Cleanup settings in the System view, on the General tabbed page. When the time limit or the job
count has been reached, a new report file will be created. If the option Backup Report is selected, all pre-
vious report files will be kept. Otherwise, the report file will be deleted as soon as a new file is created.

The job report is saved in an XML file format. This file format has the advantage that it can be used very
flexibly. For example, you can open the ColorProofLog.xml in Microsoft Excel and use all features offered
by a standard spreadsheet program such as filtering, calculations, graphs, and so on.

You can also open the file in a standard web browser application. The same contents will be shown in
HTML table layout, as defined in the transform.xsl stylesheet file also saved to the specified Job Report
Folder. In this case, the transform.xsl must be available in the same folder as the job report file. Please
remember to copy both files if copying the job report into a different folder.
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Fig. 74 ColorProofLog.xml opened in Microsoft Excel.

Customizing the job report

The following information is intended for advanced users only. It is assumed that you already have a basic
understanding of XML, XSL (Extensible Stylesheet Language), and XSLT (Extensible Stylesheet Language
Transformations).

If you open the ColorProofLog.xml file in an XML or in a basic text editor, you will see that the trans-
form.xsl file is referenced in the line <?xml-stylesheet type='text/xsl' href='transform.xsl'?>.

XSL is a stylesheet language for XML files, defining the layout, styles, colors, etc. of how the XML file will
be shown in the application in which it is opened. Thus, the visual appearance of the ColorProofLog.xml
file is defined in the transform.xsl file.

If you open the transform.xsl in a basic text editor, you will see that the layout is defined by an
HTML table. By modifying the XSL file, you can display the job report in any layout you like, with custom
fonts, colors, and so on. The output format is defined by the output mode of the XSL. Apart from HTML, the
report file can, of course, also be shown as unformatted text or just as an XML tree. You can show and hide
any information available in the job report, as the shown content is also defined in the XSL file.

Note XML and XSLT are international standards. Please have a look at the web sites http://www.w3.or-
g/XML/ and http://www.w3.org/TR/xslt for further information.

11.4.2 Job Ticket Report

If a file has been processed with a job ticket, GMG ColorProof generates a Job Ticket Report. The Job
Ticket Report is an XML file which contains all results of the processing steps (e.g. the used standard or pro-
file, channels, verification results). The location path of the report can be configured in the System view >
General tab.

http://www.w3.org/XML
http://www.w3.org/XML
http://www.w3.org/TR/xslt
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Fig. 75 Job Ticket Report Settings.

In the below screenshot of an example report, you can see the job name in GMG ColorProof, used cal-
ibration and media, and the image dimensions. The report details comprise all important information con-
cerning the color management and the used proofing components, and provide useful information on the
color accuracy based on the control strip measurements.

Fig. 76 Example job ticket report.

See also:

l "Job Ticket Hotfolder" on page 79

11.5 WebClient

11.5.1 Connecting GMG ColorProof to GMGWebClient

11.6 ProofControl Inline

11.6.1 GMG ProofControl Inline Settings

Note Some of the features described in the following may not be included in the standard GMG ColorProof
version and require an additional license (GMG DotProof, GMG FlexoProof, GMG ProfileEditor, GMG
ProofControl Inline, or GMG OpenColor). Please contact your local dealer for details.



11. System View

185 / 209

Group Short description See also

General Settings Settings that apply to GMG ProofControl Inline in general. For example, you can
choose a custom data location on the network.

Proofer Supporting
Direct Label Printing

Settings applying only to printers that are physically able to roll back the print
medium and print a label next to the control strip.

Proofer Not Sup-
porting Direct Label
Printing

If your printer does not support label printing or if you want to print the labels on an
external label printer, use these settings to automatically transfer the verification data
to the connected label printer.

Report Printing Apart from printing a label, you can also have a detailed report printed, showing all
measured values and giving you a good overview on all parameters.

Failed Proof Standard
Verification

Actions that are triggered automatically if a verification of a proof standard fails after
printing a proof control strip. This feature efficiently prevents that several jobs fail
the check in a row due to an uncalibrated printer.

If a verification fails, only the calibration set that was used for printing the job and
only for the used printer will be set to "Not Calibrated".

When the option Set Printer on Hold is activated, the software printer in GMG Col-
orProof is set to hold automatically each time the verification of a proof standard
control strip fails, giving you the opportunity to check the printer before printing the
next job. You can click the Continue button on the Output toolbar to unpause the
printer.

"Verifying a Proof with
GMG ProofControl
Inline" on page 191
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12. Job Monitoring
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13. Proof Verification

Note Some of the features described in the following may not be included in the standard GMG ColorProof
version and require an additional license (GMG DotProof, GMG FlexoProof, GMG ProfileEditor, GMG
ProofControl Inline, or GMG OpenColor). Please contact your local dealer for details.

Without a standardized control strip which can be measured by the producer and the customer, any print
can just be considered no more than a pretty picture—it may or may not relate to the press output.

Only if a proof is verified against an official print standard, you can be sure it will be possible to reproduce
the colors on the press.

Customer service: You might want to provide certified standard proofs to your customers.

Internal production/quality control: You might want to assess the quality you produce. This might also
help to avoid warranty claims and support issues.

So, how can you verify that your proofs are color accurate and meet the requirements of your standards?

Automatic proof verification with GMG ProofControl Inline

GMG ProofControl Inline is a module for GMG ColorProof featuring a fully automated verification of proof
control strips measured with the integrated measuring device of the proof printer.

If you have a GMG ProofControl Inline license on your computer, but no GMG ProofControl license, you
will be able to install GMG ProofControl to review data, to print a label, or to customize print standards.
You can then link the customized print standards to the corresponding proof standards in GMG ColorProof.
You will be able to access all GMG ProofControl features except measuring with an external measuring
device. For this feature, you will need a full GMG ProofControl license.

Advantage New Feature

Automated proof verification and quality assur-
ance procedures for ContoneProof applications

According to world-wide standards such as ISO. Can be flexibly customized for
in-house standards.

Automated verification of the print standard

Automated label printing

ISO standard conformity The new report format complies with the ISO 12647-7 standard. Reports can be
printed directly from GMG ColorProof or from the external GMG ProofControl
application.

Assure color quality on remote proofing stations If a GMG ProofControl Inline license is available on the target remote location,
imported proofs will be automatically verified.

Enhanced support of larger teams, improve your
quality assurance workflow

Manage your proof verification check results on a central server in a network.
Measurement data will be automatically saved to a custom location from GMG
ColorProof. You can review the data and print reports from the main GMG
ProofControl application.

Proof verification with GMG ProofControl

GMG ProofControl is a stand-alone tool for proof verifications. It has to be purchased separately.

The program offers the following features:

Measure control strips with an X-Rite i1 or integrated measuring device

Print a verification label on an external label printer

Review measurement data, also measured from GMG ColorProof

Print a detailed report

Edit print standards and adjust the tolerances to suit your needs

How does a proof verification work?

Official printing conditions such as "ISO Coated v2 (39L)" reference characterization data describing expec-
ted print results for different input color values (from the original image as the creator has intended) and tol-
erances that need to be met in order to comply with the standard.
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Sounds a bit complicated?—With GMG ProofControl or GMG ProofControl Inline, the procedure is actu-
ally very easy and consists of three straight-forward steps.

1. Printing: You will print a control strip together with the image. (Control strips are provided by official
organizations. The license to use them are part of the GMG ProofControl and GMG ProofControl
Inline product.)

2. Measuring: The color patches of the control strip are measured with a spectrophotometer.

3. Verification: GMG ProofControl and GMG ProofControl Inline compare the measurement values with
the target values defined by the print standard. (Widely used print standards are also part of the GMG
ProofControl and GMG ProofControl Inline product.) There are two possible results:

Pass: The measurement values match the target values within the tolerances. As official target val-
ues and an official control tool are used for verification, the proof is considered to be compliant
with the standard. You can tag your proof with a label to show the results to your customers.

Fail: The measurement values are out of tolerances.

Note For compliance with most officially used standards, a proof verification alone is not sufficient. The
standard might also expect to follow quality assurance guidelines and to use a certified proofing system
using an approved software, printer, and print medium. GMG ColorProof, GMG DotProof and GMG Flex-
oProof, and GMG ProofMedia together with high-quality printers from several manufacturers are certified
for widely used standards. For more information, please contact our sales channel partners.

See also:

l "Using Control Strips" on page 188

l "Verifying Spot Colors" on page 190

13.1 Using Control Strips

Which kind of control strips are supported in GMG ColorProof?

Control strips defined by an official print standard, CMYK only: Available for factory-default and cus-
tom proof standards, and GMG OpenColor proof standards

Control strips defined by an official print standard, CMYK and spot colors: Available for GMG
OpenColor proof standards

GMG spot color control strips: Dynamically generated from the spot color channels used in the image

GMG OpenColor control strips: Dynamically generated from the color channels (GMG OpenColor
inks) used in the image

GMG Calibration Control Strip: Used for checking if the printer still works in the tolerances or needs
to be recalibrated

All four CMYK channels need to be available.

When using a multicolor ICC profile, you can verify the CMYK part (if available) of the profile and single
spot colors, but not the overprinting behavior of the spot colors.

What do I need to do?

If you are using a factory-default GMG proof standard, you just need to select an image or job control strip
in the job and GMG ColorProof will use the correct target values as defined in the proof standard out of the
box.

Likewise, if you are using a GMG OpenColor proof standard, GMG ColorProof will take the target values
from the proof profile and you do not need to worry about it.

If you want to use stricter tolerances or verify against a custom print standard, however, you need to take
care that appropriate target values and tolerances are defined as explained in the following.
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Customize tolerances and target values

You want to use stricter tolerances? You can create a custom print standard in GMG ColorProof and then
edit the tolerances in GMG ProofControl.

You want to use custom target values? You can create a custom print standard either from an official print
standard or from the proof profile and then edit the target values (and tolerances) in GMG ProofControl.

Note Proof verification will fail if target values in the print standard XML do not match with the target val-
ues in the proof profile.

The procedure is slightly different whether you are using a proof profile from GMG OpenColor or not as
shown in the following table.

Proof profile How it works

Without GMG OpenColor Target values and tolerances for CMYK are always taken from a GMG
ProofControl Print Standard XML file linked to the proof standard, which needs
to match the selected control strip. If there are no target values for the selected
control strip, proof verification will not be possible. Target values for spot col-
ors will be extracted from the spot color set (db3).

You have multiple options to create your own custom GMG ProofControl Print
Standard XML file. Please follow the link for more information: "Adding a Cus-
tom GMG ProofControl Standard" on page 171

GMG ColorProof will use the Evaluation rules defined in the GMG ProofCon-
trol Print Standard, i.e. the delta E tolerances for the substrate, CMYK, and spot
colors. Please see here how to customize the tolerances in GMG
ProofControl: Creating a Custom Print Standard

With GMG OpenColor, custom
proof standard (static and
dynamic profiling)

You have the option to define the target values for CMYK and spot colors by linking GMG
ProofControl Print Standard XML files to the proof standard.

Note If there are no CMYK target values for the selected control strip in the
GMG ProofControl Print Standard XML files, proof verification will not be pos-
sible.

Note Proof verification will fail if target values in the print standard XML do not
match with the target values in the proof profile. To ensure that they match,
you can create the GMG ProofControl Print Standard XML file from the proof
profile as explained in the following.

You can create a custom GMG ProofControl Print Standard XML file for a static proof standard
with the action Generate From Proof Standard > From Contone MXN. For a dynamic proof stand-
ard, this action is not available. However, you can create a static proof standard with an
MXN profile, create the GMG ProofControl Print Standard XML file from this proof standard, and
then link it to a dynamic proof standard. Please follow the link for more information: "How to gen-
erate a custom GMG ProofControl standard from the profile in GMG ColorProof (Generate from
Proof Standard)" on page 171

Please see here how to customize the tolerances in GMG ProofControl: Creating a Custom Print
Standard

If you do not link any Print Standard XML file to the proof standard, target values will be calculated
from the proof profile and the tolerances from the Default Control Strip will be used.

Note If CMYK is not included in the proof profile, proof verification will not be
possible. When using dynamic profiling, the proof profile requested from GMG
OpenColor will include only the colors channels that are available in the input
document. In this case, the document needs to include CMYK color channels.

Note Please note that job control strips cannot be used for GMG OpenColor jobs.

../../../../../Content/GMG_Text/ProofControl/UseCases/PC_DefineStandard_HowTo.htm
../../../../../Content/GMG_Text/ProofControl/UseCases/PC_DefineStandard_HowTo.htm
../../../../../Content/GMG_Text/ProofControl/UseCases/PC_DefineStandard_HowTo.htm


GMG ColorProof User Manual

190 / 209

See also:

l "Adding a Custom GMG ProofControl Standard" on page 171

l "Verifying Spot Colors" on page 190

13.2 Verifying Spot Colors
If you want to know how well spot colors printed in an image match the reference values, you can add a
spot color control strip to your image in GMG ColorProof (> Image Control Strips).

With an integrated ILS30 measuring device and a GMG ProofControl Inline license, all patches are auto-
matically measured and a verification label is printed on the proof.

GMG OpenColor spot colors are validated by comparing the measured values against the Lab target values
from the multicolor profile. In both cases, the Delta E values are printed in a label, showing you which spot
colors can be reproduced by your printer-medium combination and which colors are out-of-gamut. You
can optionally define tolerances for a pass/fail verification of the spot colors.

Available spot color control strips

l Fogra MediaWedge Multicolor 5C, 6C, 7C, 8C: Verification is supported when using a printer with an
integrated ILS30 measuring device and a GMG OpenColor proof profile or proof standard.

l IDEAlliance ECG Digital Control Strip 2019: For CMYK OGV printing processes. Verification is sup-
ported when using a printer with an integrated ILS30 measuring device and a GMG OpenColor proof
profile or proof standard.

l The GMG Spot Color Strip - Full Tone uses only 100% full tone patches and has a fixed size of 10
patches. GMG ColorProof assigns the first 10 spot color channels found in the image to the 10 chan-
nels of the control strip. The strip contains one full-tone patch (100% fulcrum) for each spot. If the
image contains more than 10 spot colors, exceeding spots will be ignored.

l The GMG OpenColor Control Strip uses full tone patches plus additional spot color tints for the veri-
fication process. Only spot color tints with corresponding measurements in the GMG OpenColor data-
base can be validated. Verification is supported when using a printer with an integrated ILS30
measuring device and a GMG OpenColor proof profile or proof standard.

How to verify spot colors with an integrated measuring device

1. On the navigation panel on the left of the main program window, click System.

2. Click the GMG ProofControl Inline tab.

3. In the Proofer Supporting Direct Label Printing group, from the Print Label Automatically on Proofer
list, select Always or Only if Verification Passed to directly print the label on the proof.

4. Create a job for an image with spot colors.

5. Image > Label/Strips/Marks > Image Control Strips: Select the option Control Strip 1 (or 2).

6. From the Measuring Device list, select the integrated measuring device you are using.

7. Under Control Strip Type, select a spot color control strip and determine where to place the strip.

8. Print the job.
GMG ColorProof prints the job with the control strip. The color patches will be automatically meas-
ured by the integrated measuring device. The print medium will be rolled back and the GMG
ProofControl Inline label will be printed next to the control strip.

How to verify spot colors with an external measuring device

Note Verification of spot color control strips in GMG ProofControl is supported only for the X-Rite i1 meas-
uring device and only for spot colors from a db3 spot color set, not for spot colors from GMG OpenColor.
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1. Start GMG ProofControl.

2. Under Options > ColorProof Connection, select the option Use Automated Measurement Import.
Browse your folders and select the folder where the measurement jobs are saved (default path: <install-
ation path>\GMG\ColorProof05\ProofControl Output).

3. Create a job in GMG ColorProof using an image with spot colors.

4. Image > Label/Strips/Marks > Image Control Strips: Select the option Control Strip 1 (or 2).

5. From the Measuring Device list, select i1.

6. Under Control Strip Type, select GMG Spot Color Control Strip - Full Tone and determine where to
place the strip.

7. Print the job.
GMG ColorProof prints the job with the control strip. The job is automatically exported to the GMG
ProofControl Hotfolder defined in step 2 and displayed in the main view in the Jobs list.

8. Switch to GMG ProofControl and select the measurement job in the Jobs list.

9. Measure the strip with an i1.

10. Click on the Print Label button on the toolbar to print a label with the verification results.

13.3 Verifying a Proof with GMG ProofControl Inline

Note Some of the features described in the following may not be included in the standard GMG ColorProof
version and require an additional license (GMG DotProof, GMG FlexoProof, GMG ProfileEditor, GMG
ProofControl Inline, or GMG OpenColor). Please contact your local dealer for details.

Recommended printer settings

Note GMG ProofControl Inline does not support sheet media on Epson Stylus Pro 4900 printers.

For printers with an embedded SpectroProofer, the drying time after printing is very important for achieving
correct measurement results. Different settings are recommended for different types of measurement. Dry-
ing settings can be changed in the Change Media dialog for each printer (> Media Specific Printer
Settings).

Measurement Type Drying Method Drying Time

Measuring a control strip Air Drying 5 min

Recalibrating (GMG AutoCali Wizard) Air Drying 5 min

Measuring a Full Gamut test chart Air Drying 5 min

Measuring a Gamut test chart Air Drying 15 min

Optimizing an MX4 Profile Air Drying 15 min
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How to verify a proof and print the label automatically

1. On the navigation panel on the left of the main program window, click System.

2. Click the GMG ProofControl Inline tab.

3. In the Proofer Supporting Direct Label Printing group, from the Print Label Automatically on Proofer
list, select Always or Only if Verification Passed.

4. Create a job for an Epson Stylus Pro x900 printer.

5. Job > Label/Strips > Job Control Strip: Select the option Proof Control Strip. (Alternatively, select an
image control strip.)

Note Please note that job control strips cannot be used for GMG OpenColor jobs.

6. From the Measuring Device list, select Epson Integrated Measuring Device.

7. Select a Control Strip Type and determine where to place the strip.

8. Print the job.

GMG ColorProof will print the job with the control strip. The color patches will be automatically measured
by the integrated measuring device.

The print medium will be rolled back and the GMG ProofControl Inline label will be printed next to the
control strip. If you have selected the option Only if Verification Passed, only labels with the result
"Passed" will be printed. If you have selected the option Always, labels with the result "Failed" will be prin-
ted as well.

The verification status of each job will be shown in the History view.

Note GMG ColorProof does not validate that the control strip matches the proof standard used when print-
ing a job. If a proof verification fails, check that an appropriate control strip has been used.

Fig. 77 Proof verification status shown in the History view.

The three highlighted jobs show the three possible verification statuses Pass, Unknown, and Fail.
Description Additional Info

1 Verification
status

The overall verification status of the entire job is illustrated by a green check mark (Pass), red cross (Fail), or
yellow question mark (Unknown). "Unknown" means that a verification was not possible for any reason, for
example, because the proof standard did not contain target values compatible with the measured control
strip.

Printing multiple control strips in a single job: If the verification of only one control strip failed, the veri-
fication status of the entire job will also be "Fail", even if the verification of all other control strips passed.
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Description Additional Info

2 Verification
results

For different print standards, different criteria are specified for verification of a proof. Therefore, you might
find different parameters for different print standards in the software. If all required criteria are met, the veri-
fication status is passed.

3 Show Report
button

Generates a report compliant with the ISO 12647-7 standard in XHTML format. You can right-click the
upper part of the report window to open the context menu and print the report on any printer installed on
the Windows operating system.

The report shows the used standard and control strip, the measurement conditions, the verification results,
and the measurement values for all color patches.

How can I prevent that several jobs in a row fail the verification?

Generally, proofs that fail the verification cannot be used for contract proofing. In most cases, a verification
fails because the printer is not in a calibrated state. This can easily overcome by recalibrating the printer.

GMG ColorProof efficiently prevents that further jobs are printed after the first job failed the verification,
which saves valuable production time and resources. You can activate this function here: System > GMG
ProofControl Inline > Failed Proof Standard Verification > Set Calibration Set to "Not Calibrated".

In combination with the function Output > Printers > Automatic Actions if Calibration Set Status is
Changed to "Not Calibrated" > Start Automatic Calibration, GMG AutoCali Wizard will start auto-
matically, thus minimizing the downtime of a printer.

Example:

You are using two print modes on the same printer–medium combination. For example, job A uses a print
mode with a resolution of 300 dpi and job B uses a print mode with a resolution of 600 dpi. Both jobs use
the same proof standard, ISO Coated v2 (39L). The proof verification of job A failed, but was successful for
job B.

This means that the "300 dpi" calibration set needs to be recalibrated for this printer–medium combination.
The "600 dpi" calibration set is still ok and can be used for printing.

See also:

l "GMG ProofControl Inline Settings" on page 184

l "GMG AutoCali Wizard Settings" on page 115
Remote proofing

With GMG ProofControl Inline, users at remote locations can automatically verify proofs against their stand-
ards.

To use GMG ProofControl Inline, only the target remote location needs the license, not the creator of
a job. If the target remote location does not have a GMG ProofControl Inline license, control strips
will be measured without a verification. (The measurement data can still be imported into GMG
ProofControl for a manual verification.)

As using a custom proof profile (without using a proof standard) is not supported by GMG ProofCon-
trol Inline, you need to link the job data to the job when exporting (option Link to Color Profiles) so
that the proof profile of the target remote location will be used. The export option Embed Color Pro-
files is not supported.

To guarantee a smooth workflow, jobs containing control strips for an integrated measuring device
will be printed anyway. If the job is printed on a printer that does not support such a device, the job
will be printed without the control strip.

See also:

l "Remote Proofing" on page 196

l "Verifying Spot Colors" on page 190
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13.4 Verifying a Proof with GMG ProofControl

13.4.1 Verifying Control Strips in GMG ProofControl

The following shows you how to select a control strip in GMG ColorProof, measure the strip in GMG
ProofControl with an i1 measuring device and print a verification label.

How to verify a GMG ColorProof proof job with an X-Rite i1

1. Create a job in GMG ColorProof.

2. Job > Label/Strips > Job Control Strips / Image Control Strips: Select a Control Strip.

3. From the Measuring Device list, select i1.

4. Under Control Strip Type, select the control strip you want to use.

5. Under Position, determine where to place the strip.

6. Print the job.
GMG ColorProof prints the job with the control strip. The job is automatically exported to the defined
GMG ProofControl hotfolder and displayed in the main view in the Jobs list (see "Importing Meas-
urement Data into GMG ProofControl" on page 194).

7. Switch to GMG ProofControl and select the measurement job in the Jobs list.

8. Measure the patches of the printed control strip with the connected measuring device.
After a successful measurement, all color patches are visualized and the measured values are dis-
played in the Verification Results area.

9. Click the Save button on the toolbar to save the measured values to the database.
(All measurement data can be loaded again by clicking on the corresponding job in the History list.)

10. Click on the Print Label button on the toolbar to print a label with the verification results.

13.4.2 Importing Measurement Data into GMG ProofControl

Measurement data from GMG ColorProof can be automatically or manually imported into GMG ProofCon-
trol.

Automatic import of measurement jobs and data

With our automatic import option, every job with a control strip that finished processing in GMG Col-
orProof is automatically handed over to GMG ProofControl so that the strip can be measured with an i1 or,
if already measured with an integrated measuring device, selected in the History list to print a label or
report for it.

Fig. 78 Automatic measurement import via hotfolder.
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How to import measurement jobs from GMG ColorProof via a Hotfolder

1. On the toolbar of the GMG ProofControl main window, click Options.

2. In the tree view pane on the left, click Connectivity Options.

3. Select the option Automatic Measurement Import. Browse your folders and select the folder where
the measurement jobs are saved (default path: Users\Public\GMG\ColorProof\ProofControl Output).

4. Optional: Enable the cleanup functionality Delete Unrecognized Files to delete all unrecognized files.

5. Confirm with OK.
The selected folder is scanned every 10 seconds for new data. All incoming data is automatically lis-
ted in the Jobs and History list in the main program view.

Manual Measurement Import (PMV Files)

If you are using an integrated measuring device and want to manually import measurement data, you need
to activate the manual import option (Options > Measuring Device > Use Manual Import of PMV Files)
and define the folder which ColorProof uses for storing the measurement data (default path: User-
s\Public\GMG\ColorProof\ProofControl Output). As soon as you activated the manual import option, a
Load button is shown on the status display of the measuring device.

Fig. 79 Manual import of PMV measurement files.

Click the Load button to import single *.pmv measurement files.

Tip The data shown in the Import Measured Values dialog is filtered by the selected Filter and Backing
options (Options > Measuring Device > Manual Measurement Import).
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14. Remote Proofing

Fig. 80 Sharing the workload across multiple remote sites.

One of our key concepts is to enable our customers to always achieve exactly the same print results,
whether a printer is located next room or in another country. With the enhanced remote proofing func-
tionality in GMG ColorProof, you have every opportunity to move work between different locations.

GMG ColorProof enables you to access, store, and share your work from any location. You can configure
an automated up/download of proof jobs and color management data such as profiles, spot color sets, cal-
ibration sets, media, control strips using an FTP server or network location. With the optional password and
write protection, you can securely share files with multiple clients or associates. Furthermore, you can
share profiles or spot color sets on a network drive, centralizing the management of custom application
data.

Tip GMG ColorProof Remote Proofing Only: Instead of buying full licenses for sender and target site, you
can install a remote proofing edition of GMG ColorProof at the remote site to produce "ready-to-print" jobs
from other GMG ColorProof installations. The Remote Proofing Only license allows to print imported jobs,
calibrate printers and perform printer maintenance, import, create and edit color management sets, and
connect to GMG OpenColor to create multicolor profiles. Please ask your local dealer for further details.

The following table shows the different possibilities for sharing files and printing proof jobs in between dif-
ferent locations.

Options Short description See also

Manual remote proofing Proof jobs and color management files can each be exported manually by
selecting the file and using the Save As or Sent To command from the context
menu.

For the import, you can use the File menu or the Import buttons on the respect-
ive System tabs.

"Manual Remote Proof-
ing" on page 199

Automated remote proof-
ing via FTP

You can set up an automated job export by using the option Export Job for
Remote Proofing in a workflow (Workflow properties > Printer).

To automatically import proof jobs from an FTP server and load balance them,
you can configure an automatic transfer to a hotfolder which can directly send
the jobs to the job list in GMG ColorProof.

All remote sites can be configured and managed centrally (System view >
Remote Proofing > Manage Remote Proofing Sites).

"Automated Remote
Proofing" on page 200

"Managing Remote Proof-
ing Sites" on page 197

WebClient The client-server architecture of GMG ColorProof allows to create proof jobs
and drag and drop files to remote GMG ColorProof hotfolders and workflows
and have them processed, printed and validated.

GMG-WebClient_Quick-
StartGuide_en.pdf

Sharing data on a central
server

If you are using custom profiles and application data and want to share them
through a central server, you can easily synchronize your database by a one-
time export and import of files.

"Sharing Data Through a
Central Server" on page
202
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14.1 Managing Remote Proofing Sites

Note To be able to use the FTP client within GMG ColorProof, you need to turn off any proxy settings
within your browser (> Internet Options).

Sharing job files can be invaluable if a print provider has multiple locations and wants to be able to dis-
tribute work between them. On the Remote Proofing tab, you can set up remote sites for an automatic
upload of proof jobs to an FTP or network location. The defined remote site can then be selected in the
Manual Job Manager (Send to button) or Workflow dialog (Printer > Export Job for Remote Proofing) to
automatically transfer the jobs to the other system.

Options Short description See also

E-Mail Notifications To inform the recipient of the proof job that a new job has been uploaded to
his FTP or network location, GMG ColorProof features an optional e-mail noti-
fication service. Following each upload / download of a proof job, the notifier
automatically sends a notification including the name, ID, and creation date of
the job file to the given e-mail address(es). (Requires Outgoing E-Mail Noti-
fications.)

Export Job Options When setting up a job, you usually define a lot of data such as the job settings,
the image files, color profiles, and so on. When sending a proof job to a remote
site, you can embed these color management files (option Embed Color Pro-
files) or link them (Link to Color Profiles).

"Embedding or Linking
Color Management
Data?" on page 198

Security Options For security reasons, you can password-protect your proof jobs so that the
receiver of the jobs needs to enter the password before he is allowed to import
the job.
You can furthermore write-protect the image and job settings to ensure the
proof is printed exactly as intended.

Target Location Settings for uploading proof jobs. Proof jobs can be automatically uploaded to
a defined FTP or network location, or to a specific printer.

Proof standards and spot color sets

Generally, it is recommended to link the color management data (provided the respective files are already
present on the target system). If any file is not present on the target system, you can either export and
import the respective file separately or you embed the data. When embedding the data, all used files are
added to the proof job and the job will be imported in read-only mode.

Printer calibration

If a job uses a calibration set, the job transfer mode is irrelevant for the printer calibration, as a job with a
calibration set is always printed with the current calibration file of the target printer. As all calibration sets
are valid for a printer series such as Epson Stylus Pro x900 printers, you do not need to have the exactly
same printer on the target system, but can also print a job for an Epson Stylus Pro 4900 on a 7900 model.

If you set up a job with a custom calibration file (and not a calibration set), the color management files
have to be embedded when exporting / uploading the job to be able to import the job on another com-
puter. Consequently, the job is printed with the embedded custom calibration file and not with the current
calibration of the target printer (which is not recommended).

Control strips

If a proof job uses a control strip that is already present on the target system, the job can be easily uploaded
via the Link Job Data option. Custom control strips (which are not present on the target system), however,
cannot be embedded like any other file that is not present on the target system. To import a proof job that
uses a custom control strip, you need to export and import the control strip separately (Database view >
Control Strips >Export/Import button).
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14.1.1 Embedding or Linking Color Management Data?

When setting up a job, you usually define a lot of data such as the job settings, the image files, color pro-
files, and so on. Depending on whether a job is sent to a remote site with the used color management data
(option Embed Color Profiles) or if those are linked (Link to Color Profiles), there are a few things which
need to be taken into consideration when exporting or importing a job.

If you select the transfer mode Embed Color Profiles, all used application data will be embedded into the
proof job. This mode should be used when uploading proof jobs with custom application data (which are
not present on the target system). Proof jobs with embedded data are always write-protected to ensure that
the remote proof is printed exactly as defined by the sender. If you upload jobs with GMG application data,
which are also present on the target system, use the transfer mode Link to Color Profiles. When linking the
job data, only the internal database IDs of the used application data are written inside the XML structure of
the proof job, no files are sent along with the job.

14.2 Remote Proofing Settings
On the Remote Proofing tab, you can configure your system for sending proof jobs to remote sites (>
Remote Proofing Sites) and receiving proof jobs from remote sites (> Import FTP Settings). For a seamless
communication between sender and receiver, add your e-mail settings to keep updated on the proof status.

Group Short description See also

Outgoing E-Mail Noti-
fications

Fill in your e-mail settings for sending e-mail notifications, for example, to inform
other users when you sent a proof job to their FTP or network location. Check to
ensure your settings are set up correctly by sending a test e-mail.

Remote Proofing Sites Settings for sending proof jobs to remote sites. Click the Edit button to set up and
manage remote proofing sites. When you want a proof job to be printed on a remote
site, you can then select the defined remote site in the Manual Job Manager (Send to
button) or Workflow dialog (Printer > Export Job for Remote Proofing). This way,
proof jobs can be sent automatically to a target folder on an FTP or network loc-
ation.

"Managing Remote
Proofing Sites" on page
197

Incoming E-Mail Noti-
fications (Sent by
Remote Site)

If you want a feedback notification on sent proof jobs, fill in an e-mail address of
yours. The e-mail address is then embedded in the proof jobs and used by the noti-
fication service on the remote site to return an import notification, for example.

Import FTP Settings Settings for receiving proof jobs. Proof jobs can be automatically
imported from a defined FTP hotfolder and added to the job list in
GMG ColorProof. Available only if the option Automated Job
Import from FTP is selected.

If GMG ColorProof is not picking up jobs from your FTP server, please check your
antivirus firewall settings to ensure they are not blocking the communication
between GMG ColorProof and FTP server.

Import Hotfolder Set-
tings

You can alternatively automate the job import by specifying a target hotfolder. All
proof jobs that are copied or moved to this folder are automatically added to the job
list in GMG ColorProof. If the imported jobs are password protected, you need to
save a password list as a text file (Passwords.txt) into the hotfolder. Passwords are
entered in separate lines into the text file (line break as separator).
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Group Short description See also

Import Job Handling When importing a job with a larger media size than the one defined in the Target
Printer, you can specify a default action for the import. You can either keep the ori-
ginal job layout and then manually define a different media size or you can apply an
automatic placement with predefined settings for the image rotation.

Importing remote jobs can be made dependent on a specific dongle
serial number, forcing the system to only accept remote jobs from a
specific sender. To do so, insert one or more serial numbers and
protect the entry with the administrator password. The jobs expor-
ted out of the sender system automatically contain the license serial
number information of the sender.
On import, jobs can be automatically put on hold instead of directly being added to
the print queue.

14.3 Manual Remote Proofing
Proof jobs and color management files can each be transferred manually to another location by selecting
the file and using the Send To command. For the import, you can use the File menu (> Import Job) or the
Import commands for the respective Database items. You can automate the file import by defining an
import hotfolder (System > Remote Proofing> Automated Job Import via Hotfolder).

How to manually transfer proof jobs to another system

1. Configure a proof job in the Manual Job Manager and click Job > Send To.
The Send To dialog is displayed.

2. Select a Target Remote Site from the drop-down list.

3. Optional: Click the Edit button to edit a remote site.

4. Click Send to upload the file to the selected remote site.

Note Already printed jobs can be exported from the History list by right-clicking on a job and selecting the
Send To command from the context menu.

How to manually import proof jobs

1. System > General> Folder for Manually Imported Jobs: Select a folder for extracting the proof jobs
you want to import to.

2. On the File menu, click Import Job.
The Import Job dialog is displayed.

3. Browse for the job you want to import.

4. Optional: If you activate the option Print Directly, the job will be directly sent to the Print Queue. If
you do not select this option, the job will be opened in the Manual Job Manager.

5. Click Open to import the job.
The job archive is extracted to the specified Folder for Manually Imported Jobs and added to the Jobs
list. If the job was password-protected, you will need the correct password to import the file.

Note Import jobs with embedded color profiles are only saved temporarily. After printing the job, all
embedded job data such as the proof standards and spot color sets are deleted. This ensures that custom
profiles are only used for the submitted jobs and that the database of a remote system is not cluttered with
custom proof standards which are not used in local workflows.
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How to import proof jobs by use of a hotfolder

1. System > Remote Proofing > Import Hotfolder Settings: Activate the option Automated Job Import
via Hotfolder.

2. Under Job Import Hotfolder, select a folder for the import files.
This folder will be scanned in regular intervals for incoming job files.

3. Copy proof jobs to the specified Job Import Hotfolder.
All proof jobs will be automatically extracted and added to the job list in GMG ColorProof.

Tip GMG ColorProof creates a file called Errors.txt in your Job Import Folder. In case the extraction or the
import of a job fails, open this error log to see what causes the problem.

Password protection

When exporting a file, you can optionally enter a password to protect your files. This way, no files can be
imported without entering the correct password. To automatically import password-protected jobs, you
need to enter the password(s) into the Passwords.txt file which you can find in your Job Import Hotfolder.
Just open the text file and type in the password(s), one per row, and save the file when you are finished.

14.4 Automated Remote Proofing
Proof jobs can be automatically uploaded to an FTP target folder or network location, either by multi-select
in the job lists (> Send to) or by using the option Export Job for Remote Proofing in a workflow (Workflow
properties > Printer). Complementing the automated job upload, exported jobs can be automatically down-
loaded and printed from a target directory on a remote site.
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How to automatically export jobs from a workflow to an FTP server

1. System > Remote Proofing tab > Remote Proofing Sites: Click the Edit button to configure a new
remote site.
The Manage Remote Sites dialog is displayed.

2. Click the Add button to add a new remote site.

3. Enter a name for the remote site.

4. Under Color Management, select a transfer mode for the color management data.
Select the transfer mode Embed Color Profiles to embed the job data into the export archive (job is
read-only in this case). Select the transfer mode Link to Color Profiles to link the job data (recom-
mended if the color profiles are already present on the target system).

5. Optional: Use a password protection.

6. Optional: Enter the e-mail address of the recipient to notify him, when a job has been uploaded to his
site.
(Requires Outgoing E-Mail Notifications.)

7. Under Target Location > Automatic Transfer: Select FTP.

8. Browse for an FTP Target Folder to export the jobs to.

9. Fill in the necessary parameters for the FTP connection.

10. Optional: Test the FTP connection by clicking the Test button in the bottom right corner of the win-
dow.
(The network connection will be established automatically using the Windows internet options.)

11. Click OK to confirm the settings.

12. Close the Manage Remote Sites dialog and open the workflow you want to export jobs from.

13. On Printer tab, activate the option Export Job for Remote Proofing.
Please note that load balancing and nesting are not available for remote proofing.

14. Under Target Remote Site, select the remote site you set up in the previous steps.

15. Click OK to confirm the settings.
All proof jobs created by this workflow will now be uploaded to the specified target location instead
of being printed. If you want to first print and then upload the proof jobs, you can select the option
Print on Local Printer before Exporting.

Fig. 81 Automatic export of proof jobs from a workflow.
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How to automatically import proof jobs from an FTP server

1. System > Remote Proofing tab > Import FTP Settings: Activate the option Automated Job Import
from FTP.

2. Fill in the necessary parameters for the FTP connection.

3. Define a hotfolder to transfer the proof jobs from the FTP server to your local computer.
This way, all files will be automatically downloaded from the FTP server and added to the job list in
GMG ColorProof, load balancing the jobs to the available printers.

Import Job Handling—Image placement of imported proof jobs

In general, a remote proofing job is printed exactly as it was configured before the export. Thus the image
placement is not changed if this is not necessary in order to print the job. If, however, a proof job has been
configured for a larger media size than available on the import system, the proof job needs to be edited.
With the Import Job Handling functionality, you have the choice between manually editing the image
placement of proof jobs (> Keep Original Job Layout) or using the automatic placement of GMG Col-
orProof (> Apply Automatic Image Placement).

When keeping the original placement, a job that was configured for a larger media size and is load bal-
anced to a printer with a smaller media size, is put on hold and needs to be opened and configured in the
Manual Job Manager. If you select the automatic image placement, GMG ColorProof tries to rotate the
images in a way that they fit on the smaller media size. If an automatic placement is not possible (because
the images still do not fit), the job is also put on hold and needs to be configured manually.

14.5 Sharing Data Through a Central Server
In the following, you will learn how to share custom profiles or spot color sets on a local network for reas-
ons of maintenance.

Basically, all you have to do is: set up custom proof standards or spot color sets with the target file paths on
one computer, export the sets, and import them once to all other computers.

Note Whenever a profile is changed, the checksum will be updated, too. If you want to print a job with a
profile that has been changed, you will, for reasons of process safety, be informed of this change by an
error message in the Jobs list. Please open the corresponding proof standard and confirm this change by
clicking the OK button.
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How to share proof profiles or db3 files through a central server

1. Copy all proof profiles or db3 files you want to maintain and share from the respective subfolders of
the main program folder to a network drive.

2. Open the corresponding proof standard or spot color set in GMG ColorProof by double-clicking on it.

3. Enter the link to the profile or db3 file you copied to a network drive in step one. (Proof Standard:
Color Management tab, Spot Color Set: Import tab.)

4. Click OK to save your changes.

5. Right-click the proof standard or spot color set in the Database view and select Export on the context
menu.
The Export dialog is displayed.

6. Click the Save button to export the proof standard or spot color set.
All linked files are exported along with the selected proof standard or spot color set. The link to the
network you entered in step 3 will be preserved and checked when importing the file. If the path can-
not be found on the target system, the default path of the imported file will be used.
After exporting a proof standard or spot color set, you can change or edit the linked profile/db3 file
any time without having to repeat the procedure on all connected computers.

7. Import the standard or set in another GMG ColorProof instance (with the given file path, i.e. link to
the network).

8. Check the properties of the imported file and click OK to add it to your database.
This way, you can set up the same color management sets for use on several computers in your work
group, being sure to always use the latest version of the profile or db3 file.

Fig. 82 Proof Standard with a network link to a shared profile.
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15. Maintenance

15.1 Environment Backup
GMG ColorProof features a full backup of workflows and the environment. Moreover, it is possible to
export and import specific workflows, for example, if you want to share a certain configuration with a col-
league. The environment backup can be created on one computer and restored on another, independent of
the used operating system and the drives on which the paths are defined. This way, you can quickly trans-
fer a specific configuration to a different computer.

The environment backup feature saves and restores all folder paths (hotfolders, backup folders) and all pro-
gram settings. It also saves linked files such as color profiles.

An environment backup is also a very convenient feature if you need to set up the program on a new com-
puter.

If you follow a very strict security protocol in your company, it might also be worth considering to use the
Restore Backup feature for restoring the settings at the begin of each working day, to make sure that no
manual changes were applied to any folders or workflows, and thus to guarantee the full productivity of
your workflow setup.

To avoid data loss, especially when having a larger number of workflows, we recommend that an admin-
istrator saves a backup on a regular basis (for example, once a month) and/or each time before performing
a software update.

Tip Use the Backup Scheduler to automatically create environment backups in regular time intervals (Sys-
tem view > General > Environment Backup Scheduler).

How to save a backup

1. On the System menu, point to Environment Backup, and click Create.

2. Browse to the desired folder and save the backup under any file name.

How to restore a backup

Note As critical system parameters might be changed from software version to software version, it cannot
be guaranteed that an environment backup from a previous version can be restored on a newer installation.
Restore an environment backup only from the same software version you have used when creating the
backup.

Please make sure that you have full write access on all directories where folders are linked to GMG Col-
orProof. Otherwise, the Restore Environment Backup command might not be able to restore all folders.

1. On the System menu, point to Environment Backup, and click Restore.

2. Browse your folders and select a backup (env) file.
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